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Preface

This documentation describes the functions that are available for IBM® DB2® Web
Query for System i®.

Documentation Conventions
The following table lists and describes the conventions that apply in this manual.

Convention Description

THIS TYPEFACE

or

this typeface

Denotes syntax that you must enter exactly as shown.

this typeface Represents a placeholder (or variable), a cross-reference, or an
important term.

underscore Indicates a default setting.

this typeface Highlights a file name or command. It may also indicate a button,
menu item, or dialog box option you can click or select.

Key + Key Indicates keys that you must press simultaneously.

{ } Indicates two or three choices; type one of them, not the braces.

[ ] Indicates a group of optional parameters. None is required, but you
may select one of them. Type only the parameter in the brackets,
not the brackets.

| Separates mutually exclusive choices in syntax. Type one of them,
not the symbol.

... Indicates that you can enter a parameter multiple times. Type only
the parameter, not the ellipsis points (...).

.

.

.

Indicates that there are (or could be) intervening or additional
commands.
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Chapter 1. Introducing IBM DB2 Web Query for System i

Provides an overview of IBM DB2 Web Query for System i and describes the
end-user components and tools you use to run, view, create, and edit reports.

This documentation provides an overview of IBM DB2 Web Query for System i. It
also describes the components and tools you use to run, view, create, and edit
reports. Use this documentation to learn about the structure and the capabilities of
each component and tool.

IBM DB2 Web Query for System i Overview
IBM DB2 Web Query for System i is a complete, Web-ready data access and
reporting system, which takes advantage of the low-cost, low-maintenance, and
wide distribution capabilities of the World Wide Web and internal corporate Web
sites. This system also provides a streamlined reporting environment that virtually
eliminates the complexities of today’s corporate data.

Reporting Concepts
The reporting environment includes Domains which are the highest level of
organization. Domains provide data on a particular topic (such as sales, inventory,
or finance). The data is stored in different forms in the following domain tree
components: Reports and Other Files. The Other Files folder, available to
Administrators and Developers, can contain images (.gif, .jpg), HTML files, and
other files that you can use to customize and enhance reports.

Reporting Features
A selection of reporting tools is available for you to create and edit reports,
manipulate data in an existing report, and view a report.

Power Painter. Power Painter is a Web layout and report creation tool that enables
you to create output and page layout formats. It combines reporting, graphs, and
page layout design in a single tool.

Report Assistant. Report Assistant is an HTML-based tool that you use to create
tabular reports. From Report Assistant you select the data that constitute your
report, create new data from existing data, apply screening conditions to the data,
as well as format and style your report.

Graph Assistant. The Graph Assistant is an HTML-based tool that guides you
step-by-step through the creation of a graph. The Graph Assistant enables you to
create and style your graphs.

Reporting Interface
The reporting interface is ideal for users who quickly need to run reports. Check
your installation manual for information about browser compatibility. This
interface offers you the ability to access reporting tools such as Power Painter,
Report Assistant, and Graph Assistant.
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The reporting interface is an HTML-based front-end that allows you to:
v Run reports.
v Create reports and graphs using Power Painter, Report Assistant, or Graph

Assistant.
v Save reports and graphs.
v Share reports with other users.
v Edit reports.

Development Environment
The DB2 Web Query Developer Workbench product is an optional add-on
Windows-based development environment for creating applications. Developer
Workbench provides intuitive GUI tools that free developers from the hassles of
coding, thereby allowing them to concentrate on interface design, business logic,
and data manipulation. Using Developer Workbench, developers can build
powerful Web page interfaces that allow users to run customized reports.
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Chapter 2. Using the Reporting Interface

Describes the reporting interface for IBM DB2 Web Query for System i, which you
can use to select a domain, use items (reports, graphs, URLs) in the Domain Tree,
search domains, access reporting tools such as Power Painter, Report Assistant, and
Graph Assistant, and much more.

When you enter the reporting interface you are automatically connected to IBM
DB2 Web Query for System i.

From the reporting interface, you can:
v Select a domain.
v Use the items (reports, graphs, or URLs) in the Domain Tree.
v Access reporting tools such as Power Painter, Report Assistant, and Graph

Assistant.

Note:

The browser Back and Forward buttons cannot be used to navigate between pages
in the interface, or from an interface page to a page viewed before connecting to
the interface.

Opening the Reporting Interface
Before you can access the IBM DB2 Web Query for System i environment, you
must log on to the reporting interface.

Log On to the Reporting Interface
1. From the Login page of the reporting interface, click Login or enter the

following URL in your Web browser.
http://hostname:[port]/webquery

where:

hostname:[port]

Is the host name and optional port number (specified only if you are
not using the default port number) where the application is deployed.

2. Enter a valid i5 user ID and password.
3. Click Submit. The reporting interface opens.

Recommended Browser Setup
The following browser setup is recommended for use with the interface:
v Do not cache page content.
v Disable pop-ups for reporting environment.

For information on browser setting options, see the browser Help system.

Reporting Interface Layout
The reporting interface contains the following areas:
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v Domain Tree. Contains the list of reports that you can access. You can expand
the Domain Tree to view the entire name of an item by dragging the control bar
that separates the Domain Tree from the content area.

v Content area. Contains content when reports are displayed.

In the following image of the interface, the:
v Domain Tree is on the left side of the window.
v Content area is on the right side of the window.

Selecting a Domain
All of the domains that a user is authorized to access are displayed in the Domain
Tree. Depending on how your user profile is set up, you may not have access to all
domains.

The icon located next to an item in the Domain Tree represents the type of item. In
the following table, the first column lists the icon, and the second column describes
what the icon represents.

Icon Identifies...

- Domain Tree

Highest level of the report organization
containing folders and reports you can
access.

- Reports Folders

Location of created reports.

- Reports

Reports in a folder.

- Internet Links

Web pages and reports run from launch
pages.
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Using Domain Tree Items
A domain can contain reports, which are located in the Reports folders.

When you select an item from one of the Reports folders, a menu appears; it
allows you to select one of the available options. The option(s) for Reports
(identified by the Report icon) include Run, Power Painter, Report Assistant, Graph
Assistant, Delete, and Properties.

When you use the Delete option to delete a report, the Domain Tree refreshes and
collapses. If the report is the only item in the folder, the folder is also deleted when
you delete the report. You also have the option of deleting a folder including all of
its contents.

Note:

v If you are running very large reports, you may need to increase the virtual
memory on your machine. See your System Administrator for details.

v A menu does not appear if you are not an Administrator or a Developer.

Loading Domain Tree Folders
When a user opens one of the default folders in the Domain Tree, a request is sent
to retrieve subfolders directly under the top level folder. As each node of the tree is
expanded, only that section of the tree is populated. This reduces the time needed
to create the tree when a Domain is selected.

When reports from a folder are loaded into the Domain Tree, only a maximum of
25 report items are loaded each time. A link labeled View More is displayed in the
tree to enable users to retrieve up to an additional 25 items.

Creating Reports
In addition, you can create new reports from scratch in the Reports folder. You can
create your own reports using Report Assistant, Graph Assistant, or Power Painter
(if you have the required privilege). Depending on which tool you use to create
your report, you can edit your report using the same tool (Power Painter, Report
Assistant, or Graph Assistant). You can change the name of your report from the
Properties window.

Note: You may not be able to create reports if you do not have the privileges to do
so.

Create a Report in the Interface
1. In the Domain Tree, expand the Reports folder.
2. Right-click a subfolder and select Power Painter, Report Assistant, or Graph

Assistant.
3. Create and save your report. The report is saved in the Reports folder with the

name you provide.
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Text Editor

Administrators and Developers only can use the text editor to troubleshoot source
code for reports in the reporting interface.

The following table describes all of the functions available in the text editor. The
first column lists the buttons, and the second column lists the actions they
produce.

Button Action...

- Save button

Saves the report. Only appears if the Text
Editor is opened from the Reports subfolder.

- Save As button

Saves the report in the Reports folder with a
name you specify.

- Run button

Runs the current report.

- Quit button

Exits the Editor window. If you made
changes to the original report, a window
prompts you to save or cancel the changes.

- Help button

Opens the online help.

- Cut, Copy and Paste buttons

Cut, copy, or paste, respectively, the
highlighted text.

- Delete, Select All, Undo, and Redo buttons

Delete, select all, undo, and redo,
respectively.

- Find and Replace button

Find and replace text.

- Go to line button

Enables you to go to a particular line
number in the report.

- Uppercase button

Converts highlighted text to uppercase.

- Lowercase button

Converts highlighted text to lowercase.

- Text color button

Sets the text color in the editor.
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Button Action...

- Background color button

Sets the background color of the editor.

Note: The text color and background colors
are for the current session only.

- Font drop-down menu

Enables you to change the font of the editor.

- Font size drop-down menu

Enables you to change the font size of the
text in the editor.

Note:

v If you create a report using the Power Painter, Report Assistant, or Graph
Assistant, and then edit for troubleshooting with the text editor, you can only
open and edit the report using the text editor.

v If you use a Firefox browser, the editing toolbar, which begins with the cut,
copy, paste features listed in the table, does not appear. Use the standard control
keys (Ctrl+X, Ctrl+C, Ctrl+V) to cut, copy, and paste.

v When you click the X in the upper right corner of the text editor, the procedure
is saved, however the Domain Tree does not refresh. To refresh the Domain Tree
contents, click the refresh button (circle with arrow) in the control bar.

Using Banner Hyperlinks
The hyperlinks in the banner provide a way to easily navigate the reporting
interface:
v Logoff. Allows you to logoff the interface.
v Help. Opens a menu where you can select:

– Contents and Index, which opens the online help.
– About DB2 Web Query, which provides release information.
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Chapter 3. Using Power Painter

Describes how to use the Power Painter to create reports, graphs, and page
layouts.

Power Painter is a Web layout and report creation tool (available with DB2 Web
Query), built using AJAX technology, that enables you to create output formats
and page layout formats. It combines reporting, graphs, and page layout design in
a single tool.

Functionality of Power Painter
You can accomplish the following tasks and functions using the Power Painter tool:
v Create a Compound Report, which is a reporting document with multiple

reports and charts.
v Create a Coordinated Compound Report, which is a compound document where

the report is collectively sorted and collated by a common sort group.
v Create exact positioning requirements by adjusting the layout properties in the

canvas.
v Position components and report elements relative to each other and the page.
v Style reporting elements individually by applying a Style Sheet, theme, or

conditional styling rules.
v Access and create Compound Reports using multiple data sources to build

reports and perform ad hoc analysis.
v Develop reports using real-time data or sample data and limit the number of

records for the entire report, individual reports, or individual graphs.

Selecting and Adding a Data Source
You can use Power Painter to access a Data Source to build reports and perform ad
hoc analysis. You can open and work with Master Files by using the Data Sources
palette in Power Painter.

Open a Data Source
1. Upon opening the Power Painter tool, you are prompted to select a Data

Source. Select a Master File and click OK.
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The fields from the Data Source are available in the Data Sources palette.
Note: This step is optional. You can open or close Data Sources in Power
Painter at any time.

2. To open a new Data Source, click the Open a new data source button
from the Data Sources palette toolbar.
The Open dialog box appears prompting you to select a Data Source.

Close a Data Source

Note: If there is a component on the canvas that is referencing data from an open
Data Source, you will not be able to close the Data Source unless you delete the
associated component.

To close an open Data Source, click the Close current data source button
from the Data Sources palette toolbar.

The fields are removed from the Data Source palette.
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Using Power Painter Options and Palettes
The following image is an example of the Power Painter tool with multiple
components. Several options and palettes enable you to customize the layout for
the Power Painter tool.

The following options are available in Power Painter:

Menu bar

Standard browser menu bar options such as File, View, Tools, and so on.

Toolbar

Power Painter toolbar options such as Layout, Run, View, Alignment,
Palettes, and so on.

Canvas

The canvas where you drop objects and paint the reporting document. The
reporting document can be made up of text elements, images, tabular
report objects, charts, and lines.

The following palettes are available in Power Painter:

Toolbox palette
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Contains the tabular report, chart, text, image, and line objects for painting
your document.

Query palette

Enables you to build and customize queries for tabular reports and charts.

Data Sources palette

Contains your Data Source information.

Properties palette

Contains the property settings for the components in the canvas.

Using Palettes in the Canvas
Upon opening the Power Painter tool, the canvas appears with all of the palettes
minimized and pinned in the Power Painter margins. You can show, hide, or move
these palettes as needed. Power Painter retains these settings.

Power Painter is able to store information so that the options you set in a single
session are remembered and applied the next time you use the tool. Examples of
the settings that can be saved are how the palettes are displayed, the theme
selected, field display options, and so on. The information for these settings is
stored under each user’s directory in the DB2 Web Query repository.

Note: Reusing stored settings is only available if you access the same DB2 Web
Query environment.

Palettes in Power Painter:
v Resizable. You can change the height and width by dragging the sides of the

palette.
v Dockable. You can dock the palettes to the sides of the screen (top, bottom, left,

right) or float them anywhere in the work area.
v Stackable. If multiple palettes are docked on the same side of the canvas, they

become stacked.
v Pinnable. You can minimize the palettes and pin them in the Power Painter

margins.

Dock and Undock a Palette
1. Required: Double-click a palette to dock it on the canvas.

or
Drag a palette within 10 pixels of the edge (top, bottom, left, right) of the
canvas.
Note: A palette is docked when both the pin and close button are available
from the palette toolbar.

2. To undock a palette (float it), click the palette toolbar, left-click and hold your
mouse, and drag the palette to a new location on the canvas.
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Stack Palettes

Drag and dock multiple palettes to one side of the canvas to create vertical or
stacked palettes. You can adjust the height/width of each palette in the docking
area.

Note: Resizing any palette automatically resizes the rest of the palettes so that they
can fit into the docking area.

The following image is an example of vertically stacked palettes in the Power
Painter tool.

Pin a Palette

1. Required: Click the pin button located on the toolbar of an open palette.
The palette is pinned and minimized.
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2. You can perform the following actions with pinned palettes:
v Hover your mouse over the palette to show its contents.
v Hover your mouse out of the palette to minimize it again.
v Double-click a palette to dock it on the canvas.

Show a Palette
1. Select Palettes from the View menu.

Palettes that are checked are shown in the canvas.
2. Select an unchecked palette name.

The palette is shown maximized on the canvas. You can move or resize the
palette as needed.

Close a Palette
1. Required: Select Palettes from the View menu.
2. Required: Select a checked palette name from the list.

The palette is closed and removed from the canvas.

Note: You can also close an open palette by clicking the Close button from
the palette toolbar.

Reset the Power Painter Layout

From the View menu, select Reset Layout from the Palettes submenu.
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The Power Painter layout resets with the default palettes shown (Toolbox,
Properties, Data Sources) in the canvas.

Using Power Painter Components
The available Power Painter components are Report, Graph, Image, Text, and Line.
You can select these components from the Toolbox palette or from the Main
toolbar. The component objects are associated with corresponding properties that
you can set using the properties palette.

The following image is an example of the Toolbox palette in Power Painter.

Insert a Report Component in Power Painter
1. Required: Select the Report button from the Toolbox palette and drag it onto

the canvas.
or
Select Report from the Insert menu. The component is automatically inserted
into the canvas.
The report appears on the canvas.

2. From the Data Sources palette, select a field and drag it to the report object.
When you drag a field into the report, drop the field on the By, Across, Sum, or
Coordinated folder.
You can also double-click a field to automatically add it to the report. Numeric
fields, such as decimal and floating point, are added to the Sum folder.
Non-numeric fields, such as alphanumeric, and date fields are added to the By
folder.
Note: By and Across folders are for sorting, Sum folders are for aggregating
and displaying, and Coordinated folders contain a common sort field for

Chapter 3. Using Power Painter 15



creating multiple reports and graphs that are burst into separate page layouts.
Each value for a coordinated sort field displays on a separate page.

3. Required: To edit or delete these field selections, open the Query palette or the
Query Popup.
v From the View menu, select Query from the Palettes submenu.
v Select a report, right-click and select Query Popup from the context menu.

or
Double-click the report to bring up the Query Popup.

The By, Sum, Across, and Coordinated folders appear with the selected fields in
the report. You can drag and drop fields into different folders, delete fields, and
add and edit compute fields from this dialog box. You can also select Print to
display all of the values found in the data source for a selected field, or select
Sum to sum the values of a selected numeric field.

4. You can select a field from the Query palette to further customize the field
properties in the report.

5. You can select the report to view or edit the properties for the report in the
Report properties palette.

6. Select Save from the File menu to save the report.
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Report Properties

When a report object is selected, the following properties are available from the
Report properties palette.

Position: Top

Indicates the starting position for the top edge of the report. You can type
in a different value to change the position or manually drag the report on
the canvas.

Position: Left

Indicates the starting position for the left edge of the report. You can type
in a different value to change the position or manually drag the report on
the canvas.

Height

Indicates the height of the report object. You can type in a different value
to change the height or manually drag the report object on the canvas.

Width
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Indicates the width of the report object. You can type in a different value to
change the width or manually drag the report object on the canvas.

Stylesheet: reference

Click the browse (...) button to select an external stylesheet. The report
references the selected stylesheet which controls the global level styling of
the report. You can choose from a predefined set of stylesheets, or a
stylesheet from the Import directory.

Font

Shows the default global font for the report.

Column title styling

Click the browse (...) button to open the font dialog box. Select the font,
style, size, text, and background color for the column titles in the report.

Column data styling

Click the browse (...) button to open the font dialog box. Select the font,
style, size, text, and multiple background colors for the data in the report.

Heading

Adds a heading to the report. Click the browse (...) button to open the
Heading dialog box.
v You can use the Headings toolbar to customize and modify the font,

style, size, text color, background color, and so on.
v You can use the Data Sources area to add fields from the Master File as

your heading.

Footing

Adds a footing to the report. Click the browse (...) button to open the
Footing dialog box.
v You can use the Footings toolbar to customize and modify the font,

style, size, text color, background color, and so on.
v You can use the Data Sources area to add fields from the Master File as

your footing.

Column totals

Shows columns totals in the report. No is selected by default. To show
column totals, use the drop-down list to select Yes.

Row totals

Shows row totals in the report. No is selected by default. To show row
totals, use the drop-down list to select Yes.

Display every sort value

Determines when all instances of a vertical sort (By) field are displayed in
the report. No is selected by default to omit duplicates. To display every
instance of a vertical sort field value, use the drop-down list to select Yes.

Sizing and Overflow

Determines the vertical sizing of the report by setting fixed or flowing
overflow. For more information about sizing and overflow, see Setting
Overflow Options in Power Painter.

Minimize Column Width
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Shrinks the column width to fit the widest value in the report. Yes is
selected by default. Select No from the drop-down list to expand all of the
columns.

Record Limit

Limits the number of records used to retrieve data at run time.

Use SQL Engine Joins

Enables the database to use its internal optimization techniques which
reduce the volume of database-to-server communications and improve
response time.

Page numbering

Select On, Off, or No lead from the list box.

Currency symbol

Overrides the default currency symbol for the reporting server. Use the
drop-down list to select from Default, USD, GBP, JPY, EUR, or $. You can
also type a one-character custom symbol directly in the value column
adjacent to the Currency symbol property.

Right-click Report Properties

When you right-click a report object, the following options are available from the
dialog box that appears:

Query

Opens the query dialog box.

Size to Fit

Resizes the report as fields are added and deleted.

Delete

Deletes the report.

Properties

Displays the Report properties dialog box.

Field Properties

When a report is selected, the following properties are available from the Field
properties palette.

Note: The field properties available vary depending on the type of sort field
selected.
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Visible

Controls whether a field appears in the report graph, or is hidden. If
Visible is set to No, the column is hidden, but is still used in calculations.

Title

Enables you to enter a title for the field in the report graph.

Sorting

Sorts the column data in ascending or descending order.

Total Applies aggregation and sorting to numeric columns in one pass of the
data and is available for Sort by and Sort across fields. You must have an
aggregating display field, such as Sum, in the report.

Page break

Starts a new page when the value of a selected sort field changes.

Subtotal

Enables you to display subtotals for numeric data whenever the value of
the selected sort (By) field changes. By default, numeric field values are
summed and displayed as subtotals. Additionally, you can display other

20 System i: Database IBM DB2 Web Query for System i



summary values by applying prefix operators to numeric fields, including
computed fields, by clicking the browse (...) button to open the Sub Total
Options dialog box. For more information, see Display Subtotals and Other
Summary Values Using Prefix Operators.

Underline

Includes a horizontal line across the width of a report after the value of the
selected sort field changes.

Include missing instances

Displays missing instances of data for related fields in the report.

Drill down

Enables you to supply information to another report by using a hyperlink,
procedure, or parameter.

Conditional Styling

Enables you to assign a conditional style to a report element. Conditional
styling enables you to define conditions that determine when to apply
particular fonts, text style, and so on. For more information about
conditional styling, see Create Conditional Styling Rules.

Subheading

Adds a subheading to the report at sort breaks. Click the browse (...)
button to open the subheading dialog box.
v You can use the subheadings toolbar to customize and modify the font,

style, size, text color, background color, and so on.
v You can use the Data Sources area to add fields from the Master File as

your subheading.

Subfooting

Adds a subfooting to the report at sort breaks. Click the browse (...) button
to open the subfooting dialog box.
v You can use the Footings toolbar to customize and modify the font,

style, size, text color, background color, and so on.
v You can use the Data Sources area to add fields from the Master File as

your footing.

Ranking

Includes a column with a numeric rank for each row in a vertically sorted
report.

Ranking limit

If specified, this value limits the number of ranked values to be retrieved.

Ranking title

Displays a default column title as RANK with the sort field. You can type
in a unique title name for the ranked field.

Ranking title font

Click the browse (...) button to open the font dialog box. Select the font,
style, and size for the ranking title.

Ranking data font
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Click the browse (...) button to open the font dialog box. Select the font,
style, and size for the ranking data.

Title font

Click the browse (...) button to open the font dialog box. Select the font,
style, size, text and multiple background colors for the column title.

Data font

Click the browse (...) button to open the font dialog box. Select the font,
style, size, text and multiple background colors for the data column.

Table of Contents

Enables you to generate a Table of Contents (TOC) page which shows a
summary of the document’s contents, along with page numbers, and can
be printed with the document. The entries in the Table of Contents enable
you to easily navigate to a particular section while viewing the document.

Note: The Table of Contents only appears as a field option if you are using
a coordinated report.

Insert a Graph Component in Power Painter
1. Select the Graph button from the Toolbox palette and drag it onto the canvas.

or
Select Graph from the Insert menu.
The New Chart dialog box appears.
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2. Select a chart type and click Finish.
The graph appears on the canvas.
Tip: To view the New Chart dialog box after the graph has been added to the
canvas, select Show Chart Types from the right-click context menu of the
graph.

3. From the Data Sources palette, select a field and drag it to the graph object.
When you drag a field into the graph, drop the field on the Y axis, X group
axis, Coordinated, or other specialized field container.
You can also double-click a field to automatically add it to the graph. Numeric
fields, such as decimal and floating point, are added to the Y axis (or other
specialized) container. Non-numeric fields, such as alphanumeric, and date
fields are added to the X group axis (or other specialized) container.
Note: The Coordinated field container contains a common sort field for creating
multiple reports and graphs that are burst into separate page layouts. Each
value for a coordinated sort field displays on a separate page.
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4. Required: To edit or delete these field selections, open the Query palette or the
Query Popup.
v From the View menu, select Query from the Palettes submenu.
v Select a graph, right-click and select Query Popup from the context menu.

or
Double-click the graph to bring up the Query Popup.

The Y axis, X group axis, and Coordinated field containers appear with the
selected fields in the graph. Note that some specialized graphs have other field
containers. You can drag and drop fields into different containers, delete fields,
and add and edit compute fields from this dialog box. You can also select Print
to display all of the values found in the data source for a selected field, or
select Sum to sum the values of a selected numeric field.

5. You can select a field from the Query palette to further customize the field
properties in the graph.

6. You can select the graph to view or edit the properties for the graph in the
Chart properties palette.

7. From the View menu, select Chart Editor from the Palettes submenu to further
customize the chart titles, legends, axis, and so on.

8. Select Save from the File menu to save the graph.
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Chart Properties

For most chart types, when a graph object is selected, the following properties are
available from the Chart properties palette. Note: Some chart types with unique
properties, such as pie and three dimensional charts, have specialized properties
not shown below.

Crosstab Mode

Select from Yes or No. Displays the Series-legend icon and enables
secondary X-axis functionality.

Record limit

Type a number to edit the record limit value.

Use SQL Engine Joins

Enables the database to use its internal optimization techniques which
reduce the volume of database-to-server communications and improve
response time.

Top
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Indicates the starting position for the top edge of the graph. You can type
in a different value to change the position or manually drag the graph on
the canvas.

Left

Indicates the starting position for the left edge of the graph. You can type
in a different value to change the position or manually drag the graph on
the canvas.

Height

Indicates the height of the graph object. You can type in a different value
to change the height or manually drag the graph object on the canvas.

Width

Indicates the width of the graph object. You can type in a different value to
change the width or manually drag the graph object on the canvas.

Apply template

Select from any of the available templates to apply a predefined color
scheme to change the appearance of your chart.

Chart title

Type the desired title text.

Chart subtitle

Type the desired subtitle text.

Chart footnote

Type the desired footnote text.

Use 3D effect

Select from Yes or No to apply or not apply a three dimensional effect on
the graph.

Legend position

Select the desired option for positioning the chart’s legend.

Show data values

Select from Yes or No to display or not display data values on the graph.

X-axis Major grid

Select from Yes or No to display or not display X-axis major gridlines on
the graph.

Y-axis Major grid

Select from Yes or No to display or not display Y-axis major gridlines on
the graph.

Fit to Chart area

Select from Yes or No to turn auto placement on or off.

Chart Editor Dialog Box

When the Chart Editor dialog box is open in Power Painter, properties are
available for each object in the chart editor. The following image is an example of
the Chart Editor and the properties palette in Power Painter.
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Insert a Text Component in Power Painter
1. Required: Select the Text button from the Toolbox palette and drag it onto the

canvas.
or
Select Text from the Insert menu.
The Text Component dialog box appears on the canvas.
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2. Manually type text into the text box area to use the default font.
3. Click the Font Properties button to open the Font dialog box.
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You can customize the font, style, size, and text color of the text.
4. Click OK to close the Font dialog box.
5. Required: Click OK to close the Text component dialog box.

The text is inserted into the canvas.
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6. You can select the text component to view or edit the properties for the text in
the Text properties palette.

7. Select Save from the File menu to save the text.

Text Properties

When a text object is selected, the following properties are available from the Text
properties palette.

Height

Indicates the height of the text object. You can type in a different value to
change the height or manually drag the text object on the canvas.

Position: Left

Indicates the starting position for the left edge of the text.

Position: Top

Indicates the starting position for the top edge of the text.

Width

Indicates the width of the text object. You can type in a different value to
change the width or manually drag the text object on the canvas.
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Insert an Image Component in Power Painter
1. Select the Image button from the Toolbox palette and drag it onto the canvas.

or
Select Image from the Insert menu.
The Open dialog box appears on the canvas.

2. Select from the list of image files available.
Note: The Reporting Server is the default location for all stored images.
Images need to be copied to the appropriate directories by your administrator.

3. Required: Click OK to insert the image. The image is added to the canvas, and
the size defaults to the size of the image.

4. You can select the image component to view or edit the properties for the
image in the Image properties palette.

5. Select Save from the File menu to save the image.

Right-click Image Properties

When you right-click an image, the following options are available from the dialog
box that appears:
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Reset to original size

Resets the image to the original size.

Deletes

Deletes the image.

Properties

Opens the Image properties dialog box.

Note: Hover over an image to view the file name.

Image Properties

When an image object is selected, the following properties are available from the
Image properties palette.

Height

Indicates the height of the image object. You can type in a different value
to change the height or manually drag the image object on the canvas.

Position: Left

Indicates the starting position for the left edge of the image.

Position: Top

Indicates the starting position for the top edge of the image.

Width

Indicates the width of the image object. You can type in a different value to
change the width or manually drag the image object on the canvas.

Insert a Line Component in Power Painter
1. Required: Select the Line button from the Toolbox palette and drag it onto the

canvas.
or
Select Line from the Insert menu.
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The line object is added to the canvas as a positioned horizontal line.

Note: To insert a vertical line, use the properties palette to change the
orientation to vertical.

2. You can select the line component to view or edit the properties for the line in
the Line properties palette.

3. Select Save from the File menu to save the line.

Line Properties

When a line object is selected, the following properties are available from the Line
properties palette.

Color

Sets the color of the line. Click in the color value field to open the color
dialog box.

Height

Indicates the height of the line object. You can type in a different value to
change the height or manually drag the line object on the canvas.
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Orientation

Indicates the horizontal or vertical orientation of the line on the canvas.

Position: Left

Indicates the starting position for the left edge of the line.

Style

Sets the style of the line. Use the drop-down list to select from solid,
dotted, dashed, and so on.

Weight

Sets the thickness of the line to light, medium, or heavy.

Width

Indicates the width of the line object. You can type in a different value to
change the width or manually drag the line object on the canvas.

Display Subtotals and Other Summary Values Using Prefix
Operators

The Subtotal property in the Field Properties palette enables you to display
subtotals, and other summary values using prefix operators, for any or all of the
numeric fields, including computed fields, in a report query. From the Field
Properties dialog, when you click the browse (...) button to the right of the
Subtotals property, the Sub Total Options dialog box opens.
1. Select the Sub Totals option to replace the default setting of None.

If you are using computed fields, select the Recomputed Sub Totals option
instead.

2. Numeric field values are summed and displayed as subtotals in the report by
default. To display summary values other than the default subtotals, select
prefix operators using the drop-down lists in the Prefix area that are adjacent to
each of the selections in the Columns area. Note that the Sum prefix produces
the same subtotal results as not selecting a prefix operator.
All of the available prefix operators are listed and described in the following
table.

Prefix Description Displayed in Prefix List

SUM. Compute the sum of values Sum

ASQ. Compute the average sum of
squares

Average Square

AVE. Compute the average value Average

CNT. Count the items Count

FST. Select the first value only Show first in group

LST. Select the last value only Show last in group

MAX. Select the maximum value
only

Maximum

MIN. Select the minimum value
only

Minimum

3. To display all numeric field values as subtotals or other summary values in the
report, select the Apply totals to all columns check box in the Columns area.
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4. Required: To display subtotals or other summary values for a subset of the
numeric fields in the report, make sure the Apply totals to all columns check
box is de-selected, then select check boxes for the individual numeric fields in
the Columns area of the Subtotal tab.
When Apply totals to all columns is selected, options for all individual fields
in the Columns area are inactive by default.

5. To modify the default subtotal title, which is set to *TOTAL, type the desired
text you want to display as the title for all subtotals and any other selected
summary values in the Current Subtotal Text field.

6. To hide subtotals for sort fields that have only a single value, select the
Suppress for single lines check box.

The following image shows the Sub Total Options dialog box.

Using Reporting Functions
The following reporting functions are available within the Data Sources palette of
the Power Painter tool:
v Create a virtual field (DEFINE) for your report.
v Create a report level calculation (COMPUTE) for your report.
v Add a JOIN relationship by using the Joins tab in the Data Sources palette.
v Create conditional styling rules by using the Create Conditional Style Rule

dialog box.
v Create filters (WHERE/WHERE TOTAL statements) using the Selection Criteria

palette.
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v Use the Auto Prompting Facility to select parameters for your report.

Create a DEFINE Statement

1. Required: Click the Define button from the Data Sources palette.
The Field creator dialog box opens.

2. Required: Type the name of the virtual field in the Field input box.
3. Required: Enter an expression in the expressions box.
4. Required: Click OK to close the Define field creator dialog box.

The DEFINE field is added to the report field list.
5. Drag and drop the DEFINE field into the report.

Create a COMPUTE Statement

1. Click the Compute button from the Query palette.
The Field creator dialog box opens.

2. Type the name of the computes field in the Field input box.
3. Enter an expression in the expressions box.
4. Click OK to close the Compute field creator dialog box and apply the

COMPUTE statement.
The COMPUTE field is added to the report.

Create a JOIN Between Data Sources
1. Click the Joins tab in the Data Sources palette.
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2. Click the Add Join button from the Data Sources palette toolbar.
3. Required: Select a target Master File and click OK.

The Create Join dialog box opens.
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Note: Joins can also be created on defined fields. For more information about
defined fields, see Create a DEFINE Statement.

4. Type a name for the Join in the Description field.
5. Select the Type and Instances for the Join or use the default selections.
6. Click the Select a source field browse (...) button to select the Join source

field.
7. Click the Select a target field browse (...) button to select the target fields.

Note: If no target fields are available, you are notified that there are no fields
found.

8. Click Save & Create to save the Join relationship.
The joined field is added to the Joins tab.

38 System i: Database IBM DB2 Web Query for System i



9. Click the Fields tab in the Data Source palette to view the joined data.
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10. Drag and drop joined fields onto the canvas as you would any other field.

Note: To edit a join, double-click the join.

Create Conditional Styling Rules
1. Ensure that the Query palette or popup is open on the canvas:

v From the View menu, select Query from the Palettes submenu.
v Select a report or graph component, right-click and select Query Popup from

the context menu.
or

v Double-click the report or graph component to bring up the Query Popup.
2. Select the field name in the Query palette.

When fields are selected, properties for each field are available in the Field
properties palette.

3. Click the Field properties palette and scroll down until you see Conditional
styling.

4. Click in the Conditional styling value field and select the New styling rule
button.
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The Create Conditional Style Rule dialog box opens.
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5. Required: Create the style conditions for the field.
a. Required: Type a name for the condition or accept the default.
b. Required: Select a relationship for the condition from the Relationship

drop-down list.
c. Specify a value by doing one of the following:

v Type a literal value in the Value input field.
or

v Click Values from the Compare type section to display existing data
source values.

d. Click Done to save and apply the conditional style rule.
The condition is added to the Field properties palette and the condition is
applied to the data on the Power Painter canvas.
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The following image is an example of the Field properties palette with a Low
Balance condition rule. The report object shows red text where the conditional
styling rule was applied.

Create a WHERE Statement
1. Required: Select a report or graph object in the Power Painter canvas.
2. Required: From the View menu, select Selection Criteria from the Palettes

submenu.
The Selection Criteria palette appears on the bottom of the canvas.

3. Required: Drag a field name from the Data Sources palette to the Selection
Criteria palette.
The WHERE statement is added to the Selection Criteria palette.
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4. Required: Specify the condition by using the drop-down list.

5. Click Select Value to open the Select Value dialog box.
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6. Required: Select a Constant, Parameter, Field or Value selection button.
v If creating a constant, manually type in a value for the WHERE statement.
v If creating a parameter, click the browse (...) button to open the Variable

Editor dialog box. For details, see Create Parameters in a Standard Report.
Select the name, selection, a value options for the WHERE statement.

v If creating a Field or Value, select a value from the list supplied.
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7. Required: Click OK to close the Select Value dialog box.
The value is added to the Selection Criteria palette and the report or graph
reflects the WHERE statement as soon as the value is selected.

Note: To delete the WHERE statement, select the WHERE statement check box
and click the red X on the blue highlighted line in the Selection Criteria palette.

Importing Values From External Files for WHERE Statements
When developing a query, you can use a locally saved, external file as selection
criteria to limit query results. This enables you to quickly build a query containing
a large number of WHERE statement values without having to manually enter
repetitive or readily available data.

Create a Value List From an External File
1. Required: Navigate to the Selection criteria area.
2. Required: Begin creating a WHERE statement by selecting a field from the list

of available fields.
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3. Required: Select a data comparison option that can accept multiple values.
Valid options include EQUAL to, NOT EQUAL to, IN literal list, NOT IN
literal list, EXCLUDES literal list, and INCLUDES literal list.

4. Click Select values.
The Values dialog opens.

5. Click the import button as shown in the following image.

A dialog box opens as shown in the following image.

6. Select either the Flat file or Excel Spreadsheet (XLS) File Format option.
7. Click the Browse button.

A standard file selection dialog opens.
8. Select an external file to import from your local machine or network.

Note: The external file must only contain text with new line delimiters.
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9. Click OK.
The values contained in the file are displayed in the Multiple values entered
list in the right pane of the dialog.

10. Optionally, you can remove specific values from the Multiple values entered
list or move values up or down within the list.

11. Click OK.
You can save the query for future use and reopen the query to append new or
remove existing values.

Creating Parameters for Use in the Auto Prompting Facility
When a parameter selection criteria is added in Power Painter, the auto prompting
facility appears at run time.

Create Parameters and Run in the Auto Prompting Facility
1. From the Selection Criteria palette, create a WHERE statement.
2. Click the Select Value button.

The Select Value dialog box opens.
3. From the Select Value dialog box, select Parameters and click the Edit

Parameter Properties button.
The Variable Editor dialog box opens.
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4. In the Variable Editor dialog box, verify the Name and Description fields,
which are automatically populated based on the field you selected to create the
WHERE statement.
You can edit the populated values as needed.

5. Required: Choose from the following Selection options:
v Dynamic. This is the default option. The Data Source and Field values are

selected automatically based on the field used to create the WHERE
statement and can be changed as needed.
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v Static. Select the Constant or Value option. For Constant, enter one or more
values. For the Value option, all of the values for the selected field appear in
the Value list box. Move the values you want to the Multiple Values Entered
list box using the plus button.

For either the Dynamic or Static option, you can select the Select multiple
values at runtime check box to provide more than one value to the report from
the auto prompt page. In addition, the user will be able to select all values
from the values list.

6. Click OK to exit the Variable Editor.
The parameter is added to the Select Value dialog box.

7. Click OK to close the Select Value dialog box.
8. Click Run from the File menu in Power Painter.

The Auto Prompting facility appears.

Controlling the Overflow and Relative Positioning of Objects in Power
Painter

In Power Painter, you can control the overflow of reports, and relative vertical
positioning of reports and graphs, so they fill an entire page and maintain their
relative positions in the document. The Sizing and Overflow property in the
Report Properties palette is used to control overflow and relative positioning.

Overflow is defined as the area of a report that exceeds its defined space in the
page layout. For example, a multi-page report and a graph can both be added to a
single page layout with the graph positioned beneath the report. The report can
flow to fill the page and the graph can be relatively positioned to the report so it is
placed at the end of the document following the complete rendering of the report.

Note: There is currently no method of controlling horizontal overflow.
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Setting Overflow Options in Power Painter
When executing a report, the area that flows outside of the allocated space for the
report is considered the overflow. The following image is an example of the canvas
in Power Painter.

You can set the size and overflow of a report object to control the overflow at run
time. Sizing and overflow options are available through the Report Properties
palette.
v Fixed. When Sizing and Overflow is set to Fixed, the report is confined to the

dimensions of the canvas at run time and continues to output on multiple pages
within the same fixed dimensions until all of the data is shown.

v Flowing. When Sizing and Overflow is set to Flowing, the report fills the page
at run time and automatically pushes surrounding objects down the page until
the report is finished. This enables other objects such as repeating images and
text (headers and footers) to be shown and not overlapped by the flowing
report.

Note: These options only apply to report objects. There are no size and overflow
properties for graphs, images, text, or lines.

The following image is an example of a report with Sizing and Overflow set to
Fixed. Note how the report output maintains the size of the report object in the
Power Painter canvas, spreading the report across 6 pages.
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The following image is the same report with Sizing and Overflow set to Flowing.
Note how the report expands to fill the page at run time.
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Using Fixed Overflow in Power Painter
Reports using fixed overflow maintain the size and position of the report object
from the Power Painter canvas in the report output. You can customize and
maintain the fixed position of the report output by adjusting the position and size
options from the Report properties palette.

Customize the Fixed Position and Size of an Object
1. Required: Select an object from the Power Painter canvas.

The Report properties palette shows the available properties for the selected
object.

2. Select Fixed from the Sizing and Overflow drop-down list.
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3. To adjust the position and size of the object at run time, edit the Position Left,
Position Top, Height, and Width properties in the Report properties palette.
or
To adjust the position, hover the mouse pointer over the object until a four-way
arrow appears, then click and drag the object in any direction. To adjust the
size, hover the mouse pointer over any of the square corners or midpoints
along the border of the object until a two-way arrow appears, then click and
drag the square in any direction.

4. Run the report.

Note: If the document contains multiple fixed reports, the report output maintains
the same size and position as the report objects in the Power Painter canvas, as
shown in the image below.
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Note: If the document contains a fixed report and a graph, the report may be
broken up around the graph object. You can set the relationship between the graph
and the report to have the graph display after the report. For more information
about setting relationships, see Relate Surrounding Objects to a Report.
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Using Flowing Overflow in Power Painter
Reports using flowing overflow begin the report output at the upper left corner of
the report object and fill the page with the report results. Flow margins are
available which enable you to adjust the canvas so that flowing objects fill the
page.

Note: Flowing overflow is not available for graphs, images, text, or lines. For
example, if a graph is included in the document and the graph overlaps the report
at run time, you must set a relationship between the graph and the report so the
graph flows after the report at run time.

Set the Flowing Report Property
1. Required: Select an object from the Power Painter canvas.

The Properties palette shows the available properties for the selected object.
2. Required: Select Flowing from the Sizing and Overflow drop-down list.

Tip: Flow margins are available for the canvas which further enable you to
adjust the page so that the report fills each page between the flow margins. For
more information about flow margins, see Set Flow Margins for the Power
Painter Canvas.

3. Run the document.
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Note: If the document contains multiple flowing reports and the reports overlap at
run time, you must set the relationship between the reports. For more information
about setting relationships, see Relate Surrounding Objects to a Report.

Note: If the document contains a flowing report and a graph, and the graph
overlaps the report at run time, you must set the relationship between the graph
and the report. For more information, see Relate Surrounding Objects to a Report.
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Set Flow Margins for the Power Painter Canvas

You can set the flow margins for the document, which become page margins in the
report output when Sizing and Overflow is set to Flowing for the report. Flow
margins are set through the top and bottom margins, and flowing reports utilize
flow margins to ensure that header and footer information is preserved in the
output.

Note: There is currently no method of controlling horizontal overflow.
1. Select the canvas from Power Painter.
2. From the Document properties palette, manually type in the Flow margin:

bottom value.
The flow margin bottom value sets the ending vertical coordinate where a
flowing report ends on each page.

3. From the Properties window, manually type in the Flow margin: top value.
The flow margin top value sets the beginning vertical coordinate where a
flowing report starts on each new page.
or
You can also set flow margins on the canvas. To display flow margins, select
Layout from the toolbar menu and select Show Flow Margins.
Note: Flow margins are indicated by blue lines that appear on the top and
bottom of the Power Painter canvas.
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4. Adjust the objects on the canvas between the flow margins and run the report.
The report fills each page between the flow margins until it reaches the end.
For example, in the image below the flow margin was adjusted so that an
image could be used as a header.
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Setting a Relative Position Between Objects in Power Painter
You can set a relative (vertical) relationship between objects. Similar to the flowing
report option, you can select multiple report and graph objects and set a
relationship. The following relationship options are available from the Main
toolbar, or from the Layout menu in Power Painter:
v Relate objects. Sets the relative relationship or distance between two objects; a

surrounding object (below) and the primary object (above) that precedes it.
v Show relationships. Shows or hides all relationships on the canvas.

Relative positioning is determined by setting where a surrounding object’s upper
left corner is positioned relative to the lower left corner of the preceding primary
object.

Note: There is currently no method of setting horizontal relationships.

Relate Surrounding Objects to a Report

A surrounding object can only be related to one flowing report. However, a
flowing report can have multiple surrounding objects related to itself.
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1. Select a report or graph (surrounding) object from the Power Painter canvas.
2. Hold down the Ctrl key while selecting a flowing report (primary) object that

precedes or is above the first selected object.

Note: The primary object is indicated by solid black squares around the edges,
when selected. The surrounding object is indicated by clear squares around the
edges, when selected.

3. Set the relationship between the objects by selecting the Relate objects

button from the Main toolbar.
Note: The relationship buttons are only available from the Main toolbar when
multiple objects are selected.
An arrow appears on the canvas, indicating that the relationship has been set.
In the following image, the graph is the surrounding object to the report.
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Tip: To break the relationship, click the same surrounding objects using the
Shift key and click the Relate objects button from the Main toolbar. The arrow
is removed and the relationship is broken.

4. Run the report.

Note: If the document contains multiple reports, and the relationships have been
set, the first report runs until it is complete, followed by the surrounding reports,
at run time.
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Note: If the document contains a report and a graph, and the relationship has been
set, the report runs until complete, followed by the graph, at run time.
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Rules for Setting Relationships Between Objects

The following rules apply when setting relationships between objects:

Setting Relationships

This sets a relative distance between the flowing report and a surrounding
object. The surrounding object is rendered immediately following the end
of a flowing report with the related distance between the end of the
flowing report and the beginning of the surrounding object.

Fixed objects

A fixed object cannot be broken across a page break, it needs
enough vertical space to fit on the last page of the flowing report.

Flowing object (reports)

If a surrounding object is another flowing report, then the required
space does not need to be set. A flowing report can be broken
across pages. The reporting server determines if there is enough
room to begin rendering the surrounding flowing report.

Draw object
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Relationships do not apply to draw objects such as images, lines,
and text. Draw objects can be placed above flowing reports in a
page layout, but draw objects placed below a flowing report
should be placed outside of the bottom flow margin.

Setting a relationship between a report and a graph

If the overflow property of the report is set to flowing and there is no set
relationship between the graph and report, then the report will overlap
and display on top of the graph at run time. There is no way for Power
Painter to automatically set relationships, so you must set the relationship
between the report and the graph.

Note: A surrounding object can only be related to one flowing report; however, a
flowing report can have multiple surrounding objects related to itself.

Customizing the Power Painter Environment
After the components are in the canvas, you can customize the layout properties,
alignment options, and page to configure the canvas for precise output. You can
also adjust the work area and change the theme of the Power Painter environment.

Setting Preferences
When you access the Edit menu and select Preferences, the following dialog box
appears where you can set preferences for various defaults.

The Preferences dialog contains a General tab and a Reports and Graphs tab. The
General tab enables you to select Output Format, Page Orientation, and Page Size
options. The Reports and Graphs tab enables you to select a Preview option and
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set a Record Limit for both reports and graphs, select a Default Stylesheet for
reports, and select a Default Template for graphs.

Note: These settings do not affect the current Power Painter session. The new
settings are applied the next time Power Painter is opened.

Setting Field Display Options
When you access the View menu and select Field Display Options, another menu
opens providing you with options to display fields as a Name, Alias, Title, or
Description. You can also choose the Prefix with option to prefix fields with a
filename or segment name.

Adjusting the Layout of Objects in the Canvas
You can use the Main toolbar and the Layout menu to adjust the layout of objects
in the Power Painter canvas. The following layout options are available:
v Show grids, rulers, and guides in the canvas to fulfill pixel-perfect positioning

requirements.
v Align and size objects in the canvas.

Showing Grids, Rulers, and Guides in the Canvas
v To show grids in the canvas, select Show Grid from the Layout menu or click

the Toggle Grid icon from the Main Toolbar.
The following image is an example of how the canvas appears with grids
showing.

v To show rulers in the canvas, select Show Rulers from the Layout menu.
The following image is an example of how the canvas appears with rulers
showing.

v To show guides in the canvas, select Show Guides from the Layout menu.
The following image is an example of how the canvas appears with guides
showing.
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Tip: Use the ruler to click and drag guides onto the canvas. Guides are indicated
by the aqua line.

v To show flow margins in canvas, select Show Flow Margins from the Layout
menu.
The following image is an example of how the canvas appears with flow
margins showing. Flow margins are indicated by the light blue line.

Tip: You can left-click on the horizontal ruler or the vertical ruler and drag the
flow margins up and down the canvas.

The following image shows the Layout menu in Power Painter.
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Aligning and Sizing Objects in the Canvas

You can align objects relative to one another or to the canvas. Alignment options
are available from the Layout menu or from the Main Toolbar.
v Align objects to the page by using the align options from the Main toolbar.
v Align multiple objects to each other using the Align Items option from the

Layout menu.
v Size objects to be the same size by using the Size Items option from the Layout

menu.
v Use the Relative Positioning options to maintain the relative position of the

objects to each other at run time. The Relative Positioning options are Relate
Objects, and Show Relationships-available from the Main toolbar or Layout
menu.

The following image shows the Main toolbar in Power Painter.

Adjusting the Power Painter Work Area
Click anywhere on the canvas and select the Properties palette to adjust the
document properties.
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Data preview

Shows live data or sample data for reports and graphs.

Note: By default, sample data is shown in the Power Painter canvas.

Design Record Limit

Sets the number or records to be shown when gathering data for reports
and graphs.

Note: The default record limit value for the report is 500.

Flow margin: bottom

Sets the bottom margin for flowing reports.

Flow margin: top

Sets the top margin for flowing reports.

Output format

Enables you to select the output format from the following options: PDF,
DHTML, Power Point, Active Report, or Excel.

Page orientation

Sets the page orientation of the document. Select either Portrait or
Landscape.

Note: Portrait is the default page orientation.

Page size

Sets the page size of the document. Use the drop-down list to select a page
orientation option.

Note: Letter is the default page orientation.
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Units

Specifies the unit of measurements for the tool. Select Inches, Centimeters,
or Points.

Note: Inches is the default unit of measurement.

Changing the Theme of the Power Painter Environment
Power Painter enables you to customize your environment for seamless integration
with your organization’s color scheme.

From the View menu, select Theme to access the available skins to choose from.

The Power Painter environment changes to the theme of the environment that you
have selected.

Accessing Power Painter
You can access Power Painter from a report in the Reports folder.

Users who have the capability to create reports can access Power Painter to create
a new report in the Domains tree. From a Reports folder, right-click a folder and
select Power Painter from the context menu. Users can then save a report for
editing or running at a later time.

To edit a report, click a report and select Power Painter from the pop-up menu that
opens. The report you previously saved opens in Power Painter.
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Chapter 4. Creating a Report With Report Assistant

Describes how to use the HTML Report Assistant to create tabular reports.

DB2 Web Query Report Assistant is an HTML-based graphical tool that enables
you to select a data source, specify any sorting or grouping information, and
display the report in your browser or another desktop application. When you use
Report Assistant, DB2 Web Query creates a styled report that you can deploy on
the Web without the necessity of learning the complexities of any reporting
language. You can then take full advantage of the capabilities of the reporting
language to efficiently display your company’s data.

At the end of the chapter, reference topics provide details for every field in every
tab and sub-tab.

Note: If you are using the HTML Report Assistant with a Firefox browser, the
display may be slightly different than Internet Explorer. These differences do not
effect functionality.

Accessing HTML Report Assistant
HTML Report Assistant is accessible when creating or editing a Report.

Selecting the Master File in Report Assistant
To choose the Master File to work with, select the file and click OK. To search for a
specific Master File, use the scroll bar.

The following image shows the Browse Data dialog box containing available data
descriptions for selection.
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You can also type the first character of the name of the Master File anywhere in
the list to jump to the name of that Master File.

Layout of Report Assistant
Report Assistant builds your report as you select graphical options by internally
constructing a procedure according to the rules of the reporting language.

The following image shows the Report Assistant which is divided into these
sections or tabs:
v Field selection
v Report headings
v Selection criteria
v Join options
v Report options

Each tab contains explanatory text designed to guide you on using the specific
features accessed within the tab.
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Each tab contains a set of options that enable you to customize both the content
and appearance of your report. To toggle between tabs, select each tab at the top of
the window. Click About under the Help button to display the version and release
number of Report Assistant.

Above the tabs there are buttons for:

Save/Save As

Click Save to save your report.

Click Save As to open the Save New Report dialog box.

Run

Click Run to run your report.

Help/About

Click the icon to access help about the area of the tab in which you are
working.

Click About to open a window describing the version of Report Assistant
in which you are working.

Quit

Click to quit the application.
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Building Your Report With Report Assistant
The most basic report you can construct is a tabular report. Other report types
build on the basic design of the tabular report. A tabular report is a report whose
information is arranged vertically in columns. Internally, DB2 Web Query
constructs your report with a series of simple commands that mark the beginning
of the request, identify the data source, and mark the end of the request. Other
aspects of the request, such as styling information, are not necessary to produce a
valid report request.

Use the following basic steps in constructing your report:
v Design your presentation. How would you like to organize the information in

your report?
See Selecting Report Fields for more information about establishing basic
organizational criteria for your report.

v Identify the information you would like to present. Is it a full data set, or do
you want to construct a subset of some larger set?
See Selecting Records for a Report for more information about establishing
selection criteria for your data.

v Style your presentation. Do you want to apply customized headings or footings
to your report to make it more dynamic?

Selecting Report Fields
Begin building your report in the Field selection tab by selecting fields to include.
A field is the smallest meaningful element of data in a file. DB2 Web Query lists
available fields in several formats:
v As a list of fields shown in the following image.

74 System i: Database IBM DB2 Web Query for System i



List is the default. To enable List mode, you click the List icon in the Available
Fields box. You can view one or more options by clicking the Options arrow and
selecting: Name, Alias, Title, Format, Description, Segment, and Filename. In List
mode, you can sort any list of variables alphabetically from a to z or from z to a
by clicking the attribute, for example, Name or Alias.
Note: If you choose an option, such as alias, it does not appear with a DEFINE,
COMPUTE, or drill-down.

v As a tree separated by segments (the Field Tree) when expanded, as shown in
the following image.
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v As a tree separated by Dimensions (the Dimension Tree), as shown in the
following image. This is applicable only when the OLAP license option is
activated.
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Note: If you are viewing a Fields List in the Dimension Tree mode and you
create a recursive join (joining a file to itself), you will not be able to view the
Dimensions in the Fields List after the join is created. This is due to duplication
of field names in a recursive join. If you delete the join, you will be able to view
dimensions again.

To enable Tree mode, you click the Tree icon in the Available Fields box. Click the
arrow next to the Tree icon to select the Field Tree or the Dimension Tree. The
following options appear in a pop-up as you mouse over each field: Segment,
Name, Alias, Title, Description, and Format. You can change the field attributes
that appear in the tree by selecting from the list shown when clicking on the tree
icon. Select from: Name, Alias, Title or Description.

The Report fields section enables you to use the prefix with the segment name or
filename. You can also show the field’s alias instead of the name. You can show the
field’s title or description instead of name or alias, but title and description cannot
be prefixed with the segment name or filename. The qualified field identification
cannot exceed 66 characters.

Your selections in the Report Fields menu remain in effect for your current browser
session and are automatically saved with your request.

Note: Field names that contain a hyphen ″-″ cannot be used in the HTML Report
Assistant.

Notes on the Fields List
v Key fields are represented with a key icon in all field lists (tree and list displays)

in the HTML Report and Graph Assistant.
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The number of fields that are currently displayed shows at the bottom of the
fields list. If a field list contains more than 200 fields, the first 200 fields display
initially. Additional fields are retrieved and displayed when you select the next
set of fields.

v To select the next set of fields, scroll to the bottom of the field list and select the
Next option that appears. The Next option describes which fields will be
returned, for example in the following image it shows that the next 201-400
fields of 417 will be retrieved:

v To go back, scroll to the top of the field list and select the previous set of fields.
For example, the following image shows the Previous option to select the
previous 1-200 of 417 fields:

Fully Qualified Field Names
The HTML Report Assistant always saves a procedure with its fully qualified field
name. If you want to view this information, click the Prefix with the segment name
and Prefix with the filename options in the Report Fields section of the Field
selection tab.

Viewing Fully Qualified Field Names

Prefix with the segment name and Prefix with the filename are checked. Note that
the fields under Sort by demonstrate the field, segment, and file names.

The following image shows the result after selecting both the prefix with segment
name and prefix with the filename.
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If you open a report procedure in the Editor, the fields appear with their qualifiers
prefixed to the field name or alias.

The information for the highlighted field appears. If multiple fields are selected,
the information that appears applies to the last field chosen.

Adding Totals and Grand Totals to a Report
You can add grand total values to the end of your report and add a row total
column by checking the appropriate boxes under Report fields as shown in the
following image. The Add grand totals drop-down list provides two options. The
Totals option displays grand total values for each column in your report. The
Recompute Totals option recalculates computed fields before displaying the grand
total values. Selecting the Add a row total column check box adds a column to
display the totals for each row.

Using the Sort By, Sort Across, and Column Phrases to
Organize Data

Select fields for a report by highlighting a field in the Available fields list and
clicking the Add icon above the Sort by, Sort across, or Sum/Print field box. From
either the List or Tree view, you can also drag and drop a field on the desired field
box, or double-click a field to add it automatically.

Note: When you double-click fields, numeric fields are added to the Sum/Print
field box, and non-numeric and date fields are added to the Sort by field box.
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Numeric fields include decimal, floating point, and other formats, and
non-numeric fields are usually in alphanumeric format.

The following image shows a field selected in each of the data field boxes, the
COUNTRY field in the Sort across data field box, the CAR in the Sort by data field
box, and the SALES field in the Sum/Print display field list.

Specifying sort phrases enables you to organize the presentation of information in
a desired sequence. Adding fields to the Sort across fields box establishes the field
you selected as a column in your report. You can create a matrix report by
combining sort and across phrases. You can include a maximum of five ACROSS
fields in each report. If you try to enter a sixth ACROSS field, the following
message appears:
The Maximum number of horizontal dimensions is 5.

Adding fields to the Sort by fields box establishes your field as a sort field in your
report. Sort fields (also known as BY fields) are rows in your report. Any field can
be a sort field and you can include up to 32 sort fields in a report.

The Column data fields box designates the selected field as Sum or Print (Detail).
After selecting the field, you must also decide if you want DB2 Web Query to add
the values together (Sum) or print the values individually (Print). DB2 Web Query
displays the field you select in the last column of your report and performs the
requested operation on the data (Sum or Print). The default selection is Sum.
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You must select at least one field for the Sort or Sum/Print field lists to create a
report.

Add Report Fields in Tree or List View
1. Click the Tree or List icon.
2. Select a field from the Available fields list and click the Add icon above the

Sort by, Sort across, or Sum/Print field box to add the chosen field.
or
Click and hold the left mouse button, and drag the field to the desired field
box.
or
Double-click a:
v Numeric field to add it to the Sum/Print field box.
v Non-numeric or date field to add it to the Sort by field box.

3. Optionally, you can use shortcut keys to quickly go to one of the field boxes.
In the following table, the first column (Field Box) describes where you go
when using the shortcut keys and the second column (Shortcut Keys) defines
the shortcut key combination.

Field Box Shortcut Keys

Sort across Alt+A

Sort by Alt+S

Column Alt+C

Press Alt+M to go to the Available Fields list, tab to the field and press Enter
to add the chosen field.

Multi-Select Fields in List View
1. Click the List icon.
2. Required: If the fields are:

v Adjacent to each other, click the first field you want to select and hold down
the Shift key while clicking the last field you want to include in the report.

v Not adjacent to each other, hold down the Ctrl key while clicking the fields
you want to include in the report.

3. Click the Add icon to the Sort across, Sort by, or Column fields box to add the
chosen fields.

Note: Multi-select of fields is only possible when in List mode. You must drag and
drop or use the Add icon to add individual fields when in Tree mode.

Select a Report Type

To select a report type, click one of the following buttons in the Sum/Print display
field list:
v Sum. A summary report shows the summarized values of the selected data

source fields.
v Print. A detailed report shows all selected records from a data source.

Delete Report Fields
1. Select the field in the Sort Across, Sort by, or Column fields box.

or
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Use the shortcut keys to quickly go to one of the field boxes. In the following
table the first column (Field Box) describes where you go when using the
shortcut keys and the second column (Shortcut Keys) defines the shortcut key
combination.

Field Box Shortcut Keys

Sort across Alt+A

Sort by Alt+S

Column Alt+C

Use the arrow keys to move to the field you wish to delete.
2. Click the Delete button or press the Delete key.

Searching Field Lists
You can search the field list on the Field selection tab, Report Headings tab,
Selection criteria tab, and Join options tab (for the host Master File) in the HTML
Report Assistant and HTML Graph Assistant. You can search by the following
Master File attributes: Name, Alias, Title, Format, Description, Segment, and
Filename.

When you apply a search to a field list, your search results appear in all other
areas of the tool, until you reset the field list. Your search results are saved when
you exit the tool, so when you open the procedure again, you only see the results
of your search in the field list.

Note:

v The field list that appears for conditional styling is already restricted to the
fields selected for the report and is not further restricted by the search string.

v Search options are available when viewing fields in List mode. It is not available
when viewing fields in Tree mode.

Search a Field List
1. In the Field selection tab, Headings tab, or Selection criteria tab in the HTML

Report Assistant or HTML Graph Assistant, click Show - Field list searching.
If you are searching for a field name from the Join options tab, click the Field

list searching icon.
The Field list searching dialog box opens.
The following image shows the Field list searching dialog box. It contains a
drop-down list for what pattern you want to search by, a text box, and a
submit button.
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2. Select the Master File attribute for which you want to search. The following
table lists the pattern attributes and a description of each.

Attribute Description DSPFFD Equivalent

Filename Name of the data source. File

Name Name of the field. Field

Alias Alias for the field. Alternative Name

Title Display title for the field, as
defined in the Master File.

Column Heading

Format Field format, for example A4. Data Type

Description Field description, as defined
in the Master File.

N/A

Segment A segment of fields in the
Master File.

N/A

3. Type your search string. You can use an asterisk (*) as a wildcard. For example,
type c* to find all fields that begin with the letter ″c″. The character string is
not case sensitive.

4. Click the right arrow and results appear in the field list.

Reset the Field List After a Search
1. In the Field selection tab, Headings tab, or Selection criteria tab in the HTML

Report Assistant or HTML Graph Assistant, click Show - Field list searching.
If you are searching for a field name from the Join options tab, click the Field

list searching icon.
The Field list searching dialog box opens.

2. Enter a blank value (space bar) or an asterisk (*) and click the arrow .
The field list is reset to the default display, which is to show all fields.

Creating Temporary Fields
A temporary field is a field whose value is not stored in the data source, but can
be calculated from the data that is there, or assigned an absolute value. When you
create a temporary field, you determine its value by writing an expression. You can
combine fields, constants, and operators in an expression to produce a single value.
For example, if your data contains salary and deduction amounts, you can
calculate the ratio of deductions to salaries using the following expression:
deduction / salary.

You can specify the expression yourself, or you can use one of the many supplied
functions that perform specific calculations or manipulations. In addition, you can
use expressions and functions as building blocks for more complex expressions, as
well as use one temporary field to evaluate another.

There are two types of temporary fields—a virtual field and a calculated
value—which differ in how they are evaluated:
v A virtual field (Define) is evaluated as each record that meets the selection

criteria is retrieved from the data source. The result of the expression is treated
as though it were a real field stored in the data source.
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Virtual fields (Defines) are not applicable to queries that originated in IBM
Query/400. They can be used only with new queries created in the Web Query
product.

v A calculated value (Compute) is evaluated after all the data that meets the
selection criteria is retrieved, sorted, and summed. Therefore, the calculation is
performed using the aggregated values of the fields.

You can create temporary fields from the Field selection tab.

Create a Temporary Field
1. Required: On the Field selection tab, click one of the following:

v New define field icon (located above the fields list)

v New computed field icon (located with the Sum/Print fields).
The Field Creator dialog box opens.

2. Enter the name for the field in the Field box. Field names for temporary fields
cannot exceed 66 characters.

3. Enter the format for the field in the Format box. Click the Format button for
assistance in selecting a format. See Change Format Dialog Box.

4. Click in the expression box to enter an expression.
If you are familiar with coding Compute and Define expressions, you can type
the expression in the text box. Otherwise, you can use the key pad to assist you
in creating the expression. To use the key pad:
a. Click the Tree or List button to open the fields list or click the Functions

button to open the DB2 Web Query functions list. If you hover your cursor
over a function, a brief description appears.

b. Double-click a field or function to add it to the expression box.
c. If you select a field, complete the expression using the key pad and

additional fields, as necessary. See Field Selection Tab: Field Creator Dialog
Box for details on key pad operations.

5. Click OK. New calculated values (Compute) are added to your report’s column
(Sum/Print) list. New virtual (Define) fields are added to the fields list, where
you can select them as if they were real fields.

Note: When you create a defined field in Report Assistant, if you want that field
value to be blank, the blank must be contained in quotation marks.

Edit a Temporary Field
1. Required: Select the temporary field.
2. Required: Click the down arrow next to the Define icon and select Edit define

field.
or
Above the Sum/Print display field list, click the Edit computed field menu
item.
The Field Creator dialog box opens.

3. Make your desired edits and click OK.
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Delete a Temporary Field

Select a field in the Sum/Print display field list and click the Delete icon (or press
the Delete key).

or

Perform the following steps:
1. Select a virtual field in the Available fields box.
2. Click the down arrow next to the Define icon.
3. Click Delete define field.

Examples of Creating A Virtual Field and Creating a Calculated
Value

The following are examples of creating a virtual field and creating a calculated
value.

Creating a Virtual (Defined) Field Using a Function

The following image shows the Define field creator dialog box with a defined field
that uses a function (ARGLEN). This field uses the EMPLOYEE sample data
source.

Creating a Calculated (Computed) Value

The following image shows a computed field created using the SALES sample data
source. The expression creates the computed field REVENUE based on the product
of the existing fields UNIT_SOLD and RETAIL_PRICE.
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Changing a Field Format
The following image shows the Change Format Dialog box, which you use to
assign a format to a virtual or column field. Refer to the following procedures for
the step-by-step instructions.

Assign an Alphanumeric Format
1. Required: Select the virtual or column field.
2. Required: Click the down arrow next to the Define icon and select Edit define

field.
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or
Click the New computed field icon.
The Field Creator dialog box opens.

3. Click Format. The Change Format dialog box opens.
4. Select the Alphanumeric option button in the Format Types option button

group.
5. To assign a different length, specify a number between 1 and 256 in the Length

spin box.
6. Click OK twice to close the Change Format dialog box and return to the Field

selection window. The new format appears in the Format column in the
Available fields list.

Assign a Numeric Format
1. Select the virtual or column field.
2. Click the down arrow next to the Define icon and select Edit define field.

or
Click the New computed field icon.
The Field Creator dialog box opens.

3. Click Format. The Change Format dialog box opens.
4. Select one of the following option buttons in the Format Types option button

group:
v Floating Point (default length 7.2)
v Integer (default length 5)
v Decimal (default length 12.2)
v Packed (default length 12.2)
If the selected field matches the selected format type, its current length appears
in the Length spin box. Otherwise, the default length appears in the Length
spin box. The Decimal spin box shows the number of decimal places for
Floating Point, Decimal, and Packed.

5. To assign a different length, specify numbers in the Length spin box for format
types as follows: 1- 9 for Floating Point, 1- 11 for Integer, 1- 20 for Decimal, and
1- 33 for Packed.

6. To assign a different number of decimal places for Floating Point, Decimal, or
Packed, specify the number in the Decimal spin box.

7. Click OK twice to close the Change Format dialog box and return to the Field
selection window. The new format appears in the Format column in the
Available fields list.

Assign a Date Format
1. Select the virtual or column field.
2. Click the down arrow next to the Define icon and select Edit define field.

or
Click the New computed field icon.
The Field Creator dialog box opens.

3. Click Format. The Change Format dialog box opens.
4. Select the Date option button in the Format Types option button group. The

default date display format is MDY.
5. To assign a different date display format, click the down arrow to the right of

the Date Format list box.
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6. Choose a date format.
7. Click OK twice to close the Change Format dialog box and return to the Field

selection window. The new format appears in the Format column in the
Available fields list.

Add a Percent Sign to a Numeric Field

You can add a percent sign to the end of a numeric value (Decimal, Integer,
Floating Point format types). This numeric display option includes a percent sign
along with the numeric data, but does not calculate the percent.
1. Select the virtual or column field.
2. Click the down arrow next to the Define icon and select Edit define field.

or
Click the New computed field icon.
The Field Creator dialog box opens.

3. Click Format. The Change Format dialog box opens.
4. Click the down arrow in the Select options list box to choose Percent sign - %.
5. Click OK twice to close the Change Format dialog box and return to the Field

selection window. The new format appears in the Format column in the
Available fields list.

Using the Percent Sign Edit Option

The following table consists of a Format column for each numeric format, a Data
column for its actual data value, and a Display column for how it appears.

Format Data Display

I2% 21 21%

D7% 97 97%

F3.2% 48 48.00%

Using Calculated Values From the Master File
In the HTML Report and Graph Assistants, calculated values (COMPUTEs) that
exist in the Master File appear in the fields list with all other temporary virtual
fields and calculated values. The following image shows the fields list in the
HTML Report Assistant with a calculated value from the Master File (PROFIT).
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Calculated values from the Master File are available in all fields lists in the HTML
Report and Graph Assistant except for the fields lists that appear for Define fields
and Joins.

Support for Calculated Values From the Master File

You can use a calculated value from the Master File:
v As a Sum/Print field.
v As a Sort by field. You can also use a temporary calculated value as a Sort by

field.
Note: The By sort is automatically converted to a Total field since calculated
values are calculated after data has been sorted and aggregated, but before the
report is displayed. Since sorting (BY) has already been done, the phrase BY
TOTAL is used to indicate that this sort is performed after any BY sorting. This
applies to calculated values from the Master File and temporary calculated
values.

v For conditional styling.
v In a temporary calculated value.
v In a page heading or page footing (Report headings tab).
v In selection criteria statements. You can also use a temporary calculated value in

selection criteria.
Note: When you use calculated values for selection criteria, the Where is
automatically converted to Where Total. This occurs because the Where Total is
added after the data is retrieved and sorted, but before the report is finalized.
This applies to selection criteria created with calculated values from the Master
File and temporary calculated values.

Chapter 4. Creating a Report With Report Assistant 89



Calculated fields from the Master File are not supported:
v As Across sort fields.
v As the X-axis in a graph. This means that you won’t be able to add a calculated

value to the Field value plotted on X axis or Create a separate graph for each
value of this field fields on the Field selection tab of the HTML Graph
Assistant.

v In a Join statement or Defined field.
v With prefix operators, for example MAX.

Calculated Value Dependencies

These dependencies apply to calculated values from the Master File and to
temporary calculated values.

When you include a calculated value in selection criteria or in a page
heading/footing, the field must exist in the report as either a By sort field or a
Sum/Print field. If you create a selection criteria statement with a calculated value
or add a calculated value to a page heading/footing and the field does not already
exist in the report, then it is automatically added to the Sum/Print display field
list. The Make this field invisible option is automatically selected in the Field
options dialog box so that the calculated value does not appear in the output.
When this occurs, a message appears stating:

″The field has been added to the list of fields in the report.″

Note: You do not see this message for temporary calculated values (those that do
not come from the Master File) that are added to a page heading/footing since
these already appear in the Report headings fields list.

You can change the attributes of the calculated value from the Field options dialog
box on the Field selection tab. If you attempt to delete the calculated value from
the Sum/Print display list and the same field exists in either selection criteria or in
a page heading/footing, you receive a one of the following messages:

or

You must remove the field from the page heading/footing or selection criteria
before you can remove it from the Sum/Print display list.
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Defining Field Characteristics
To choose field options, select the field in the Sort across, Sort by, or Column
(Sum/Print) box in the Field selection tab. Click Show field options to style each
field in your report.

The following table lists and describes the available Field options in the Display,
Sorting, Ranking, Subhead, and Subfoot tabs that appear for each selected field
type. The ability to create a title in the Title tab is available for all field types. If a
Field option tab is not available for a selected field type, ″n/a″ appears in the
table.

Field Type Display Sorting Ranking
Subhead &
Subfoot

Sort across Make this field
invisible check
box

Font button that
opens styles
dialog

Drill down
button that
opens Drill
down dialog

Ascending/
Descending
options

Total check box

n/a n/a

Sort by Make this field
invisible check
box

Font button that
opens styles
dialog

Conditional
styling button
that opens
conditional
styling dialog

Drill down
button that
opens Drill
down dialog

Include missing
instances check
box

Ascending/
Descending
options

Total check box

Create a page
break check box
(activates the
’And reset page
number to 1’
check box)

Separate with
underline check
box

Subtotal numeric
sum/print fields
check box
(activates the
Subtotal tab, and
the ’And higher
level sort fields’
and ’Recalculate
computed fields
with subtotals’
check boxes)

Add Ranking
column check
box (activates
the ’Limit the
number of
ranked values
to’ check box,
and the Font
button that
opens styles
dialog)

Select Font type,
size, and style.

Select text
alignment.

Set text and
background
colors.
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Field Type Display Sorting Ranking
Subhead &
Subfoot

Column (Sum/
Print)

Make this field
invisible check
box

Font button that
opens styles
dialog

Conditional
styling button
that opens
conditional
styling dialog

Drill down
button that
opens Drill
down dialog

Format in report
as button opens
change format
dialog

’Calculated as’
drop-down list
adds prefix to
column

Include missing
instances check
box

n/a n/a n/a

You can use this table to determine which of the following options are available for
a selected field in the Field selection tab:
v Suppress the display of a field (make a field invisible).
v Apply font options with the styles dialog box.
v Apply conditional styling with the conditional styling dialog box.
v Create drill down parameters with the Drill down dialog box.
v Select format options in the report with the change format dialog box.
v Specify how the field will be calculated by choosing an option from a

drop-down list box.
v Include references to missing instances in reports.
v Specify field display titles, subheads, subfoots, and subtotals.
v Specify ascending or descending field sorting.
v Include the Sort by options for page breaks.
v Include the Sort by options for subtotals, sub-totals, and recalculated subtotals.

Note:

v Subtotal numeric sum/print fields is not checked by default. If checked,
numeric values are summed and a subtotal is displayed when the selected Sort
by field value changes.
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v If you select And higher level sort fields, SUB-TOTAL syntax is used to display
subtotals for numeric values when the selected Sort by field value changes and
when any higher-level Sort by field value changes.

v If you are using computed fields, select Recalculate computed fields using
subtotal values.

Change the Field’s Display Title
1. Select the field whose title you want to change.
2. If hidden, click Show report field options for the selected field.
3. Click the Title tab.
4. Enter the title you want to display in the report output.

Note: When using HTML output, leading spaces in the field title do not
display.

Suppress the Display of a Field

The Field selections tab enables you to conceal the data of a selected field in a
report. To suppress the display of a field:
1. If hidden, click Show report field options for the selected field.
2. Check the Make this field invisible check box.

Include References to Missing Instances in Reports: The ALL.
Prefix

In a report, you can include parent segment instances that lack descendants by
attaching the ALL. prefix to one or more column fields, as follows:
1. If hidden, click Show report field options for the selected field.
2. Check the Include missing instances check box.

Note:

v The ALL. prefix and an additional prefix operator from the Column Options
drop-down list may be applied to the same field.

v The ALL. prefix can be applied to multiple fields.
v The ALL. prefix can be applied to both column fields and sort fields.

Arrange Fields in Ascending or Descending Order

To list sort field data in the report from greatest to smallest (descending) or from
smallest to greatest (ascending):
1. If hidden, click Show report field options for the selected field.
2. Select the Sorting tab.
3. Select the Ascending or Descending option button.
4. Click Save.

If you have multiple sort fields, you can specify a different order for each one.
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Include Page Breaks

To start a new report page when the value of a selected sort field changes:
1. If hidden, click Show report field options for the selected field.
2. Select the Sorting tab.
3. Check the Create a page break check box.
4. Click Save.

Include Subtotals

To display a subtotal for numeric data when a selected sort field changes:
1. If hidden, click Show report field options for the selected field.
2. Select the Sorting tab.
3. Check the Subtotal numeric sum/print fields check box.

Subtotals are activated for this report and the Subtotal tab appears to the right
of the Subfoot tab. Note that the default *TOTAL title is displayed next to each
subtotal value. For more information, see Include Display Titles for Subtotals.
Additionally, the following options are activated:
v And subtotal all higher level sort fields. Displays subtotals for numeric

values when the Sort by field value changes and when any higher-level Sort
by field value changes.

v Recalculate computed fields with subtotal values.
4. Required: Optionally, select the Subtotal tab to:

v Modify the default subtotal title text in the Current Subtotal Text field.
v Suppress subtotals for sort fields that have only a single value.
v Apply subtotals to a subset of the numeric fields in a report.
v Apply prefix operators, which enables you to display the sum, average,

average square, count, first in group, last in group, minimum, or maximum
value for any or all of the numeric fields, including Computes, in a report.

For more information, see Displaying Subtotals and Other Summary Values
Using Prefix Operators.

5. Click Save.

Include Display Titles for Subtotals

When including subtotals, you can also specify display titles for them. These titles
appear next to each subtotal in the report. The default subtotal display title is
*TOTAL. To edit the default display title:
1. If hidden, click Show report field options for the selected field.
2. Click the Sorting tab.
3. Check the Subtotal numeric sum/print fields check box. The Subtotal tab

appears to the right of the Subfoot tab.
4. Click the Subtotal tab.
5. Type the desired display title in the Current Subtotal Text field in the Subtotal

tab.
6. Click Save.

Note: If the Subtotal numeric sum/print fields check box is not selected, subtotals
are not displayed in the report.
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Include Subheads/Subfoots for Sort Fields

The Fields Options tab enables you to include subheads (which appear above) and
subfoots (which appear below) for each of the sort field’s records in the report.
1. If hidden, click Show report field options for the selected field.
2. Click the Subhead or Subfoot tab.
3. Click in the text box or press Alt+T to enter a subhead or subfoot title.
4. Style the subhead/subfoot using the formatting toolbar.
5. Click Save.

Editing a Field Format
Use the report field options section on the Field selection tab to change the field
format for the Column field. The following image shows the Field selection tab
with a field selected and the Field Options pane open.
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Change the Field Format for a Column Field
1. Required: If hidden, click Show report field options.
2. Required: Select a field in the Sum/Print display field list.
3. Required: Click the browse (...) button next to the Format in report as field to

open the Change Format dialog box.
Note: You can also edit the format by typing directly in the Format in report as
field. This is not recommended unless you know the exact format because
validation is not performed until run time.

4. Select a Format type and the desired options for the field, then click OK.

For more information, see Changing a Field Format.
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Styling Fields
Use the styling options on the Field selection tab to style report fields.

Style Sort by, Sort Across, or Column Fields
1. If hidden, click Show report field options.
2. Select a field and click the Display tab in the report field options section.

The following image shows the Display tab of the Field Options pane.

3. Click the Font button.
4. Select the desired styling options from the Font, Style, and Size boxes.
5. In the Set Styles for box, select the Title & Data, Title Only, or the Data Only

option button, depending on the report element you wish to style.
Note: If you select a font property (font, style, size, text color, background color,
or justification) and select the Title & Data option button, the changes will be
reflected in both the Title Style and Data Style boxes.
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However, if you then select a different parameter for a given property using the
Title Only option button, the Title Style will change while the Data Style will
not reflect this change. To change the Data Style, you must click the Data Only
option button and then make your change. Likewise, if you select the Data
Only option button and make a change, this change will not be reflected in the
Title Style. You must click the Title Only option button to make your change.

6. Choose a text color from the list box.
7. Choose a background color from the list box.
8. Choose a justification (left, center, or right) from the list box.
9. Click OK.

Note: Clicking Reset returns the styling options to the following default settings:
v Font: Times New Roman
v Style: Normal
v Size: 13
v Text Color: Black
v Background Color: Transparent
v Justification: Left

Drilling Down to New Procedures
When you click Drill Down in the report fields options section on the Field
selection tab, the No action option button is the default. When you select Execute
Procedure, a list of procedures contained within the Reports subfolder displays.
You can also select procedures from different domains.

For more information, see Drill Down Dialog Box.

End User Drill-down Capability
Along with Administrators and Developers, end users can drill down to other
reports from within the currently displayed report.

Styling Specified Field Values
Use the Conditional Styling dialog box to style records based on specified field
values. Conditional styling, also referred to as stoplighting, enables you to define
conditions that determine when to apply particular fonts, point size, text style,
foreground and background color, and drill-down procedures to your report’s data
when the report is run.

You can style specified values for one or several column and sort fields. However,
you cannot style values for sort across fields.

Style Records Based on Specified Field Values
1. In the HTML Report or Graph Assistant, if hidden, click Graph Field Options.
2. Click the Display tab in the report field options section.
3. Click the Conditional styling button.

The Conditional Styling dialog box opens.
4. Click the Add button and create a new condition.

The following image shows the edit condition dialog box that opens where you
begin to set the conditional styling.

98 System i: Database IBM DB2 Web Query for System i



5. Provide a meaningful and unique file name in the Condition input box.
6. Select a field name from the Field list box and a relation from the Relations list

box.
7. To specify a value that completes the relation, first select one of the following

in the Compare Type option button group:
v Value, to compare the selected report field to a data source value or literal

value.
v Another Field, to compare the selected report field to the value of another

field. The list of report fields appears in the possible values area. Select one
of the report fields to compare to.

8. If you select Value under Compare Type, perform one of the following to
complete the relation:
v Click Values to display existing data source values in the Value list box, and

select a value.
v Type a literal value in the Value input box.

9. Click OK.
You return to the Conditional Styling dialog box.

Creating Parameters
Parameters enable you to specify criteria and conditions for drill-down reports. By
defining parameters, you can control the amount and type of information to
retrieve when you click a hotspot.

Create a Parameter in the Main and Drill Down Procedures
1. Select the Selection criteria tab.
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2. Create an expression (WHERE statement) that defines a parameter. For more
information, see Creating a Where or Where Total Statement.

3. If hidden, click the Show report field options section.
4. Select the field that you want to drill down on.
5. Click Drill Down. The DB2 Web Query Drill Down Dialog opens.
6. Click Execute Procedure (FOCEXEC) or Execute URL.

The following image shows the Execute Procedure option button selected and
the location and procedure name of the drill-down report (app/css.fex) in the
Execute procedure field.

7. Click Add. The Drill Down Parameter Dialog box opens where you create the
drill down parameter.
The following image shows the Drill Down Parameter dialog box, which
contains a text box where you enter the name of the parameter, and option
buttons to select the parameter as a field or a constant value.
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8. Enter the name of the parameter you created in the drill down procedure in
the Parameter Name text box, for example, Classes.
Note: When passing parameters to a drill-down procedure, you must use local
amper variables (&variables). Global amper variables (&&variables) cannot be
used as drill-down parameters. Also, when entering your parameter name it is
not necessary to type an ampersand (&) before the parameter name. This will
create a global amper variable that cannot be used as a drill-down parameter.

9. When you pass the parameter to the drill down procedure, you must set a
value for it in the Drill Down Parameter dialog box. If you select:
v Field. The parameter will be set to the corresponding value of the object the

user drills down on in the specified field.
v Constant value. The parameter is set to the specified value.
Note: If the drill-down report contains a -DEFAULTS statement that sets a
default value to the same amper variable passed from the main report, the
amper variable value passed down overwrites the -DEFAULTS statement in
the target procedure.

10. Once a value has been supplied, click OK to return to the Drill Down Dialog
box.
The parameter is added to the With Parameters list box as shown in the
following image.
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Aggregating and Sorting Fields
You can apply aggregation and sorting simultaneously to numeric columns in your
report in one pass of the data using the Total sort option. The Total option is
available for Sort by and Sort across fields. For the Total sort option to work
correctly, you must have an aggregating display field, such as Sum, in the report.
A non-aggregating display field, such as Print, simply retrieves the data without
aggregating it.

Note: When you add a computed field to the Sort by field, it is automatically
given the Total property.

The following image shows the PRICE field with the Total option selected in the
Field options.
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Rank Data With the Total Sort Option

To rank report data using the Total option on the Sorting tab, perform the
following steps:
1. Add multiple fields to the Sort by data field box, and highlight the Sort by field

you want to rank.
2. Add any other desired fields to the Sum/Print field box.
3. If hidden, click Show field options for the selected field.
4. Click the Sorting tab.
5. Select the Total check box.

Tip: Select the Descending option to make the largest number the first row of
ranked data in the report. The default sorting option is Ascending, which ranks
the smallest number first.

6. Click the Ranking tab.
7. Select the Adding Ranking column check box.

Optionally, in the text box, type a custom title for the ranking column. The
default title is RANK.

8. Run the report.

Note: For the Total sort option to work correctly, you must have an aggregating
(numeric) display field, such as Sum.
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Displaying Subtotals and Other Summary Values Using Prefix
Operators

The Subtotal tab enables you to display subtotals, and other summary values using
prefix operators, for any or all of the numeric fields, including computed fields, for
a selected Sort by field in a report query. You can choose to display subtotals for
all numeric fields whenever a selected Sort by field value changes, or you can
select to display subtotal and other summary values for a subset of the numeric
fields.

In the Subtotal tab, as shown in the following image, you can customize the title
text used to display subtotals and other summary values, and suppress subtotals
for sort fields that have only a single value, in addition to working with prefix
operators.

Display Subtotals and Other Summary Values Using Prefix
Operators

To access the Subtotal tab to apply subtotals, prefix operators, and modify other
subtotal text and settings, perform the following steps:
1. If hidden, click Show report field options for the selected field.
2. Select the Sorting tab.
3. Select the Subtotal numeric sum/print fields check box. The Subtotal tab

appears to the right of the Subfoot tab.
4. Select the Subtotal tab.
5. Numeric field values are summed and displayed as subtotals in the report by

default. To display summary values other than the default subtotals, select
prefix operators using the drop-down lists in the Prefix area that are adjacent
to each of the selections in the Columns area. Note that the Sum prefix
produces the same subtotal results as not selecting a prefix operator.
All of the available prefix operators are listed and described in the following
table:

Prefix Description Displayed in Prefix List

SUM. Compute the sum of values Sum
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Prefix Description Displayed in Prefix List

ASQ. Compute the average sum of
squares

Average Square

AVE. Compute the average value Average

CNT. Count the items Count

FST. Select the first value only Show first in group

LST. Select the last value only Show last in group

MAX. Select the maximum value
only

Maximum

MIN. Select the minimum value
only

Minimum

6. To display all numeric field values as subtotals or other summary values in
the report, select the Apply totals to all columns check box in the Columns
area.

7. To display subtotals or other summary values for a subset of the numeric
fields in the report, make sure the Apply totals to all columns check box is
de-selected, then select check boxes for the individual numeric fields in the
Columns area of the Subtotal tab.
When Apply totals to all columns is selected, options for all individual fields
in the Columns area are inactive by default.

8. To modify the default subtotal title, which is set to *TOTAL, type the desired
text you want to display as the title for all subtotals and any other selected
summary values in the Current Subtotal Text field.

9. To hide subtotals for sort fields that have only a single value, select the
Suppress for single lines check box.

10. Click Save to save your settings and selections in the report query in which
you are working.

Applying Predefined and Cascading StyleSheets
You can select a predefined StyleSheet from Report Assistant, instead of applying
custom styling. A predefined StyleSheet is a StyleSheet that a DB2 Web Query
Administrator places in a domain using Developer Workbench. Any user who then
accesses Report Assistant from the domain can apply the predefined StyleSheet to
their report.

When a new procedure is created, Report Assistant sets a default StyleSheet. You
can apply a different StyleSheet to a report using the StyleSheet drop-down menus
in the Global report styling area of the Report options tab.

The following image shows the report styling options in the Report options tab.
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The Global report styling section includes the Apply an existing DB2 Web Query
Style Sheet and Apply an existing Cascading Style Sheet list boxes. To apply a
StyleSheet to a report, select a StyleSheet from the appropriate list box. The list box
for DB2 Web Query StyleSheets includes all StyleSheet files stored in the domain.

When a predefined StyleSheet is applied to a report, Report Assistant disables all
customizable styling options and does not apply any previous styling selections for
the entire report. These settings are not lost. If you decide not to apply a
predefined StyleSheet, Report Assistant restores the report’s original styling
settings and enables you to further customize a report’s styling.

Note: When applying a StyleSheet, if you select the Format HTML Output check
box, use only the Full or Paged setting. The Fixed setting is not supported with
StyleSheets.

Customizing Headings and Footings
Use the Report headings tab to specify the content, style, and placement of
headings and footings in your report. Headings and footings can be customized
only if a StyleSheet has not been applied. Since Report Assistant applies a
StyleSheet by default, you must set the StyleSheet in the Report Options tab to
None.

The following image shows the Report headings tab opened with a formatting tool
bar, the Page heading and the Page footing text boxes.
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Note: Dragging and dropping items, including images, is not supported in the
Report Assistant.

Add and Align a Heading in a Report
1. In the Report headings tab, click in the text box or press Alt+H to enter a page

heading title.
2. Click the Center icon to center the heading in the report. The heading is

left-aligned by default.

Add and Align a Footing in a Report
1. In the Report headings tab, click in the text box or press Alt+F to enter a page

footing title.
2. Click the Center icon to center the footing on the report. The footing is

left-aligned by default.
3. Click the Bottom icon to place the footing at the bottom of the report.

Include a Field in a Heading or Footing

You can include a specified field in a heading or footing. When you run the report,
the data value for the field will be included in the heading or footing.
1. Click the Show fields list icon to the left of the Report headings box to display

the Available fields window.
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2. Select a field from the Available fields window and drag the field to the Page
heading or Page footing box.
or
Click and hold the left mouse button, and drag the field to the fields box you
chose.
or
Use the shortcut keys to quickly go to one of the field boxes.
In the following table, the first column (Field Box) describes where you go
when you use the shortcut key combination described in the second column
(Shortcut Keys).

Field Box Shortcut Keys

Page Heading Alt+H

Page Footing Alt+F

Press Alt+M to go to the Available Fields window, tab to the field and press
Enter to add the chosen field in the page heading or footing text box.

Note:

v You can add more than one field name to either the Page heading or Page
footing box by selecting one field at a time.

v The report’s heading or footing will contain the first value retrieved for the field
in the heading or footing.

Style a Heading or Footing

To style a heading or footing:
1. Select the field you want to style in the Page heading or the Page footing text

box in the Report headings tab.
2. Click the Cut, Copy, Paste, Select all, and Remove formatting icons to format

the text of your choice.
3. Click the appropriate icons to bold, italicize, or underline your text.
4. Click the icons for left, center, or right alignment to specify justification.
5. Click the Bottom icon to move your text to the bottom of the report.
6. Click the Font list box or press Alt+N to specify your selections.

Note: When selecting a font, be sure to click in the text box before you select
the font name, otherwise the font may return to the original font selection.

7. Click the Font Size list box or press Alt+S to specify your selections.
8. Click the Text Color icon or press Alt+C and Enter to open the Color palette

window. Choose a color from the color list.
9. Click the Background Color icon or press Alt+B and Enter to open the Color

palette window. Choose a color from the color list.
10. Click Save or Save As to save your settings.

Note: The default styling settings are as follows:
v Font: Times New Roman
v Size: 13 (If you change the font size of your heading, which is a FOCUS title, the

code may not properly reflect the font size you specified when you open the
procedure in a text editor. This does not affect functionality. You can edit the
procedure manually to correct the size.)
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v Style: Normal
v Text Color: Black
v Background Color: Transparent
v Justify: Left

Selecting Records for a Report

When generating a report and specifying which fields to display, you may not
want to show every instance of a field. By including selection criteria, you can
display only those field values that meet your needs. In effect, you can select a
subset of the data, which you can easily redefine each time you issue the report
request.

When developing a report request, you can define criteria to select records based
on:
v The values of an individual field (using a Where statement).
v The aggregate value of a field, for example, the sum or average of a field’s

values (using a WHERE TOTAL statement).

The Selection criteria tab enables you to create Where or Where Total statements
for record selection.

Creating a Where or Where Total Statement
Where and Where Total statements enable you to display only those records that
pass your selection criteria. These statements select the data source records to be
included in a report. The data is evaluated according to the selection criteria before
it is retrieved from the data source. Use the Selection criteria tab to create a new
Where or Where Total statement.

Note: In the Report Assistant, when you create a Where statement in the Selection
criteria tab for a range of dates using FROM - TO, you will not be alerted if the TO
field is chronologically before the FROM field. For example, if you enter something
like ″from 12/31/05 to 1/1/05″, there will be no records in the resulting report.

Select Records Based on Values, Parameters, Fields, or a
Constant
1. In the Report Assistant, click the Selection criteria tab.
2. Select a field from the Available fields window and drag the field to the

Screening conditions pane.
or
Press Alt+M to go to the Available Fields window, tab to the field and press
Enter to add the chosen field.
The field name and EQUAL to and Select values appear in the Screening
conditions pane.

3. Select WHERE or WHERE TOTAL.
4. Select an operator from the drop-down list (for example, EQUAL to) in the

right pane.
5. Click Select values to complete the expression.
6. Select one of the following compare type option buttons:

v Constant. Enter a value that will serve as a constant (a value that will not
change). For example, enter vehicle.
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After you click OK, the constant, vehicle, appears in the WHERE statement
which reads BODYTYPE EQUAL to vehicle.

v Parameter. Enter the name of the variable. For example, moped as shown in
the following image with the Parameter option button selected and the
variable name entered as moped.

You can set parameter properties, for details see Setting Parameter Properties.
After you click OK, the parameter, &moped, appears in the WHERE
statement which reads BODYTYPE EQUAL to &moped.

Note: The ampersand is automatically added by DB2 Web Query.
v Fields. Select a field from the list.

After you click OK, the field BHP appears in the Where statement which
reads CAR.COMP.CAR EQUAL to CAR.SPECS.BHP.

v Values. Select a value for the field you initially chose (in this case, car).
After you click OK, the value, Audi, appears in the Where statement which
reads CAR.COMP.CAR EQUAL to AUDI.
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Create a Where Statement Using Date and Time Values

In the Report Assistant,
1. Click the Selection criteria tab.
2. Select a field from the Available fields window and drag the field to the

Screening conditions pane.
or
Press Alt+M to go to the Available Fields window, tab to the field and press
Enter to add the chosen field.

3. Click EQUAL to in the right pane to display a list of operators. Click the
operator of your choice.

4. Click Select values to complete the expression.
5. Click Field to access date and time values for that field. For example, EYEAR.
6. Click Values and click the value of your choice. For example, 1989/01/18.

After you click OK, the value, 1989/01/18, appears in the WHERE statement
which reads START_DATE EQUAL to 19890118.

Importing Values From External Files for WHERE Statements
When developing a query, you can use a locally saved, external file as selection
criteria to limit query results. This enables you to quickly build a query containing
a large number of WHERE statement values without having to manually enter
repetitive or readily available data.

Create a Value List From an External File
1. Required: Navigate to the Selection criteria area.
2. Required: Begin creating a WHERE statement by selecting a field from the list

of available fields.
3. Required: Select a data comparison option that can accept multiple values.

Valid options include EQUAL to, NOT EQUAL to, IN literal list, NOT IN
literal list, EXCLUDES literal list, and INCLUDES literal list.

4. Click Select values.
The Values dialog opens.

5. Click the import button as shown in the following image.
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A dialog box opens as shown in the following image.

6. Select either the Flat file or Excel Spreadsheet (XLS) File Format option.
7. Click the Browse button.

A standard file selection dialog opens.
8. Select an external file to import from your local machine or network.

Note: The external file must only contain text with new line delimiters.
9. Click OK.

The values contained in the file are displayed in the Multiple values entered
list in the right pane of the dialog.

10. Optionally, you can remove specific values from the Multiple values entered
list or move values up or down within the list.

11. Click OK.
You can save the query for future use and reopen the query to append new or
remove existing values.
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Setting Parameter Properties
When you create parameters for Selection Criteria (WHERE statements) you can
set the properties for the parameter. For example, you can create a dynamic or
static list of values to choose from at run time.

Set Parameter Properties
1. In the Report Assistant, click the Selection criteria tab.
2. Create a WHERE or WHERE TOTAL expression.
3. Select an operator. Some operators are not supported with the Variable Editor,

see Supported Operators for the Variable Editor for details.
4. Click Select values. The Variable Editor dialog box opens
5. Select the Parameter option.
6. Click the Auto Prompt button.

The Parameter Properties dialog box opens.
7. Verify the Name and Description fields, which are automatically populated

based on the field you selected for the WHERE clause. You can edit the
populated values as needed. Note that the Description field cannot contain a
period (.) because a period is the delimiter to specify the beginning and end of
the description value.

8. Choose the Selection type, Dynamic or Static.
The Dynamic option is selected by default.
Optionally, choose the Select multiple values at runtime check box to provide
multiple values to the report from the auto prompt page at run time.

9. Set the parameter values.
v For the Dynamic selection type, the Data Source and Field values are

selected by default based on the field you are screening on and can be
changed as needed.
If you want to see the fully qualified Field name, select the Display fully
qualified field name check box. This setting is for display purposes only
and is not preserved.

v For the Static selection type, select the Constant or Show field values
option. For Constant, enter one or more values. For Show field values, all of
the values for the selected field appear in the list box. Move the values you
want from the selection list to the Prompt values list.

10. Click OK to exit the Parameter Properties dialog box.

Supported Operators for the Variable Editor

Operator Enabled for the Variable editor?

Equal to Yes

Not equal to Yes

Greater than Yes

Less than Yes

Greater than or equal to Yes

Less than or equal to Yes

In literal list No

Not in literal list No

Missing No
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Operator Enabled for the Variable editor?

Not missing No

From - to No

Not-from - to No

Includes literal list Yes

Excludes literal list Yes

Contains characters Yes

Omits characters Yes

Like character mask Yes

Not like character mask Yes

Combining Expressions
Use the right pane of the Selection criteria tab to use or delete existing Where
statements and to combine expressions.

Combine Expressions
1. Create an expression.
2. When you create additional expressions, they are combined with the default

operator AND, as shown in the following image with two statements, the first
a WHERE and the second an AND statement.

3. Use the drop-down list to select from AND, OR, WHERE, and WHERE TOTAL.

Delete an Active Expression
1. Select the check box next to the expression you want to delete. Click the Delete

icon above the box.
2. You are prompted to delete the expression. Click OK to delete.

Grouping Expressions Together With Parentheses
You can use parentheses to group expressions together to optimize the Where
statement.
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Group Where Statements Together Using Parentheses

Click the grayed out parentheses to activate the parentheses and group expressions
together.

Limiting Data With Filters
Filters enable you to quickly select predefined criteria that limit data included in a
report. Filters are selection criteria (Where statements) that an Administrator
creates for you to apply as needed, without having to create your own selection
criteria.

DB2 Web Query displays filters in filter groups. Each filter group can contain
multiple filters. Selecting a single filter within one group creates a report with
simple filtering criteria. By selecting multiple filters within a group or combining
filters from different groups, you can create complex filtering expressions.

The following image shows a few sample filters as they appear in the Selection
criteria tab of the HTML Report Assistant. They are listed by Group and Name.

Simple Filtering Criteria
Simple filtering criteria consists of one or more filters from the same filter group. If
you select only one filter, the data must match that filter to be included in the
report. If you select multiple filters from the same filter group, the data must
match only one filter to be included in the report. This type of criteria is an OR
criterion.

Complex Filtering Criteria
Complex filtering criteria consists of one or more filters from multiple filter groups.
Data must match one filter from each filter group to be included in the report. This
type of criteria is an AND criterion.

Selecting Records With LIKE and NOT LIKE Operators
Alphanumeric fields include the following operators:
v LIKE the character mask. This means that the value for the field you selected

will be included in the report. All other values for that field will not be included
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in the report. For example, if you select the Plant field and specify Boston with
LIKE the character mask, only values for Boston will appear in the report.
Values for plants in all other locations will not be included.

v NOT LIKE the character mask. This means that all values except the one you
specify for the field you selected will be included in the report. For example, if
you specify Boston with the NOT LIKE character mask, data for Dallas, Los
Angeles, New Orleans, Seattle, and St. Louis will display and no data will
display for Boston.

These operators generate the appropriate LIKE and NOT LIKE expressions using
the character mask available in the expressions list when creating a WHERE
statement.

Working With Joins
A join is a temporary connection between two or more data sources that share at
least one common field. Once you join two data sources, each time DB2 Web
Query retrieves a record from the first data source (host file), it also retrieves the
matching records from the second data source (target file).

You use the Join tool to link data sources in both Report Assistant and Graph
Assistant. The Join tool provides a graphical method for creating and manipulating
joins. You can also create define-based joins and multi-field joins.

When you access the Join tool, the window displays a field list for the host data
source (which you specified when you created the report), and a field list for any
target data source you add to the window.

Important:

v Only Administrators and Developers have access to the Join options tab.

Create a Join
1. Click the Join options tab in Report Assistant or Graph Assistant and click

New.
The DB2 Web Query masters list dialog box opens where you select a target
data source.

2. Select a data source and click OK.
The following image shows the Join settings window where you select fields
from the Host field and the Target field lists to create a join.
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3. Select the fields you want to join from the Host field list and the Target field
list and add them to their respective Selected Fields boxes.
or
Press Alt+M to go to the Host field list.
or
Press Alt+T to go to the Target field list.
Then, tab to the field and press Enter to add the chosen field to the
corresponding Selected Fields box.
Note: Fields must have the same format and be indexed fields in order to use
them to create joins.

4. Select your join properties:
v Unspecified. Indicates neither an inner nor left outer join.
v Inner Join. A join that results when a report includes host rows that have

corresponding cross-referenced rows.
v Left Outer Join. Extends the results of an Inner Join and retrieves records

from both host and cross-referenced tables, including all records from the left
table (host) and any records from the right table (cross-referenced) where the
condition values match. If there are no matching values in the
cross-referenced table, the join still retrieves records from the host table.

v Multiple Instance (formerly Non Unique). A one-to-many join structure that
matches one value in the host data source to multiple values in the
cross-referenced field. Joining employee ID in a company’s employee data
source to employee ID in a data source that lists all the training classes
offered by that company would result in a listing of all courses taken by each
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employee, or a joining of the one instance of each ID in the host file to the
multiple instances of that ID in the cross-referenced file. The default join type
is inner.

v Single Instance (formerly Unique). A one-to-one join structure that matches
one value in the host data source to one value in the cross-referenced data
source. Joining an employee ID in an employee data source to an employee
ID in a salary data source is an example of a unique join.

5. To see the join syntax, click View.
6. Click OK.
7. In the Description box, give the join a meaningful and unique name.
8. Click Save & Create and the new join appears in the Joins list.

Create a Define-based Join
1. Click the Join options tab in Report Assistant or Graph Assistant and click

New.
The DB2 Web Query masters list dialog box opens where you select a target
data source.

2. Select a data source and click OK.
3. Click the down arrow of the Define icon and then click New define field.

The following image shows the list of Define field options.

The following image shows the Define field creator dialog box where you
create the Define expression.
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4. Create the defined field. The new define field appears in the Available fields

list. The field is prefixed with the define symbol.
5. Add the defined field and the target field to their respective Selected Fields

boxes.
Note: Fields must have the same format and be indexed fields in order to use
them to create joins.

6. If you want to see the syntax, click View to display the define-based join
syntax.

7. Give the join a meaningful and unique name in the Description box.
8. Click Save & Create. The new join appears in the Joins list.

Create Multi-field Joins
1. Click the Join options tab in Report Assistant or Graph Assistant and click

New.
The DB2 Web Query masters list dialog box opens where you select a target
data source.

2. Select a data source and click OK.
3. Enter multiple fields in the Host field list box and one field in the Target field

list box.
4. If you want to see the syntax, click View to display the multi-field join syntax.
5. In the Description box, give the join a meaningful and unique name.
6. Click Save & Create.

The new join appears in the Joins list.

Delete a Join
1. Select a join from the Select an existing join list box.
2. Click Delete.
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Edit a Join
1. Select a join from the Select an existing join list box.
2. Make your desired changes.
3. Click Save & Create.

Applying Other Report Options
The Report options tab enables you to select from a variety of options for the
output of your report.

The features of the Report options tab are shown in the following image.

The following is a list of the Report options tab features:
v Save a report to an output format that supports styling options.
v Save a report to an output format that supports CSS.
v Specify the page-numbering format.
v Set record/read limits.
v Use SQL engine joins for database optimization.
v Enter a report title.
v Enter summary text.
v Style the entire report.
v Style a PDF or PS report.
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v Justify an entire report.
v Enable On-demand Paging and grid lines.
v Display pop-up field descriptions for column titles.
v Optimize output with internal Cascading Style Sheets (CSS).
v Run long queries with the Paged option.
v Create a DB2 file as report output.
v Use accessibility features.
v Enable OLAP features.
v Enable the Automatic Drill Down features.
v Direct output to a printer.

Save a Report to an Output Format That Supports Styling
Options

1. From the Report options tab, select the Show styled formats option from the
drop-down list.

2. The Generate report as list box offers a choice of file types for the report
output. Select one of the following formats from this list:
v HTML. Creates the report in HTML, sending the output to the Web browser,

with or without grid lines.
v AHTML (Active Report). Creates an HTML report that is designed for

offline analysis. Users can interact with the data, using analysis options
similar to those found in an Excel workbook, without any connection to a
server. See Creating an HTML Active Report.

v PDF. Captures the entire report and creates a Portable Document Format
(.PDF) file, which can be opened in the Adobe® Acrobat Reader (Adobe’s
PDF viewer).

v EXL97. Generates a report in Excel97 format.
v EXL2K. Generates fully styled reports in the Excel 2000 HTML format. Excel

2000 provides full support for HTML files with embedded XML.
v EXL2KFORMULA. Excel with Formula.
v PS. Creates the report as a postscript file.

Save a Report to an Output Format That Supports CSS
1. From the Report options tab, select the Show unstyled formats option from the

drop-down list.
2. The Generate report as list box offers a choice of file types for the report

output. Select one of the following formats:
v EXCEL. Excel 95.
v DOC. Plain text with page breaks.
v WP. Plain text without page breaks.
v WK1. Import to Lotus® 1-2-3®. See Notes on Using LOTUS Format.
v DIF. Import to Spreadsheet.
v LOTUS. Import to Lotus 1-2-3. See Notes on Using LOTUS Format.
v TABT. Tab delimited.
v XML. eXtensible Markup Language.
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Specify Page Numbering Format

The Page Numbering list box offers several options for page numbering. Select one
of the following from the list box:
v Default. Numbers each page of the report in the format PAGE 1, PAGE 2, and

so on. The default value is ON.
v ON. Numbers each page of the report in the format PAGE 1, PAGE 2, and so on.
v OFF. Suppresses the display of page numbers.
v NOLEAD. Suppresses the two leading blank lines included on each page by

default.

Set a Record Limit or Read Limit

To limit the number of records retrieved when reporting from a non-FOCUS data
source, enter a number greater than zero in the Read Limit box. A read limit
specification is ignored when reporting from a FOCUS data source.

To limit the number of records retrieved when reporting from a FOCUS data
source, enter a number greater than zero in the Record Limit box.

These options are for development only.

Note:

v A warning is issued to indicate to the user that the report they are viewing is
only a subset of the actual data. This occurs when either Record limits or Read
limits are checked in the Properties tab, under Warning message displayed in
Heading.

v The This report is only a subset of the data edit box is checked by default. You
can deselect the check box for this message or design a new message. Either
message will appear in the heading of the report.

Set Optimization When Running Requests

You can optimize report requests which will reduce the volume of
database-to-server communication and improve response time. It also enables the
database to exploit its own internal optimization techniques. This function creates
SQL statements that take advantage of join, sort, and aggregation capabilities.

To enable this function, select the check box labeled Use SQL Engine Joins.
Multiplicative effect may result. Web Query protection is suppressed.

Include a Report Title

You can specify a report title in the Report Title field that will appear in the title
bar of your report. This option is not available for reports generated in PDF or PS
format or for reports that utilize on-demand paging.

Include Summary Text for a Report

You can specify summary text for your report in the Summary Text for Report
field. This will place a description of the output into a SUMMARY object inside the
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output HTML TABLE. The length limit of this summary is 500 characters. If you
try to set the SUMMARY to more than 500 characters, you receive the following
message:
Limit on length of summary is 500 characters.

Note: You can only specify summary text when the Use Accessibility features
(Section 508) option is checked.

Style the Entire Report

To style the entire report:
1. Click Font and Settings in the Global report styling section on the Report

options tab.
The Styles dialog box opens where you can select report style options.

2. Select the font styling options from the Font, Style, and Size boxes.
3. Select a text color from the Text color list box.
4. Select a background color from the Background color list box.
5. Select a justification from the Justification list box.
6. Select a different currency symbol to override the currency symbol set on the

reporting server. Choose from Default, USD, GBP, JPY, EUR, $, or Custom in
the Currency Symbol menu. When you select Custom, replace “Custom” with
the desired one-character custom currency symbol in the Currency Symbol
field.

7. Click OK.
8. To specify an existing DB2 Web Query Style Sheet or Cascading Style Sheet,

make your choice from the relevant list box.

Note: Clicking Reset returns the styling options to the following default settings:
v Font: Times New Roman
v Style: Normal
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v Size: 13
v Text Color: Black
v Background Color: Transparent
v Justification: Left

Style a PDF or PostScript Report

When you select PDF or PostScript® (PS) as the display format for a report, DB2
Web Query offers several additional styling features.
1. Select PDF or PS from the Generate report as list box.
2. Click Font and Settings. The Styles dialog box opens.
3. Select a font.
4. Click the Page Orientation list box to select either Portrait or Landscape.
5. Click the Page size list box to select the page size for the report.
6. Select a different currency symbol to override the currency symbol set on the

reporting server. Choose from Default, USD, GBP, JPY, EUR, $, or Custom in
the Currency Symbol menu. When you select Custom, replace “Custom” with
the desired one-character custom currency symbol in the Currency Symbol
field.

7. Click OK.

Justify an Entire Report

The following procedure describes how to justify an entire report. This affects
headers, footers, fields, and field headings.
1. Click Font and Settings. The Styles dialog box opens.
2. In the Justification list box, select Left, Right, or Center.
3. Click OK.

Enable On-Demand Paging and Grid Lines
1. Select HTML - Web browser or HTML - Web browser (with grid) in the

Generate report as list box.
Note: The latter option provides grid lines that separate cells of data in your
report.
You can only use On-demand Paging for reports that use the HTML format.

2. Click the On-demand Paging check box.
3. Save and run the report.

DB2 Web Query displays the first page of the report in the DB2 Web Query
Viewer.

Optimize Output With Cascading Style Sheets

When you check Optimize output with Cascading Style Sheets in the Report
options tab of Report Assistant, your report will reflect the styling options you
select, and generate Internal Cascading Style Sheet code in the HEAD tag of HTML
reports. This feature is available only if you select HTML in the Generate report as
drop-down list.
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Run Long Queries With the Paged Option

To display the first few pages of results prior to the completion of a long-running
query, use the Paged option for HTML output. From the Report options tab, select
the Format HTML Output check box, then select Paged from the drop-down list.

Note: Output for summary reports will be finalized when the query is complete.

Create a DB2 File as Report Output

To create a DB2 file as report output, complete the following steps.
1. From the Report options tab, select the Show database formats option from the

format drop-down list.
2. Accept the default value in the Generate report as list box, which is DB2- DB2

database table.
3. In the Database Output section, supply values for the following options:

v Destination Library - name of the library destination for the DB2 report file.
v Name - name of the DB2 file.

4. If you need to overwrite an existing file, select the Overwrite existing file check
box.
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Note: When specifying to overwrite an existing database file, the file will not
be overwritten if the user does not have specific write authority to the file. A
message will be displayed which says that the file already exists, even though
overwrite was specified.
The following image illustrates the options for the DB2 database format.

Use the Accessibility Feature

If you check this box, the output will be 508 compliant. See Include Summary Text
for a Report.

Setting OLAP Reporting Options

OLAP options are available in the Interactive options section of the Report options
tab in Report Assistant only when the OLAP license option is activated. The
relevant options—Enable OLAP and Automatic Drill Down—are located here.

Enable OLAP Options

The Enable OLAP options in the Report Assistant control how users can interact
with an OLAP report and access OLAP tools.

Administrators and Developers who are creating reports can OLAP-enable them
and control the following OLAP interfaces and drill down options.
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v OFF. OLAP is off when off is selected, OLAP options are not available for the
report.

v Columns only. Turns off the OLAP Control Panel and the OLAP Selections pane,
but enables OLAP functionality from the report itself. You can access options on
right-click menus, drag and drop columns within the report, and use up and
down arrows to sort columns from high to low or vice versa. This is the default.

v Columns with panel. Provides access to the OLAP Selections pane from a
square button to the left of the column titles.

v Show filters on top. Opens the OLAP Selections pane above the report. The
Measures, Graph, and Dimension controls, as well as the band containing the
OLAP, Run, and Reset buttons appear above the report output. You can open the
Control Panel by clicking the OLAP button on the Selection pane.

v Show filters on bottom. Opens the OLAP Selections pane below the report. The
Measures, Graph, and Dimension controls, as well as the band containing the
OLAP, Run, and Reset buttons appear below the report output. You can open
the Control Panel by clicking the OLAP button on the Selection pane.

v Show Panel in Report. Opens the OLAP report with the OLAP Selections pane
hidden. You can perform a variety of analytic tasks from the report itself.
Selection Criteria is shown next to the OLAP button.

v Show Tabbed. For OLAP reports that have multiple dimensions, this option
groups the dimension elements under a tab labeled with the dimension name.

Automatic Drill Down Options

These options enable you to sort instantly from high to low or low to high for
selected report columns:
v Off. Disables automatic drill downs.
v Dimensions only. Enables automatic drill downs on dimensions in reports and

graphs.
v Measures and Dimensions. Enables automatic drill downs on dimensions in

both reports and graphs and on measures in reports.

Direct Output to a Printer

To create a direct output to a printer, complete the following steps.
1. From the Report Options tab, select the Send to printer check box, which

activates the Printer Name field.
2. Type the name of the network printer you wish to print to in the Printer Name

field, for example, CAN28B1, as shown in the following image.
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Displaying Pop-up Field Descriptions for Column Titles
You can have pop-up field descriptions display in an HTML report when the
mouse pointer is positioned over column titles. Field description text displays in a
pop-up box near the column title using the default font for the report. Pop-up text
appears for report column titles including titles created with ACROSS phrases and
stacked column titles created with OVER phrases.

The pop-up text displayed for a column title is defined by the Description attribute
in the Master File for the corresponding field. If a column title has no Description
entry in the Master File, then no pop-up box is generated when your mouse is
positioned over the title.

This feature is not supported in the HTML Graph Assistant.

Display Pop-up Field Descriptions in an HTML Report
1. Open the HTML Report Assistant.
2. In the HTML Report Assistant window, select the Report options tab.
3. In the Interactive Options area, select the Show pop-up field description check

box.
4. Click Save to save this option in your report.
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Creating an HTML Active Report
Note: Active Report functionality is available only when the Active Reports license
option is activated.

An HTML Active Report is a report that is designed for offline analysis.

When using an HTML Active report you can:
v Interact with the data, using analysis options similar to those found in an Excel

workbook, without any connection to a server.
v Work offline without any additional plug-ins or programs. HTML Active Reports

are self-contained reports, meaning they contain all of the data and JavaScript™

within the HTML output file. Packaging the data and the interactive functions in
the HTML file also makes the output highly compressible for e-mail and
transparent to security systems.

v Save the report on a local machine with the packaged interactivity. Since no
connection to a server is required to view the data or use the analysis options,
you can save and use the report anywhere.

The following image shows a simple HTML Active Report. The record status and
page navigation bar appears at the top of the report.

Create an HTML Active Report With HTML Report Assistant
1. In the HTML Report Assistant, click the Report options tab.
2. Ensure that the Show styled formats option is selected from the drop-down

list.
3. From the Generate report as drop-down list, select AHTML - Active Report.
4. Click the Active Report Styling button.

The Active Report Styling dialog box opens.
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5. Select styling options for the Active Report.
For details, see Formatting an HTML Active Report.

Formatting an HTML Active Report
You can apply the following custom formatting to an HTML Active Report:
v Report view. You can set the report view as a standard table or as an

expandable report. An expandable report is a collapsed report that can be fully
expanded for sorting and other purposes.

v Pagination. You can set the justification for the information that appears in the
record status and page navigation bar and set the number of records that appear
per page. Pagination options are not available for expandable report views.

v Calculations. You can set certain calculations for fields in the report. You set
calculation results to show in a row that appears either above or below the
report.

v Color. You can set the color for data visualization graphs, the text and
background for the record status and page navigation bar, selected rows, the
value and background for calculations, and the text, background, and border for
the menu.

v Freeze columns. Enables you to freeze the report at a particular point so that
columns to the left of the freeze point remain in view while the user scrolls
through the other report columns.

Active Report Styling Dialog Box

The Active Report styling options are:

Report view
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Sets the report view as a standard table (Tabular) or as an Accordion
report. Users can fully expand accordion reports for sorting and other
purposes.

Pagination options

Following are the pagination options for HTML Active Reports. Pagination
options are not available for Accordion report views.

Justification

Justifies the text that appears in the record status and page
navigation bar. Options are Left, Center, and Right. Left is the
default.

Records per page

Sets the number of records that appear per page. Options are:
Default, 10, 20, 30, 40, 50, Show All. The default is 57 lines per
page.

Text

Sets the color for the text in the record status and page navigation
bar. The default is black.

Background

Sets the background color for the record status and page
navigation bar. The default color is silver.

Row selection colors

An HTML Active Report offers visual assistance for viewing data in the
report. For example, when a user hovers over a row of data the row is
highlighted with a background color and when they click a row of data it
is also highlighted with a background color. You can set the colors for
these options, Hover and Selected. The default color for Hover is RGB(255
252 204), which is a shade of yellow, and the default color for Selected is
RGB(51 255 204), which is a mix of green and blue.

Visualization colors

Users can apply data visualization to numeric fields in an HTML Active
Report. Here you can designate the colors of the bars. You can set different
colors for positive and negative values. The default color for positive and
negative values is black.

Freeze columns

Enables you to freeze the report at a particular point so that columns to the
left of the freeze point remain in view while the user scrolls through the
other report columns. Options include:
v None turns off the freeze option. This is the default.
v The fields in the request. If the report can be viewed fully viewed in the

browser window, then freeze is not applied.

Calculations

Set options for calculations:

Colors

Specifies the colors for the values in a calculation:
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Values sets the font color of the calculation results. This color
defaults to black.

Background sets the background color of the calculation results.
This color defaults white.

Location

Sets the location of the calculations. Options are Top row or Bottom
row. Top row is the default.

Menu options

Set options for the menu.

Font color

Enables you to set the colors for the menu text:

Text sets the color of the text

The default is black.

Hover sets the color of the text when the mouse hovers over it

The default color is black (text hover does not show).

Menu color

Set the colors for the menu:

Background sets the background color of the menu. The default color is
silver.

Hover sets the background hover color of an individual item on the
menu. For example, if the background color of the menu is black, the
hover color can be set to white to visually show which option on the menu
the mouse is currently hovering over. The default color is white.

Border sets the color of the menu border. The default color is white.

Active Cache

Select to enable the Active Cache option.

Because all post-retrieval processing is performed in the Web browser’s
memory, an Active Report has a processing limit of approximately 5,000
records or 100 pages of output. To create answer sets in excess of 5,000
records, the Active Cache option enables you to send only the first page of
Active Report output to the browser and retrieve subsequent pages from a
temporary cache on the WebFOCUS Reporting Server. The server also
becomes the resource for performing all calculations, sorting, and filtering
when Active Cache is enabled.

Running a Report
You may periodically run a report as you create it as well as when you have
finished creating it.

Run a Report
1. Click the Run icon in the Report Assistant.

If you click Run, the report appears in a separate browser session.
2. To return to the Report Assistant, close the browser window displaying the

report.
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Note: You can continue to make changes to your existing report procedure or
create another report by clicking Save As.

Saving a Report
When you click the Save or Save As buttons you save your report (procedure). If
you make changes in your report without subsequently saving them and then click
Quit, you are prompted with the following options:
v Yes. Click to save your changes and exit the report.
v No. Click to discard your changes and exit the report.
v Cancel. Click to return to your report to continue working or use Save or Save

As to save your changes and then click Quit to exit your report.

Editing a Report
When you create a report using Report Assistant and you add a new comment as
the first line of the report code, the report no longer opens in Report Assistant.
Instead, the report opens in the Editor.

When there is an error in a procedure that HTML Report Assistant cannot identify,
the code in the procedure appears in a window. At the top of the window, a
message appears that describes what line of code the error is occurring on. You
must reopen the procedure in the editor and correct the error before the procedure
can be reopened in HTML Report Assistant.

HTML Report Assistant Tab References
The topics in this section provide reference information for all of the fields in the
various tabs in the HTML Report Assistant.
v Field Selection Tab.
v Report Headings Tab.
v Selection Criteria Tab.
v Join Options Tab.
v Report Options Tab (IBM).

Field Selection Tab
The Field selection tab is used to select fields for a report.

Field Selection Tab: Available Fields Window

The following image shows the Available fields window on the Field selection tab.
The fields are sorted by the Name column with corresponding columns containing
their Alias, Format, and Segment information.
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Available Fields Window

Displays a list of field names from the selected data source.

Define icon

Click the Define (calculator) icon to select: New define field, Edit define
field, or Delete define field. If you select the New define field or Edit
define field, the Define field creator dialog box opens where you can create
or edit a defined field.

Note: The New define field is not for use with queries originated in IBM
Query/400.

Tree icon

Displays a tree structure of field names by segment with segment, alias,
title, description, and format information below the tree. Individual field
information appears when you click on the field.

List icon

Displays a list of all field names with information that you select from the
adjacent arrow that opens a list box: name, alias, title, format, description,
segment, and file name. You can also choose to sort by file order.
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Field Selection Tab: Report Fields Window

The following image shows the Report fields section on the Field selection tab. You
can view the selected fields with the following options:

Selected field display options

Lists the following field display options:

Prefix with the Segment Name

Prefixes the field name with the segment name.

Prefix with the Filename

Prefixes the field name with the name of the data source.

Show the field’s alias instead of name

Uses the alias defined in the Master File as the field name.

Show field’s title

Uses the title in the Master File instead of the field name.

Show field’s description

Uses the description in the Master File instead of the field name.

Add grand totals

The Add grand totals drop-down list provides two options. The Totals
option displays the totals for each column. The Recompute Totals option
recalculates computed fields before displaying the totals for each column.

Add a row total column

Displays the total for each row.

Sort By
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Lists the vertical field that you have selected from the Available Fields
window.

Add icon

Adds a field to the Sort By window.

Remove icon

Removes a field from the Sort By window.

Move Up or Move Down icons

Moves the position of the field within the report.

Sort Across

Lists the horizontal field you have selected from the Fields window.

Add icon

Adds a field to the Sort Across window.

Remove icon

Removes a field from the Sort Across window.

Move Up or Move Down icons

Moves the position of the field within the report.

Sum

Indicates a report that aggregates data by the horizontal field.

Print

Prints each value on a record-by-record basis.

New Computed Field icon

Opens the Computed Field Creator dialog box where you can
define the parameters for a new computed field. For more
information on the Field Creator dialog box, see Field Selection
Tab: Field Creator Dialog Box.

Add icon

Adds a field to the report fields.

Remove icon

Removes a field from the report fields.

Move Up or Move Down icons

Moves the position of the field within the report.

Field Selection Tab: Field List Searching

The following image shows the Field List Searching options that you can use to
search for a field in the Fields List. For more details, see Searching Field Lists.
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Pattern Search

Select the Master File attribute for which you want to search. The
following table lists the pattern attributes and a description of each.

Attribute Description

Name Name of the field.

Alias Alias for the field.

Title Display title for the field, as defined in the
Master File.

Format Field format, for example A4.

Description Field description, as defined in the Master
File.

Segment A segment of fields in the Master File.

Filename Name of the data source.

Text Box

Type your search string. You can use an asterisk (*) as a wildcard. For
example, type c* to find all fields that begin with the letter ″c″. The
character string is not case sensitive.

Field Selection Tab: Show Report Field Options for Sort By

The following image shows the Show report field options where you choose
various styles and functions for a selected field.
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The Display subtab for a Sort by field has these options:

Make this field invisible

Check to hide the display of a Sort By field.

Font button

Opens the font styling dialog box. See Font Dialog Box.

Conditional Styling button

Opens the conditional styling dialog box where you use to add conditional
styling in a report.

Drill Down button

Opens the drill-down dialog box. See Drill Down Dialog Box.

Format in report as

Is grayed out and unavailable.

Calculated as

Is grayed out and unavailable.

Include missing instances

Inserts ’.’ when no field value exists.

The Title subtab for a Sort by field has this option:

Title

Is the name of the field in the Sort By list box.

The Sorting subtab shown in the following image for a Sort by field has these
options:
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Ascending

Click to arrange fields in ascending order.

Descending

Click to arrange fields in descending order.

Total

Applies aggregation and sorting simultaneously to numeric columns in
your report in one pass of the data. See Aggregating and Sorting Fields.

On vertical sort value change (By)

Select:
v Create a page break (on value change).
v Separate (from next) with underline.
v Subtotal numeric sum/print fields.

Note:

v When you select the Create a page break check box, the And reset page
number to 1 check box is activated.

v When you select the Subtotal numeric sum/print fields check box, the
Subtotal tab appears and the And higher level sort fields and the
Recalculate computed fields using subtotal values check boxes are
activated. For more information about subtotals, see Include Subtotals.

The Ranking subtab, shown in the following image for a Sort by field has these
options:
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Add Ranking column

This check box is unselected by default and enables a user to add a
Ranking column.

Limit the number of ranked values to

This check box is grayed out by default and activated only if the Add
Ranking column check box is selected. It enables a user to enter an integer
value to select the number of ranked values to display in the report (5 is
the default value).

Text Box

The title of the ranking column can be changed from the default of RANK.

Font button

Opens the font styling dialog box. See Font Dialog Box.

The Subhead/Subfoot subtab, shown in the following image for a Sort by field has
these options:

Formatting toolbar
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Specify the font, font size, font style, text alignment, text color, and
background color of the subhead or subfoot.

Text box

Enter a subhead/subfoot in the text box.

The Subtotal subtab for a Sort by field has:

Text box

Enter text to display for the subtotal.

Note: This sub tab appears when you select the Subtotal numeric
sum/print fields option on the Sorting sub tab.

Field Selection Tab: Show Report Field Options for Sort
Across

The following image shows the Show report field options where you choose
various styles and functions for a selected field.

The Display subtab for a Sort across field has these options:

Make this field invisible

Check to hide the display of a Sort Across field.

Font button

Opens the font styling dialog box. See Font Dialog Box.

Conditional Styling button

Is grayed out and unavailable.

Drill Down button

Opens the drill-down dialog box. See Drill Down Dialog Box.

Format in report as

Is grayed out and unavailable.

Calculated as
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Is grayed out and unavailable.

Include missing instances

Is grayed out and unavailable.

The Title subtab for a Sort across field has this option:

Title

Is the name of the field in the Sort Across list box.

The Sorting subtab for a Sort across field has these options:

Ascending

Click to arrange fields in ascending order.

Descending

Click to arrange fields in descending order.

Note: Other options are grayed out and unavailable.

Field Selection Tab: Show Report Field Options for Column

The following image shows the Show report field options where you choose
various styles and functions for a selected field.

The Display subtab for a Column field has these options:

Make this field invisible

Check to temporarily hide the display of a Column field.

Font button

Opens the font styling dialog box. See Font Dialog Box.

Conditional Styling button

Opens the conditional styling dialog box where you use to add conditional
styling in a report.

Drill Down button
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Opens the drill-down dialog box. See Drill Down Dialog Box.

Format in report as

Click ... to open the change format dialog where you can edit the field
format. See Change Format Dialog Box.

Calculated as

Make a selection from the drop-down list.

Include missing instances

Inserts ’.’ when no field value exists.

The Title subtab for a Column field has this option:

Title

Is the name of the field in the Columns list box.

Drill Down Dialog Box

The following image shows the drill down dialog box, where you can add drill
down capability to a report.

Execute procedure (FOCEXEC)

Lists the domains and procedures that are available as drill-down reports.
Click the procedure you want to execute.

Show all domains
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When Execute procedure (FOCEXEC) is selected, click this check
box to gain access to procedures in the Standard Reports folders of
all available domains.

No action

Is the default.

Execute procedure

The procedure you selected appears in this text box.

Execute URL

Enter the URL of a Web page that will open when a user drills down.

With parameters

Once a parameter is created using the Add button, it is automatically
added to this area.

Alternate comment for hyperlink

You can place comments here.

Add button

Opens the drill-down parameter dialog shown in the following image.

Parameter name

Enter the parameter name you created in the drill down procedure.

Parameter value: Field

Select the field the user can drill down.

Parameter value: Constant value

The parameter is set to the specified value.

OK button

Returns to the drill down dialog. The parameter is added to the
With parameters list box.
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Font Dialog Box

The following images shows the font dialog box.

Font

Select from the list box.

Style

Select from normal or bold, italic, underline, and various combinations.

Size

Select a font size from the list box.

Set Style for Title & Data, Title only, or Data only option buttons

Set the style for Title & Data, Title only, or Data only.

Text color

Select a color from the color palette.

Background color

Select a color from the color palette.

Justification

Select left, right, or center from the list box.

Apply these styling conditions to all report fields check box

Apply these styling conditions to all report fields.

Field Selection Tab: Field Creator Dialog Box

Use the Field Creator Dialog Box to create or edit temporary fields, as shown in
the following image.

Chapter 4. Creating a Report With Report Assistant 145



Field

Enter a name for the temporary field. Note that field names cannot exceed
66 characters.

Format button

Displays the Change Format dialog box where you can modify the data
formats. See Change Format Dialog Box.

Tree or List mode buttons

Opens the field list in either tree or list mode.

Functions button

Displays a list of predefined functions.

Fields window

Double-click a field or function to include it in an expression.

Concatenation operators

Concatenates two or more alphanumeric constants and/or fields into a
single character string. The concatenation operator has two forms: | (weak
concatenation, which preserves trailing blanks) and || (strong
concatenation, which moves trailing blanks to the end of a concatenated
string).

IF... THEN... ELSE... operators

Creates a conditional expression. A conditional expression assigns a value
based on the result of a logical expression. The assigned value can be
numeric or alphanumeric. IF, THEN, ELSE logic expressions take this form:
IF expression1 THEN expression2 ELSEexpression3
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ELSE is an optional operator. All alphanumeric values in conditional
expressions must be enclosed in single quotation marks. For example, IF
REGION EQ ’West’.

Logical operators

Used to create relational and Boolean expressions. A relational expression
returns a value based on a comparison of two individual values (either
field values or constants) and a Boolean expression returns a value based
on the outcome of two or more relational expressions.

Logical operators are:
v

adds the less than (LT) operator to the expression. This operator returns

a value if the value on the left is less than the value on the right.
v

adds the greater than (GT) operator to the expression. This operator

returns a value if the value on the left is greater than the value on the
right.

v

adds the less than or equal to (LE) operator to the expression. This

operator returns a value if the value on the left is less than or equal to
the value on the right.

v

adds the greater than or equal to (GE) operator to the expression. This

operator returns a value if the value on the left is greater than or equal
to the value on the right.

v

adds the equal (EQ) operator to the expression. This operator returns a

value if the value on the left is equal to the value on the right.
v

add the not equal to (NE) operator to the expression. This operator

returns a value if the value on the left is not equal to the value on the
right.

v AND returns a value if both operands are true.
v OR returns a value if either operand is true.
v NOT returns a value if the operand is false.
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Arithmetic operators

Click any of the arithmetic operators to use them in your expression: +
(addition), - (subtraction), * (multiplication), / (division), **
(exponentiation).

Two operators cannot appear consecutively. The following expression is
invalid:

a* -1

To make it valid, you must add parentheses:

a* (-1)

Parentheses

Adds parentheses to the expression box. Parentheses affect the order in
which the specified operations are performed. For information on when to
use parentheses, see Order of Evaluation for Expressions.

Quotation Marks

Adds quotation marks to the expression box. Use single quotation marks to
enclose alphanumeric and date literals.

U option

Converts entries in the expression box to uppercase. Click the U key in the
calculator. Note that field names are case-sensitive.

Order of Evaluation for Expressions

DB2 Web Query performs numeric operations in the following order:
1. Parentheses.
2. Exponentiation.
3. Division and multiplication.
4. Addition and subtraction.

When operators are at the same level, they are evaluated from left to right. Because
expressions in parentheses are evaluated before any other expression, you can use
parentheses to change this predefined order. For example, the following
expressions yield different results because of parentheses:
COMPUTE PROFIT/D12.2 = RETAIL_PRICE - UNIT_COST * UNIT_SOLD ;
COMPUTE PROFIT/D12.2 = (RETAIL_PRICE - UNIT_COST) * UNIT_SOLD ;

In the first expression, UNIT_SOLD is first multiplied by UNIT_COST, and the
result is subtracted from RETAIL_PRICE. In the second expression, UNIT_COST is
first subtracted from RETAIL_PRICE, and that result is multiplied by
UNIT_SOLD.gives an incorrect result because UNIT_SOLD is first multiplied by
UNIT_COST, and then the result is subtracted from RETAIL_PRICE.

Change Format Dialog Box

The following image shows the Change Format dialog box.
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Format types

Choose:
v Alphanumeric
v Floating point
v Integer
v Decimal
v Packed
v Date
v Date-Time

Length

Choose an available number based on the format type you chose.

Select options

Choose options based on the format type you chose.

Report Headings Tab
The Report headings tab is used to select and style headings and footings for a
report.

Report Headings Tab

The following image shows the Report headings tab where you enter and style a
page title heading and/or footing. You can also include a field value from the
Available fields list in the page heading and/or footing.
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Formatting tool bar

v Cut, copy, paste.
v Select all.
v Remove formatting.

Note: The above icons are not available for Firefox users. You must use the
standard key combinations Ctrl+C, Ctrl+V, Ctrl+X, and so on.
v Font styles. Select from bold, italic, and underline.
v Alignment. Select left, center, right, or bottom alignment.
v Font. Select a different font from the list box.
v Font size. Select a font size from the list box.
v Text color. Select the text color from the color menu.
v Background color. Select the background color from the color menu.

Show/Hide Fields list

Show or hide the Available Fields window.

Available fields window

Insert a field in your heading or footing from the fields list.

Define icon

Click the Define (calculator) icon to select: New define field, Edit define
field, or Delete define field. If you select the New define field or Edit
define field, the Define field creator dialog box opens where you can create
or edit a defined field.

Tree icon

Displays a tree structure of field names by segment with segment, alias,
title, description, and format information below the tree. Individual field
information appears when you click on the field.
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List icon

Displays a list of all field names with information that you select from the
adjacent arrow that opens a drop-down list: name, alias, title, format,
description, segment, and file name. You can also choose to sort by file
order.

Page Heading

Enter the text for the heading in the Page Heading box.

Page Footing

Enter the text for the footing in the Page Footing box.

Selection Criteria Tab
The Selection criteria tab is used to create WHERE and WHERE TOTAL statements
for a report.

Selection Criteria Tab: Screening Conditions

The following image shows the Screening conditions section on the Selection
criteria tab where you create a WHERE statement by dragging and dropping a
field from the Available Fields window.

WHERE/WHERE TOTAL

Use WHERE to select records based on the values of an individual field.

Use WHERE TOTAL to select records based on the aggregate value of a
field, for example, the sum or average of a field’s values.

Fieldname

Is the field you initially chose.

Operator Expression

Select an operator from the drop-down list, for example, EQUAL to.

Select Values

Click to open the Values dialog box, which is shown in the following
image.
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Constant

Type a constant value. To use multiple constant values, click the
plus sign in the Multiple values entered list box after each constant
value that you type.

Select from file (Import) button

Opens the Select file dialog box. For more information, see
Importing Values From External Files for WHERE Statements.

Parameter

Type a parameter name. To use multiple parameter values, click
the plus sign in the Multiple values entered list box after each
parameter name that you type.

Auto Prompt button

Opens the Parameter Properties dialog box. See Parameter
Properties Dialog Box (Dynamic Parameters) and Parameter
Properties Dialog Box (Static Parameters) for details.

Field

Select a field from the Field list box.

Values

Select a field value from the Values list box. To use multiple field
values, click the plus sign in the Multiple values entered list box
after each field value that you select.

Multiple values entered

Displays the constants, imported values, parameters, or field values
you added to the Multiple values list box. Use the available
buttons to add, remove, and change the order of the selected
values.
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Parameter Properties Dialog Box (Dynamic Parameters)

The following image shows the Parameter Properties dialog box with the Dynamic
option selected.

Name

Name is the parameter name. This field is automatically filled in with
information from the selected field. You can change the name if desired.

Description

Text that appears in the Auto prompt page as a prompt for the selection
list. This field is automatically filled in with information from the selected
field. You can change the description if desired.

Selection

Select the type of parameter:
v Dynamic retrieves values from the specified data source when the

request is run. This is the default selection.
v Static contains a list of values you supply. These values do not change

unless you change them.

Select multiple values at runtime

Selecting this check box enables you to provide more than one value to the
report from the auto prompt page. In addition, the user is able to select all
values from the values list.

Data Source

Select a data source that contains the values for the parameter. The data
source must be on your APP PATH.
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Field

Select the field from the data source whose values will populate the
selection list.

Parameter Properties Dialog Box (Static Parameters)

The following image shows the Parameter Properties dialog box with the Static
option selected.

Name

Is the parameter name. This field is automatically filled in with
information from the selected field. You can change the name if desired.

Description

Text that appears in the Auto prompt page as a prompt for the selection
list. This field is automatically filled in with information from the selected
field. You can change the description if desired.

Selection

Select the type of parameter:
v Dynamic retrieves values from the specified data source when the

request is run. This is the default selection.
v Static contains a list of values you supply. These values do not change

unless you change them.

Select multiple values at runtime
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Selecting this check box enables you to provide more than one value to the
report from the auto prompt page. In addition, the user is able to select all
values from the values list.

Constant

Enter one or more constant values.

Show field values

Shows the values in the selected field. Move the values you want in the
selection list to the Prompt values list.

Prompt values

Prompt Values are the values that appear in the selection list. You can use
the available buttons to add, remove, and change the order of the Prompt
values.

Join Options Tab
The Join options tab is used to create joins for a report.

Join Options Tab: Add or New

The following image shows the Join options tab where you create joins for a
report.

Select an existing join

Use the list box to select the join with which you want to work.

New

Opens the Masters List dialog box where you select the target data source.

Delete

Click to delete the join.

OK button
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Click to select a Master File.

Cancel button

Click to return to the Add/New Join window.

When you select a target data source you have multiple join related settings and
options, as shown in the following image.

The Join Settings section provides the following fields and buttons for creating
joins:

Description

Enter a description for your join.

Internal name

DB2 Web Query assigns an alphanumeric name for the join, for example
J001.

Save & Create

Once you have selected your host and target fields, click Save & Create to
create the join.

View

Click to view the syntax of your join, which displays the code sent to the
DB2 Web Query Reporting Server to validate the join, but may not be the
same code required to run the report. This is the case for a DEFINE based
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JOIN where only the JOIN statement is displayed for validation, but both
the JOIN and DEFINE statements are needed when the report is run.

The Join Type drop-down list provides the following join type options:

Inner Join

A join that results when a report omits host rows that lack corresponding
cross-referenced rows.

Unspecified

Indicates neither an inner nor left outer join.

Left Outer Join

Extends the results of an Inner Join and retrieves records from both host
and cross-referenced tables, including all records from the left table (host)
and any records from the right table (cross-referenced) where the condition
values match. If there are no matching values in the cross-referenced table,
the join still retrieves records from the host table.

The Instances drop-down list provides the following join instance options:

Multiple Instance (formerly Non Unique)

A one-to-many join structure that matches one value in the host data
source to multiple values in the cross-referenced field. Joining employee ID
in a company’s employee data source to employee ID in a data source that
lists all the training classes offered by that company would result in a
listing of all courses taken by each employee, or a joining of the one
instance of each ID in the host file to the multiple instances of that ID in
the cross-referenced file.

Single Instance (formerly Unique)

A one-to-one join structure that matches one value in the host data source
to one value in the cross-referenced data source. Joining an employee ID in
an employee data source to an employee ID in a salary data source is an
example of a unique join.

The Host Field List contains:

Search (binoculars) icon

Opens the Field List Searching dialog box. See Searching Field Lists for
details.

Define icon

Click the Define icon to select: New define field, Edit define field, or Delete
define field. If you select the New define field or Edit define field, the
Define field creator dialog box opens where you can create or edit a
defined field.

Tree icon

Displays a tree structure of field names by segment with segment, alias,
title, description, and format information below the tree. Individual field
information appears when you click the field.

List icon
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Displays a list of all field names with information that you select from the
adjacent arrow that opens a list box: name, alias, title, format, description,
segment, and file name. You can also choose to sort by file order.

Available fields

Lists of fields from the host data source for creating a join.

The Target Field List contains:

Select a target button

Click to select a target Master File.

Tree icon

Displays a tree structure of field names by segment with segment, alias,
title, description, and format information below the tree. Individual field
information appears when you click the field.

List icon

Displays a list of all field names with information that you select from the
adjacent arrow that opens a list box: name, alias, title, format, description,
segment, and file name. You can also choose to sort by file order.

Fields

Lists of fields from the target data source for creating a join.

For both the Host and Target field lists, each has its own Selected Fields window
that has:

Selected Fields window

Shows the fields selected from the data source for a join.

Add icon

Adds a field.

Remove icon

Removes a field.

Move Up or Move Down icons

Moves the position of the field within the join.

Report Options Tab
The Report options tab is used to select options for a report.

Report Options Dialog Box

The following image shows the Report options tab where you select report output
formats.
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Generate report as list box (when check box is selected)

When the Show styled formats check box is selected, choose from the
following formats:
v HTML - Web browser
v HTML - Web browser (with grid)
v AHTML - Active Report
v PDF - Portable Document Format
v EXL97 - Excel 97
v EXL2K - Excel 2000
v EXL2KFORMULA - Excel 2000 with FORMULA
v PS - Postscript

Generate report as list box (when check box is not selected)

When the Show styled formats check box is not selected, choose from the
following formats:
v EXCEL 95 - Excel 95
v DOC - Plain text with page breaks
v WP - Plain text without page breaks
v WK1 - Import to Lotus 1-2-3. See Notes on Using LOTUS Format.
v DIF - Import to spreadsheet
v LOTUS - Import to Lotus 1-2-3. See Notes on Using LOTUS Format.
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v TABT - Tab-delimited
v XML - eXtensible Markup Language

Show styled formats check box

Check to show output formats that support styling options.

The Output format specific section has these options:

Report title

Enter the report title in the text box.

Optimize output with Cascading Style Sheets

Check to optimize output with Cascading Style Sheets.

Use accessibility features (Section 508)

Check to use accessibility features (Section 508).

Summary text for report

Add summary text in the text box. See Include Summary Text for a Report.

The Interactive options subsection has these options:

Enable OLAP

Choose:
v OFF
v Columns only
v Columns with panel
v Show filters on top
v Show filters on bottom
v Show panel in report
v Show Tabbed

Automatic drill down

Choose:
v Off
v Dimensions only
v Dimensions and Measures

On-demand paging

Check to initiate on-demand paging.

Show pop-up field description

Check to display pop-up field descriptions for column titles. See
Displaying Pop-up Field Descriptions for Column Titles.

The Global report styling section has these options:

Font and Settings button

Opens the Styles dialog box.

Font

Select from the list box.

Style
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Select from normal or bold, italic, underline, and various
combinations.

Size

Select a font size from the list box.

Text color

Select a color from the color palette.

Background color

Select a color from the color palette.

Justification

Select left, right, or center from the list box.

Currency Symbol

Select a different currency symbol to override the currency symbol
set on the reporting server. Choose from Default, USD, GBP, JPY,
EUR, $, or Custom in the Currency Symbol menu. When you select
Custom, replace “Custom” with the desired one-character custom
currency symbol in the Currency Symbol field.

Active Report Styling

Opens the Active Report Styling dialog box. This button is only active
when you select the AHTML - Active Report output format. See Creating
an HTML Active Report.

Apply an existing WebFOCUS Style Sheet

Select None or a Style Sheet from the list box.

Apply an existing Cascading Style Sheet

Select None or a Style Sheet from the list box.

The Content and generation section has these options:

Page numbering

Select Default, On, Off, or No lead from the list box.

Limit the number of read operations performed during report generation

Enter a number in the text box.

Stop retrieving reports after the specified number have been included in the
report

Enter a number in the text box.

Notes on Using Lotus Format

The Display Format selection box on the Report options tab lists Lotus as a display
format. This format, however, does not create a valid Lotus™ spreadsheet. To work
around this limitation, follow these steps:
1. Select the Excel display format.
2. When the request is run, WebFOCUS prompts you to save or open the file,

select Save.
3. Save the file with an .xls extension to a valid directory.

Lotus Release 5.0 or higher can open files with an .xls extension.
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Report Options Tab
The Report options tab is used to select options for a report.

Report Options Dialog Box

The following image shows the Report options tab where you select output
formats for a report.

Generate report as list box (when Show styled formats is selected)

When the Show styled formats option is selected from the drop-down list,
choose from the following formats:
v HTML - Web browser
v HTML - Web browser (with grid)
v AHTML - Active Report
v PDF - Portable Document Format
v EXL97 - Excel 97
v EXL2K - Excel 2000
v EXL2KFORMULA - Excel 2000 with formula
v PS - Postscript

Generate report as list box (when Show unstyled formats is selected)
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When the Show unstyled formats option is selected from the drop-down
list, choose from the following formats:
v EXCEL 95 - Excel 95
v DOC - Plain text with page breaks
v WP - Plain text without page breaks
v WK1 - Import to Lotus 1-2-3. See Notes on Using LOTUS Format.
v DIF - Import to spreadsheet
v LOTUS - Import to Lotus 1-2-3. See Notes on Using LOTUS Format.
v TABT - Tab-delimited
v XML - eXtensible Markup Language

Generate report as list box (when Show database formats is selected)

When the Show database formats option is selected from the drop-down
list, choose from the following formats:
v DB2 - DB2 database table

When the Show database option is selected, the Database Output section
becomes active.

Show formats drop-down list

The drop-down list for selecting formats has these options:
v Show styled formats. Displays output formats that support styling

options.
v Show unstyled formats. Displays output formats that do not support

styling options.
v Show database formats. Displays database formats. When selected, the

Database Output section becomes active.

For styled formats, the Output format specific section has these options:

Report title

Enter the report title in the text box.

Format HTML Output

Full - Retains standard HTML formatting. This is the default.

Paged - Specifies that each page of a report is returned to the browser as a
separate HTML table.

Fixed - Turns off HTML formatting and allows the report designer to
determine where items in the report are placed.

Optimize output with Cascading Style Sheets

Check to optimize output with Cascading Style Sheets.

Use accessibility features (Section 508)

Check to use accessibility features (Section 508).

Summary text for report

Add summary text in the text box. See Include Summary Text for a Report.

In the Interactive options subsection:

Enable OLAP
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Choose:
v OFF
v Columns only
v Columns with panel
v Show filters on top
v Show filters on bottom
v Show panel in report
v Show Tabbed

Automatic drill down

Choose:
v Off
v Dimensions only
v Dimensions and Measures

On-demand paging

Check to initiate on-demand paging.

Show pop-up field description

Check to display pop-up field descriptions for column titles. See
Displaying Pop-up Field Descriptions for Column Titles.

The Global report styling section has these options:

Font and Settings button

Opens the Styles dialog box.

Font

Select from the list box.

Style

Select from normal or bold, italic, underline, and various
combinations.

Size

Select a font size from the list box.

Text color

Select a color from the color palette.

Background color

Select a color from the color palette.

Justification

Select left, right, or center from the list box.

Currency Symbol

Select a different currency symbol to override the currency symbol
set on the reporting server. Choose from Default, USD, GBP, JPY,
EUR, $, or Custom in the Currency Symbol menu. When you select
Custom, replace “Custom” with the desired one-character custom
currency symbol in the Currency Symbol field.

Active Report Styling
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Opens the Active Report Styling dialog box. This button is only active
when you select the AHTML - Active Report output format. See Creating
an HTML Active Report.

Apply an existing Style Sheet

Select None or a Style Sheet from the list box.

Apply an existing Cascading Style Sheet

Select None or a Style Sheet from the list box.

The Send to printer check box allows you to send your output directly to a
designated printer.

The Content and generation section has these options:

Page numbering

Select Default, On, Off, or No lead from the list box.

Limit the number of read operations performed during report generation

Enter a number in the text box.

Stop retrieving reports after the specified number have been included in the
report

Enter a number in the text box.

Use SQL Engine Joins. Multiplicative effect may result. Web Query protection is
suppressed.

Enables the database to use its internal optimization techniques which
reduce the volume of database-to-server communications and improve
response time.

The Database Output section has these options:

Destination Library

Enter name of the library destination for the DB2 report file.

Name

Enter the name of the DB2 file.

Overwrite existing file

Select this option if you need to overwrite an existing file. Note: When
specifying to overwrite an existing database file, the file will not be
overwritten if you do not have specific write authority to the file. A
message will be displayed which says that the file already exists, even
though overwrite was specified.

The Printer section has one option:

Name Enable when the Send to printer check box is selected. Enter the name of
the printer.

Notes on Using Lotus Format

The Display Format selection box on the Report options tab lists Lotus as a display
format. This format, however, does not create a valid Lotus™ spreadsheet. To work
around this limitation, follow these steps:
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1. Select the Excel display format.
2. When the request is run, DB2 Web Query prompts you to save or open the file,

select Save.
3. Save the file with an .xls extension to a valid directory.

Lotus Release 5.0 or higher can open files with an .xls extension.
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Chapter 5. Analyzing Data in an OLAP Report

Presents the terminology and benefits of using Online Analytical Processing
(OLAP). Describes how to customize reports with the OLAP selections panel and
the OLAP Control Panel. Describes how to sort and apply various selection criteria
(to restrict your data) as well as how to troubleshoot an OLAP�enabled report.
Explains how the OLAP Control Panel (OCP) provides you with a versatile way to
gain more insight from your reports by dynamically manipulating report data.
From the Control Panel, you can perform every function available to a DB2 Web
Query OLAP user.

If the OLAP license option has been activated, DB2 Web Query Online Analytical
Processing (OLAP) enables you to view and quickly analyze data in order to make
critical business decisions.

We Do It Every Day: Typical Web Query
Suppose that you own a small business in New York and are exploring a
partnership with a company in Oakland, California. You need to get to a Monday
morning meeting. How do you go about arranging your flight?

Most likely, you go online.

First, you check available flights on the airline that holds your frequent flyer miles.
You discover that your frequent flyer carrier requires a change of planes and you
would prefer a direct flight, so you look at routes and fares for other airlines.

In New York, you can get to LaGuardia, JFK, and MacArthur airports on Long
Island. In California, you can fly into Oakland or San Francisco.

While you would prefer to fly out on Sunday and return Tuesday morning, you
could consider a Saturday flight to California and a return flight on the red-eye
Monday night, if fares and schedules are better.

You begin your search by airline and then look at options for each departure point
and destination, by day, time and price.

Another approach is to start with an online consolidator, enter the times you can
fly, and see what flights and fares are available.

There are a lot of variables to play with, but in ½ hour you have done your
research and can make a good decision based on all available factors.

The Web sites you access are designed to facilitate your queries. Various menus
and selection boxes make it easy to pursue each line of inquiry. Required and
optional information is identified for you. You can move forward down a path of
choices, backtrack and start down a different path, or resume the original path
with different selections.

You need to keep track of the question you want to answer, but a well-designed
site makes your investigation easy. For most of us, this process has become
intuitive.
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The same process works when analyzing the data in an OLAP-enabled DB2 Web
Query report.

Running OLAP Examples
You can run all of the examples in this chapter using several OLAP-enabled
Standard Reports. If the reports are not already available in your sample
repository, ask your Managed Reporting administrator to provide them for your
use. There are 9 reports named olaprep1.fex through olaprep9.fex. and are located
in the \ibinccen directory. If you have installed a non-English version of the
’ibincc’ directory, you will need to install the English version (ibinccen) in order to
access these files.

Each example indicates which Standard Report to run. After the report appears in
your browser, you can perform the analytic task shown, or pursue your own line
of inquiry.

Suppose that you are an analyst for the fictional Century Corporation, which
manufactures electronics equipment. You need to determine which of the stores
that sells your products had the highest sales in 2002, and whether there is a
pattern in sales periods and/or best selling products that should be considered
when planning manufacturing schedules and parts inventories.

You have created a base report that shows sales data only for 2002. You have also
OLAP-enabled the report to permit quick analysis of the data.
1. Run the Standard Report OLAPREP1.

Before you begin your analysis, the OLAP report looks like the following
image.
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The Quarterly information is spread out over the left-most column. You can
try a horizontal display to make comparison easier.

2. Drag and drop QUARTER above the report.
The report changes immediately and appears, as shown in the following
image, across the top of the report with the Quantity and Line Cost of Goods
Sold columns repeating for each quarter. The store information is more
compact, but it is no easier to identify the store with the best sales record, so
drag QUARTER back to its original position.

3. Right-click Line Cost of Goods Sold and choose Visualization as shown in
the following image. This applies a data visualization bar graph to each value
in the column.

The display changes as shown in the following image. The bar graphs still do
not reveal a trend.
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4. Sort the data by highest value by either right-clicking Line Cost of Goods
Sold and choosing Sort by Highest, or clicking the Up arrow (the tool tip
reads Sort LINE_COG highest to lowest).
As shown in the following image, the report shows Audio Expert has the
highest sales in the digital product lines in Quarters 1 and 2, with eMart
trailing slightly. Each value under the QUARTER, Store Name and
PRODTYPE column is hyperlinked for more details.

170 System i: Database IBM DB2 Web Query for System i



5. Click Q2 for Audio Expert to check the monthly breakdown.
In the monthly report, both stores recorded their highest sales in June (06).
Filter out the other stores and focus on Audio Expert in June.

6. Click Audio Expert as shown in the following image.

Chapter 5. Analyzing Data in an OLAP Report 171



You now see information for digital and analog sales at Audio Expert. Since
the significant sales for Audio Expert are in the digital area, let’s see which
digital products contributed to the June figures.

7. Click Digital as shown in the following image.

The breakdown shows clearly that PDAs drove Audio Expert digital sales.
8. Click PDA Devices to see the details as shown in the following image.

As shown in the following image, ZT Digital PDA - Commercial was by far
the top seller.

Let’s now see what drove digital sales at eMart, the second highest producer.
9. Click the browser’s Back arrow until you return to the following window.

This time, click eMart, as shown in the following image.
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Once again, the digital category leads sales.
10. Click Digital as shown in the following image.

PDA is the strong seller here too.
11. Click PDA Devices as shown in the following image to examine the models

that comprise these sales.

The report shows sales figures for the two digital models as shown in the
following image.
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ZT Digital PDA - Commercial far outsells ZC Digital PDA -Standard.
This information from the two top selling stores suggests that Century
Corporation should evaluate and adjust available parts inventories for each
model and consider shifting production schedules of plants to produce more
Commercial units.
You have done all of your data manipulation from the report. But, because of
the options you selected when OLAP-enabling this report, it is easy to expose
the OLAP Selections pane where you can review the selections that are
currently in effect, and make additional selections if you like. For details on
OLAP set-up options, see OLAP-Enabling a Report.

12. To expose the OLAP Selections pane, right-click Product Name and select
Show Panel from the menu as shown in the following image.

The selection panel appears above the report as shown in the following image.
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Notice that STORENAME is eMart, PRODTYPE is Digital, and PRODCAT is
PDA Devices.

OLAP Reporting Requirements
OLAP reporting requires some preparation both of the data to be reported against
and of the report itself. In many instances, this preparation is entirely transparent,
having been done before a user encounters an OLAP report. However, for
developers who are charged with OLAP-enabling data and reports and for users
who wish, and are authorized, to OLAP-enable their personal reports, the
following summary will be useful.

OLAP-Enabling Data
Behind the scenes of any DB2 Web Query OLAP report is a hierarchical data
structure. For example, a typical hierarchy of sales regions might contain a
GEOGRAPHY category including the fields (in descending order) Region, State,
and City. Region, the highest level in this hierarchy, would contain a list of all
available regions within GEOGRAPHY. State, the second highest level in the
hierarchy, would contain a list of all available states within those regions, and so
on.

In DB2 Web Query, the hierarchical structure is generally built into the Master File
for a data source, where it becomes active for any report that uses that data source.
Developers or administrators who are responsible for describing data in a Master
File can use the underlying language. The keyword WITHIN defines the elements
in each dimension in the hierarchy.

In addition, those working in Developer’s Workbench have access to a variety of
graphical tools that make it easy to drag and drop fields into position to form a
hierarchy. The hierarchy may be global to all procedures or local to one procedure.
To define a:
v Global hierarchy in a Master File for use with multiple procedures, use the

Dimension Builder.
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v Local hierarchy as a component of a particular procedure, use the Dimension
tool. The hierarchy you define with this tool does not affect the source Master
File.

OLAP-Enabling a Report
In addition to using OLAP-enabled data, a report must be enabled to support
OLAP analysis. OLAP-enabling a report consists of specifying how a user will
interact with and drill down on OLAP data.

The primary interactions occur in the report itself. In addition, you can choose to
expose two supplementary tools, the OLAP Selections pane and the Control Panel.

Setting OLAP Reporting Options

OLAP Interface Options

Users who are creating their own reports can OLAP-enable them and control the
OLAP interfaces and following drill-down options.
v OFF. Provides an OLAP button to open the OLAP Control Panel.
v Columns only. Turns off the OLAP Control Panel and the OLAP Selections pane,

but allows OLAP functionality from the report itself. You can access options on
right-click menus, drag and drop columns within the report, and use up and
down arrows to sort columns from high to low or vice versa. This is the default.

v Columns with panel. Provides access to the OLAP Selections pane from a
square button to the left of the column titles.

v Show filters on top. Opens the OLAP Selections pane above the report. The
Measures, Graph, and Dimension controls, as well as the band containing the
OLAP, Run, and Reset buttons appear above the report output. You can open the
Control Panel by clicking the OLAP button on the Selection pane.

v Show filters on bottom. Opens the OLAP Selections pane below the report. The
Measures, Graph, and Dimension controls, as well as the band containing the
OLAP, Run, and Reset buttons appear below the report output. You can open
the Control Panel by clicking the OLAP button on the Selection pane.

v Show Panel in Report. Opens the OLAP report with the OLAP Selections pane
hidden. You can perform a variety of analytic tasks from the report itself.
Selection Criteria is shown next to the OLAP button.

v Show Tabbed. For OLAP reports that have multiple dimensions, this option
groups the dimension elements under a tab labeled with the dimension name.

Drill Down options

These options enable you to sort instantly from high to low or low to high for
selected report columns:
v None

Disables automatic drill downs.
v Dimensions

Enables automatic drill downs on dimensions in both reports and graphs.
v Dimensions and Measures

Enables automatic drill downs on dimensions in both reports and graphs and,
also, on measures in reports.
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Note: Explicit drill downs in a StyleSheet (if they exist) take precedence over
OLAP-enabled hyperlinks. If you click a hyperlink associated with an explicit
drill-down, the behavior will be defined by the StyleSheet rather than by the
AutoDrill On or All settings.

OLAP Terminology
The following table describes OLAP terms that may be useful as you work in the
DB2 Web Query OLAP tools. Some of these terms are directly reflected in the
interfaces of the OLAP Selections pane and the OLAP Control Panel. Others
provide useful background information.

The first column of the following table provides the term and the second column
provides the definition.

Term Definition

Dimension Group or list of related elements, usually structured in a hierarchy.
For example, a Location dimension could include the elements
Country, Region, State, and City arranged in a hierarchy where
Country is the top level and City is the base level. Dimensional
data usually describes the measured item.

Hierarchy Logical parent-child structure of elements within a dimension.

Measure Type of item that specifies the quantity of another element with
which it is associated. A measure typically defines how much or
how many. For example, Units, Revenue, and Gross Margin are
measures in the Account dimension and specify how many units
were sold, how much revenue was generated, and at what profit
margin, respectively.

Pivot Manipulating (or rotating) the view of a report by moving a field
(or a group of fields) from a column to a row, or vice versa.

Characteristics of an OLAP Report
An OLAP-enabled report has a number of features that distinguish it from other
DB2 Web Query reports.

A basic OLAP report is shown in the following image.
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Every OLAP user can take advantage of the analytic features that are built into the
OLAP report:
v Hyperlinks. The values in an OLAP report are usually hyperlinks from which

you can drill down to related information.
Depending on your OLAP settings, the hyperlinks may be active for both the
dimension fields (by which the report is sorted) and the measures fields (which
display quantitative data), or only for the dimension fields. For related
information, see OLAP-Enabling a Report.

v Context menus. You can right-click any column title to access a menu of options
that facilitate analysis. The options vary slightly to suit the tasks associated with
dimensions and measures.

v Sorting diamonds . The measures (fields that make up the body of the
report) have blue diamonds adjacent to them. You can click either the top or
bottom of the diamond to instantly sort data from high to low or low to high.

v Drag and drop capabilities for dimensions and measures.

– You can drag and drop sort fields to shift sorting from vertical (By) to
horizontal (Across) or vice versa.

– You can change the order in which sorting occurs by dragging sort fields
from inner to outer positions (and vice versa).

– You can drag measures from one position to another to affect the order in
which data appears.

Beyond the features in the report itself, your OLAP options depend on the
interface and drill down settings that are in effect for a particular report. Those
choices determine whether you have access to the following tools:
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v Selections Pane. When this tool is available, a pane may appear above, as
shown in the following image, or below your report. For details, see Selections
Pane.

v OLAP Control Panel. When this tool is available, the blue squares adjacent
to the sort fields (By or Across) in the report become active. You can click a
square or the OLAP button to open the Control Panel, as shown in the following
image. For details, see OLAP Control Panel.
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Three Ways of Working With OLAP Data
There are three ways to work with OLAP data: from the report itself, from the
Selections pane, and from the Control Panel. This documentation is organized to
help you understand what you can do from each location and which method is
most suitable and efficient for your particular OLAP settings.

The Report
You can perform a wide range of basic analytic functions from the report itself.
Changes you make in the report are implemented instantly. Every OLAP user can
perform these tasks:
v Sort the data in measures in either ascending (lowest value to highest) or

descending order (highest value to lowest).
v Drill down on measures, dimensions, or both (depending on the settings

described in Setting OLAP Reporting Options).
v Hide fields in the current report.
v View hidden fields in the dimensions hierarchy and add them to the report.
v Change a vertical (By) sort field to a horizontal (Across) sort field and vice

versa.
v Delete sort fields.
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v Add a column of small bar graphs that help you visualize trends in numeric
data (measures).

v Display a graphical representation of your data in a frame above the tabular
report.

For an illustration of report-powered OLAP analysis, see We Do It Every Day:
Typical Web Query.

Selections Pane
When the OLAP Selections pane is turned on, you can quickly limit the data in the
report by selecting specific values for the dimensions in the hierarchy. A
drop-down list is available for each dimension. You can multi-select values from
one or more dimension lists to refine your report output.

If you wish to add a dimension element to the report you can drag it from the
Selections pane into the report frame. (The cursor changes to a + sign to indicate
an acceptable location.)

Each dimension has a relational operator button located to its left. This button
toggles through a selection of basic numeric operators that enable you to quickly
define your selection criteria. The operators are: Equal to, Not equal to, Less than
or equal to, Less than but not equal to, Greater than or equal to, Greater than but
not equal to. For details, see Selection Criteria Relational Operators.

The following image shows the Equal to operator as the selection for each
dimension in the Selection Pane.

The name of the dimension field appears as defined in the Master File, even if an
alternate column title has been specified.

In addition, you can customize the display of the measures in your report from the
Selections pane. You can click either the Measures or the Graphs arrow in the
upper left corner of the pane to list the measures.
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v From the Measures arrow, you can display or hide the selected measure(s) or
request a column of simple bar graphs to reveal trends.

v From the Graphs arrow, you can choose the measure(s) you wish to graph and
specify one of seven basic graph types: vertical and horizontal bar, line, area
charts and pie charts.

Note that the Selections pane is resizable; the controls for dimensions, measures,
and graphs float as you resize the report window so that they continue to be
visible in the frame.

Three buttons appear below the Selections pane: OLAP, Run, and Reset.
v OLAP opens the OLAP Control Panel (OCP).
v Run executes the report with the current set of selections.
v Reset resets all the controls in the report to their previous state (that is, before

the current set of selections was made and after the last execution of the report).

OLAP Control Panel
From the Control Panel you can perform every analytic function available to a DB2
Web Query OLAP user as shown in the following image.
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The main window of the Control Panel contains the following components:
v Dimensions box reflects the hierarchical structure of the data source being used

by the current report (for example, the Location dimension contains the Region,
State, and City fields; the Region is made up of several States, and each State
contains several Cities). You click the arrow to the left of a dimension name to
view the elements that comprise it. (The fields shown here are also listed in the
Selections pane.)
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v Drill Down and Drill Across boxes list the fields being used to sort the report.
You can ’pivot’ a Drill Down field to a Drill Across field and vice versa, and
shift their positions in the report. (You can also accomplish these tasks by
dragging fields within the report.)

v Measures Properties box contains the body of your report (usually numeric
fields). You can change the display mode of a measure by clicking the check box
next to the measure; the options are display, hide, and show a column of
associated bar graphs. (This is equivalent to the options available from the
Measures control in the Selections pane.)

Although the most frequently used functions are available directly from an OLAP
report and/or from the Selections pane, several can only be performed from the
Control Panel.

Unique Control Panel operations include:
v Sorting options for dimensions: from highest to lowest and vice versa (A>Z or

Z>A); restricting sort field values to a specified number of either highest or
lowest values; assigning a rank number to each row in the report. For details,
see Sorting Data.

v Options for grouping numeric data by tile (for example, percentile, decile,
quartile, etc.). For details, see Grouping Numeric Data Into Tiles.

v Defining selection criteria based on omitted or existing characters, dates, and
range specifications. For details, see Limiting Data.

v Saving OLAP output in PDF and Excel formats. In Managed Reporting, users
can also save OLAP output in the My Reports folder. For details, see Saving and
Displaying OLAP Reports and Graphs in Other Formats.

v Stacking multiple measures to limit the width of the report. For details, see
Stacking Measures.

Drilling Down On Dimensions and Measures
You can drill down on dimensions in OLAP reports and graphs and, also, on
measures in reports. The settings activate the required hyperlinks:
v Dimensions enables automatic drill downs on dimensions in reports and

graphs.
v Dimensions and Measures enables automatic drill downs on dimensions in both

reports and graphs and on measures in reports.
v None disables automatic drill downs. This is the default.

In Developer’s Workbench, you can set drill down options from the Report
Options Format tab. For details about this setting, see Setting OLAP Reporting
Options.

Drilling Down on Dimensions in a Report

What result can you expect when you drill down on a dimension?

It is easiest to discern the pattern by looking at a concrete example.

This report you are about to run uses data from a hierarchy that contains three
dimensions, each of which has three elements. The report is sorted by the specified
field from each dimension. The following table outlines three dimensions, Time
Period, Location and Product Dimension to which each contains three elements.
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Time Period Location Product Dimension

Year Manufacturing Plant PRODTYPE

Quarter State PRODCAT

Month Store Name PRODNAME

The report will show data at different levels in each dimension: Quarter is down
one level in its dimension; Store Name is at the lowest level in its dimension;
PRODTYPE is the top level in its dimension. This determines how much farther
you can drill down within each dimension. If you drill down on a value of
Quarter, the report shows information broken down by Month within that Quarter.
The Quarter column itself will no longer appear.
1. Run the Standard Report OLAPREP2.

In this quarterly report, drill down hyperlinks are active for both dimensions
and measures.

2. Click Q1 in the quarterly report to see a monthly report as shown in the
following image.

The monthly report looks like this. Since Month is the bottom level in its
dimension, if you drill down on a month value, you will no longer see the
month column; however, you will see the data that relates to the selected
month in subsequent columns.
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3. Click the 01 in the monthly report to see details for January as shown in the
following image.

As shown in the following image, the January report shows product type,
quantity, and sales for each store.
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Next, see what happens when you drill down in the Location dimension—in
this case, on a value of Store Name in the second column of the report. When
you drill down on a dimension column other than the first, output is affected
to the right and left of that column.

4. Click the browser’s Back button to return to the monthly report, then click AV
VideoTown in the second column.
Since Store Name is the lowest level in its dimension, the Store Name column
no longer appears, nor does the Time Period column to its left. Nevertheless,
both the store name (AV VideoTown) and the current time period (January) set
the context for the information you see, which now consists of types of
products sold, quantity sold, and line cost of sold goods for AV VideoTown in
January as shown in the following image.

Drill Down on Measures in Reports

By drilling down on a measure, you expose the next level of detailed information
associated with that measure for each displayed dimension in the hierarchy. In
other words, when you drill down on a measure, the current dimension is used as
a limiting criterion; the rest of the hierarchy is then expanded based on that
limitation.
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Remember that a measure contains quantitative information about fields in each
dimension.

In this example, Quantity and Line of Sold Goods provide data about products at
particular stores during particular time periods.
1. Run the Standard Report OLAPREP2.

Notice that quantity of sales for all digital products at AV VideoTown in the
first quarter of the year is 22,206. You want to find out how much each digital
product contributed to the total quantity.

2. Click 22,206 under Quantity as shown in the following image.

As shown in the following image, the report now shows total quantity for
digital products sold at AV VideoTown broken out by month, product category,
and product name. Notice that Store Name no longer appears; since it is the
lowest level of the Location dimension, there is no lower level of detail.
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Since all relevant information is now visible, no further drill downs are possible
and the measure is no longer represented as a hyperlink.
Next, verify this behavior at another level in the hierarchy.

3. Click the Back button in your browser to return to the original report.
4. Click Q1 to see the monthly breakdown for that quarter.
5. Click AV Video Town. You are now looking at types of products sold, quantity

sold, and line cost of goods sold at AV Video Town.
6. Drill down on 1, 426 under Quantity as shown in the following image.

PRODTYPE Digital serves as the limiting criterion. Therefore, the expanded
hierarchy shows the next level of detail for each digital product. This level is
comprised of digital product categories (PRODCAT) and the names of the
products in each category (Product Names).
The report displays, as shown in the following image, the detailed data for
each element in the PRODTYPE dimension—in this case, the product categories
and product names that comprise the quantity figure of 1,426. The total
quantity and, correspondingly, the line cost of goods data, is now broken down
by product.
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Note that when you drill down on a measure value, results may differ
depending on the combination of sort fields in the report. The examples that
follow show several variations.

Drilling Down on a Measure in a Report With ACROSS Fields

When you drill down on a measure in a report with at least one dimension Across
field and no By fields, all Across fields are removed from the report and all of the
dimension elements under the removed Across fields become By fields from left to
right in the resulting report. (This convention ensures that the maximum number
of Across values supported by DB2 Web Query is not exceeded.)

The values that appear for the new By fields are controlled by internally generated
selection criteria. The measure values in the resulting report depend on the values
of the new By fields.
1. Run the Standard Report OLAPREP3.

In the report, RISK_CLASS and Continent are dimension Across fields on
which you can drill down.

2. Click the Balance value 671,290 under RISK_CLASS Low and Continent
AMERICAS as shown in the following image.

190 System i: Database IBM DB2 Web Query for System i



The report now looks like the following image.

In the new report, the RISK_CLASS and Continent fields are removed based on
two internally generated criteria: IF RISK_CLASS EQ ’Low’ and IF Continent
EQ ’AMERICAS.’
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The only dimension element under RISK_CLASS is Risk_Factor; the dimension
elements under Continent are Region and Country. These become By fields in
the new report, from left to right. The data displayed for the measures in the
resulting report are those that satisfy the values in the current By fields.

Drill Down on a Measure When BY/ACROSS Fields Are Under the
Same Dimension

When you drill down on a measure in a report with at least one By and one
Across dimension field under the same root dimension, both the By and Across
fields are hidden and the subordinate element(s) in the same dimension becomes
By fields in the new report. In effect, the report is filtered based on the values of
the dimensions. As a result, the sorting controlled by both hidden and visible
dimensions remains in effect.
1. Run the Standard Report OLAPREP4.

In the report, Continent is a By field and Region is an Across field; both are in
the Geographic Area dimension.

2. Click the CANADA_DOLLAR value of 56,280,934 in the Continent row for
AMERCAS under the Region CENTRAL AMERICA as shown in the following
image.

The report now looks like the following image.
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The new report, data is filtered based on the internally generated criteria: IF
Continent EQ ’AMERICAS’ and IF REGION EQ ’CENTRAL AMERICA.’
(Continent and Region are no longer visible.)
REGION is replaced by the last element in the Geographic Area dimension,
Country, which becomes the controlling By field in the report. The data
displayed for the measures are those that satisfy the values in the current By
field.

Drill Down on a Measure When BY/ACROSS Fields Are Under
Different Root Dimensions

When you drill down on a measure in a report with at least one By and one
Across dimension field from different root dimensions, the By fields are broken
down to their last dimension level, then the Across fields are broken down.

The original By and Across fields are removed. The dimension elements under the
removed By fields become the first set of By fields from left to right. The
dimension elements under the removed Across fields follow the first set of By
fields from left to right.
1. Run the Standard Report OLAPREP5.

In the report, Continent is a By field from the Geographic Area dimension and
Risk Class is an Across field from the Risk dimension.

2. Click the CANADA_DOLLAR value of 67,021,020 in the Continent row for
EUROPE under the RISK_CLASS High as shown in the following image.
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The report looks like the following image.

In the new report, the Continent and RISK_CLASS fields are removed based on
the internally generated criteria: IF CONTINENT EQ ’EUROPE’ and IF
RISK_CLASS EQ ’High.’
The By field (Continent) is broken down to its last dimension element. Then,
the Across field (RISK_CLASS) is broken down to its last dimension level. The
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resulting By fields in the report, from left to right, are Region, Country, and
Risk Factor. The data displayed for the measures satisfy the values in the
current By fields.

Sorting Data
You can sort the data in an OLAP report based on the values of dimensions in the
hierarchy and/or the values of the quantitative measures that constitute the body
of the report. Sorting options vary depending on the nature of the data being
sorted. For details, see Sorting Measures and Sorting Dimensions.

You can also group numeric data into any number of tiles (percentiles, quartiles,
deciles, etc.). See Grouping Numeric Data Into Tiles.

Sorting Measures
You can apply aggregation and sorting simultaneously to a numeric measure in an
OLAP report, and sort the data from high to low (descending order) or from low
to high (ascending order). All other columns are sorted correspondingly.

For the measure being sorted, you can restrict the report to a specified number of
highest values (when sorting high to low) or lowest values (when sorting from low
to high).

When you sort a measure, any subtotals, subheadings, or subfootings in the report
are automatically suppressed since these elements relate to a specific sort field and
are not meaningful when the report is resorted by the values in a measure column.
For an illustration, see “Applying a Percent Calculation to a Measure” on page 221.

Note: Sorting by measures is not available in a report in which measures have
been stacked. See Hiding and Displaying Measures.

Sort Measures High to Low/Low to High in an OLAP Report

To sort the values of a measure from high to low:

v Click the top half of the diamond button.
or

v Right-click the measure and select Sort By Highest from the menu.

The report runs automatically. The highest value is now first in the column. The
top of the diamond button becomes solid blue to indicate the current sort direction.

To sort the values of a measure from low to high:

v Click the bottom half of the diamond button.
or

v Right-click the measure and select Sort By Lowest from the menu.

The lowest value is first in the column. The bottom of the diamond button
becomes solid blue.

Tip: After a measure has been sorted, clicking the upper or lower half of the
diamond button inverts the sort order of that measure. Place your mouse over
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either half of the diamond to see a message that indicates the next sort order that
will occur if you click that half of the diamond.

Sorting a Measure From High-to-Low in the Report

The following is an example of sorting a measure from high-to-low in the report.
1. Run the Standard Report OLAPREP2.

The OLAP report shows sales information sorted by quarter, store, and product
type.
You are interested in seeing where the greatest quantity of goods have been
sold.

2. Click the top half of the diamond button next to the Quantity measure, as
shown in the following image, to sort the values from high to low.

As shown in the following image, the report now shows data values for the
Quantity measure in descending order. The top half of the diamond next to
Quantity is blue and solid to indicate the current sort order of the measure.
This is now the controlling sort in the report; all other values are reordered
correspondingly.
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Tip: To invert the sort order, click either the solid or hollow part of the diamond
button.

Sort Measures High to Low/Low to High From the Control Panel
1. Open the OLAP Control Panel.
2. Click a measure in the Measures box to open the sort options pane (do not

click the Measures check box which controls the display of a measure, not its
sorting).
Verify that the Sort box is checked (this setting is required to apply sorting
specifications to the selected measure).

3. Select the High-to-Low or Low-to-High options button to specify the sort order
you wish to apply. The default sort order is high to low.

4. Click OK.
The sort pane is replaced by the Measures box, where the measure becomes
blue to indicate that sorting specifications have been defined.

5. Click Run to display the report with sorting applied to the selected measure.
The diamond button next to the sorted measure changes to reflect the sort
order: if High to Low, the top half of the diamond is solid blue; if Low to High,
the bottom half is solid blue.

Note:

v Report execution is automatic when you sort a measure in an OLAP report.
However, if the Control Panel is open, all current changes in the Control Panel
are applied.

v If an OLAP request contains a horizontal (Across) sort field, the measures
appear several times in the report, once for each Across value. If you apply
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sorting to a measure, the sort is performed on the first column occurrence of the
measure, and reflected in all subsequent instances. The appropriate half of the
diamond button becomes solid only for the first instance. Any additional sorting
you wish to perform must be done from the first occurrence of the measure.

View a Subset of Data for Sorted Measures

You can select to view only a subset of the total number of records in your report.
1. Open the OLAP Control Panel.
2. Click a measure name in the Measures box to open the sort options pane (do

not click the Measures check box which controls the display of a measure, not
its sorting).
Verify that the Sort check box is selected (this setting is required to apply
sorting specifications to a measure).

3. Select the Rank check box, then specify the number of sort field values to be
included in the report. (Notice that Highest or Lowest appears to the left of the
input box to reflect the current sort order.)
v Use the spin buttons located to the right of the word Highest or Lowest to

increase or decrease the number of sort fields.
or

v Position the cursor in the input box and type a number.
The default number of sort fields values is 5.

4. Click OK.
The sort pane is replaced by the Measures box, where the measure becomes
blue to indicate that sorting specifications have been defined.

5. Click Run to display the report with the designated number of sorted values.

Displaying a Subset of Sorted Data for a Measure

The following is an example of displaying a subset of sorted data for a measure.
1. Run the Standard Report OLAPREP2.

The report shows sales information sorted by quarter, store, and product type.
2. Click the blue square next to QUARTER to open the Control Panel (notice that

the original report is open on the left).
3. Click Quantity in the Measures box.

The sort pane opens as shown in the following image on top of the report.
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4. If not already selected, click the Sort check box.
High to Low sorting is selected by default.

5. Click the Rank check box.
Because the report is being sorted from high to low, you can indicate the
number of values you wish to see, beginning with the highest.

6. Specify Highest 4.
7. Click OK.

The main Control Panel window appears. In the Measures box the Quantity
measure is blue to indicate that sorting specifications have been defined.

8. Click the Run button at the bottom of the Control Panel.
As shown in the following image, the report now shows Quantity sorted from
high to low with the highest four values appearing.
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Remove Sorting Criteria for a Measure

You can remove sorting specifications for a measure whether the measure is
appears or hidden.
1. Open the OLAP Control Panel.
2. In the Measures box, click the measure for which you want to remove sorting

specifications.
3. Clear the Sort check box.
4. Click OK.

Sorting Dimensions
There are several ways in which you can sort dimensions in an OLAP hierarchy.
You can:
v Control the order in which data is sorted: ascending or descending.
v Restrict sort field values to a specified number of either highest or lowest values.
v Assign a rank number to each row in a vertically sorted report.
v Shift the positions of sort fields in the report. For example, you can change from

sorting by State and then by Product to sorting by Product and then by State.
v Pivot a vertical (By) sort field to make it a horizontal (Across) sort field and vice

versa.
v Hide a sort field in the report while retaining the sorting associated with it. For

example, you can sort data by quarters without showing the Quarter column.
v Group numeric data in tiles (for example, percentile, decile, etc.).

Change Sort Order for a Dimension
1. Open the Control Panel.
2. Select a field from the Drill Down or Drill Across box.

3. Click the Sort button.
The sort pane opens.

4. Under Sort Order, choose the Low to High or High to Low options button
(Low to High is the default for a dimension).

5. Click OK.
The main Control Panel window reopens.

6. Click Run to execute the report.

Inverting the Sort Order of a Dimension

The following is an example of inverting the sort order of a dimension.
1. Run the Standard Report OLAPREP4.
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In the report, the values of both sort fields—Continent and Region—are sorted
from low to high (A to Z) as shown in the following image.

2. To sort the report in reverse alphabetical order, click the OLAP button on the
band below the Selections pane to open the Control Panel.

3. Select Continent in the Drill Down box and click the Sort button.
The sort pane opens.

4. Under Sort Order, choose the High to Low options button as shown in the
following image on the OLAP Control Panel.
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5. Click OK.
The main Control Panel window reopens.

6. Repeat the process for Region: select Region in the Drill Across box and click
the Sort button. When the sort pane opens, select the High to Low options
button and click OK.
The main Control Panel window opens.

7. Click the Run button.
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Both dimensions are now sorted in inverse alphabetical order (Z to A) as
shown in the following image.

Restrict the Display of Sort Values

To restrict the display of sort field values to a certain number of highest or lowest
values:
1. Open the OLAP Control Panel.
2. Select a field from the Drill Down box.

3. Click the Sort button.
The sorting pane opens.

4. Under Sort Order, choose the Low to High or High to Low options button as
shown in the following image on the OLAP Control Panel.
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5. Under Limit Output, click the Limit check box and choose or type a value in
the input area.

6. Click OK.
The main Control Panel window reopens.

7. Click Run to execute your report.

Rank Rows in a Vertically Sorted Report
1. Open the OLAP Control Panel.
2. Select a field from the Drill Down box.
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3. Click the Sort button.
The sort pane opens.

4. Under Sort Order, choose the Low to High or High to Low options button.
5. Click the Rank check box.
6. If you wish to place a restriction on the number of sort field values to rank,

click the Limit check box, choose or type a value in the input area.
v If the High to Low option button is selected, you can rank a specified

number of Highest values.
v If the Low to High option button is selected, you can rank a specified

number of Lowest values.
7. Click OK.

The main Control Panel window reopens.
8. Click Run to execute your report.

Ranking and Restricting the Number of Sort Values

The following is an example of ranking and restricting the number of sort values.
1. Run the Standard Report OLAPREP2.

Information for all stores is shown for each quarter. You want to see quarterly
information for only the first two stores in alphabetical order (low to high).

2. Click the blue square next to QUARTER to open the Control Panel (notice that
the original report is open at the left).

3. Choose Store Name in the Drill Down box and click the Sort
button.
The sort pane opens.
The following image shows these three selections on the OLAP Control Panel.
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a. Accept the default sort order: Low to High.
b. Click the Limit check box and choose 2 from the input area.
c. Click the Rank check box.

4. Click OK to return to the main Control Panel window.
5. Click the Run button at the bottom of the Control Panel.

Notice that only two values now appear for each Quarter and ranked low to
high within each group as shown in the following image.
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Reposition Sort Fields in an OLAP Report

You can change the order in which data is sorted and presented in the report. For
example, you can change from sorting by State and then by Product to sorting by
Product and then by State.) If you want to reposition:
v Vertical (By) sort fields, drag and drop a field into a new column position.
v Horizontal (Across) sort fields, drag and drop the lower field above the higher

one or vice versa.

In each case, the cursor changes to a plus (+) sign to indicate acceptable places into
which you can drop the field. Unacceptable positions are shown by a circle with a
slash across the center.

Repositioning Sort Fields in an OLAP Report

The following is an example of repositioning sort fields in an OLAP report.
1. Run the Standard Report OLAPREP2.
2. Click the top half of the diamond button next to Quantity to sort values from

high to low.
The dimension values adjust accordingly. The report now shows the Quantity
values from high to low but according to the QUARTER sort order as shown in
the following image.
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You would like to change the sort order in the report, making Store Name the
first sort field, followed by PRODTYPE and QUARTER.

3. Drag QUARTER after PRODTYPE.
The cursor changes to a plus (+) sign to indicate acceptable places into which
you can drop the field.
The report changes immediately as shown in the following image with the
Store Name being the first sort order.

Reposition Sort Fields From the Control Panel
1. Open the OLAP Control Panel.
2. Select a field in the Drill Down or Drill Across box.
3. Click the Shift Up or Shift Down arrow until the field is in the desired

position.
Repeat for other fields as needed.

4. Click Run to execute your report.

Repositioning Sort Fields From the Control Panel

The following is an example of repositioning sort fields from the Control Panel.
1. Run the Standard Report OLAPREP2.
2. Click the top half of the diamond button next to Quantity to sort values from

high to low.
The dimension values adjust accordingly. The report now shows the Quantity
values from high to low but according to the QUARTER sort order as shown in
the following image.
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You would like to change the sort order in the report, making Store Name the
first sort field, followed by PRODTYPE and QUARTER.

3. Click the blue square button next to QUARTER to open the Control Panel.
4. Select Quarter from the Drill Down box.
5. Click the Shift Down arrow twice.

QUARTER is now the third item in the Drill Down list as shown in the
following image.

6. Click the Run button at the bottom of the Control Panel.
QUARTER appears in the third column of the report as shown in the following
image.
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Pivot Rows and Columns In an OLAP Report

You can quickly change a field from one that sorts data vertically, creating rows, to
one that sorts data horizontally, creating columns, or vice versa. To change a:
v Vertical (By) sort field to a horizontal (Across) sort field, drag and drop a field

above the row of column titles.
v Horizontal (Across) sort field to a vertical (By) sort field, drag and drop the field

into the desired location in the row of column titles.

In each case, the cursor changes to a plus (+) sign to indicate acceptable places into
which you can drop the field. (Unacceptable positions are shown by a circle with a
slash across the center.)

Pivoting Rows and Columns in a Report

The following is an example of pivoting rows and columns in a report.
1. Run the Standard Report OLAPREP2.
2. Click Q1.

The report is now sorted vertically, by month, store, and product type as shown
in the following image.
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You want to create a matrix in which data is sorted horizontally by month, and
vertically by store and product type.

3. Drag Month above the report to sort data horizontally (Across).
The cursor changes to a plus (+) sign to indicate acceptable places into which
you can drop the field.
In the new report, Quantity and Line Cost of Goods Sold are repeated
horizontally for each month as shown in the following image.
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Pivot Rows and Columns From the Control Panel

You can change a field from one that sorts data vertically, creating rows, to one
that sorts data horizontally, creating columns, or vice versa.
1. Open the OLAP Control Panel.
2. Select the title of the row or column you want to pivot in the Drill Down or

Drill Across box.

3. Click the Pivot button. The title appears in the new location.
4. Click Run to execute your report.

Pivoting Rows Into Columns From the Control Panel

The following is an example of pivoting rows into columns from the Control Panel.
1. Run the Standard Report OLAPREP2.
2. Click Q1.

The report is now sorted vertically, by month, store, and product type as shown
in the following image.

212 System i: Database IBM DB2 Web Query for System i



You want to create a matrix in which data is sorted horizontally by month, and
vertically by store and product type.

3. Click the blue square next to MONTH to open the Control Panel.

4. Select Month in the Drill Down box and click the Pivot button.
Month moves into the Drill Across box as shown in the following image.
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5. Click the Run button on the Control Panel.
In the new report, Quantity and Line Cost of Goods Sold are repeated
horizontally for each month as shown in the following image.
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Sort by a Field Without Displaying the Sort Column

To use a field to sort your data, but not show the sort field as a column in the
report:
1. Open the OLAP Control Panel.
2. Select a field in the Drill Down or Drill Across box.

3. Click the Sort button.
The sort pane opens.

4. Under Sort Order, click the Hide check box.
5. Click OK.

The main Control Panel window reopens.
6. Click Run to execute the report.

Tip: To expose the hidden sort field, repeat the process and deselect the Hide
check box.

Sorting by a Hidden Field

The following is an example of sorting by a hidden field.
1. Run the Standard Report OLAPREP2.

The first sort field in the report is QUARTER. You want to retain the sorting
but not display this field.

2. Click the blue square next to QUARTER to open the Control Panel.

3. Select QUARTER in the Drill Down box, then click the Sort button.
The sort pane opens.

4. Select the Hide check box as shown in the following image.
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5. Click OK.
The main Control Panel window reopens.

6. Click the Run button in the Control Panel.
Report sorting is unchanged, but the QUARTER column no longer appears as
shown in the following image.
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Grouping Numeric Data Into Tiles
You can group numeric data into any number of tiles (percentiles, deciles,
quartiles, etc.) in tabular reports. For example, you can group student’s test scores
into deciles to determine which students are in the top ten percent of the class or
determine which salesmen are in the top half of all salesmen based on total sales.

Grouping is based on the values in the selected vertical (BY) field and data is
apportioned as equally as possible into the number of tile groups you specify.

The following occurs when you group data into tiles:
v A new column (labeled TILE by default) is added to the report output and

displays the tile number assigned to each instance of the tile field. You can
change the column title in the Tiles section of the OLAP Control Panel.

v Tiling is calculated within all of the higher-level sort fields in the request and
restarts whenever a sort field at a higher level than the tile field’s value changes.

v Instances are counted using the tile field. If the request displays fields from
lower level segments, there may be multiple report lines that correspond to one
instance of the tile field.

v Instances with the same tile field value are placed in the same tile. For example,
consider the following data, which is to be apportioned into three tiles:
1
5
5
5
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8
9
In this case, dividing the instances into groups containing an equal number of
records produces the following table:

Group Data Values

1 1,5

2 5,5

3 8,9

However, because all of the same data values must be in the same tile, the fives
(5) that are in group 2 are moved to group 1. Group 2 remains empty. The final
tiles look like the following table:

Tile Number Data Values

1 1,5,5,5

2

3 8,9

Group Data Into Tiles in an OLAP Report
1. Open the OLAP Control Panel.
2. Select a numeric or date field from the Drill Down box.
3. Click the Tiles button.

The Tiles pane opens at the bottom of the OLAP Control Panel as shown in
the following image.
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4. Click the Tile the Report check box.
5. In the In Groups Of input area, select the number of tiles to be used in

grouping the data. For example, 100 tiles produces percentiles, 10 tiles
produces deciles, etc.

6. In the Name of Tile Group input box, type a name for the Tile column.
7. In the Restrict Report to only the Top input area, select the number of tile

groups to display in the report.
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8. Optionally, select a Sort Order option button:
v Choose High to Low to sort data in descending order so that the highest

data values are placed in tile 1.
v Choose Low to High to sort data in ascending order so that the lowest data

values are placed in tile 1. This is the default.
9. If you wish to specify the highest tile value to appear in the report, select a

value from the Limit input area. For example, if you enter a Limit of 3, the
report will not display any data row that is assigned a tile number greater
than 3.

10. Click OK to accept the selections and return to the main Control Panel
window.

11. Click Run to re-execute and view the report.

Performing a Calculation on a Measure
You can perform standard calculations, such as average, percent, and summarize,
on the numeric data in measures on an OLAP report.

Apply a Calculation to a Measure
1. Run the Standard Report.
2. Open the OLAP Control Panel.
3. Click a measure in the Measures box.

The sort options pane opens. Do not click the Measures check box, which
controls the display of a measure, not its sorting.

4. Required: Click the arrow under Measure Calculations and select a calculation
from the drop-down list.
None is the default value. For details, see Calculations You Can Perform on a
Measure.

5. Click OK.
The sort pane is replaced by the Measures box, where the selected calculation
appears as a prefix to the measure.

6. Click Run.
The applied calculation is added to the column title.

Calculations You Can Perform on a Measure

The following table lists the types of calculations in the first column and describes
their functions in the second column.

Calculation Function

Average Sum
of Squares

Computes the average sum of squares for standard deviation in
statistical analysis.

Average Computes the average value of the field.

Count Counts the number of occurrences of the field.

Count
Distinct

Counts the number of distinct values within a field when using
-REMOTE. For other modes of operation, this behaves like Count.

Maximum Generates the maximum value of the field.

Minimum Generates the minimum value of the field.
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Calculation Function

Percent Computes a field’s percentage based on the total values for the
field. The Percent can be used with detail as well as summary
fields.

Percent
Count

Computes a field’s percentage based on the number of instances
found.

Row Computes a field’s percentage based on the total values for the
field across a row.

Summarize Sums the number of occurrences of the field.

Total Counts the occurrences of the field for use in a heading (includes
footings, subheads, and subfoots).

Applying a Percent Calculation to a Measure

The following is an example of applying a percent calculation to a measure.
1. Run the Standard Report OLAPREP6.

The report shows Quantity and Line Cost of Goods sold sorted by plant and
product category, with a subtotal at each sort break.
You want to create a report column that shows the percent of total sales for
each plant.

2. Click the blue square next to PLANT to open the Control Panel as shown in the
following report image.
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3. Click Line Cost of Goods Sold in the Control Panel’s Measures box.
The sort pane opens.

4. Under Measures Calculations, choose Percent from the drop-down list as
shown in the following image, then click OK to see the calculation as a prefix
for the measure in the Measures box.
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5. Click the Run button at the bottom of the Control Panel.
The report now breaks down sales for each product at each plant by as a
percentage of total sales as shown in the following image.
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Notice that the subtotals have been removed from the report because the
breakdown by plant is no longer suitable for the data.

Limiting Data
An OLAP report is limited to values belonging to the parent categories in the
dimensions hierarchy. There are several ways to further limit the data that appears
in the report.

From the Selections pane or the Control Panel, you can explicitly limit the data in
an OLAP report by selecting dimension values and relational operators (such =, >,
<). For a list of the relational operators, see Selection Criteria Relational Operators.
v The Selections pane provides the easiest approach since you can choose both

dimension values and relational operators with a few mouse clicks, while the
report is fully exposed to view.
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v The Control Panel offers several options that are not available from the
Selections pane, including record selection based on a date or date range and on
the existence or absence of specific characters.

Note that changes you make in the Selections Pane are immediately implemented
in the Control Panel (even if the Control Panel is closed). However, the inverse is
not true; changes you make in the Control Panel are not reflected in the Selections
pane until the report is run.

From the report, you can limit data indirectly by drilling down on measures and
dimensions to hone in on subset of information. For details, see Drilling Down On
Dimensions and Measures.

Selection Criteria Relational Operators

You can define selection criteria using several relational operators, most of which
are supported in both the Selections pane and the Control Panel. Those supported
only in the Control Panel are noted in the following table which describes the
operators.

The first column shows the operator and the second column describes the operator.

Equal to Are equal to the criteria you specified.

This is the default operator.

- Not Equal to

Are not equal to the criteria you specified.

- Less than or equal to

Are less than or equal to the criteria you
specified.

- Less than

Are less than, but not equal to, the criteria
you specified.

- Greater than or equal to

Are greater than or equal to the criteria you
specified.

- Greater than

Are greater than, but not equal to, the
criteria you specified.

- Contains

Contain the criteria you specified.

Note: This operator is available only for
alphanumeric fields and is only supported
in the Control Panel.

- Not contain

Do not contain the criteria you specified.

Note: This operator is available only for
alphanumeric fields and is only supported
in the Control Panel.

Note: You can select more than one value using the same relational operator.
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The following relational operators are available for selecting a range of dates. They
are only available from the Control Panel.

The following table shows the relational operators in the first column and
describes them in the second column.

Within range The value in the indicated date field falls
within the specified range.

Note: To use this relational operator, you
must select the Range check box in the Date
Selection panel.

- Not within range

The value in the indicated date field does
not fall within the specified range.

Note: To use this relational operator, you
must select the Range check box in the Date
Selection panel.

Apply Selection Criteria From the Selections Pane

When the Selections pane is turned on, there is one control (drop-down list) for
every dimension in the OLAP hierarchy. (Note that the name of the dimension
field appears as defined in the Master File, even if an alternate column title has
been specified.)

To limit data for the dimensions that are included in the report:
1. Click the arrow to the right of the dimension to open the list of values.
2. Select one or more values from the list (All is the default value).

To select multiple values, click the desired values while holding the Ctrl key on
the keyboard.

3. Select a relational operator from the button to the left of the dimension to
indicate the basis for selection (equals (=) is the default).
You can toggle through a list of operators. See Selection Criteria Relational
Operators.

4. Repeat steps 1-3 for each dimension whose values you wish to limit.
5. Click the Run button on the band below the Selections pane.

Tip: To change or eliminate selection criteria, reopen the values list and choose
another value or choose All.

Limiting Continents and Regions From the Selections Pane

The following is an example of limiting continents and regions from the selections
pane.
1. Run the Standard Report OLAPREP7.

As shown in the following image, the Selections pane above the report, the
controls for Continent and Region are set to All to show all values of each
dimension. You wish to focus on the data for one continent and one region.
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2. In the Selections pane, click the arrow to the right of CONTINENT and select
AMERICAS from the list of values. Use the default operator = to limit the
data.

3. Next, click the arrow to the right of REGION and select NORTH AMERICA.
Once again, accept the default operator =.

4. Click the Run button on the band below the Selections pane.
The output is now limited to data for the selected continent and region as
shown in the following image
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Apply Selection Criteria From the Control Panel
1. Open the Control Panel.
2. Click the Selection Criteria button at the bottom right of the window.

The Selection Criteria pane opens.
3. In the Dimensions box above the Selection Criteria pane, expand a dimension

and click Values.
A secondary window opens; select one or more values (press the Ctrl key to
multi-select).

4. Click OK to return to the Selection Criteria pane, where the selected values
appear in the drop-down lists.
v If a Developer has applied selection criteria to the Reporting Object from

which you create an OLAP report, you only see the selected acceptable
values of the field.

v If no selection criteria have been applied, you see all the values of the field
in the drop-down lists.

5. In the Selection Criteria pane, click a relational operator next to the dimension
to specify the relationship that you want to base selection on—for example, =,
>, or <. For a complete list, see Selection Criteria Relational Operators.

6. Repeat the process for other dimensions whose values you wish to limit.
7. Click Run to execute your report.

Limiting Continents and Countries From the Control Panel

The following is an example of limiting continents and countries from the Control
Panel.

Tip: If you have access to the Selections pane, it provides the quickest way to limit
data. For an illustration, see “Limiting Continents and Regions From the Selections
Pane” on page 226.
1. Run the Standard Report OLAPREP8.

The report shows data for continents and countries. You want to restrict the
information to the Countries ARGENTINA and BRAZIL in the Continent
AMERICAS.

2. Click the blue square next to Continent to open the Control Panel as shown in
the following image.
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3. Click the Selection Criteria button at the bottom right to open the Selection
Criteria pane.

4. In the Dimensions box above the Selection Criteria pane, expand the
Geographic Area dimension and click Values under Country.
A secondary window lists the acceptable values.

5. In this window, choose ARGENTINA and BRAZIL as shown in the following
image (hold down the Ctrl key to multi-select values).
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6. Click OK to return to the Selection Criteria pane.
7. Repeat step 3, but click Values under Continent and choose AMERICAS, then

click OK.
The selected values now appear in the drop-down lists in the Selection Criteria
pane as shown in the following image.
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8. Verify that you want to use the default operator =, then click the Run button at
the bottom of the Control Panel.
The new report displays the data by Continent, Americas followed by Country
as shown in the following image.

Change Selection Criteria From the Control Panel

Tip: If you have access to the Selections pane, it provides the easiest way to adjust
or remove selection criteria. See Apply Selection Criteria From the Selections Pane.

From the Selections Criteria pane in the Control Panel:
1. Click the Select button next to the dimension value you wish to modify.

A secondary window opens.
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To change a value, type the new value in the text box or select one or more
values from the list. (The value you type must be in the same case as the value
in the data source.)
You can input only one value in the text box. If you select more than one value
from the list, only the first value appears. However, all values appear in your
report.
To deselect a value, hold down the Ctrl key while clicking the value.

2. Click OK to return to the Selection Criteria pane where you can verify the
revised value and/or change the relational operator if required.

3. Click OK again to confirm your choice and return to the main Control Panel
window.

4. Click Run to execute your report.

Remove Selection Criteria From the Control Panel

Tip: If you have access to the Selections pane, it provides the easiest way to adjust
or remove selection criteria. See Apply Selection Criteria From the Selections Pane.

From the Selections Criteria pane in the Control Panel:
1. Select the criterion you want to remove.

2. Click the Delete button.
The selection category is removed from the list.

3. Click Run to execute your report with all values.

Applying Selection Criteria to Date Elements
You can apply selection criteria to date elements just as you apply them to other
types of elements. The results are limited by the date(s) you select. For example,
you can select to view data associated with a particular date or to exclude data
from the specified date.

Note: Like other dimension elements, date fields must have been defined in the
Master File by a Managed Reporting developer. The Master File specifies the date
formats available for selection criteria.

This feature is only supported from the Control Panel, where you choose the
selection criteria from a Date selection pane that contains the appropriate controls
for the date format.

You can also select a range of dates in a designated year by specifying a From and
To date. Two relational operators are available for selecting a range of dates:

v The Within range operator displays records when the value in the
indicated date field falls within the specified range.

v The Not within range operator displays records when the value in the
indicated date field does not fall within the specified range.

For more information on supported date formats, see Date Format Limitations.
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Apply Selection Criteria to a Date Field
1. Required: Open the Control Panel.
2. Required: Click the Selection Criteria button.

The Selection Criteria pane opens.
3. In the Dimensions box above the Selection Criteria pane, expand the dimension

that includes the date field, and click the Values button.
A secondary window displays controls for the dimension’s date format. For
example, if the date format is YYM, only the year and month controls appear. If
the format is YYMD, year, month, and day controls appear.
Note: The date selection pane appears only when a supported date format is
provided. See Date Format Limitations.

4. Specify a date using the spin controls, drop-down lists, or by typing the value.
If your date format includes edit masking such as Y.M.D, the date appears with
forward slashes in the Date selection list box, the Selection Criteria pane, and
the drop-down list at the bottom of the report. However, the date edit mask
appears as specified within the body of the report.

5. Click Add to display the date in the Selections list box.
6. Click OK to return to the Selection Criteria pane and verify the selected date.
7. In the Selection Criteria pane, click a relations button to the left of the date

field (for example, =, >, or <) to indicate a basis for record selection.
8. Optionally, define additional date selection criteria by repeating steps 2-7.
9. Click Run to execute your report.

Applying Selection Criteria to a Date Field

The following is an example of applying selection criteria to a date file.
1. Run the Standard Report OLAPREP9.

As shown in the following images, the multi-page OLAP report shows several
years of data about reported problems falling into five categories: incorrect
labeling, missing components, physical damage, power failure, remote failure.
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You want to investigate problems reported on June 6, 2001. You can limit data
based on a single date from the Control Panel.
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Note: To show the selection of a particular date, a dimension component has
been added to the procedure. This dimension places Date Prob. Reported in
the Time Period dimension hierarchy directly below the root.

2. Click the OLAP button below the report to open the Control Panel.
The OLAP button appears at the bottom of this report because the OLAP
CONTROL setting was selected. For details, see Setting OLAP Reporting
Options.

3. Click the Selection Criteria button at the bottom of the Control Panel.
The Selection Criteria pane opens.

4. In the Dimensions box above the Selection Criteria pane, expand the
TIMEPERIOD hierarchy.

5. Click Values under Date Problem was Reported.
The PROBLEM_DATE pane replaces the Selections Criteria pane, with a
drop-down list for each selectable value (Year, Month, and Date) based on the
date format of the selected field as shown in the following image.
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6. Select values. For example:
a. Change the year to 2003 in the Year box by using the spin buttons or typing

the value.
b. Select May from the Months drop-down list.
c. Select 15 from the Days drop-down list.
d. Click Add to enter these criteria in the input box.
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7. Click OK to return to the Selection Criteria pane, which now reflects your
entries as shown in the following image.

The relational operator to the left of the Date box indicates that your report will
contain data only for those rows where date is equal to (=) the values you
entered. This default operator is correct for this example.

8. Click Run to see the problem report for the specified date.
Your selection criteria are listed beside the OLAP button at the bottom of the
report as shown in the following image.
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Apply Selection Criteria to a Date Range
1. Open the OLAP Control Panel.
2. Click the Selection Criteria button.

The Selection Criteria pane opens.
3. In the Dimensions box above the Selection Criteria pane, expand the dimension

that includes the date field, and click the Values button.
A secondary window displays controls for the dimension’s date format. For
example, if the date format is YYM, only the year and month controls appear. If
the format is YYMD, year, month, and day controls appear.
Note: The Date selection pane appears only when a supported date format is
provided. See Date Format Limitations.

4. Required: Click the Range check box.
Inclusive and Exclusive options buttons appear:
v Choose Inclusive to show the range including the dates specified.
v Choose Exclusive to show the range excluding the dates specified.
Note:

v You can select only one range of dates at a time.
v You can apply selection criteria to a range of dates only if the date format

contains a year. See Date Format Limitations.
From and To drop-down lists open for all selectable options. By default, the
current date appears.

5. Specify a From date and a To date by using the spin controls and drop-down
lists.

6. Click OK to return to the Selection Criteria pane.
7. To view both the From and To dates of the range selected, click the down

arrow on the drop-down list.
8. Click a relational operator to the left of the date element in the Selection

Criteria pane:

v Choose Within range operator to display records when the value falls
within the specified range.
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v Choose Not within range operator to display records when the value
does not fall within the specified range.

9. Click Run to execute your report.

Applying Selection Criteria to a Range of Date Fields

The following is an example of applying selection criteria to a range of date fields.
1. Run the Standard Report OLAPREP9.

As shown in the following images, your report shows problem information
reported over the course of several years.

The information falls into the following categories: incorrect labeling, missing
components, physical damage, power failure, remote failure.
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You want to restrict the information to problems reported between June 6,
2001 and July 6, 2001. From the Control Panel, you can limit data based on a
range of dates.

2. Click the OLAP button below the report to open the Control Panel.
3. Click the Selection Criteria button at the bottom right of the Control Panel.

The Selection Criteria pane opens.
4. In the Dimensions box above the Selection Criteria pane, expand the

TIMEPERIOD hierarchy.
5. Click Values under Date Problem was Reported.

The PROBLEM_DATE pane opens over the Selections Criteria pane, with a
drop-down list for each selectable value (Year, Month, and Date) based on the
date format of the selected field.

6. Select the Range check box:
v Inclusive and Exclusive options buttons appear. To show the range

including the dates specified, choose Inclusive (the default).
v From and To drop-down lists open for all selectable options. By default, the

current date appears.
7. Specify values for the From date. For example:

a. Change the current year to 2001 by using the spin buttons.
b. Select June from the Months drop-down list to change the current calendar

month.
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c. Select 6 from the Days drop-down list to change the current calendar day.
8. Specify values for the To date. For example:

a. Change the current year to 2001 by using the spin buttons.
b. Select July from the Months drop-down list to change the current calendar

month.
c. Select 6 from the Days drop-down list to change the current calendar day.

The following image shows the selections.
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9. Click OK to return to the Selection Criteria pane.
a. To view the range of dates, click the down arrow in the drop-down list,

then click OK again.
b. To report on information within the specified range of dates, accept the

default, Within range operator.
10. Click Run to execute the report, which now only displays problem

information from June 6, 2001 to July 6, 2001 as shown in the following image.
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The date element appears at the bottom of the window.
11. To view the range of dates, click the arrow in the drop-down list.
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Add Dates to the Selections List Box
1. Open the Control Panel.
2. Click Selection Criteria to open the Selection Criteria pane.
3. Click the Select button to open the Date selection pane.
4. Specify the date you want to add by using the spin buttons, drop-down lists, or

by typing the value.
5. Click Add.

The date appears inside the Selections list box.
6. Click OK to return to the Selection Criteria pane.

Delete Dates From the Selections List Box
1. Open the Control Panel.
2. Click Selection Criteria to open the Selection Criteria pane.
3. Click Select to open the Date selection pane.
4. Select one or more dates that you want to remove from the Selections list box.
5. Click Delete.

The date is removed.
6. Click OK to return to the Selection Criteria pane.
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Date Format Limitations

Note the following limitations when applying selection criteria to date elements:
v The Date selection pane does not support Julian dates. However, if you are

using Julian dates, the Date controls still open.
v Dates containing only a day format (D, I2D, A2D) are not supported from the

Date selection pane. Instead, the data source provides a list of values.
v The Range check box is enabled on the Date selection pane when the date

format contains one of the following formats:
– Any smart date format—for example, YMD, MDY, YYMD, MDYY, Q, M.
– A4YY
– I4YY
– I8YYMD
– A8YYMD
– I6YYM
– A6YYM

Visualizing Trends
To make your reports more powerful, you can insert visual representations of
selected data directly into the report output. These visual representations, which
appear as a column of vertical or horizontal bar graphs adjacent to the numeric
data, make relationships and trends among data more obvious.

You can apply data visualization graphs to selected measures from:
v Context menus in the report itself.

This is the quickest way to apply data visualization bar graphs to numeric
measures.

v The Measures control in the Selections pane.
v Check boxes in the Measures box on the Control Panel.

For details about data visualization graphs, see Visualizing Trends in Reports.

Add a Column of Bar Graphs for a Numeric Measure

The quickest way to apply data visualization graphics is from the report itself:
1. Right-click the title of a measure column.
2. Choose Visualization from the menu.

The report runs automatically, displaying a column of bar graphs following the
selected measures column.

Tip: To remove the bar graphs, right-click the measure column title and choose
Remove Visualization from the menu.

For other methods of applying bar graphs to columns, see Visualizing Trends in
Reports.
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Displaying Graphs and Reports
When you graph a measure in an OLAP report, you select the specific data
elements to include and view the tabular report and a graphical representation of
the identical information simultaneously in a split window. The graph appears in a
frame in the top half of the window to facilitate comparison.

To be graphable, the data in the report must include at least one numeric measure
and one sort field (By or Across). The Graph control is activated in the Selections
pane or the Control Panel when these basic requirements are met.

As shown in the following image, it includes three sort fields (PRODCAT, Store
Name, and Manufacturing Plant) and three numeric measures (Quantity, Our Cost,
and Price), displayed as horizontal bar charts for quick comparison.

You can request a graph from an OLAP report, from the Selections pane, or from
the Control Panel:
v From an OLAP report, you can create a vertical bar chart to represent the data

in a selected measure.
v From the Selections pane or the Control Panel, you can create seven different

types of graphs and apply them to one or more measures:
– Vertical Bar (This is the default graph type.)
– Vertical Line
– Vertical Area
– Horizontal Bar
– Horizontal Line
– Horizontal Area
– Pie
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If you choose to graph more than one measure, you can employ different graph
types to suit the data in each column, with the following restrictions:
v When you select Vertical or Horizontal Bar, Line, or Area as the controlling

graph style for a measure, you can apply any combination of these styles to
other measures. For example, the first measure can appear as bars, the second
measure as lines, and the third measure as areas. All measures must have the
same orientation (vertical or horizontal).

v When you choose Pie as the controlling graph style, you can use only pie charts
for other measures.

For details about supported combinations, see Combining Graph Styles and
Measure Styles in OLAP Graphs.

Note: If drill down capability has been enabled for the dimensions in a report, the
same functionality is automatically enabled for graphs. You can, therefore, drill
down from one graphical representation of your data to another.

Combining Graph Styles and Measure Styles in OLAP Graphs

The following table lists the available style combinations in the second column for
each graph style in the first column.

Controlling Graph Style Potential Measure Styles

Vertical Bar (default) Vertical Bar (default)

Vertical Line

Vertical Area

Vertical Line Vertical Line (default)

Vertical Bar

Vertical Area

Vertical Area Vertical Area (default)

Vertical Bar

Vertical Line

Horizontal Bar Horizontal Bar (default)

Horizontal Line

Horizontal Area

Horizontal Line Horizontal Line (default)

Horizontal Bar

Horizontal Area

Horizontal Area Horizontal Area (default)

Horizontal Line

Horizontal Area

Pie Pie

Graph a Measure From the Selections Pane
1. Click the down arrow to the left of the Graph control to open a pane that

contains all the numeric measures in the current report.
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There is a check box to the left of each measure and a graph button to the right
of each measure. All check boxes are unchecked by default and all graph
buttons are grayed (inactive) by default.

2. Select a check box associated with a measure.
The graph button to the right of the measure becomes active. The default graph
style is Vertical bar.

3. Toggle through the seven graph style icons until you reach the one you want to
apply to the selected measure.

4. Repeat steps 2 and 3 for any other measures you want to graph.
For a list of graph types that can be defined, see Combining Graph Styles and
Measure Styles in OLAP Graphs.

5. Click the Run button on the band below the Selections pane.
The graph opens in a separate frame above the report and Selections pane.

Graphing Multiple Measures From the Selections Pane

This example contains two measures, BALANCE and CANADA_DOLLARS, sorted
by Continent. You would like to see graphical representations of both measures. To
contrast the graphical information, you use a different graph type for each one.
1. Run the Standard Report OLAPREP4.
2. Right-click the Region field and select Delete from the menu to limit the report

to the fields you want to graph—one dimension, Continent, and two measures,
BALANCE and CANADA DOLLARS.

3. In the Selections pane above the report, click the arrow to the left of the Graph
control to list the measures.
v Click the BALANCE measure check box, then choose the vertical bar icon to

the right of the measure. (This is the default graph type.)
v Click the CANADA_DOLLAR measure check box, then toggle through the

graph icons until you see the vertical area graph.
As shown in the following image, the Selections pane has the Graph control
listing BALANCE represented as a vertical bar and CANADA_DOLLAR
represented as a vertical area.
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4. Click the Run button on the band below the Selection pane to generate the
graphs.
The following image shows the results of the graph selections.

Create a Pie Chart From the Selections Pane

The following procedure is an example of creating a pie chart from the Selections
pane.
1. Run the Standard Report OLAPREP2.

The report shows order information for stores that sell Century Corporation’s
electronic products. Audio Expert shows the highest numbers, with orders of
digital products significantly exceeding analog.
You want a clearer picture of how the digital orders breakdown by product so
you decide to create a pie chart.

2. Click Digital for Audio Expert in Q2 to hone in on the data you want to graph
as shown in the following image.
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The report now shows the Quantity and Line Cost of Goods sold for several
digital products sold at Audio Expert in Q2 as shown in the following image.

3. Right-click Quantity and choose Show Panel to open the Selection pane.
4. In the Selections pane, click the arrow to the left of the Graph control, then

click the check box for Quantity and toggle through the graph options until
you reach the pie icon as shown in the following image.
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5. Click the Run button on the band below the Selections pane.
As shown in the following image, the graph appears in a pane above the
report. You can see at a glance that PDA Devices constituted about 1/3 of
digital sales at the Audio Expert store in Q2.
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Graph a Measure From the Control Panel
1. Open the Control Panel.
2. Select the Show Graph check box located below the Measures Properties box.

Note that the contents of the Drill Down and Drill Across boxes determine the
X-axis fields. When there are multiple drill (X-axis) fields, multiple graphs
appear vertically stacked in the same frame. The measures appear as Y-axis
fields on the graphs you display.

3. Click the Graph icon adjacent to the Show Graph check box.
The Measures and GraphStyle pane opens.
Check boxes associated with the available measures are unchecked by default.

4. Click one of the seven icons at the bottom of the window to set a controlling
graph style.

5. Select the check box(es) for the measure(s) you wish to graph.
The graph icon corresponding to the controlling graph style appears next to
each selected measure.

6. Click the icon next to a measure to choose a different graph style from the
supported combinations as shown in the following image.
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7. Click OK to return to the main Control Panel window with all the graph
settings retained.

8. Click Run to display the graph(s) and the tabular report in a split window.

Note:

v If you select the Show Graph check box and click Run without selecting a
controlling graph style, the default style (Vertical Bar) is applied.
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v If you click Run without selecting the Show Graph check box, a tabular report
appears without a graph.

v If you select at least one measure in the Measures and GraphStyle pane without
selecting the Show Graph check box, when you click OK the system
automatically selects the Show Graph check box. The tabular report appears
with a graph.

v You cannot choose to graph alphanumeric or date fields. If there are no numeric
measures, the Show Graph check box and the Graph button are disabled (grayed
out).

Controlling the Display of Measures in a Report
While you cannot add new measures to an OLAP report without returning to the
original report request, you can adjust the display of the measures in the report in
several ways. You can:
v Stack measures in rows.
v Change the order of measure columns.
v Hide and expose measures.
v Add a column of data visualization bar graphs following any numeric measure.

Stacking Measures
When you have more than one measure in an OLAP report, you can stack the
measures in separate rows within the same column to reduce the width of the
report.

You cannot apply data visualization bar graphs to stacked measures.

Display Stacked Measures
1. Open the Control Panel.
2. Select the Stack Measures check box to display measures in separate rows

under one column.
3. Click Run to execute your report.

Tip: To restore the standard display, deselect the Stack Measures check box and
rerun the report.

Displaying Stacked Measures

The following is an example of displaying stacked measures.
1. Run the Standard Report OLAPREP4.

Initially, this report is sorted vertically by Continent and Risk_Class and
horizontally by Region, and the measures—Balance and
CANADA_DOLLARS—appear as separate columns.

2. For this example, you will not need the Region dimension, but you will need
the Country dimension. You can quickly make these changes to the report:
a. Right-click Region and select Delete from the menu.
b. Right-click Continent and select Unhide from the menu, then select

Country from the secondary menu.
The report now displays data by Continent followed by Country as shown
in the following image.
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You wish to show the measure titles and data values in rows.
3. Click the OLAP button on the band below the Selections pane to open the

Control Panel.
4. Click the Stack Measures check box below the Measures box as shown in the

following image.
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5. Click Run to execute the report and display the titles and values of the
measures stacked over each other in separate rows as shown in the following
image.
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Changing the Order of Measure Columns
You can change the order in which measure columns are presented in the report.

Reposition Measure Columns in an OLAP Report

To reposition a numeric column, drag and drop the field into a new column
position.

The cursor changes to a plus (+) sign to indicate acceptable places into which you
can drop the field. (Unacceptable positions are indicated by a circle with a slash
cross the center.)

Repositioning Measure Columns

The following is an example of repositioning measure columns.
1. Run the Standard Report OLAPREP2.

As shown in this image, the column for the Quantity measure precedes the
column for the Line Cost of Goods Sold measure.
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2. To change the order of columns, drag and drop Line Costs of Goods Sold
before Quantity.
The cursor changes to a + sign to designate where you can drop the field. The
report, as shown in the following image, now displays the Quantity column as
its last column.

Hiding and Displaying Measures
You can hide and expose measures from an OLAP report, the Selections pane, or
the Control Panel.
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Hide or Expose a Measure From the Report

To hide a measure column, right-click the column title and choose Hide from the
menu. The column is automatically removed from the display.

To expose a hidden measure column, right-click a displayed measure and choose
Unhide from the menu. A secondary menu lists any hidden measures.

Choose the one you want to re-expose in the report.

Tip: If you want to add a new measure to the report, you must return to the
original request and add the field there.

Hiding and Exposing a Measure From the Report

The following is an example of hiding and exposing a measure from the report.
1. Run the Standard Report OLAPREP2.

The report includes two measures: Quantity and Line Cost of Goods Sold.
2. Right-click the Line Cost of Goods Sold and choose Hide from the menu as

shown in the following image.

The report runs and displays only the Quantity measure.
3. Right-click Quantity and select Unhide.

A secondary menu displays the hidden measure.
4. Select LINE_COGS to redisplay Line Cost of Goods Sold as shown in the

following image.
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The report now displays the Line Cost of Goods Sold column as shown in the
following image.

Hide or Display a Measure From the Selections Pane
1. Click the down arrow to the left of the Measures control to display a list of the

measures in the report.
2. Click the check box next to a measure to display or hide it. The check box

toggles through three positions.
v To hide the measure, click the check box until it is blank.
v To expose a hidden measure, click the check box until you see a check mark.

Tip: You can use the same check box to display a column of data visualization bar
graphs for numeric measures. This setting is represented as a graph in the check
box. For details, see Visualizing Trends.
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Hiding and Exposing a Measure Column From the Selections Pane

The following is an example of hiding and exposing a measure column from the
Selections pane.
1. Run the Standard Report OLAPREP2.

Because of the OLAP settings selected for this report, the Selections pane is
hidden. For this example, you will need to expose it.

2. Right-click QUARTER and select Show Panel from the menu.
As shown in the following image, the report now looks like this: two
measures—Quantity and Line Cost of Goods Sold—appear.

3. In the Selection pane, click the arrow to the left of the Measures control to list
the measures in the report. Notice that both measures are checked.

4. To hide Line Cost of Goods Sold, click the check box until it is blank as shown
in the following image.
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5. Click the Run button on the band below the Selections pane.
Only Quantity now appears as shown in the following image.

6. Open the Measures control again and recheck Line Cost of Goods Sold as
shown in the following image.
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7. Run the report again.
The output now looks as it originally did.

Display or Hide a Measure From the Control Panel
1. Open the Control Panel.
2. In the Measures box, click the check box next to a measure to display or hide it.

The check box toggles through three positions.
v To hide the measure, click the check box until it is blank.
v To expose a hidden measure, click the check box until you see a check mark.
Tip: You can use the same check box to display a column of data visualization
bar graphs for numeric measures. This setting is represented as a graph in the
check box. For details, see Visualizing Trends.

3. Click Run to execute your report.

Adding and Removing Dimensions
Since all of the values in a dimensions hierarchy are available in an OLAP report,
you can add dimensions to the OLAP report at any time, without returning to the
original report request. You can add dimensions from:
v An OLAP report.
v The Control Panel.

Add a Dimension Element From the Control Panel
1. Open the Control Panel.
2. Select a report layout box (Drill Down or Drill Across) to indicate how you

want the new sort dimension to be used in the report.
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3. Expand a dimension in the Dimensions box at the top of the window, then
click the dimension element you want to add to the designated layout box. The
new dimension is added to the bottom of the list.

4. If you wish to change the position of the new sort field, click the up arrow to
reposition it.

5. Click Run to execute your report with the new settings.

Adding a Dimension Element From the Control Panel

The following is an example of adding a dimension element from the Control
Panel.
1. Run the Standard Report OLAPREP2.

Initially the report is sorted by quarter, store, and product type as shown in the
following image.

You want to sort by month within each quarter.
2. Click the square button next to QUARTER to open the Control Panel.
3. In the Control Panel:

a. Click in the Drill Down box to activate the buttons immediately above the
box.

b. Expand the Time Period dimension and click MONTH. It is added to the
bottom of the Drill Down list.

c. Click the Shift Up arrow twice to move MONTH below QUARTER as
shown in the following image.
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4. Click the Run button at the bottom of the Control Panel.
The report is now sorted by quarter, month, store, and product type as shown
in the following image.
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Delete a Dimension Element From the Report

Right-click the dimension column you wish to remove and choose Delete from the
menu.

The report runs automatically.

Deleting a Dimension Element From the Report

The following is an example of deleting a dimension element from the report.
1. Run the Standard Report OLAPREP2.

Initially the report is sorted by quarter, store, and product type. You wish to
remove PRODTYPE as a sort category.

2. Right-click the PRODTYPE column and choose Delete from the menu as
shown in the following image.
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The report runs automatically. The new report is sorted by quarter and store as
shown in the following image.
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Delete a Dimension Element From the Control Panel
1. Select the element in the Drill Down or Drill Across box. The buttons above the

box become active.

2. Click Remove . The element is deleted from the Drill Down or Drill
Across box.

3. Click Run to see the new report.

Deleting a Dimension Element From the Control Panel

The following is an example of deleting a dimension element from the Control
Panel.
1. Run the Standard Report OLAPREP2.

Initially the report is sorted by quarter, store, and product type. You wish to
remove PRODTYPE as a sort category.

2. Click the blue square button next to QUARTER to open the Control Panel.
3. Select PRODTYPE in the Drill Down box as shown in the following image.

4. Click the Remove button.
5. Click the Run button at the bottom of the Control Panel.

The new report is sorted by quarter and store as shown in the following image.
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Saving OLAP Reports
DB2 Web Query includes several saving features for OLAP reports:
v The dialog for saving reports allows them to be placed in subfolders of the

user’s choice under Reports; subfolders can also be created from the OLAP tool.
v Users can save their reports with the OLAP functionality removed, so the OLAP

tool can serve as a simple report writer tool.
v Field name referencing is uniform throughout the OLAP product. For example,

the AS or TITLE phrases will appear in reports generated using the OLAP
Selections pane or the OLAP Control Panel (OCP).

Note: When saving OLAP reports to Managed Reporting, you must refresh the
Domain to see the newly saved reports. Otherwise, the new reports will not be
listed in the Managed Reporting tree.

Saving Options
If you are working in the OLAP Selections pane, you can save your report by
using the Save button on the toolbar. You can also access other saving options in
the OCP by selecting the Options button.

Save a Report in OLAP
1. Click the Save button in the OLAP Selections Pane.

The following image shows the OLAP Selections Pane containing five buttons,
OLAP, Run, Reset, Save, and Help.
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or
Click the Options button in the OLAP Control Panel (OCP).
The following image shows the OLAP Control Panel where the Options button
appears at the bottom of the panel.

You are now presented with several saving options.
The following image shows the Options menu containing five options, Save the
data in an Excel file, Save the data in an Excel 2000 file, Save the data in an
Excel 2000 file with formulas, Display as a PDF Report, and Save Report.
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2. Click Save Report to open a new dialog box as shown in the following image.

3. Click Reports to enable the New Folder icon in the upper right corner as
shown in the following image.
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4. A pop-up prompts you to create a new folder, for example, a subfolder called
OLAP Reports as shown in the following image.

5. Name your report in the Save As box and click OK to return to your report.

Save an OLAP-enabled Report as a Plain Report Without OLAP
Functionality

Users can save their reports with the OLAP functionality removed, so the OLAP
tool can be used as a simple report writer tool.
1. Create a subfolder by following these procedures: Save a Report in OLAP.
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2. After a subfolder is selected, check the Save without OLAP box.
3. Enter a new name for your report in the Save As box and click OK.

DB2 Web Query generates a new report without OLAP functionality. The following
image shows a normal report of employees’ pay levels which is sorted by
employee’s last name.

Uniform Field Name Referencing in OLAP
However the developer designs the report with regard to field referencing will
carry through to both the OCP and the OLAP Selections pane. Field referencing
does not differ between the report and the OCP and OLAP Selections pane. Field
references by AS, TITLE, or Field Name, are uniform in the report output and
OLAP controls.

Saving and Displaying OLAP Reports and Graphs in Other Formats
OLAP reports and graphs appear in your browser in HTML format. You can
display the report and corresponding graph in PDF and Excel formats, and in
folders within Managed Reporting.

The following image shows a pop up menu listing the available formats to save
and/or display.
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v PDF (Adobe Acrobat’s Portable Document Format) is useful when you want a
report or graph to maintain its presentation and layout regardless of a user’s
browser or printer type.
When you choose PDF format, the report appears in Adobe Acrobat Reader; the
graph continues to appear above it in a browser window. If you print from
Acrobat, only the report will be printed.

v Excel is useful when you want to convert a large database to a spreadsheet or
save a report and graph in a commonly used Office tool. Two Excel formats are
available:
– Excel 2000 supports most StyleSheet attributes, allowing for full report

formatting. The computer on which the report is being displayed must have
Microsoft® Excel 2000 or higher installed.
When you choose Excel 2000, the report and graph are displayed in the same
tool where you can manipulate the data using Excel options. From Excel you
can print both the report and the graph.
When you save in Excel 2000 format, only explicit drill-downs (based on
parameters passed from the base report to the drill-down report) continue to
work. Automatic drill downs on Dimensions and Measures are not supported
in Excel.

– Excel is a binary display format with limited formatting support. The
computer on which the report is being displayed must have Microsoft Excel
installed.
Drill-downs of any kind are not supported.
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In Managed Reporting, a user can save the HTML output in the Reports folder.

Display an OLAP Report and Graph in PDF Format
1. Open the Control Panel.
2. Click the Options button at the bottom of the window.
3. Select Display as a PDF Report.

The graph appears in the browser above the report, while a second browser
opens and launches the report output in Adobe Acrobat as shown in the
following image.

Tip: If you wish, you can save and print the PDF report from Adobe Acrobat.

Save an OLAP Report and Graph as an Excel File
1. Open the Control Panel.
2. Click the Options button at the bottom of the window.
3. Select Save the data in an Excel file or Save the data in an Excel 2000 file.
4. Follow the instructions to export the data.

Saving OLAP Reports and Graphs in the Reports Folder
You can save an OLAP report and graph in your Reports folder.
1. Open the Control Panel.
2. Click the Options button at the bottom of the window.
3. Select Save as My Reports.
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A secondary window opens.
4. Enter a descriptive name and click OK to save the graph(s) and the tabular

report.

Note: There is no limit to the number of characters in a graph legend’s label, but
long labels may appear truncated.
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Chapter 6. Creating a Graph With Graph Assistant

Describes how to use the HTML Graph Assistant to create graphical reports.

This chapter provides information on graphs and how to use the Graph Assistant.

Graph Overview
Graphs often convey meaning more clearly than data listed in tabular format.
Using the Graph Assistant, you can easily transform almost any type of data into
an effective graph that you can customize to suit your needs.

You can link your graph to other resources. You may also select from a multitude
of graph styles, which include the standard graph formats bar, line, pie, and scatter
as well as many variations on these types.

You can also represent data graphically using data visualization. For details, see
Visualizing Trends in Reports.

Content Analysis: Determining Graphing Objectives
DB2 Web Query offers a range of reporting tools that allow you to create reports
that deliver critical information to your users. By selecting a tool that is well suited
to your particular needs, you can design the information you deliver to users. One
effective option with almost any type of data is a graphical presentation.

Graphs enable you to display multivariate or complex data efficiently, precisely,
and in a way that a viewer can intuitively grasp. A graph is an effective
presentation tool because it presents a visual idea, communicating meaningful
changes in data to a user in a memorable way. By viewing your graph, a user can
identify and track a change that you want them to notice.

Creating a meaningful graph is not simply a matter of applying aesthetics to your
data. Instead, graphs allow you to design your presentation to capture the essential
information in your data.

The first step in creating excellent graphs is determining your graphing objectives.
You can break this process into several stages.
1. Assess your data:

Look for meaningful patterns or changes in the data. Does your data change
most dramatically over time or in relationship to some other value? Are there
two sets of data that you would like to compare to each other?
Determine what movement or changes you would like to highlight. Which of
the patterns in the data would you most want the viewer to picture?

2. Select the graph type and style that best suits your argument and the overall
shape of your data. Determine what will lead viewers to the cognitive
task/connection that you want them to make.

3. Begin developing your graph.
4. Refine your graph:

Are the labels meaningful/useful?
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How can the data be organized in a meaningful way? Consider customizing the
scales you use with your graph.

Accessing the Graph Assistant
HTML Graph Assistant is accessible:
v During the creation of a new Report.
v When editing a Report within Domains.

The HTML Graph Assistant is best viewed using a resolution of 1024 x 768.

You may be prompted for a DB2 Web Query Reporting Server ID.

Note: If you are using the HTML Graph Assistant with a Firefox browser, the
display may be slightly different than Internet Explorer. These differences do not
effect functionality.

Options Available on All Tabs

The following options are available from any tab in the Graph Assistant:

Save/Save As

Click Save to save your graph. Click Save As to open the Save New Report
dialog box.

Run

Click run to run your graph.

Help

Click the icon to access help about the area of the tab in which you are
working. Click About to open a window describing the version of Graph
Assistant in which you are working.

Quit

Click to quit the application.

Selecting a Graph Type and Style
When creating a graph, it is important to select the appropriate graph type with
which to display your data. You may select from a number of basic graph types, as
well as refinements on these types, known as graph styles. Basic graph types
include line graphs (connected point plots), bar graphs, pie graphs, and scatter
graphs. Use the brief descriptions (see Graph Types) to select a graph type that
suits the data set you are displaying and the change you want to highlight. Keep
in mind that the data are the sets of numbers that you are displaying, and the
scales are the numbers or variable measures that appear along the axes of the
graph.

The Graph types tab of the Graph Assistant provides a list and brief descriptions
of the many graph types and graph styles available in DB2 Web Query.

Note: When using a stacked chart of any type at least 2 series are required.
Negative values are not supported in stacked charts.

The following image shows the Graph types tab with a sample cluster bar chart.
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Graph Types
Following are descriptions of the types of graphs you can create:
v Line graphs. Line graphs are useful for emphasizing the movement or trend of

numerical data over time, since they allow a viewer to trace the evolution of a
particular point by working backwards or interpolating. Highs and lows, rapid
or slow movement, or a tendency towards stability are all types of trends that
are well suited to a line graph.
Line graphs can also be plotted with two or more scales to suggest a comparison
of the same value, or set of values, in different time periods. The number of
scales your graph has depends on the type of graph you select. There is a
description of each available graph type on the Graph types tab of the Graph
Assistant.

v Bar graphs. Bar graphs plot numerical data by displaying rectangular blocks
against a scale. The length of a bar corresponds to a value or amount. Viewers
can develop a clear mental image of comparisons among data series by
distinguishing the relative heights of the bars. Use a bar graph to display
numerical data when you want to present distributions of data. You can create
horizontal as well as vertical bar graphs.

v Pie graphs. Pie graphs emphasize where your data fits in relation to a larger
whole. Keep in mind that pie graphs work best when your data consists of
several large sets. Too many variables divide the pie into small segments that are
difficult to see. Use color or texture on individual segments to create visual
contrast.
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v Scatter graphs. Scatter graphs share many of the characteristics of basic line
graphs. Data can be plotted using variable scales on both axes. When you use a
scatter graph, your data is plotted using a basic line pattern. Use a scatter graph
to visualize the density of individual data values around particular points or to
demonstrate patterns in your data. A numeric X-axis, or sort field, will always
yield a scatter graph by default.
It is important to note that scatter graphs and line graphs are distinguishable
from one another only by virtue of their X-axis format. Line graphs can appear
without connecting lines (making them look like scatter graphs) and scatter
graphs can appear with connecting lines (making them look like line graphs).

v Area graphs. Area graphs are similar to line graphs except that the area between
the data line and the zero line (or axis) is usually colored or textured. Area
graphs allow you to stack data on top of each other. Stacking enables you to
highlight the relationship between data series, showing how some data series
approach or shadow a second series.

v 3D graphs. 3D graphs add dimension to your graphing presentation.
Dimensionality enables your viewers to recognize trends based on two or more
data sets easily. 3D graphs also add impact to your presentation.

v Bubble charts. Bubble charts are used to display three dimensions, requiring
only three COLUMN fields representing X, Y, and Z data values in that order.
The data points can be either opaque or transparent bubbles. If you want to
visualize the precise data point, you can add a dot in the center of the bubble.
The size of the bubbles are proportional to the values they represent.

v Polar graphs. The Graph Assistant supports two styles of Polar graphs: an XY
Polar Chart or a polar coordinate scatter chart and an XY Polar Dual-Axis Chart
or a Dual-Y polar coordinate chart. In both styles, only one Column field is
allowed in the following order: X (degree) for the Column field and Y (distance
from the center) for the Across/By field.

v Radar graphs. Radar graphs are used to compare two or more data sets. You can
use axes or polygons to represent values in a star or spider configuration. They
are essentially analogous to a line chart, except that the scale wraps around.
Radar graphs work well with any data that are cyclical, such as the months of a
year.

v Stock Chart. Stock charts are used to track the trend of a particular stock. Stock
charts show the stock’s volume, opening and closing values as well as the
stock’s high and low values over a specific time period. The data is represented
by sets of bars and/or lines.

v Histogram. Histograms depict the distribution of a data set by grouping all of
the data together and assigning it to buckets based on their value. You only
measure one variable in histograms. After the data is sorted by this variable, you
count the number of instances of this data. This determines the height of each
bar. For example, if a company wanted to measure how many franchises there
are in each class of annual revenue, a histogram would show the number of
franchises that have 1,000,000 to 2,000,000; 2,000,000 to 5,000,000; 5,000,000 to
10,000,000; and 10,000,000 to 15,000,000.

v Multi-y. A Multi-y is a vertical, triple/quadruple/quintuple-Y-axis clustered bar
chart. Any series can be assigned to any of the triple/quadruple/quintuple axes.

v Waterfall. A Waterfall chart is a cumulative stacked chart. The waterfall chart
will automatically perform the cumulative sum when using Subtotal or Total.
Waterfall charts essentially require one data value for each series or group
marker to be drawn in a chart.

v Miscellaneous. The Miscellaneous Graph Type includes a variety of Graph
Styles:
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– Default (Circular Gauge). A Gauge Chart usually indicates the current
position of a value within a given spectrum.

– Funnel. A Funnel Chart is basically a pie chart displaying only one group of
data at a time from the first series to the last series at the bottom of the
funnel.

– Pareto. The X-axis scale is for the group members. The Y-axis scale is the
percent of the total accumulation for each selected series.

– Product Position. A Product Position chart provides a visual representation of
market share and growth versus revenue and measurement (past, present,
and future). Product Position charts require a set of three display fields.

– Resource Return. Resource charts plot X- and Y-axis data cumulatively. They
are useful for plotting two independent variables against each other,
particularly in cases where one or both of the axes specify percentages and
the user wants to examine issues such as capacity utilization.

– Spectral Map. This is a Spectral Map Chart. This is a chart with row or
column matrix of markers that are colored according to data values.

Graph Styles
You can choose among several graph styles for each graph type. First you select
the graph type with which you want to work in the Graph Type drop-down list
box, and then you select the graph style from the Graph Styles drop-down list box.
A thumbnail graph with a graph type and style definition appears to the right on
the Graph types tab.

Previewing Styling Options for Your Graph
The graph in the Graph Preview window displays the graph type and style you
chose as well as any styling information you specified from the template
drop-down list or in the Properties tab. The Preview does not open by default for
other resolutions. In this case, you have to click the Show Preview button.

The following image is of a bar graph that uses the 3DBAR graph style. This
generic chart is a two-dimensional chart with three-dimensional type bars.
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The graphical representation in the Graph Preview is based on an internal
algorithm to help show the type and style of the graph. It is not a true
representation of your particular data. However, legends and axis labels will reflect
selected fields, formats, and positioning. The data used for this Graph Preview is
built with the selected field format types and lengths of the data. In this case, the
X-axis field (car) is alphanumeric (A16) and will be displayed as the series label

where:

A, B, C

Represents the data type alphanumeric.

xxxxxxxxxxxxxxxx

Indicates the number of characters or digits allowed.

The Y-axis (dealer cost and retail cost) scale is based on a data range of selected
Y-axis fields.

You can manually update the Graph Preview by clicking the Update button to see
how your changes will look in a graph. You can choose to have the Graph Preview
updated automatically any time you make changes by selecting the Automatic
update check box.
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Important: Merged graphs are not supported in the Preview panel.

Auto Arranging Graph Elements
The auto arrange feature enables the Graph Preview to arrange all the elements in
a graph report efficiently. The auto arrange feature is checked by default.

Arrange the Elements of a Graph Efficiently

Check the Automatically arrange the chart elements so that they make the best
use of the available space option.

Note: This option is checked by default. If you uncheck this feature, DB2 Web
Query will arrange the elements.

Comparing the Arrangement of the Elements of a Graph

In the Graph types tab:
1. Uncheck the Automatically arrange the chart elements so that they make the

best use of the available space option.
2. Click Show Graph Preview.

The Graph preview window opens. The following image shows the Graph
types tab with a sample bi-polar stacked bar chart of a sales report with sales
and mpg dimensions.

Note how the MPG symbol partially blocks the data along the right Y-axis.
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3. Now check the Automatically arrange the chart elements so that they make
the best use of the available space option.
A new Graph preview window opens. The following image shows the same
bi-polar stacked bar chart with the elements arranged automatically.

Note how the Y-axis and X-axis labels fit within the size of the report.

Select a Graph Type and Style
1. Highlight a graph type from the Graph Type list on the Graph types tab of the

Graph Assistant. Next, highlight a graph style from the Graph Styles
drop-down list.
A thumbnail image and a brief description of the graph are provided when you
highlight a graph type and style. Be sure to read the description of the graph
before selecting a graph type and style. Certain graph types require a particular
number and/or type of data values; therefore, if your data does not satisfy the
requirements, your graph will not accurately represent your data.

2. After you have found the graph type and style you desire, click the next tab to
continue creating your graph.

Selecting Scales
After you have chosen a graph type, you should select an appropriate scale. A
scale is a classification scheme or series of measures that you select for application
to the axes of your graph. The scale provides the framework against which your
data are plotted. When you choose an appropriate scale for your data, meaningful
patterns can emerge, and when you modify a scale, the overall shape of your
graph changes.
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Steps or measures in the scale are represented along the axes of your graph by
marks. The type of scale you choose determines the number of divisions along the
scale. There are two general types of scales you can apply to the y-axis of your
graph:
v Linear scales
v Logarithmic scales

A linear scale is a scale in which the values increase arithmetically. Each measure
along the scale is one unit higher than the one that precedes it. Linear scales are
useful when the data you are plotting are relatively small in range.

A logarithmic scale is a scale in which the values increase logarithmically. Each
measure along the scale represents an exponential increase in the data value.
Logarithmic scales are useful when you need to accommodate a large range of
numbers.

Select Scales
1. Click the Properties tab of the Graph Assistant.
2. Click the Y axis subtab.
3. Find the Log Scale check box. When this option is checked, the Y-axis scale

uses logarithmic scaling. When unchecked, the Y-axis scale uses linear scaling.

Selecting Values for the X and Y Axes
The values you select for the X- and Y-axes determine what data is included in the
graph you are creating, and how it appears.

You can also:
v Select a second horizontal category (X-axis), which will produce multiple graphs.

For details, see Creating Multiple Graphs.
v Temporarily hide the display of a Y-axis field. For details, see Hiding the Display

of a Y-Axis Field.
v Interpolate X and Y-axis values using linear regression.

You can search fields lists. For details, see Searching Field Lists.

Note: Field names that contain a hyphen ″-″ cannot be used in the HTML Graph
Assistant.
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Notes on the Fields List
v Key fields are represented with a key icon in all field lists (tree and list displays)

in the HTML Report and Graph Assistant.
v The number of fields that are currently displayed shows at the bottom of the

fields list. If a field list contains more than 200 fields, the first 200 fields display
initially. Additional fields are retrieved and displayed when you select the next
set of fields.
To select the next set of fields, scroll to the bottom of the field list and select the
Next option that appears. The Next option describes which fields will be
returned, for example in the following image it shows that the next 201-400
fields of 417 will be retrieved:

To go back, scroll to the top of the field list and select the previous set of fields.
For example, the following image shows the Previous option to select the
previous 1-200 of 417 fields:
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v If you are viewing a Fields List in the Dimension Tree mode and you create a
recursive join (joining a file to itself), you will not be able to view the
Dimensions in the Fields List after the join is created. This is due to duplication
of field names in a recursive join. If you delete the join, you will be able to view
dimensions again.

Select Values for the Y-axis
1. Click the Field selection tab from the Graph Assistant.
2. If available, click the List or Tree icon.
3. Select the field from the Available fields window and click the Add icon to the

Field value(s) plotted on Y-axis fields box.
or
Click and hold the left mouse button, and drag the field to the Field value(s)
plotted on Y-axis fields box.
or
Press Alt+C to go the Field value(s) plotted on Y-axis fields box. Then press
Alt+M to go to the Available Fields window, tab to the field and press Enter to
add the chosen field.

To add more than one field name at a time:
1. Ensure the List icon is selected.
2. Click the field names you wish to include. The fields will highlight as you click

on them.
3. Drag and drop or use the Add icon to add all the selected fields to the Field

value(s) plotted on Y-axis fields box.

Note: The display field(s) determines the vertical Y-axis of the graph. When the
number of Y-axis labels is greater than one, the labels do not appear along the
Y-axis. Instead, they appear in a legend that provides the names of the fields being
graphed.

Select Values for the X-axis
1. Click the Field selection tab from the Graph Assistant.
2. Select the field from the Available fields window and click the Add icon to the

Field value(s) plotted on X-axis fields box.
or
Click and hold the left mouse button, and drag the field to the Field value(s)
plotted on X-axis fields box.
or
Press Alt+S to go the Field value(s) plotted on X-axis fields box. Then press
Alt+M to go to the Available Fields window, tab to the field and press Enter to
add the chosen field.
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Hiding the Display of a Y-axis Field
You can hide the display of a Y-axis field in a graph. This option is useful when
you want to temporarily remove a particular Y-axis field while retaining all of the
original graph properties.

To hide a Y-axis field temporarily, use the Make this field invisible check box
located on the subtab of the Show graph field options of the Field Selection tab. By
default, the check box is not selected for each Y-axis field. If there are no Y-axis
fields, the Show graph field options subtab is disabled.

Hide the Display of a Y-axis Field

On the Field selection tab:
1. From the Field value(s) plotted on Y-axis fields box, highlight the Y-axis field

you want to hide.
2. If hidden, click Show graph field options.
3. Check the Make this field invisible check box.

Assigning Characteristics to Y-axis Values
You can assign a characteristic for each Y-axis field in your graph. In the following
table, the first column lists the prefix operators or characteristics, and the second
column lists their descriptions.

Summary Type Description

Field_Name (Plain field value)

ASQ Average Square

AVE Average

CNT Count

FST Show first in group

LST Show last in group

MAX Maximum

MIN Minimum

PCT Percentage

PCT.CNT Count Percentage

RPCT Row Percentage

TOT Total

Assign Characteristics to Y-axis Values
1. From the Field selection tab, select Summary Type under Y-axis values.
2. From the Field value(s) plotted on Y-axis fields box, select the field you would

like to assign a characteristic (or prefix operator) to.
3. If hidden, click Show graph field options.
4. Select the characteristic from the Summary Type list box.

The field name in the Field value(s) plotted on Y-axis fields box is updated with
the appropriate prefix. For example, if you have a field named SEQ_NO, and you
select the Average Square summary type, the field name changes to ASQ.SEQ_NO.
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Selecting Records for a Graph
When generating a report and specifying which fields to display, you may not
want to show every instance of a field. By including selection criteria, you can
display only those field values that meet your needs. In effect, you can select a
subset of the data, which you can easily redefine each time you issue the report
request.

When developing a report request, you can define criteria to select records based
on:
v The values of an individual field (using a Where statement).
v The aggregate value of a field, for example, the sum or average of a field’s

values (using a WHERE TOTAL statement).

The Selection criteria tab enables you to create Where or Where Total statements
for record selection.

Creating a Where or Where Total Statement
Where and Where Total statements enable you to display only those records that
pass your selection criteria. These statements select the data source records to be
included in a report. The data is evaluated according to the selection criteria before
it is retrieved from the data source. Use the Selection criteria tab to create a new
Where or Where Total statement.

Note: In the Graph Assistant, when you create a Where statement in the Selection
Criteria tab for a range of dates using FROM - TO, you will not be alerted if the
TO field is chronologically before the FROM field. For example, if you enter
something like ″from 12/31/05 to 1/1/05″. There will be no records in the
resulting report.

Select Records Based on Values, Parameters, Fields, or a
Constant
1. In the Graph Assistant, click the Selection criteria tab.
2. Select a field from the Available fields window and drag the field to the

Screening conditions pane.
or
Press Alt+M to go to the Available Fields window, tab to the field and press
Enter to add the chosen field.
The field name and Equal to and Select values appear in the Screening
conditions pane.

3. Select WHERE or WHERE TOTAL.
4. Select an operator from the drop-down list (for example, Equal to) in the right

pane.
5. Click Select values to complete the expression.
6. Required: Select one of the following compare type option buttons:

v Constant. Enter a value that will serve as a constant (a value that will not
change). For example, enter vehicle.
After you click OK, the constant, vehicle, appears in the WHERE statement
which reads BODYTYPE Equal to vehicle.
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v Parameters. Enter the name of the variable. For example, moped as shown in
the following image with the Parameter option button selected and the
variable name entered as moped.

You can set parameter properties, for details see Setting Parameter Properties.
After you click OK, the parameter, &moped, appears in the WHERE
statement which reads BODYTYPE Equal to &moped.
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Note: The ampersand is automatically added by DB2 Web Query.
v Fields. Select a field from the list.

After you click OK, the field BHP appears in the Where statement which
reads CAR.COMP.CAR Equal to CAR.SPECS.BHP.

v Values. Select a value for the field you initially chose (in this case, car).
After you click OK, the value, Audi, appears in the Where statement which
reads CAR.COMP.CAR Equal to AUDI.

Create a Where Statement Using Date and Time Values

In the Graph Assistant,
1. Click the Selection criteria tab.
2. Select a field from the Available fields window and drag the field to the

Screening conditions pane.
or
Press Alt+M to go to the Available Fields window, tab to the field and press
Enter to add the chosen field.

3. Click Equal to in the right pane to display a list of operators. Click the operator
of your choice.

4. Click Select values to complete the expression.
5. Click Field to access date and time values for that field. For example, EYEAR.
6. Required: Click Values and click the value of your choice. For example,

1989/01/18.
After you click OK, the value, 1989/01/18, appears in the WHERE statement
which reads START_DATE Equal to 19890118.

Importing Values From External Files for WHERE Statements
When developing a query, you can use a locally saved, external file as selection
criteria to limit query results. This enables you to quickly build a query containing
a large number of WHERE statement values without having to manually enter
repetitive or readily available data.
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Create a Value List From an External File
1. Required: Navigate to the Selection criteria area.
2. Required: Begin creating a WHERE statement by selecting a field from the list

of available fields.
3. Required: Select a data comparison option that can accept multiple values.

Valid options include EQUAL to, NOT EQUAL to, IN literal list, NOT IN
literal list, EXCLUDES literal list, and INCLUDES literal list.

4. Click Select values.
The Values dialog opens.

5. Click the import button as shown in the following image.

A dialog box opens as shown in the following image.

6. Select either the Flat file or Excel Spreadsheet (XLS) File Format option.
7. Click the Browse button.
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A standard file selection dialog opens.
8. Select an external file to import from your local machine or network.

Note: The external file must only contain text with new line delimiters.
9. Click OK.

The values contained in the file are displayed in the Multiple values entered
list in the right pane of the dialog.

10. Optionally, you can remove specific values from the Multiple values entered
list or move values up or down within the list.

11. Click OK.
You can save the query for future use and reopen the query to append new or
remove existing values.

Setting Parameter Properties
When you create parameters for Selection Criteria (WHERE statements) you can
set the properties for the parameter. For example, you can create a dynamic or
static list of values to choose from at run time.

Set Parameter Properties
1. In the Graph Assistant, click the Selection criteria tab.
2. Create a WHERE or WHERE TOTAL expression.
3. Select an operator. Some operators are not supported with the Variable Editor,

see Supported Operators for the Variable Editor for details.
4. Click Select values.
5. Select the Parameter option button.
6. Click the Auto Prompt button.

The Parameter Properties dialog box opens.
7. Required: Choose the Selection type, Dynamic or Static.

The Dynamic option is selected by default.
The Name and Description fields are automatically populated based on the
field you are screening on, but you can edit the populated values.
Note: The Description field cannot contain a period (.) because a period is the
delimiter to specify the beginning and end of the description value.

8. Required: Set the parameter values. For the:
v Dynamic selection type, the Data Source and Field are selected by default

based on the field you are screening on. You may change these as necessary.
v Static selection type, select the Constant or Show field values option button.

For constant, enter a value or values. For Show field values, all of the values
for the selected field appear in the list box. Move the values you want in the
selection list to the Prompt values list.

9. Click OK to exit the Parameter Properties dialog box.

Supported Operators for the Variable Editor

Operator Enabled for the Variable editor?

Equal to Yes

Not equal to Yes

Equal to multiple No

Not equal to multiple No

Greater than Yes
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Operator Enabled for the Variable editor?

Less than Yes

Greater than or equal to Yes

Less than or equal to Yes

In literal list No

Not in literal list No

Missing No

Not missing No

From - to No

Not-from - to No

Includes literal list No

Excludes literal list No

Contains characters Yes

Omits characters Yes

Like character mask Yes

Not like character mask Yes

Combining Expressions
Use the right pane of the Selection criteria tab to use or delete existing Where
statements and to combine expressions.

Combine Expressions
1. Create an expression.
2. When you create additional expressions, they are combined with the default

operator AND as shown in the following image with two statements, the first a
WHERE and the second an AND statement.

3. Toggle between AND, OR, WHERE, and WHERE TOTAL by clicking the AND
to make your choice.
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Delete an Active Expression
1. Select the check box next to the expression you want to delete. Click the Delete

icon above the box.
2. You are prompted to delete the expression. Click OK to delete.

Grouping Expressions Together With Parentheses
You can use parentheses to group expressions together to optimize the Where
statement.

Group Where Statements Together Using Parentheses

Click the grayed out parentheses to activate the parentheses and group expressions
together.

Limiting Data With Filters
Filters enable you to quickly select predefined criteria that limit data included in a
graph. Filters are selection criteria (WHERE statements) that an Administrator
creates for you to apply as needed, without having to create your own selection
criteria.

DB2 Web Query displays filters in filter groups. Each filter group can contain
multiple filters. Selecting a single filter within one group creates a report with
simple filtering criteria. By selecting multiple filters within a group or combining
filters from different groups, you can create complex filtering expressions.

The following image shows a few sample filters as they appear in the Selection
Criteria tab of the HTML Graph Assistant. They are listed by Group and Name.

Creating Temporary Fields
You can create temporary fields from the HTML Graph Assistant. Temporary fields
are created the same way in the HTML Report and Graph Assistant. For complete
details, see Creating Temporary Fields.
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Creating Multiple Graphs
You can create multiple graphs by selecting a second horizontal category (X-axis).

The number of graphs created depends on the number of values in the field you
select. For example, if you select a field with two values, two graphs are generated.
If you select a field with ten values, ten graphs are generated.

You can select the second horizontal category from the Field selection tab in the
Graph Assistant.

Multiple graphs can appear in either merged format or in columns. For details, see
Merging Multiple Graphs and Displaying Multiple Graphs in Columns.

Create Multiple Graphs
1. Click the Field selection tab of the Graph Assistant.
2. Select the field from the Available fields window and click the Add icon to the

Create a separate graph for each value of this field box.
or
Click and hold the left mouse button, and drag the field to the Create a
separate graph for each value of this field box.
or
Press Alt+A to go the Create a separate graph for each value of this field box.
Then press Alt+M to go to the Available Fields window, tab to the field and
press Enter to add the chosen field.

3. If you want to change the title of the field name, click Show graph field option
if hidden.

4. In the Axis label text box located under the General subtab, type the new field
title name.

Merging Multiple Graphs
When you create a graph with a second horizontal category, multiple graphs are
generated. You can merge these graphs into a single graph.

You can do this from the Field selection tab in the Graph Assistant.

Merge Multiple Graphs
1. Click the Field selection tab of the Graph Assistant.
2. Add a field to the Create a separate graph for each value of this field box.
3. If hidden, click Show graph field options.
4. Click the Merge graphs into a single graph option button. When you run your

graph, the display shows an X, Y, and Z axis to represent the dual X-axis and
the Y-axis.

Merging Multiple Graphs

The following image illustrates a graph with two categories (Manufacturing Plant
and Product Name) that have been merged.
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Displaying Multiple Graphs in Columns
When you create a graph with a second horizontal category, multiple graphs are
generated. You can display these graphs in columns.

Display Multiple Graphs in Columns
1. Click the Field selection tab of the Graph Assistant.
2. Add a field to the Create a separate graph for each value of this field box.
3. If hidden, click Show graph field options.
4. Select the Display graphs in number of columns option button. This is the

default selection.
5. Select the number of columns to display the graphs. The default value of 1

displays all of the graphs in one single column, one underneath the other.
Selecting a number greater than 1 places the graphs in an HTML table, with the
number of cells across the table corresponding to the number of columns
specified.

Displaying Multiple Graphs in Columns

The following image shows a graph that has a second horizontal category. The
multiple graphs that are generated appear in 2 columns since the Display graphs
in columns option button was selected when creating the graph.
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Working With Joins
A join is a temporary connection between two or more data sources that share at
least one common field. Once you join two data sources, each time DB2 Web
Query retrieves a record from the first data source (host file), it also retrieves the
matching records from the second data source (target file).

You use the Join tool to link data sources in both Report Assistant and Graph
Assistant. The Join tool provides a graphical method for creating and manipulating
joins. You can also create define-based joins and multi-field joins.

When you access the Join tool, the window displays a field list for the host data
source (which you specified when you created the report), and a field list for any
target data source you add to the window.

Create a Join
1. Click the Join options tab in Report Assistant or Graph Assistant and click

New.
The DB2 Web Query masters list dialog box opens where you select a target
data source.

2. Select a data source and click OK.
The following image shows the Join settings window where you select fields
from the Host field and the Target field lists to create a join.
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3. Select the fields you want to join from the Host field list and the Target field
list and add them to their respective Selected Fields boxes.
or
Press Alt+M to go to the Host field list.
or
Press Alt+T to go to the Target field list.
Then, tab to the field and press Enter to add the chosen field to the
corresponding Selected Fields box.
Note: Fields must have the same format and be indexed fields in order to use
them to create joins.

4. Select your join properties:
v Unspecified. Indicates neither an inner nor left outer join.
v Inner Join. A join that results when a report includes host rows that have

corresponding cross-referenced rows.
v Left Outer Join. Extends the results of an Inner Join and retrieves records

from both host and cross-referenced tables, including all records from the left
table (host) and any records from the right table (cross-referenced) where the
condition values match. If there are no matching values in the
cross-referenced table, the join still retrieves records from the host table.

v Multiple Instance (formerly Non Unique). A one-to-many join structure that
matches one value in the host data source to multiple values in the
cross-referenced field. Joining employee ID in a company’s employee data
source to employee ID in a data source that lists all the training classes
offered by that company would result in a listing of all courses taken by each

Chapter 6. Creating a Graph With Graph Assistant 299



employee, or a joining of the one instance of each ID in the host file to the
multiple instances of that ID in the cross-referenced file. The default join type
is inner.

v Single Instance (formerly Unique). A one-to-one join structure that matches
one value in the host data source to one value in the cross-referenced data
source. Joining an employee ID in an employee data source to an employee
ID in a salary data source is an example of a unique join.

5. To see the join syntax, click View.
6. Click OK.
7. In the Description box, give the join a meaningful and unique name.
8. Click Save & Create.

The new join appears in the Joins list.

Create a Define-based Join
1. Click the Join options tab in Report Assistant or Graph Assistant and click

New.
The DB2 Web Query masters list dialog box opens where you select a target
data source.

2. Select a data source and click OK.
3. Click the down arrow of the Define icon and then click New define field.

The following image shows the list of Define field options.

The following image shows the Define field creator dialog box where you
create the Define expression.
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4. Create the defined field. The new define field appears in the Available fields
list. The field is prefixed with the define symbol as shown in the following
image.

5. Add the defined field and the target field to their respective Selected Fields
boxes.
Note: Fields must have the same format and be indexed fields in order to use
them to create joins.

6. If you want to see the syntax, click View to display the define-based join
syntax.

7. Give the join a meaningful and unique name in the Description box.
8. Click Save & Create. The new join appears in the Joins list.

Create Multi-field Joins
1. Click the Join options tab in Report Assistant or Graph Assistant and click

New.
The DB2 Web Query masters list dialog box opens where you select a target
data source.

2. Select a data source and click OK.
3. Enter multiple fields in the Host field list box and one field in the Target field

list box.
4. If you want to see the syntax, click View to display the multi-field join syntax.
5. In the Description box, give the join a meaningful and unique name.
6. Click Save & Create.

The new join appears in the Joins list.
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Delete a Join
1. Select a join from the Select an existing join list box.
2. Click Delete.

Edit a Join
1. Select a join from the Select an existing join list box.
2. Make your desired changes.
3. Click Save & Create.

Displaying Missing Data Values in a Graph
You can display missing data values (in a bar graph, line graph, area graph, or any
variation of these graph types) in one of the following formats:
v Graph as zero. In bar graphs, a bar appears on the zero line. In line graphs, a

solid line connects the missing value with the succeeding value. In area graphs,
the area appears on the zero line.

v Graph as gap. In all graph types (bar, line, or area), missing values appear as a
gap in the graph.

v Dotted line to zero. In line graphs, a dotted line connects the missing value
with the succeeding value. In 3D bar graphs, solid lines outline the flat bar
corresponding to the missing value. In 2D bar graphs, a gap appears in the
graph. In area graphs, a transparent area extends down to the zero line and then
up to the succeeding value.

v Interpolated dotted line. In a line graph, missing values appear as an
interpolated dotted line that connects the plot points immediately preceding and
succeeding the missing value. In bar and area graphs, missing values display as
an interpolated (transparent) bar or area.

Display Missing Values in a Graph
1. In the Graph Assistant, click the Properties tab.
2. Click the Y-axis subtab.
3. Required: From the Missing values display list box, select one of the following

values:
v Graph as zero.
v Graph as gap.
v Dotted line to zero.
v Interpolated dotted line.

Displaying Missing Values as Zero in a Graph

The following image illustrates how missing values are represented in a bar graph
when designated to appear as zero. The CURR_SAL values for McCoy and Stevens
are missing.
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Displaying Missing Values as a Gap

The following image illustrates how missing values are represented in a bar graph
when designated to appear as a gap. The CURR_SAL value for McCoy is missing.
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Displaying Missing Values as a Dotted Line to Zero

The following image illustrates how missing values are represented in a line graph
when designated to appear as a dotted line to zero. The CURR_SAL value for
McCoy is missing.

Displaying Missing Values as an Interpolated Dotted Line

The following image illustrates how missing values are represented in a line graph
when designated to appear as an interpolated dotted line. The CURR_SAL value
for McCoy is missing.
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Applying Conditional Styling to a Graph
You can add further value to your graph by using conditional styling to highlight
certain defined data with specific styles and colors. Conditional styling, also
referred to as stoplighting, enables you to define conditions that determine when
to apply particular fonts, point size, text style, foreground and background color,
and drill down procedures to your report’s data when the report is run.

For example, you can apply the color red to all departments that did not reach
their sales quotas and apply the color black to all departments that did reach their
sales quotas. In this example, the user can view quickly which departments did or
did not reach their quotas. To examine how the results of one department may
impact the results of a second department, you may want to provide a drill-down
to a report that examines this possibility.

You can apply color to the following graph types:
v Bar graphs.
v Three-dimensional graphs with noncontinuous plot points.
v Pie graphs.
v Stack charts.

Conditional styling is only supported for Y-axis values.

Applying Conditional Styling to a Graph

The following illustrates how you can apply conditional styling to a graph. In this
example:
v Blue is specified as the default color for all data in the graph.
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v Firebrick is specified as the color for data in the DOLLARS column.
v Silver is specified as the color for data in the DOLLARS column when the value

is greater than five million.
v Lime is specified as the color for data in the UNITS column when the value is

less than two hundred thousand.

The output is shown in the following image.

Linking Graphs to Other Resources
To drill down to a more detailed level of information in a graph, you can link a
procedure (FOCEXEC) or a URL to one or more values in your graph. When you
run your graph, the selected values become ″hot spots″ that invoke the underlying
procedure or URL.

Link a Graph to Other Resources
1. Click the Field selection tab in the Graph Assistant.
2. Select a field from the Field value(s) plotted on Y-axis list.
3. If hidden, click Show graph field options.
4. Click the Drill down button. The Drill Down dialog box opens.
5. Select either Execute Procedure (FOCEXEC) or Execute URL option button.

You can select the No action option button to disable a drill-down link.
6. If you are linking your graph to a:

v URL, type the URL in the URL text box. If you don’t want the URL to appear
when a user moves the mouse over a link in the graph, you can enter
different text in the Alternate Comment for Hyperlink text box.

v Procedure, select the procedure from the hierarchy.
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7. Use the Add button to add any parameters. For details, see Creating
Parameters.

8. Click OK.

Note: You can disable drill-down by following steps 1-3 and then selecting the No
action option button from the Drill Down dialog box.

Creating Parameters
Parameters enable you to specify criteria and conditions for the associated
(drill-down) report. By defining parameters, you can control the amount and type
of information to retrieve when you click on a hot spot.

Note: To avoid conflicts, do not name variables beginning with Date, IBI, or WF, as
variables beginning with these values are reserved for IBM use.

Create a Parameter in the Main and Drill Down Procedures
1. Click the Selection criteria tab.
2. Create an expression (WHERE statement) that defines a parameter. For details

on creating WHERE statements, see Selection Criteria Tab in HTML Graph
Assistant.

3. Select the Field selections tab.
4. Select the Sort by field that you want to drill down on, for example, Product.
5. Click Drill down. The DB2 Web Query Drill Down dialog box opens.
6. Click Execute Procedure (FOCEXEC) or Execute URL.

The following image shows a sample drill down dialog box with Execute
Procedure (FOCEXEC) option selected.
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7. Click Add. The Drill Down Parameter dialog box opens as shown in the
following image.
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8. Enter the name of the parameter you created in the drill down procedure in
the Parameter Name text box, for example, Coffee.
Note: When passing parameters to a drill-down procedure, you must use local
variables (&variables). Global variables (&&variables) cannot be used as
drill-down parameters. Also, it is not necessary to type an ampersand (&)
before the parameter name. This will create a global variable that cannot be
used as a drill-down parameter.

9. When you pass the parameter to the drill down procedure, you must set a
value for it in the Drill Down Parameter Dialog box. If you select:
v Field, the parameter will be set to the corresponding value of the object the

user drills down on in the specified field.
v Constant value, the parameter is set to the specified value.
Note: If the drill-down report contains a -DEFAULTS statement that sets a
default value to the same variable passed from the main report, the variable
value passed down overwrites the -DEFAULTS statement in the target
procedure.

10. Once a value has been supplied, click OK to return to the Drill Down Dialog
box. The parameter is added to the With Parameters list box as shown in the
following image.
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Adding Labels to a Graph
Adding labels to your graph helps provide important information about what the
data in your graph represents. You may choose to add headings and/or footings to
your graph, as well as style legend text and horizontal (X) and vertical (Y) axis
labels.

From the Headings tab of the Graph Assistant, you can add titles, headings, and
footings and customize them. For details on customizing, see Customizing Fonts in
a Graph.

Note:

v There is a 95-character limit for Graph Titles.
v Dragging and dropping items, including images, is not supported in the HTML

Graph Assistant.

310 System i: Database IBM DB2 Web Query for System i



The following image shows the Headings tab with a list of available fields on the
left and the Page Heading and Page Footing fields on the right.

Note: If your graph labels or legends do not appear correctly when you run your
graph, see Change Color Settings for details on correcting this.

Location of Headings and Footings in Graph Output

The following image illustrates where FOCUS Titles and Graph Titles appear in
graph output. Note that none of the headings in this sample have been formatted
and appear in their default format. Also note that the Graph Titles chart title will
appear in the graph output as well as in your browser’s title bar.
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Note: The graph preview reflects all display changes to the graph. FOCUS Titles
are not shown in the graph preview.

When you use the Graph Assistant to create a graph and add it to a report in the
PDF Layout Painter, if the graph contains FOCUS Titles (Page Heading, Page
Footing), they are automatically removed from the graph. To utilize headings or
footings in a graph you intend to add to the PDF Layout Painter, use the Graph
Assistant to create Graph Titles (Chart Title, Chart Subtitle, Chart Footnote). You
can also add Text objects to a graph in the PDF Layout Painter and position them
to function as a heading or footing.

Add a Heading or Footing to Your Graph
1. Click the Headings tab of the Graph Assistant.
2. Click the Page subtab.
3. Required: Click in the text box or press Alt+H to enter a page heading title.

or
Click in the text box or press Alt+F to enter a page footing title.

Note:

v If you change the font size of your heading (FOCUS titles), the code may not
properly reflect the font size you specified when you open the procedure in a
text editor. This does not affect functionality. You can edit the procedure
manually to correct the size.

v When selecting a font for the page heading or footing, be sure to click in the text
box before you select the font name, otherwise the font may return to the
original font selection.
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Add a Field to a Graph Heading or Footing
1. Click the Headings tab of the Graph Assistant.
2. Click the Page subtab.
3. Select a field from the Available fields window and drag the field to the Page

heading or Page footing box.
or
Click and hold the left mouse button, and drag the field to the text box you
chose.
The following table lists the shortcut keys you can use to quickly go to one of
the text boxes. The first column specifies the text box you go to when using the
shortcut keys and the second column shows the shortcut key combination.

Text Box Shortcut Keys

Page Heading Alt+H

Page Footing Alt+F

Press Alt+M to go to the Available Fields window, tab to the field and press
Enter to add the chosen field.

Add Titles, Subtitles, and Footnotes to a Graph
1. Click the Headings tab of the Graph Assistant.
2. Click the Page subtab.
3. Enter the text for the Chart Title, Chart Subtitle, and Chart Footnote in the

respective boxes.

Note: There is a 95-character limit for Graph Titles.

Adding Vertical (Y-axis) and Horizontal (X-axis) Labels to a
Graph

Vertical (Y-axis) and horizontal (X-axis) graph labels are placed on the graph
according to the display fields and sort fields specified in the request. The titles
that appear on the graph are the titles that appear in the Master File for that
particular field.

The vertical (Y-axis) title of the graph is determined by the display field. Note that
when the number of Y-axis labels is greater than one, the labels do not appear
along the Y-axis. Instead, the labels appear in a legend that provides the names of
the fields being graphed.

The horizontal (X-axis) title of the graph is determined by the sort field.

You can change the titles for the X and Y-axis from the Graph tab in the Headings
tab in the Graph Assistant.

Applying Custom Styling to a Graph
Using the Graph Assistant, you may customize your graph using the subtabs
(Options, Settings, X-axis, Y-axis, Pie) on the Properties tab. The customizations
you can apply to your graph include customizing fonts, output destination, graph
on server, label locations for all graph types, legend location, and much more.
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You can also select the orientation of the X- and Y- axes and 3D effects as well as
choose a predefined template using the Graph types tab.

Selecting Graph Orientation and 3D Effects
You can select either vertical or horizontal orientation for your graph on the Graph
types tab. The default selection is vertical. If horizontal is selected, the X-axis
appears along the side of the graph while the Y-axis appears along the bottom. You
can choose vertical or horizontal orientation for Bar, Line, and Area graphs.

You can apply 3D effects to your graph, also on the Graph types tab. This option is
not supported for histograms, spectral, stock, or radar graphs. To display bubble
help when using 3D Effects, markers must be checked under Settings in the
Properties tab.

Some graph types and graph styles require vertical and horizontal orientations,
with and without 3D effects. In such cases, the relevant option buttons are selected
and grayed out. You will only be able to make changes to orientation and 3D
effects by changing the Graph Type and Graph Style. For example, if you select the
3D Graph Type and Bar Graph Style, the vertical option button is selected and
grayed out.

Using Predefined Templates
When you check the Use a predefined template check box on the Graph types tab,
you can choose one of the color and texture templates from the drop-down list:
Pastels, Beveled on Tan, Color to White, Cylinder on Grey, Fade to Grey, Bumps,
Greys, Plum On White, Red Accent, Speckled, and True colors.

Customizing Fonts in a Graph
You can change the font for the X and Y-axis data and labels, legend text, headings,
footings, subheadings, and footnotes. From the text properties dialog box you can
customize the:
v Font. Select the font type. Note that depending on what fonts you have installed

on your machine, some fonts in the text properties dialog box may not be
distinguishable from other fonts. In particular, Monospaced and Dialog Input
may look the same as well as Dialog and San Serif.

v Style. Select the text style from normal, italic, bold, underline, or a combination
of these.

v Size. Select the font size.
v Set Style for. Select either Title or Data to apply style changes.
v Text Color. Select the font color.
v Text Justification. Select left, center, or right justification.
v Autofit. Automatically adjusts the font size to fit the graph and disables the Size

drop-down list. To select a different font size, uncheck this box and select the
font size in the Size drop-down list.

v Wrap. Check this box to wrap the text.
v Text Rotation. Select the data label to display horizontally, vertically (from top to

bottom or from bottom to top), and at a 45-degree angle.

Arrange X-axis Property Data Styles
1. Click the Properties tab and then the X axis subtab.
2. Click the Style Labels button to open the X-axis properties dialog box.
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3. To enable the text rotation features, select the check box at the top of the X-axis
properties dialog box as shown in the following image.

Note: This option is grayed out if the Automatic Arrangement option is
de-selected on the Graph Types tab.

4. Required: Under Text rotation, choose one of the following:
v Horizontal
v Vertical - Bottom to top
v Vertical - Top to bottom
v 45-degree bottom to top

In this case, 45-degree bottom to top is highlighted. Accordingly, the Data
Style label is positioned at a 45-degree angle.

As you make changes to the text properties, sample text appears to the right and
reflects all selections. If you leave the Autofit check box checked for a particular
object, the font size will be automatically adjusted to fit your graph. You can also
wrap the text by checking the Wrap check box. Note that when you select the
Wrap option, text only wraps to the next line if there is not enough room to
display the entire text in the chart.

The text properties dialog box can be invoked from many places in the Graph
Assistant. Depending on where it is invoked from, different options are available.
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Note: You can choose Background and Frame colors in the Options tab in the
Properties tab.

Change X-axis Label Fonts
1. Click the Properties tab of the Graph Assistant.
2. Click the X axis subtab.
3. Click the Style Labels button. The X-Axis Properties dialog box opens.
4. Select the font properties. You can change the fonts for the data text and for the

x-axis title text by selecting either the Data or Title option button.
5. Click OK.

Change Y-axis Label Fonts
1. Click the Properties tab of the Graph Assistant.
2. Click the Y axis subtab.
3. Click the Style Labels button. The Y1 Axis Label Properties dialog box opens.

If you are selecting fonts for the Y2 axis, the Y2 Axis Label Properties dialog
box opens; it contains the same style options.

4. Select the font properties. You can change the fonts for the data text and for the
y-axis title text by selecting either the Data or Title option button.

5. Click OK.

Change Graph Legend Fonts
1. Click the Properties tab of the Graph Assistant.
2. Click the Settings subtab.
3. Click the Style legend text button.

The Legend Properties dialog box opens.
4. Select the font properties.
5. Click OK.

Change Graph Title Fonts
1. Click the Headings tab of the Graph Assistant.
2. Click the Graph subtab.
3. Click Style Title, Style Subtitle, or Style Footnote for Chart title, Chart

subtitle, or Chart footnote.
Depending on the option you select, the Heading Properties, Subheading
Properties, or Footnote Properties dialog box opens.

4. Select the font properties.
5. Click OK.

Setting the Graph Height and Width
The width (or horizontal axis) of each graph, which includes any surrounding text,
is automatically set to 770 pixels. When setting the graph width, you should allow
for the inclusion of any text required for the vertical axis and its labels along the
left margin.

The height (or vertical axis) of your graph is automatically set to 405 pixels.

The vertical axis is automatically set to cover the total range of plotted values. The
height of the axis is set as high as possible (taking into consideration the presence
of any headings or footings and the need to provide suitably rounded vertical class
markers). The range is divided into intervals called ″classes.″ The scale is
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normalized to provide class values rounded to the appropriate multiples and
powers of 10 for the intervals plotted on the axis.

Set the Graph Height and Width
1. Click the Properties tab of the Graph Assistant.
2. Click the Options subtab.
3. In the Graph Size field, select the Custom size option button.
4. Enter the horizontal (width) value and the vertical (height) value, both in

pixels.
The horizontal value can be any number between 20 and 985.
The vertical value can be any number between 20 and 518.

Running, Saving, and Printing Your Graph
When you run your graph, you may print the output directly from the browser.

Note: If your graph labels or legends are not appearing correctly when you run
your graph, see Change Color Settings for details on correcting this.

If you log off DB2 Web Query without first closing the HTML Graph Assistant,
you must manually close the tool.

Save Your Graph From the Graph Assistant
1. Click Save or Save As from the Graph Assistant.
2. From the Save New Report dialog box, enter a name for the graph.

Note: If you are editing an existing graph, clicking Save will automatically save the
edits to the current graph file. You will not be prompted to name the file again.

Saving Options

When you click the Save or Save As buttons you save your report (procedure). If
you make changes in your report without subsequently saving them and then click
Quit, you are prompted with the following options:
v Yes. Click to save your changes and exit the report.
v No. Click to discard your changes and exit the report.
v Cancel. Click to return to your report to continue working or use Save or Save

As to save your changes and then click Quit to exit your report.

Note: In the HTML Graph Assistant, if you close the window by clicking the X,
your changes will not be saved.

Run Your Graph

After creating your graph in the Graph Assistant, click Run from any tab in the
Graph Assistant to view your graph output.

Print Your Graph
1. Run your graph.
2. From the browser, select Print from the File menu.
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Note: Some older printers, such as the IBM model 6262, do no support graphical
output.

Send Graph Output Directly to a Printer
1. From the Properties tab, click the Options subtab.
2. Select Printer from the Output list box.

You do not need to provide a name or select a format.
3. Click Run.

The graph prints to your default printer setting.

Change Color Settings
1. From the Windows® Control Panel, select Display.
2. Click the Settings tab.
3. In the Color palette box, click the drop-down arrow and select True Color (32

bit) or a higher color count.
4. Click OK.

If you use different color settings from this recommended value, your graphs may
appear in grayscale format.

Graph Display Formats
Following are descriptions of the graph display formats:
v PNG (Portable Network Graphics). PNG graphs are bitmapped and can support

16 million colors. In addition, PNG graphs have lossless compression (data is
decompressed 100% back to the original). Therefore, saving, altering, and
resaving a PNG does not degrade its overall quality. The PNG graph appears in
the browser.

v GIF (Graphics Interchange Format). GIF compresses well but only supports 256
colors. The GIF graph appears in the browser.

v JPEG (Joint Photographic Experts Group). A compressed file format.
v SVG (Scalable Vector Graphics). SVG is a text-based graph file format that

enables Web application developers to design powerful, interactive graphs. SVG
is compact and generates high quality images on any media regardless of
resolution. The SVG is viewable with an Adobe plug-in.
Note: To include a graph in the PDF Layout Painter, the graph must be saved in
.SVG or .jpg format.

v PDF/SVG (Portable Document Format/Scalable Vector Graphics). The SVG
graph is automatically embedded into a PDF and shown only on the screen.
Drill down is not available with this format.

v PDF/GIF (Portable Document Format/Graphics Interchange Format). The GIF
graph is automatically embedded into a PDF and shown only on the screen.
Drill down is not available with this format.

Choosing Formats for Output to the Screen or Printer

When you create or edit a graph in Graph Assistant, you can choose among these
formats in the Output section in the Options tab. If you are designating Output To
the Screen, all options listed in Graph Display Formats are available, as shown in
the Format drop-down list.

The following image shows the Options subtab.
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If you are designating Output to a Printer, the PNG, GIF, and SVG options also are
available. Note that the printer must be able to print images.

The following image shows the Output section of the Options tab with the Output
to Printer option selected.
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Graph Types Tab
The Graph Types tab is used to create and view a graph type and style.

Graph Types Tab: Graph Types Window

The following image shows the Graph types tab with a sample cluster bar chart.

In the Graph types component:

Select from the following graph types

Displays Line, Bar, Pie, Scatter, Area, 3D, Bubble, Polar, Radar, Spectral
Map, Stock, Histogram, Multi-Y, Waterfall, and Miscellaneous graph types.

Select from the following Graph Styles

Displays several graph styles customized for each graph type.

General options:

Vertical

Displays the date vertically, along the Y-axis.

Horizontal

Displays the data horizontally, along the X-axis.
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Use 3D effect

Applies a three-dimensional look to either the vertical or horizontal data.

Apply template

Displays the Pastels, Beveled on Tan, Color to White, Cylinder on Grey,
Fade to Grey, Bumps, Greys, Plum on White, Red Accent, Speckled
templates, and True colors.

Reset button

Resets all styling information back to the default values.

Automatically arrange the chart elements so that they make the best use of
available space

Specify this option with a check in the check box.

The Graph type description component of the Graph types subtab includes a
description of the Graph type and style you have chosen, along with a sample
graph. In addition, you have the following options:

Show Graph Preview button

Displays the actual graph in a separate window with the options you
specified.

Update button

Updates a graph after you make changes.

Automatic Update check box

Check to have your graph automatically updated each time a change is
made.

Field Selection Tab in HTML Graph Assistant
The Field selection tab, shown in the following image, is used to choose the fields
you want to use in a graph.
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Field Selection Tab: Available Fields

The following image shows the Available fields area of the Field selection tab. The
Available fields area in the Field selection tab, as shown in the following image,
provides the following functionalities and options for selecting available fields in a
graph.
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Available fields

Displays a list of field names from the selected data source.

Define button

Click the Define button to select from New define field, Edit define field,
or Delete define field. If you select the New define field or Edit define
field, the Define field creator dialog box opens where you can create or
edit a defined field. For more information, see Field Selection Tab: Field
Creator Dialog Box.

Tree button

When this button is selected, field names are displayed in a tree structure.
Optionally, data can be displayed in different ways by clicking the adjacent
down-arrow to open a drop-down list that provides options to Show name,
Show alias, Show title, or Show description. The Show Field Tree display
type is the default value, and for some database structures, the Show
Dimension Tree option can be selected.

List icon

This button is selected by default to display a list of all field names.
Additional related information can be displayed by clicking the adjacent
down-arrow to open a drop-down list that provides options to display
Name, Alias, Title, Format, Description, Segment, and Filename. You can
also choose the option to Sort by file order.
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Field Selection Tab: Graph Fields

The Graph fields area in the Field selection tab, as shown in the following image,
provides the following functionalities, including many options, for selecting and
displaying fields in a graph.

You can view the selected fields with the following options:

Prefix with the segment name prefixes the selected fields with the
segment name.

Prefix with the filename prefixes the selected fields with the name of the
data source.

Show the field’s alias instead of name displays the aliases defined in the
Master File instead of the field names.

Show field’s title displays the titles defined in the Master File instead of
the field names.

Show field’s description displays the descriptions defined in the Master
File instead of the field names.

Field Value Plotted on X axis

Displays the horizontal (X-axis) field that was selected from the Available
fields area.

Add button

Adds a field to the X-axis.

Remove button

Removes a field from the X-axis.

Create a separate graph for each value of this field
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Displays the second horizontal (X-axis) field (formerly referred to as an
Across field) that was selected from the Available fields area.

Add button

Adds a second field to the X-axis.

Remove button

Removes a field from the X-axis.

Field value(s) plotted on Y axis

Displays the vertical (Y-axis) field that has been selected from the Available
fields area.

Sum

Creates a graph that aggregates data by the X-axis field. This is the
default.

Print

Creates a graph that plots each Y-axis field value on a
record-by-record basis. If the selected X-axis value is numeric, a
scatter graph is generated; if the selected X-axis value is
alphanumeric, a line graph is generated.

New computed field button

Opens the Computed Field Creator dialog box where you can
define the parameters for a new computed field. You can also click
the adjacent down-arrow to open a drop-down list to select the
Edit computed field option. For more information, see Field
Selection Tab: Field Creator Dialog Box.

Add button

Adds a field to the Y-axis.

Remove button

Removes a field from the Y-axis.

Move Up or Move Down buttons

Moves the position of the field within the graph.

Field Selection Tab: Field Options

Below the Graph fields area in the Field selection tab is the Field options panel you
can display by clicking Show - Field options or hide by clicking Hide - Field
options. A different Field options panel is displayed depending on whether you
have a Y-axis, X-axis, or secondary X-axis field selected in the Graph fields area.

For the Y-axis Field options Display tab:

The Display tab appears by default when the Field options panel is displayed for
Y-axis fields and provides the buttons, fields, and options described after the
following image.
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Make this field invisible

Check to temporarily hide the display of the selected Y-axis field.

Y axis field label

The selected Y-axis field name is automatically displayed. You can edit this
field to display a different label for the Y-axis field.

Summary Type

Select a summary type for the selected Y-axis field. The choices are: Plain
field value, Average Square, Average, Count, Distinct, Show first in group,
Show last in group, Maximum, Minimum, Percentage, Count Percentage,
Row Percentage, Sum, and Total.

Field Color

Select to open a pop-up color palette, shown in the following image, where
you can select the display color for the selected Y-axis field.
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Conditional Styling button

Click to open the conditional styling dialog box, as shown in the following
image, which you can use to add conditional styling in a graph.

OK

Returns to the Field selection tab after the conditional styling is added to
the graph.

Drill Down
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Click to open the drill-down dialog box, which provides the fields and
options listed after the following image, that you can use to add drill
down capability to a graph.

No action

This option is selected by default. (No procedure will be executed.)

Execute procedure (FOCEXEC)

Select this option to access procedures in the Standard Reports
folder of the default domain. Click the procedure you want to
execute.

Show all domains

When Execute procedure (FOCEXEC) is selected, click this
check box to gain access to procedures in the Standard
Reports folders of all available domains.

Execute procedure

The procedure you selected appears in this text box.

Execute URL

Select this option to enter the URL you want to execute.

With parameters

When a parameter is created, it is automatically added to this list
box.

Alternate comment for hyperlink
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Type text here to display in place of the hyperlink specified in the
Execute URL field.

Add button

Click to open the drill-down parameter dialog box, which provides the
fields and options listed after the following image.

Parameter name

Enter the parameter name you created in the drill down procedure.

Parameter value: Field

The parameter will be set to the corresponding value of the object
the user drills down on in the specified field.

Parameter value: Constant value

The parameter is set to the specified value.

OK button

Returns to the drill down dialog box. The parameter is added to
the With parameters list box.

For the Y-axis Field options Visualize tab:

The Visualize tab appears when the Field options panel is displayed for an X-axis
field and provides the options described after the following image.
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Force the values of this field to be plotted as:

Choose Bar, Line, or Area.

Place this field on the specified axis

You can choose 1st axis or 2nd axis. (Available for dual axis graph types
only.)

For the X-axis Field options:

The General tab appears when the Field options panel is displayed for an X-axis
field and provides the fields and options described after the following image.

Sorting order

Click Ascending or Descending.

X-axis field label

The X-axis field name is automatically displayed. You can edit this field to
display a different label for the X-axis field.

For the Secondary X-axis (Across) Field options:
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The General tab appears when the Field options panel is displayed for a second
X-axis (Across) field and provides the fields and options described after the
following image.

Sorting order

Click Ascending or Descending.

Display graphs in number of columns

Enter a number in the text box.

Merge graphs into a single graph

Click this option button to activate merge functionality.

Axis label

The selected field name is is automatically displayed. You can edit this
field to display a different label for this Across field.

Field Selection Tab: Field Creator Dialog Box

Use the Field Creator Dialog Box to create or edit Defined and Computed fields, as
shown in the following image.
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Field

Enter a name for the computed or defined field.

Format

Click to display the Change Format Dialog box, as shown in the following
image.
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Format types

Choose:
v Alphanumeric
v Floating point
v Integer
v Decimal
v Packed
v Date (opens additional date related fields in the dialog box)
v Date-Time (opens additional date related fields in the dialog

box)

Length

Choose an available number based on the format type you chose.

Select options

Choose options based on the format type you chose.

Tree or List mode buttons

Opens the field list in either tree or list mode.

Fields window

Double-click a field to include a field name in an expression.

Functions

Displays a list of pre-defined functions shown in the following image.
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Operator on the computer keypad

Click to include arithmetic operations in an expression.

Boolean operator on the computer keypad

Click to include a Boolean operator in an expression.

Conditional operator on the computer keypad

Click to include a conditional operator in an expression.

Headings Tab
The Headings tab is used to create headings and footings. It has Page and Graph
subtabs.

Headings Tab: Page

The Page subtab of the Headings tab shown in the following image is used to
create report headings and footings.
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Formatting tool bar

v Cut, copy, paste. Cut or copy and paste a selection.
v Select all. Select all highlighted text.
v Remove formatting. Remove formatting from selection.
v Font styles. Select from bold, italic, and underline.
v Alignment. Select left, center, right, or bottom alignment.
v Font. Select a different font from the drop-down list.
v Font size. Select a font size from the drop-down list.
v Text color. Select the text color from the color menu.
v Background color. Select the background color from the color menu.

Show/Hide Fields list

Insert a field in your heading or footing from the fields list.

Page Heading

Enter the text for the heading in the Page Heading box.

Page Footing

Enter the text for the footing in the Page Footing box.

Headings Tab: Graph

The Graph subtab of the Headings tab shown in the following image is used to
create chart titles, subtitles, and footings.
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Show/Hide Fields list

Insert a field in your heading or footing from the fields list.

Chart Title

Enter text for the chart title here. The chart title will appear in the graph
output as well as in your browser’s title bar.

Chart Subtitle

Enter text for the chart subtitle here.

Chart Footnote

Enter text for the chart footnote here.

Style Title, Style Subtitle, Style Footnote

To change the properties, click Style Title, Style Subtitle, or Style
Footnote button for the respective text box (Chart Title, Chart Subtitle,
Chart Footnote). For details, see Chart Title, Subtitle, and Footnote
Properties Dialog Box.
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Chart Title, Subtitle, and Footnote Properties Dialog Box

In the Headings tab, click Set style button in the Graph subtab in the Chart Title,
Chart Subtitle, and Footnote areas to open the Heading properties dialog box as
shown in the following image.

Font

Select the font type.

Style

Select the font style.

Size

Select the text size.

Text Color

Select a text color from the drop-down list.

Text Rotation

Horizontal. Displays text in a horizontal orientation that reads left to right.

Vertical - Bottom to top. Displays text in a vertical orientation that reads
from bottom to top.

Vertical - Top to bottom. Displays text in a vertical orientation that reads
from top to bottom.

Text Justification

Indicate whether the text will be left, center, or right justified.

Autofit

Chapter 6. Creating a Graph With Graph Assistant 337



Checked. Automatically adjusts the heading font size to fit the graph and
disables the Size drop-down list.

Unchecked. This is the default. To select a different heading font size,
select the font size in the Size drop-down list.

Wrap

Check this box to wrap the text.

Selection Criteria Tab in HTML Graph Assistant
You can create WHERE and WHERE TOTAL statements from the Selection criteria
tab in the Graph Assistant.

Selection Criteria Tab - Screen Conditions Window

The Screening conditions window shown in the following image allows you to
drag and drop a field from the Available fields window.

WHERE/WHERE TOTAL

Use WHERE to select records based on the values of an individual field.

Use WHERE TOTAL to select records based on the aggregate value of a
field, for example, the sum or average of a field’s values.

Fieldname

Is the fieldname you initially chose.

Expression

Select an expression from the drop-down list, for example, equals.

Select Values

Click to open the Values dialog box.
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Constant

Enter a constant.

Parameter

Enter the name of the &variable.

Field

Select a field from the Field list box.

Values

Select a field from the Values list box.

Join Options Tab
The Join options tab is used to create joins.

Join Options Tab: Add or New

The following image shows the Join options tab where you create joins for a graph.
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Select an existing join

Enter the name of a join you have previously created.

New

Press the New button to create a new join.

Delete

Click to delete the join.

OK button

Click to select a Master File.

Cancel

Click to return to the Add/New Join window.

When you select a target data source you have multiple join related settings and
options, as shown in the following image.
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The Join Settings section provides the following fields and buttons for creating
joins:

Description

Enter a description for your join.

Internal name

DB2 Web Query assigns an alphanumeric name for the join, for example
J001.

Save & Create

Once you have selected your host and target fields, click Save & Create to
create the join.

View

Click to view the syntax of your join, which displays the code sent to the
DB2 Web Query Reporting Server to validate the join, but may not be the
same code required to run the report. This is the case for a DEFINE based
JOIN where only the JOIN statement is displayed for validation, but both
the JOIN and DEFINE statements are needed when the report is run.

The Join Type drop-down list provides the following join type options:

Unspecified

Select from the Join Types drop-down list to indicate neither an inner or
outer join.

Inner Join
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Select from the Join Types drop-down list for a join that results when a
report omits host rows that lack corresponding cross-referenced rows.

Left Outer Join

Select from the Join Types drop-down list to extend the results of an Inner
Join and retrieve records from both host and cross-referenced tables,
including all records from the left table (host) and any records from the
right table (cross-referenced) where the condition values match. If there are
no matching values in the cross-referenced table, the join still retrieves
records from the host table.

The Instances drop-down list provides the following join instance options:

Multiple Instance (formerly Non Unique)

Select from the Instances drop-down list for a one-to-many join structure
that matches one value in the host data source to multiple values in the
cross-referenced field. Joining employee ID in a company’s employee data
source to employee ID in a data source that lists all the training classes
offered by that company would result in a listing of all courses taken by
each employee, or a joining of the one instance of each ID in the host file
to the multiple instances of that ID in the cross-referenced file.

Single Instance (formerly Unique)

Select from the Instances drop-down list for a one-to-one join structure that
matches one value in the host data source to one value in the
cross-referenced data source. Joining an employee ID in an employee data
source to an employee ID in a salary data source is an example of a unique
join.

Host Field List:

Search (binoculars) icon

Opens the Field List Searching dialog box. See Searching Field Lists for
details.

Define icon

Click the Define icon to select: New define field, Edit define field, or Delete
define field. If you select the New define field or Edit define field, the
Define field creator dialog box opens where you can create or edit a
defined field.

Tree icon

Displays a tree structure of field names by segment with segment, alias,
title, description, and format information below the tree. Individual field
information appears when you click on the field.

List icon

Displays a list of all field names with information that you select from the
adjacent arrow that opens a drop-down list: name, alias, title, remarks,
format, description, segment, and file name. You can also choose to sort by
file order.

Add button

Adds a field.

Remove button
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Removes a field.

Move Up or Move Down buttons

Moves the position of the field within the join.

Target Field List:

Select a target button

Click to select a target Master File.

Tree icon

Displays a tree structure of field names by segment with segment, alias,
title, description, and format information below the tree. Individual field
information appears when you click the field.

List icon

Displays a list of all field names with information that you select from the
adjacent arrow that opens a drop-down list: name, alias, title, remarks,
format, description, segment, and file name. You can also choose to sort by
file order.

Add button

Adds a field.

Remove button

Removes a field.

Move Up or Move Down buttons

Moves the position of the field within the join.

Properties Tab
The Properties tab is used to set properties options for one or more components of
a graph.

Legend Properties Dialog Box

Click the Style Legend Text button on the Settings subtab in the Properties tab to
open the Legend properties dialog box as shown in the following image.
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Font

Select the font type.

Style

Select the font style.

Size

Select the text size.

Text Color

Select a text color from the drop-down list.

Text Rotation

Horizontal. Displays legend text in a horizontal orientation that reads left
to right.

Vertical - Bottom to top. Displays legend text in a vertical orientation that
reads from bottom to top.

Vertical - Top to bottom. Displays legend text in a vertical orientation that
reads from top to bottom.

Text Justification

Indicate whether the text will be left, center, or right justified.

Autofit

Checked. This is the default. Automatically adjusts the legend font size to
fit the graph and disables the Size drop-down list.

Unchecked. To select a different legend font size, uncheck this box and
select the font size in the Size drop-down list.

Wrap
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Checked to enable wrapping the text.

X-axis Label Properties Dialog Box

Click the Style Labels button on the X axis subtab of the Properties tab to open the
X-axis properties dialog box as shown in the following image.

Font

Select the font type.

Style

Select the font style.

Size

Select the text size.

Set Style For

Select to style Title or Data.

Text Color

Select a text color from the drop-down list.

Text Rotation
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Horizontal. Displays text in a horizontal orientation that reads left to right.

Vertical - Bottom to top. Displays text in a vertical orientation that reads
from bottom to top.

Vertical - Top to bottom. Displays text in a vertical orientation that reads
from top to bottom.

45-degree bottom to top. Displays text in a diagonal that reads from
bottom to top.

Text Justification

Indicate whether the text will be left, center, or right justified.

Autofit

Checked. This is the default. Automatically adjusts the X-axis font size to
fit the graph and disables the Size drop-down list.

Unchecked. To select a different X-axis font size, uncheck this box and
select the font size in the Size drop-down list.

Wrap

Check this box to wrap the text.

Y-axis Label Properties Dialog Box

Click the Style Labels button on the Y axis subtab of the Properties tab to open
the Y-axis properties dialog box as shown in the following image.
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Font

Select the font type.

Style

Select the font style.

Size

Select the text size.

Set Style For

Select to style Title or Data.

If you have selected more than one Y-axis field, the Title option will not be
available in the Label Properties dialog box. The Data option will be
selected by default.

Text Color

Select a text color from the drop-down list.

Text Rotation

Horizontal. Displays text in a horizontal orientation that reads left to right.

Vertical - Bottom to top. Displays text in a vertical orientation that reads
from bottom to top.
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Vertical - Top to bottom. Displays text in a vertical orientation that reads
from top to bottom.

45-degree bottom to top. Displays text in a diagonal that reads from
bottom to top.

Text Justification

Indicate whether the text will be left, center, or right justified.

Autofit

Checked. Automatically adjusts the Y-axis font size to fit the graph and
disables the Size drop-down list.

Unchecked. This is the default. To select a different Y-axis font size, select
the font size in the Size drop-down list.

Wrap

Check this box to wrap the text.

Graph Assistant Properties Tab: Options

The following image shows the Options subtab of the Properties tab.

Graph Size

Select the DB2 Web Query default size, let the applet application choose
the size, or set a custom size for horizontal and vertical, both in pixels. For
more information about graph size, see Set the Graph Height and Width.

Output
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Select Screen or Printer from the list box. If you select:

Screen, the output appears in the browser. Choose: PNG, SVG, GIF, JPEG,
PDF/SVG, PDF/GIF.

Printer, graph output is sent directly to your browser’s default printer.
Choose: PNG, SVG, GIF, JPEG.

Note: To include a graph in the PDF Layout Painter, the graph must be
saved in .SVG format.

Background Color

Select a background color from the color picker for the current graph.

Frame Color

Select a frame color from the color picker for the current graph.

Stop retrieving records after the specified number have been included in the
report

Record limits are used to limit the amount of data that appears or is used
in your graph.

Limit the number of read operations performed during report generation

Read limits are used to limit the amount of records retrieved (or read) from
the data source. The Read Limit option is not available with FOCUS data
sources.

Use SQL Engine Joins. Multiplicative effect may result. Web Query protection is
suppressed.

Enables the database to use its internal optimization techniques which
reduce the volume of database-to-server communications and improve
response time.

Summary Text for Graph

Provides a SUMMARY attribute for reports and graphs that maps to the
HTML <TABLE SUMMARY> tag. A description of the graph is placed into
a summary object inside the HTML table in the source code. This complies
with section 508 accessibility.

The description of the graph can be no longer than 500 characters.

Graph Assistant Properties Tab: Settings

The following image shows the Settings subtab of the Properties tab.
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Graph Settings

Show Data Values

Check this box to display data values in your graph. If this box is
unchecked, data values will not be included.

FOCUS Grid

Grids are parallel lines drawn across a graph at the vertical and horizontal
class marks on the axes. Check this box if you wish grid lines displayed.
This option is only available on connected point plots, histograms, bar
charts, and scatter diagrams.

Graph on Server

Runs the graph on a server (rather than your local machine) and produces
the graph as an HTML file with a GIF image. Graph on Server cannot be
used when the Enable Zoom/Pan box is checked.

Note: This option is only available if the server was configured for server
side graphics.

Enable Zoom/Pan

350 System i: Database IBM DB2 Web Query for System i



Enables you to zoom on a graph. This feature is available for all graphs
except radar, polar, 3D, pie, spectral, and stock graphs. Enable Zoom/Pan
cannot be used when the Graph on Server box is checked.

Legend Settings

Show Legend

Check this to display the legend in your graph.

Legend Style

Select the position of the legend’s text. You may select to have the legend’s
text on the right or left side, above or below the legend marker, or inside
the legend marker.

Reverse Legend Order

Enables the display of the graph legend in reverse order. This is generally
most helpful when Reverse Order of Groups is selected.

Style Legend Text

Opens the Legend properties dialog box where you can select and style the
font for the legend text.

Markers

Select how you want markers (shapes that represent data points) to appear
on your graph.

Show Markers

Will show marker shapes at the data points on line graphs. You
must have this option set to on in order for values to appear when
you hover your cursor over an area or line graph.

Use on Legend

Will show marker shapes on the graph legend.

Show Lines

Is the default in the Markers group. When this check box is
deselected, marker shapes show on a line graph, but connecting
lines are not drawn.

Graph Assistant Properties Tab: X axis

The following image shows the X axis subtab of the Properties tab.
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Show axis labels

Top - X-axis labels appear above vertically oriented graphs and to the right
of horizontally oriented graphs.

Bottom - X-axis labels appear below vertically oriented graphs and to the
left of horizontally oriented graphs. (This is the default.)

Top and Bottom - X-axis labels appear both above and below vertically
oriented graphs and to both the left and right of horizontally oriented
graphs.

Stagger Labels - When this box is checked, X-axis labels will be staggered.

Hide first label - When this box is checked, the first X-axis label will not
appear.

Hide last label - When this box is checked, the last X-axis label will not
appear.

Value Format

Enables you to select a format for the display of X-axis values. You can
only change the display format if your x-axis values are numeric and the
graph style is bubble, histogram (bar), or scatter.

Style Labels

Opens the X-axis properties dialog box where you can select and style the
fonts for the X-axis.

Reverse order of groups

When checked, enables the display of the groups (X-axis) data in reverse
order. When unchecked, the graph will display groups in natural order.

Major grid lines

Divide a graph at regular intervals according to the scale. Major grid lines
cross their axis line at the exact location of the scale label. Styles include:
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Regular Grids - Normal grid lines that are the height of the frame.

Grids and Ticks - Normal grid lines that extend outside the frame.

Inner Ticks - Small tick marks from the frame edge inward.

Outer Ticks - Small tick marks from the frame edge outward.

Spanning Ticks - Small tick marks that span the frame edge.

Minor grid lines

Divide a graph at regular intervals according to the scale. Minor grid lines
cross their axis line at equal intervals between major grids/ticks; they
never align directly with a scale label. Styles include:

Regular Grids - Normal grid lines that are the height of the frame.

Grids and Ticks - Normal grid lines that extend outside the frame.

Inner Ticks - Small tick marks from the frame edge inward.

Outer Ticks - Small tick marks from the frame edge outward.

Spanning Ticks - Small tick marks that span the frame edge.

Graph Assistant Properties Tab: Y axis

The following image shows the Y axis subtab of the Properties tab.

Axis Selection List Box

If you have more than one Y-axis, select which axis you would like to
apply properties to here, either Y1 Axis or Y2 Axis.

Show axis labels
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Left Side - Y-axis labels will appear on the low (bottom or left) side of the
graph.

Right Side - Y-axis labels will appear on the high (top or right) side of the
graph.

Both Sides - Y-axis labels will appear on both the low and high sides of
the graph.

Hide Maximum Value - When checked, the largest Y-axis label will not
appear.

Hide Minimum Value - When checked, the smallest Y-axis label will not
appear.

Always include Zero on Scale - Includes zero on the Y-axis scale when
checked. If you have manually set your scale range to exclude zero, this
property will be ignored.

Log Scale - When checked, the Y-axis scale will use logarithmic scaling.
When unchecked, the Y-axis scale will use linear scaling.

Value Format

Enables you to select a format for the display of Y-axis series values. Value
Format cannot be used in combination with Slice Label.

Style Labels

Opens the Y-axis properties dialog box where you can select and style the
fonts for the Y-axis.

Reverse order of series

When checked, enables the display of the series (Y-axis) data in reverse
order. When unchecked, the graph will display its series in natural order.

Descending Axis

Inverts the direction of the Y-axis so values of zero or less appear at the
top of the graph, while values greater than zero appear at the bottom of
the graph.

Axis Line

Enables the display of the Y-axis base line.

Zero Line

Enables the display of the Y-axis Zero line when zero is within the Y-axis
range.

Missing Values Display

Displays missing data values (in a bar graph, line graph, area graph, or
any variation of these graph types) in one of the following formats:
v Graph as zero.
v Graph as gap.
v Dotted line to zero.
v Interpolated dotted line.

Major Grid Lines

Divide a graph at regular intervals according to the scale. Major grid lines
cross their axis line at the exact location of the scale label. Styles include:
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Regular Grids - Normal grid lines that are the height of the frame.

Grids and Ticks - Normal grid lines that extend outside the frame.

Inner Ticks - Small tick marks from the frame edge inward.

Outer Ticks - Small tick marks from the frame edge outward.

Spanning Ticks - Small tick marks that span the frame edge.

Minor Grid Lines

Divide a graph at regular intervals according to the scale. Minor grid lines
cross their axis line at equal intervals between major grids/ticks; they
never align directly with a scale label. Styles include:

Regular Grids - Normal grid lines that are the height of the frame.

Grids and Ticks - Normal grid lines that extend outside the frame.

Inner Ticks - Small tick marks from the frame edge inward.

Outer Ticks - Small tick marks from the frame edge outward.

Spanning Ticks - Small tick marks that span the frame edge.

Graph Assistant Properties Tab: Pie

The following image shows the Pie subtab of the Properties tab.

Show Axis Labels

When checked, enables the display of feelers and data text in a pie graph.

Feeler Lines and Labels - Shows both feelers and data text.

Labels Only - Shows only data text.

Labels on Slices - Shows data text on slices.

A feeler is a line or set of lines that stretch from a pie slice label to its pie
slice. Feelers are visual aids that help you know that a particular number
belongs to a particular pie slice.

Slice Label

When this option button is selected, the Y-axis label will appear at the end
of the feeler.
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Percent Value

When this option button is selected, the Y-axis value expressed as a
percentage appears at the end of the feeler.

Slice Label and % Value

When this option button is selected, the Y-axis label, and its value
expressed as a percentage, appear at the end of the feeler.

True Value of Slice

When this option button is selected, the Y-axis value appears at the end of
the feeler.

Value Format

Enables you to select a format for the display of Y-axis series values. Value
Format cannot be used in combination with Slice Label.
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Chapter 7. Using Functions

Introduces functions and explains the different types of available functions.

The following topics offer an introduction to functions and explain how to use
them. Functions provide a convenient way to perform certain calculations and
manipulations.

In order to use any of the specified functions described in this reference manual,
you need to create a temporary field which is discussed later.

Types of Functions
You can access any of the following types of functions:
v Character functions. Manipulate alphanumeric fields or character strings.
v Data source and decoding functions. Retrieve data source values and assign

values based on the value of an input field.
v Date and time functions. Manipulate dates and times.
v Format conversion functions. Convert fields from one format to another.
v Numeric functions. Perform calculations on numeric constants and fields.
v System functions. Call the operating system to obtain information about the

operating environment.

Character Functions
The following functions manipulate alphanumeric fields or character strings.

ARGLEN

Measures the length of a character string within a field, excluding trailing
blanks.

BITSON

Evaluates an individual bit within a character string to determine whether
it is on or off.

BYTVAL

Translates a character to its corresponding ASCII or EBCDIC decimal
value.

CHKFMT

Checks a character string for incorrect characters or character types.

CTRAN

Translates a character within a character string to another character based
on its decimal value.

CTRFLD

Centers a character string within a field.

EDIT

Extracts characters from or adds characters to a character string.
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GETTOK

Divides a character string into substrings, called tokens, where a specific
character, called a delimiter, occurs in the string.

LCWORD

Converts the letters in a character string to mixed case.

LJUST

Left-justifies a character string within a field.

LOCASE

Converts alphanumeric text to lowercase.

OVRLAY

Overlays a base character string with a substring.

PARAG

Divides a line of text into smaller lines by marking them with a delimiter.

POSIT

Finds the starting position of a substring within a larger string.

REVERSE

Reverses the characters in a character string.

RJUST

Right-justifies a character string.

SOUNDEX

Searches for a character string phonetically without regard to spelling.

SPELLNUM

Takes an alphanumeric string or a numeric value with two decimal places
and spells it out with dollars and cents.

SUBSTR

Extracts a substring based on where it begins and its length in the parent
string.

UPCASE

Converts a character string to uppercase.

Data Source and Decoding Functions
The following functions retrieve data source values and assign values.

DECODE

Assigns values based on the coded value of an input field.

LAST

Retrieves the preceding value for a field.

Date and Time Functions
The following functions manipulate dates and times.
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Standard Date and Time Functions
AYM

Adds or subtracts months from dates that are in year-month format.

AYMD

Adds or subtracts days from dates that are in year-month-day format.

CHGDAT

Rearranges the year, month, and day portions of alphanumeric dates, and
converts dates between long and short date formats.

DA

Converts dates to the corresponding number of days elapsed since
December 31, 1899.

DADMY converts dates in day-month-year format.

DADYM converts dates in day-year-month format.

DAMDY converts dates in month-day-year format.

DAMYD converts dates in month-year-day format.

DAYDM converts dates in year-day-month format.

DAYMD converts dates in year-month-day format.

DATEADD

Adds a unit to or subtracts a unit from a date format.

DATECVT

Converts date formats.

DATEDIF

Returns the difference between two dates in units.

DATEMOV

Moves a date to a significant point on the calendar.

DATETRAN

Formats dates in international formats.

DMY, MDY, and YMD

Calculates the difference between two dates.

DOWK and DOWKL

Finds the day of the week that corresponds to a date.

DT

Converts the number of days elapsed since December 31, 1899 to the
corresponding date.

DTDMY converts numbers to day-month-year dates.

DTDYM converts numbers to day-year-month dates.

DTMDY converts numbers to month-day-year dates.

DTMYD converts numbers to month-year-day dates.
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DTYDM converts numbers to year-day-month dates.

DTYMD converts numbers to year-month-day dates.

GREGDT

Converts dates in Julian format to year-month-day format.

HADD

Increments a date-time field by a given number of units.

HCNVRT

Converts a date-time field to a character string.

HDATE

Extracts the date portion of a date-time field, converts it to a date format,
and returns the result in the format YYMD.

HDIFF

Calculates the number of units between two date-time values.

HDTTM

Converts a date field to a date-time field. The time portion is set to
midnight.

HGETC

Stores the current date and time in a date-time field.

HHMMSS

Retrieves the current time from the system.

HINPUT

Converts an alphanumeric string to a date-time value.

HMIDNT

Changes the time portion of a date-time field to midnight (all zeros).

HNAME

Extracts a specified component from a date-time field and returns it in
alphanumeric format.

HPART

Extracts a specified component from a date-time field and returns it in
numeric format.

HSETPT

Inserts the numeric value of a specified component into a date-time field.

HTIME

Converts the time portion of a date-time field to the number of
milliseconds or microseconds.

JULDAT

Converts dates from year-month-day format to Julian (year-day format).

TIMETOTS

Converts a time to a timestamp.
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TODAY

Retrieves the current date from the system.

YM

Calculates the number of months that elapse between two dates. The dates
must be in year-month format.

Format Conversion Functions
The following functions convert fields from one format to another.

ATODBL

Converts a number in alphanumeric format to double-precision format.

EDIT

Converts an alphanumeric field that contains numeric characters to
numeric format or converts a numeric field to alphanumeric format.

FTOA

Converts a number in a numeric format to alphanumeric format.

HEXBYT

Obtains the ASCII or EBCDIC character equivalent of a decimal integer
value.

ITONUM

Converts a large binary integer in a data source to double-precision format.

ITOPACK

Converts a large binary integer in a data source to packed-decimal format.

ITOZ

Converts a number in numeric format to zoned format.

PCKOUT

Writes a packed number of variable length to an extract file.

Numeric Functions
The following functions perform calculations on numeric constants or fields.

ABS

Returns the absolute value of a number.

BAR

Produces a horizontal bar chart.

CHKPCK

Validates the data in a field described as packed format.

DMOD, FMOD, and IMOD

Calculates the remainder from a division.

EXP

Raises the number ″e″ to a specified power.

INT
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Returns the integer component of a number.

LOG

Returns the natural logarithm of a number.

MAX and MIN

Returns the maximum or minimum value, respectively, from a list of
values.

PRDNOR and PRDUNI

Generates reproducible random numbers.

RDNORM and RDUNIF

Generates random numbers.

SQRT

Calculates the square root of a number.

System Functions
The following functions call the operating system to obtain information about the
operating environment.

FGETENV

Retrieves the value of an environment variable and returns it as an
alphanumeric string.

GETUSER

Retrieves the ID of the connected user.

HHMMSS

Retrieves the current time from the system.

TODAY

Retrieves the current date from the system.

Supplying an Argument in a Function
When supplying an argument in a function, you must understand which types of
arguments are acceptable, the formats and lengths for these arguments, and the
number and order of these arguments.

Argument Types
The following are acceptable arguments for a function:
v Numeric constant, such as 6 or 15.
v Date constant, such as 022802.
v Date in alphanumeric, numeric, or date format.
v Alphanumeric literal, such as STEVENS or NEW YORK NY. A literal must be

enclosed in single quotation marks.
v Number in alphanumeric format.
v Field name, such as FIRST_NAME or HIRE_DATE. A field can be a data source

field or temporary field. The field name can be up to 66 characters long or a
qualified field name, unique truncation, or alias.
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v Expression, such as a numeric, date, or alphanumeric expression. An expression
can use arithmetic operators and the concatenation sign (|). For example, the
following are valid expressions:
CURR_SAL * 1.03 and FN || LN

v Format of the output value enclosed in single quotation marks.
v Another function.

Argument Formats
Depending on the function, an argument can be in alphanumeric, numeric, or date
format. If you supply an argument in the wrong format, you will cause an error or
the function will not return correct data. To obtain the valid formats, click the
Format button on the tool for a list of possible types and lengths. The following
are the types of argument formats:
v Alphanumeric argument. An alphanumeric argument is stored internally as one

character per byte. An alphanumeric argument can be a literal, an alphanumeric
field, a number or date stored in alphanumeric format, an alphanumeric
expression, or the format of an alphanumeric field.

v Numeric argument. A numeric argument is stored internally as a binary or
packed number. A numeric argument includes integer (I), floating-point
single-precision (F), floating-point double-precision (D), and packed-decimal (P)
formats. A numeric argument can be a numeric constant, field, or expression, or
the format of a numeric field. All numeric arguments are converted to
floating-point double-precision format when used with a function, but results are
returned in the format specified for the output field.

v Date argument. A date argument can be in either alphanumeric, numeric, or
date format. The list of arguments for the individual function will specify what
type of format the function accepts. A date argument can be a date in
alphanumeric, numeric, or date format; a date field or expression; or the format
of a date field. If you supply an argument with a two-digit year, the function
assigns a century based on the DATEFNS, YRTHRESH, and DEFCENT
parameter settings.

Using a Function in a Temporary Field
In order to use any of the specified functions described in this reference manual,
you need to create a temporary field.

A temporary field is a field whose value is not stored in the data source, but can
be calculated from the data that is there, or assigned an absolute value. When you
create a temporary field, you determine its value by writing an expression. You can
combine fields, constants, and operators in an expression to produce a single value.
For example, if your data contains salary and deduction amounts, you can
calculate the ratio of deductions to salaries using the following expression:
deduction / salary.

You can specify the expression yourself, or you can use one of the many supplied
functions that perform specific calculations or manipulations. In addition, you can
use expressions and functions as building blocks for more complex expressions, as
well as use one temporary field to evaluate another. You can create temporary
fields from the Field selection tab by selecting the Define or Compute tool.

All examples in this reference manual show the complete syntax for Computed
fields, as seen in a text editor. For example, COMPUTE NAME_LEN/I3 = ARGLEN(15,
LAST_NAME, 'I3');
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When creating a temporary field using the Compute tool, you do not need to:
v Include COMPUTE in the expression, which is implicit.
v End the expression with a semicolon, which is implicit.
v Include AND when creating more than one expression; it is implicit. Each

COMPUTE expression must be created separately as a new temporary field.

To illustrate, the following image in Report Assistant shows the function, ARGLEN
in its full syntax. In the Compute tool, the Field name is NAME_LEN, the Format
is I3, and the expression window contains ARGLEN(15, LAST_NAME, ’I3’).

Character Functions
Character functions manipulate alphanumeric fields and character strings.

ARGLEN: Measuring the Length of a String
The ARGLEN function measures the length of a character string within a field,
excluding trailing spaces. The field format in a Master File specifies the length of a
field, including trailing spaces.

Measure the Length of a Character String
ARGLEN(inlength, infield, 'outfield')

where:

inlength

Integer

Is the length of the field containing the character string, or a field that
contains the length.

infield
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Alphanumeric

Is the name of the field containing the character string.

outfield

Integer

Is the format of the output value enclosed in single quotation marks.

Measuring the Length of a Character String

ARGLEN determines the length of the character string in LAST_NAME and stores
the result in NAME_LEN:
COMPUTE NAME_LEN/I3 = ARGLEN(15, LAST_NAME, 'I3');

BITSON: Determining If a Bit Is On or Off
The BITSON function evaluates an individual bit within a character string to
determine whether it is on or off. If the bit is on, BITSON returns a value of 1; if
the bit is off, it returns a value of 0. This function is useful in interpreting
multi-punch data, where each punch conveys an item of information.

Determine If a Bit Is On or Off
BITSON(bitnumber, string, 'outfield')

where:

bitnumber

Integer

Is the number of the bit to be evaluated, counted from the left-most bit in
the character string.

string

Alphanumeric

Is the character string to be evaluated, enclosed in single quotation marks,
or a field that contains the character string. The character string is in
multiple eight-bit blocks.

outfield

Integer

Is the format of the output value enclosed in single quotation marks.

Evaluating a Bit in a Field

BITSON evaluates the 24th bit of LAST_NAME and stores the result in BIT_24:
COMPUTE BIT_24/I1 = BITSON(24, LAST_NAME, 'I1');

BYTVAL: Translating a Character to a Decimal Value
The BYTVAL function translates a character to the ASCII, EBCDIC, or Unicode
decimal value that represents it, depending on the operating system.

Translate a Character
BYTVAL(character, 'outfield')

where:
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character

Alphanumeric

Is the character to be translated. You can specify a field that contains the
character, or the character itself enclosed in single quotation marks. If you
supply more than one character, the function evaluates the first.

outfield

Integer

Is the format of the output value enclosed in single quotation marks.

Translating the First Character of a Field

BYTVAL translates the first character of LAST_NAME into its ASCII or EBCDIC
decimal value and stores the result in LAST_INIT_CODE. Since the input string
has more than one character, BYTVAL evaluates the first one.
COMPUTE LAST_INIT_CODE/I3 = BYTVAL(LAST_NAME, 'I3');

CHKFMT: Checking the Format of a String
The CHKFMT function checks a character string for incorrect characters or
character types. It compares each character string to a second string, called a mask,
by comparing each character in the first string to the corresponding character in
the mask. If all characters in the character string match the characters or character
types in the mask, CHKFMT returns the value 0. Otherwise, CHKFMT returns a
value equal to the position of the first character in the character string not
matching the mask.

If the mask is shorter than the character string, the function checks only the
portion of the character string corresponding to the mask. For example, if you are
using a four-character mask to test a nine-character string, only the first four
characters in the string are checked; the rest are returned as a no match with
CHKFMT giving the first non-matching position as the result.

Check the Format of a Character String
CHKFMT(numchar, string, 'mask', 'outfield')

where:

numchar

Integer

Is the number of characters being compared to the mask.

string

Alphanumeric

Is the character string to be checked enclosed in single quotation marks, or
a field that contains the character string.

mask

Alphanumeric

Is the mask, which contains the comparison characters enclosed in single
quotation marks.
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Some characters in the mask are generic and represent character types. If a
character in the string is compared to one of these characters and is the
same type, it matches. Generic characters are:

A is any letter between A and Z (uppercase or lowercase).

9 is any digit between 0-9.

X is any letter between A-Z or any digit between 0-9.

$ is any character.

Any other character in the mask represents only that character. For
example, if the third character in the mask is B, the third character in the
string must be B to match.

outfield

Integer

Is the format of the output value enclosed in single quotation marks.

Checking the Format of a Field

CHKFMT examines EMP_ID for nine numeric characters starting with 11 and
stores the result in CHK_ID:
COMPUTE CHK_ID/I3 = CHKFMT(9, EMP_ID, '119999999', 'I3');

CTRAN: Translating One Character to Another
The CTRAN function translates a character within a character string to another
character based on its decimal value. This function is especially useful for changing
replacement characters to unavailable characters, or to characters that are difficult
to input or unavailable on your keyboard.

To use CTRAN, you must know the decimal equivalent of the characters in
internal machine representation.

In Unicode configurations, this function uses values in the range:
v 0 to 255 for 1-byte characters.
v 256 to 65535 for 2-byte characters.
v 65536 to 16777215 for 3-byte characters.
v 16777216 to 4294967295 for 4-byte characters (primarily for EBCDIC).

Translate One Character to Another
CTRAN(charlen, string, decimal, decvalue, 'outfield')

where:

charlen

Integer

Is the number of characters in the string, or a field that contains the length.

string

Alphanumeric

Is the character string to be translated enclosed in single quotation marks,
or the field that contains the character string.

decimal
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Integer

Is the ASCII or EBCDIC decimal value of the character to be translated.

decvalue

Integer

Is the ASCII or EBCDIC decimal value of the character to be used as a
substitute for decimal.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks.

Translating Spaces to Underscores on an EBCDIC Platform

CTRAN translates the spaces in ADDRESS_LN3 (EBCDIC decimal value 64) to
underscores (EBCDIC decimal value 109) and stores the result in ALT_ADDR:
COMPUTE ALT_ADDR/A20 = CTRAN(20, ADDRESS_LN3, 64, 109, 'A20');

CTRFLD: Centering a Character String
The CTRFLD function centers a character string within a field. The number of
leading spaces is equal to or one less than the number of trailing spaces.

CTRFLD is useful for centering the contents of a field and its report column, or a
heading that consists only of an embedded field. HEADING CENTER centers each
field value including trailing spaces. To center the field value without the trailing
spaces, first center the value within the field using CTRFLD.

Limit: Using CTRFLD in a styled report (StyleSheets feature) generally negates the
effect of CTRFLD unless the item is also styled as a centered element. Also, if you
are using CTRFLD on a platform for which the default font is proportional, either
use a non-proportional font, or issue SET STYLE=OFF before running the request.

Center a Character String
CTRFLD(string, length, 'outfield')

where:

string

Alphanumeric

Is the character string enclosed in single quotation marks, or a field that
contains the character string.

length

Integer

Is the number of characters in string and outfield, or a field that contains
the length. This argument must be greater than 0. A length less than 0 can
cause unpredictable results.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks.
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Centering a Field

CTRFLD centers LAST_NAME and stores the result in CENTER_NAME:
COMPUTE CENTER_NAME/A12 = CTRFLD(LAST_NAME, 12, 'A12');

EDIT: Extracting or Adding Characters
The EDIT function extracts characters from or adds characters to an alphanumeric
string. It can extract a substring from different parts of the parent string, and can
also insert characters from a parent string into another substring. For example, it
can extract the first two characters and the last two characters of a string to form a
single substring.

EDIT works by comparing the characters in a mask to the characters in a source
field. When it encounters a nine in the mask, EDIT copies the corresponding
character from the source field to the new field. When it encounters a dollar sign
in the mask, EDIT ignores the corresponding character in the source field. When it
encounters any other character in the mask, EDIT copies that character to the
corresponding position in the new field. EDIT does not require an outfield
argument because the result is obviously alphanumeric and its size is determined
from the mask value.

EDIT can also convert the format of a field. For information on converting a field
with EDIT, see EDIT: Converting the Format of a Field.

Extract or Add Characters
EDIT(fieldname, 'mask');

where:

fieldname

Alphanumeric

Is the source field.

Is the string to extract characters from. It should be at least as long as the
mask.

mask

Alphanumeric

Is a character string enclosed in single quotation marks. The length of the
mask, excluding any characters other than nine and $, determines the
length of the output field.

Extracting and Adding a Character to a Field

EDIT extracts the first initial from the FIRST_NAME field and stores the result in
FIRST_INIT. EDIT also adds dashes to the EMP_ID field and stores the result in
EMPIDEDIT:
COMPUTE FIRST_INIT/A1 = EDIT(FIRST_NAME, '9$$$$$$$$$'); AND
COMPUTE EMPIDEDIT/A11 = EDIT(EMP_ID, '999-99-9999');

GETTOK: Extracting a Substring (Token)
The GETTOK function divides a character string into substrings, called tokens. A
specific character, called a delimiter, occurs in the string and separates the string
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into tokens. GETTOK returns the token specified by the token_number. GETTOK
ignores leading and trailing blanks in the parent character string.

For example, suppose you want to extract the fourth word from a sentence. Use
the space character for a delimiter and four for the token_number. GETTOK
divides the sentence into words using this delimiter, then extracts the fourth word.
If the string is not divided by the delimiter, use the PARAG function for this
purpose.

Extract a Substring (Token)
GETTOK(infield, inlen, token_number, 'delim', outlen, 'outfield')

where:

infield

Alphanumeric

Is the field containing the parent character string.

inlen

Integer

Is the length of the parent string in characters. If this argument is less than
or equal to 0, the function returns spaces.

token_number

Integer

Is the number of the token to extract. If this argument is positive, the
tokens are counted from left to right. If this argument is negative, the
tokens are counted from right to left. For example, -2 extracts the second
token from the right. If this argument is 0, the function returns spaces.
Leading and trailing null tokens are ignored.

delim

Alphanumeric

Is the delimiter in the parent string enclosed in single quotation marks. If
you specify more than one character, only the first character is used.

outlen

Integer

Is the maximum size of the token. If this argument is less than or equal to
0, the function returns spaces. If the token is longer than this argument, it
is truncated; if it is shorter, it is padded with trailing spaces.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks. The
delimiter is not included in the token.

Extracting a Token From a Field

GETTOK extracts the last token from ADDRESS_LN3 and stores the result in
LAST_TOKEN:
COMPUTE LAST_TOKEN/A10 = GETTOK(ADDRESS_LN3, 20, -1, ' ', 10, 'A10');
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LCWORD: Converting a Character String to Mixed Case
The LCWORD function converts the letters in a character string to mixed case. It
converts every alphanumeric character to lowercase except the first letter of each
new word and the first letter after a single or double quotation mark. For example,
O’CONNOR is converted to O’Connor and JACK’S to Jack’S.

If LCWORD encounters a number in the character string, it treats it as an
uppercase character and continues to convert the following alphabetic characters to
lowercase. The result of LCWORD is a word with an initial uppercase character
followed by lowercase characters.

Convert a Character String to Mixed Case
LCWORD(length, string, 'outfield')

where:

length

Integer

Is the length in characters of the character string or field to be converted,
or a field that contains the length.

string

Alphanumeric

Is the character string to be converted enclosed in single quotation marks,
or a field containing the character string.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks. The
length must be greater than or equal to the length of length.

Converting a Character String to Mixed-Case

LCWORD converts the LAST_NAME field to mixed-case and stores the result in
MIXED_CASE:
COMPUTE MIXED_CASE/A15 = LCWORD(15, LAST_NAME, 'A15');

LJUST: Left-Justifying a Character String
The LJUST function left-justifies a character string within a field. All leading spaces
become trailing spaces.

LJUST will not have any visible effect in a report that uses StyleSheets (SET
STYLE=ON) unless you center the item.

Left-Justify a Character String
LJUST(length, string, 'outfield')

where:

length

Integer

Is the length in characters of string and outfield, or a field that contains the
length.
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string

Alphanumeric

Is the character string to be justified, or a field that contains the string.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks.

Left-Justifying a Field

LJUST left-justifies the XNAME field and stores the result in YNAME:
COMPUTE YNAME/A25 = LJUST(15, XNAME, 'A25');

LOCASE: Converting Text to Lowercase
The LOCASE function converts alphanumeric text to lowercase.

Convert Text to Lowercase
LOCASE(length, string, 'outfield')

where:

length

Integer

Is the length in characters of string and outfield, or a field that contains the
length. The length must be greater than 0 and the same for both
arguments; otherwise, an error occurs.

string

Alphanumeric

Is the character string to be converted in single quotation marks, or a field
that contains the string.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks. The
field name can be the same as string.

Converting a Field to Lowercase

LOCASE converts the LAST_NAME field to lowercase and stores the result in
LOWER_NAME:
COMPUTE LOWER_NAME/A15 = LOCASE(15, LAST_NAME, 'A15');

OVRLAY: Overlaying a Character String
The OVRLAY function overlays a base character string with a substring.

Overlay a Character String
OVRLAY(string1, stringlen, string2, sublen, position, 'outfield')

where:

string1
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Alphanumeric

Is the base character string.

stringlen

Integer

Is the length in characters of string1 and outfield, or a field that contains the
length. If this argument is less than or equal to 0, unpredictable results
occur.

string2

Alphanumeric

Is the substring that will overlay string1.

sublen

Integer

Is the length of string2, or a field that contains the length. If this argument
is less than or equal to 0, the function returns spaces.

position

Integer

Is the position in the base string at which the overlay begins. If this
argument is less than or equal to 0, the function returns spaces. If this
argument is larger than stringlen, the function returns the base string.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks. If the
overlaid string is longer than the output field, the string is truncated to fit
the field.

Replacing Characters in a Character String

OVRLAY replaces the last three characters of EMP_ID with CURR_JOBCODE to
create a new security identification code and stores the result in NEW_ID:
COMPUTE NEW_ID/A9 = OVRLAY(EMP_ID, 9, CURR_JOBCODE, 3, 7, 'A9');

PARAG: Dividing Text Into Smaller Lines
The PARAG function divides a line of text into smaller lines by marking them with
a delimiter. It scans a specific number of characters from the beginning of the line
and replaces the last space in the group scanned with the delimiter. It then scans
the next group of characters in the line, starting from the delimiter, and replaces
the last space in this group with a second delimiter. It repeats this process until
reaching the end of the line.

Each group of characters marked off by the delimiter becomes a sub-line. The
GETTOK function can then place the sub-lines into different fields. If the function
does not find any spaces in the group it scans, it replaces the first character after
the group with the delimiter. Therefore, make sure that no word of text is longer
than the number of characters scanned (the maximum sub-line length).

If the input lines of text are roughly equal in length, you can keep the sub-lines
equal by specifying a sub-line length that evenly divides into the length of the text
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lines. For example, if the text lines are 120 characters long, divide each of them
into two sub-lines of 60 characters or three sub-lines of 40 characters. This
technique enables you to print lines of text in paragraph form.

However, if you divide the lines evenly, you may create more sub-lines than you
intend. For example, suppose you divide 120-character text lines into two lines of
60 characters maximum, but one line is divided so that the first sub-line is 50
characters and the second is 55. This leaves room for a third sub-line of 15
characters. To correct this, insert a space (using weak concatenation) at the
beginning of the extra sub-line, then append this sub-line (using strong
concatenation) to the end of the one before it.

Divide Text Into Smaller Lines
PARAG(length, string, 'delim', subsize, 'outfield')

where:

length

Integer

Is the length in characters of string and outfield, or a field that contains the
length.

string

Alphanumeric

Is the text enclosed in single quotation marks, or a field that contains the
text.

delim

Alphanumeric

Is the delimiter enclosed in single quotation marks. Choose a character that
does not appear in the text.

subsize

Integer

Is the maximum length of each sub-line.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks.

Dividing Text Into Smaller Lines

PARAG divides ADDRESS_LN2 into smaller lines of not more than ten characters
using a comma as the delimiter. It then stores the result in PARA_ADDR:
COMPUTE PARA_ADDR/A20 = PARAG(20, ADDRESS_LN2, ',', 10, 'A20');

POSIT: Finding the Beginning of a Substring
The POSIT function finds the starting position of a substring within a larger string.
For example, the starting position of the substring DUCT in the string
PRODUCTION is four. If the substring is not in the parent string, the function
returns the value 0.
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Find the Beginning of a Substring
POSIT(parent, inlength, substring, sublength, 'outfield')

where:

parent

Alphanumeric

Is the parent character string enclosed in single quotation marks, or a field
that contains the parent character string.

inlength

Integer

Is the length of the parent character string in characters, or a field that
contains the length. If this argument is less than or equal to 0, the function
returns a 0.

substring

Alphanumeric

Is the substring whose position you want to find. This can be the substring
enclosed in single quotation marks, or the field that contains the string.

sublength

Integer

Is the length of substring. If this argument is less than or equal to 0, or if it
is greater than inlength, the function returns a 0.

outfield

Integer

Is the format of the output value enclosed in single quotation marks.

Finding the Position of a Letter

POSIT determines the position of the first capital letter I in LAST_NAME and
stores the result in I_IN_NAME:
COMPUTE I_IN_NAME/I2 = POSIT(LAST_NAME, 15, 'I', 1, 'I2');

REVERSE: Reversing Characters in a Character String
The REVERSE function reverses the characters in a character string.

Reverse Characters in a Character String
REVERSE(length, string, 'outfield')

where:

length

Integer

Is the length in characters of string and outfield, or a field that contains the
length.

string

Alphanumeric
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Is the text enclosed in single quotation marks, or a field that contains the
text.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks.

Reversing the Characters in a String

REVERSE reverses the characters in PRODCAT and stores the result in
REVERSE_NAME:
COMPUTE REVERSE_NAME/A15 = REVERSE(15, PRODCAT, 'A15');

RJUST: Right-Justifying a Character String
The RJUST function right-justifies a character string. All trailing blacks become
leading blanks. This is useful when you display alphanumeric fields containing
numbers.

RJUST does not have any visible effect in a report that uses StyleSheets (SET
STYLE=ON) unless you center the item. Also, if you use RJUST on a platform on
which StyleSheets are turned on by default, issue SET STYLE=OFF before running
the request.

Right-Justify a Character String
RJUST(length, string, 'outfield')

where:

length

Integer

Is the length in characters of string and outfield, or a field that contains the
length. The lengths must be the same to avoid justification problems.

string

Alphanumeric

Is the character string, or a field that contains the character string enclosed
in single quotation marks.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks.

Right-Justifying a Field

RJUST right-justifies the LAST_NAME field and stores the result in
RIGHT_NAME:
COMPUTE RIGHT_NAME/A15 = RJUST(15, LAST_NAME, 'A15');

SOUNDEX: Comparing Character Strings Phonetically
The SOUNDEX function searches for a character string phonetically without regard
to spelling. It converts character strings to four character codes. The first character
must be the first character in the string. The last three characters represent the next
three significant sounds in the character string.
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To conduct a phonetic search, do the following:
1. Use SOUNDEX to translate data values from the field you are searching for to

the phonetic codes.
2. Use SOUNDEX to translate your best guess target string to a phonetic code.

Remember that the spelling of your target string need be only approximate;
however, the first letter must be correct.

3. Use WHERE or IF criteria to compare the temporary fields created in Step 1 to
the temporary field created in Step 2.

Compare Character Strings Phonetically
SOUNDEX(inlength, string, 'outfield')

where:

inlength

2-byte Alphanumeric

Is the length, in characters, of string, or a field that contains the length. It
can be a number enclosed in single quotation marks, or a field containing
the number. The number must be from 01 to 99, expressed with two digits
(for example ’01’); a number larger than 99 causes the function to return
asterisks (*) as output.

string

Alphanumeric

Is the character string enclosed in single quotation marks, or a field that
contains the character string.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks.

Comparing Character Strings Phonetically

The following request creates three fields:
v PHON_NAME contains the phonetic code of employee last names.
v PHON_COY contains the phonetic code of your guess, MICOY.
v PHON_MATCH compares the guess with the phonetic code.
COMPUTE PHON_NAME/A4 = SOUNDEX('15', LAST_NAME, 'A4'); AND
COMPUTE PHON_COY/A4 WITH LAST_NAME = SOUNDEX('15', 'MICOY', 'A4'); AND
COMPUTE PHON_MATCH/A3 = IF PHON_NAME IS PHON_COY THEN 'YES' ELSE 'NO';

SPELLNM: Spelling Out a Dollar Amount
The SPELLNM function spells out an alphanumeric string or numeric value
containing two decimal places as dollars and cents. For example, the value 32.50 is
THIRTY TWO DOLLARS AND FIFTY CENTS.

Spell Out a Dollar Amount
SPELLNM(outlength, number, 'outfield')

where:

outlength

Integer
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Is the length of outfield in characters, or a field that contains the length.

If you know the maximum value of number, use the following table to
determine the value of outlength:

If number is less than... ...outlength should be

$10 37

$100 45

$1,000 59

$10,000 74

$100,000 82

$1,000,000 96

number

Alphanumeric or Decimal (9.2)

Is the number to be spelled out.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks.

Spelling Out a Dollar Amount

SPELLNM spells out the values in CURR_SAL and stores the result in
AMT_IN_WORDS:
COMPUTE AMT_IN_WORDS/A82 = SPELLNM(82, CURR_SAL, 'A82');

SUBSTR: Extracting a Substring
The SUBSTR function extracts a substring based on where it begins and its length
in the parent string. SUBSTR can vary the position of the substring depending on
the values of other fields.

Extract a Substring
SUBSTR(inlength, parent, start, end, sublength, 'outfield')

where:

inlength

Integer

Is the length of the parent string in characters, or a field that contains the
length.

parent

Alphanumeric

Is the parent string enclosed in single quotation marks, or the field
containing the parent string.

start

Integer

Is the starting position of the substring in the parent string. If this
argument is less than one, the function returns spaces.
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end

Integer

Is the ending position of the substring. If this argument is less than start or
greater than inlength, the function returns spaces.

sublength

Integer

Is the length of the substring (normally end - start + 1). If sublength is
longer than end - start +1, the substring is padded with trailing spaces. If it
is shorter, the substring is truncated. This value should be the declared
length of outfield. Only sublength characters will be processed.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks.

Extracting a String

POSIT determines the position of the first letter I in LAST_NAME and stores the
result in I_IN_NAME. SUBSTR then extracts three characters beginning with the
letter I from LAST_NAME, and stores the results in I_SUBSTR.
COMPUTE I_IN_NAME/I2 = POSIT(LAST_NAME, 15, 'I', 1, 'I2'); AND
COMPUTE I_SUBSTR/A3 = SUBSTR(15, LAST_NAME, I_IN_NAME, I_IN_NAME+2, 3, 'A3');

UPCASE: Converting Text to Uppercase
The UPCASE function converts a character string to uppercase. It is useful for
sorting on a field that contains both mixed-case and uppercase values. Sorting on a
mixed-case field produces incorrect results because the sorting sequence in
EBCDIC always places lowercase letters before uppercase letters, while the ASCII
sorting sequence always places uppercase letters before lowercase. To obtain
correct results, define a new field with all of the values in uppercase, and sort on
that.

Convert Text to Uppercase
UPCASE(length, input, 'outfield')

where:

length

Integer

Is the length in characters of input and outfield.

input

Alphanumeric

Is the character string enclosed in single quotation marks, or the field
containing the character string.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks.
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Converting a Mixed-Case Field to Uppercase

UPCASE converts the LAST_NAME_MIXED field to uppercase and stores the
result in LAST_NAME_UPPER:
COMPUTE LAST_NAME_UPPER/A15 = UPCASE(15, LAST_NAME_MIXED, 'A15') ;

Data Source and Decoding Functions
Data source and decoding functions retrieve data source values and assign values
based on the value of an input field.

DECODE: Decoding Values
The DECODE function assigns values based on the coded value of an input field.
DECODE is useful for giving a more meaningful value to a coded value in a field.
For example, the field GENDER may have the code F for female employees and M
for male employees for efficient storage (for example, one character instead of six
for female). DECODE expands (decodes) these values to ensure correct
interpretation on a report.

You can use DECODE by supplying values directly in the function or by reading
values from a separate file.

Supply Values in the Function
DECODE fieldname(code1 result1 code2 result2...[ELSE default]);

where:

fieldname

Alphanumeric or Numeric

Is the name of the input field.

code

Alphanumeric or Numeric

Is the coded value for which DECODE searches. If the value has
embedded blanks, commas, or other special characters, enclose it in single
quotation marks. When DECODE finds the specified value, it assigns the
corresponding result.

result

Alphanumeric or Numeric

Is the value assigned to a code. If the value has embedded blanks or
commas or contains a negative number, enclose it in single quotation
marks.

default

Alphanumeric or Numeric

Is the value assigned if the code is not found. If you omit a default value,
DECODE assigns a blank or zero to non-matching codes.

You can use up to 40 lines to define the code and result pairs for any given
DECODE function, or 39 lines if you also use an ELSE phrase. Use either a comma
or blank to separate the code from the result, or one pair from another.
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Supplying Values in the Function

EDIT extracts the first character of the CURR_JOBCODE field, then DECODE
returns either ADMINISTRATIVE or DATA PROCESSING depending on the value
extracted.
COMPUTE DEPX_CODE/A1 = EDIT(CURR_JOBCODE, '9$$'); AND
COMPUTE JOB_CATEGORY/A15 = DECODE DEPX_CODE(A 'ADMINISTRATIVE'
B 'DATA PROCESSING') ;

Read Values From a File
DECODE fieldname(ddname [ELSE default]);

where:

fieldname

Alphanumeric or Numeric

Is the name of the input field.

ddname

Alphanumeric

Is a logical name or a shorthand name that points to the physical file
containing the decoded values.

default

Alphanumeric or Numeric

Is the value assigned if the code is not found. If you omit a default,
DECODE assigns a blank or zero to non-matching codes.

Guidelines for Reading Values From a File
v Each record in the file is expected to contain pairs of elements separated by a

comma or blank.
v If each record in the file consists of only one element, this element is interpreted

as the code, and the result becomes either a blank or zero, as needed.
This makes it possible to use the file to hold screening literals referenced in the
screening condition
IF field IS (filename)

and as a file of literals for an IF criteria specified in a computational expression.
For example:
TAKE = DECODE SELECT (filename ELSE 1);
VALUE = IF TAKE IS 0 THEN... ELSE...;

TAKE is 0 for SELECT values found in the literal file and 1 in all other cases.
The VALUE computation is carried out as if the expression had been:
IF SELECT (filename) THEN... ELSE...;

v The file can contain up to 32,767 characters in the file.
v Leading and trailing blanks are ignored.
v The remainder of each record is ignored and can be used for comments or other

data. This convention applies in all cases, except when the file name is HOLD.
In that case, the file is presumed to have been created by the HOLD command,
which writes fields in the internal format, and the DECODE pairs are interpreted
accordingly. In this case, extraneous data in the record is ignored.
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Reading Values From a File

DECODE assigns the value 0 to an employee whose EMP_ID appears in the HOLD
file and 1 when EMP_ID does not appear in the file.
COMPUTE NOT_IN_LIST/I1 = DECODE EMP_ID(HOLD ELSE 1);

LAST: Retrieving the Preceding Value
The LAST function retrieves the preceding value for a field.

The effect of LAST depends on whether it appears in a DEFINE or COMPUTE
command:
v In a DEFINE command, the LAST value applies to the previous record retrieved

from the data source before sorting takes place.
v In a COMPUTE command, the LAST value applies to the record in the previous

line of the internal matrix.

Retrieve the Preceding Value
LAST fieldname

where:

fieldname

Alphanumeric or Numeric

Is the field name.

Retrieving the Preceding Value

LAST retrieves the previous value of the DEPARTMENT field to determine
whether to restart the running total of salaries by department. If the previous value
equals the current value, CURR_SAL is added to RUN_TOT to generate a running
total of salaries within each department.
COMPUTE RUN_TOT/D12.2M = IF DEPARTMENT EQ LAST DEPARTMENT THEN

(RUN_TOT + CURR_SAL) ELSE CURR_SAL ;

Date and Time Functions
Date and time functions manipulate date and time values.

When using standard date and time functions, you need to understand the settings
that alter the behavior of these functions, as well as the acceptable formats and
how to supply values in these formats.

You can affect the behavior of date and time functions by defining which days of
the week are work days and which are not. Then, when you use a date function
involving work days, dates that are not work days are ignored.

AYM: Adding or Subtracting Months to or From Dates
The AYM function adds months to or subtracts months from a date in year-month
format. You can convert a date to this format using the CHGDAT or EDIT
function.
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Add or Subtract Months to or From a Date
AYM(indate, months, 'outfield')

where:

indate

Integer (I4, I4YM, I6, or I6YYM)

Is the original date in year-month format, the name of a field that contains
the date, or an expression that returns the date. If the date is not valid, the
function returns a 0.

months

Integer

Is the number of months you are adding to or subtracting from the date.
To subtract months, use a negative number.

outfield

Integer (I4YM or I6YYM)

Is the format of the output value enclosed in single quotation marks.

Tip: If the input date is in integer year-month-day format (I6YMD or
I8YYMD), divide the date by 100 to convert to year-month format and set
the result to an integer. This drops the day portion of the date, which is
now after the decimal point.

Adding Months to a Date

The COMPUTE command converts the dates in HIRE_DATE from year-month-day
to year-month format and stores the result in HIRE_MONTH. AYM then adds six
months to HIRE_MONTH and stores the result in AFTER6MONTHS.
COMPUTE HIRE_MONTH/I4YM = HIRE_DATE/100; AND
COMPUTE AFTER6MONTHS/I4YM = AYM(HIRE_MONTH, 6, 'I4YM');

AYMD: Adding or Subtracting Days to or From a Date
The AYMD function adds days to or subtracts days from a date in year-month-day
format. You can convert a date to this format using the CHGDAT or EDIT
function.

If the addition or subtraction of days crosses forward or backward into another
century, the century digits of the output year are adjusted.

Add or Subtract Days to or From a Date
AYMD(indate, days, 'outfield')

where:

indate

Integer (I6, I6YMD, I8, I8YYMD)

If the date is not valid, the function returns a 0.

days

Integer
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Is the number of days you are adding to or subtracting from indate. To
subtract days, use a negative number.

outfield

Integer (I6, I6YMD, I8, or I8YYMD)

Is the format of the output value enclosed in single quotation marks. If
indate is a field, outfield must have the same format.

Adding Days to a Date

AYMD adds 35 days to each value in the HIRE_DATE field, and stores the result in
AFTER35DAYS:
COMPUTE AFTER35DAYS/I6YMD = AYMD(HIRE_DATE, 35, 'I6YMD');

CHGDAT: Changing How a Date String Displays
The CHGDAT function rearranges the year, month, and day portions of an input
character string representing a date. It may also convert the input string from long
to short or short to long date representation. Long representation contains all three
date components: year, month, and day; short representation omits one or two of
the date components, such as year, month, or day. The input and output date
strings are described by display options that specify both the order of date
components (year, month, day) in the date string and whether two or four digits
are used for the year (for example, 97 or 1997). CHGDAT reads an input date
character string and creates an output date character string that represents the
same date in a different way.

Note: CHGDAT requires a date character string as input, not a date itself. Convert
the input to a date character string (using the EDIT or DATECVT functions, for
example) before applying CHGDAT.

The order of date components in the date character string is described by display
options comprised of the following characters in your chosen order:

Character Description

D Day of the month (01 through 31).

M Month of the year (01 through 12).

Y[Y] Year. Y indicates a two-digit year (such as
94); YY indicates a four-digit year (such as
1994).

To spell out the month rather than use a number in the resulting string, append
one of the following characters to the display options for the resulting string:

Character Description

T Displays the month as a three-letter
abbreviation.

X Displays the full name of the month.

Display options can consist of up to five display characters. Characters other than
those display options are ignored.
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For example: The display options ’DMYY’ specify that the date string starts with a
two digit day, then two digit month, then four digit year.

Note: Display options are not date formats.

Short to Long Conversion

If you are converting a date from short to long representation (for example, from
year-month to year-month-day), the function supplies the portion of the date
missing in the short representation, as shown in the following table:

Portion of Date Missing Portion Supplied by Function

Day (for example, from YM to YMD) Last day of the month.

Month (for example, from Y to YM) Last month of the year (December).

Year (for example, from MD to YMD) The year 99.

Converting year from two-digit to four-digit
(for example, from YMD to YYMD)

If DATEFNS=ON, the century will be
determined by the 100-year window defined
by DEFCENT and YRTHRESH.

If DATEFNS=OFF, the year 19xx is supplied,
where xx is the last two digits in the year.

Change the Date Display String
CHGDAT('in_display_options', 'out_display_options', date_string, 'outfield')

where:

in_display_options

Alphanumeric (A1 to A5)

Is a series of up to five display options that describe the layout of
date_string. These options can be stored in an alphanumeric field or
supplied as a literal enclosed in single quotation marks.

out_display_options

Alphanumeric (A1 to A5)

Is a series of up to five display options that describe the layout of the
converted date string. These options can be stored in an alphanumeric field
or supplied as a literal enclosed in single quotation marks.

date_string

Alphanumeric (A2 to A8)

Is the input date character string with date components in the order
specified by in_display_options.

Note that if the original date is in numeric format, you must convert it to a
date character string. If date_string does not correctly represent the date
(the date is invalid), the function returns blank spaces.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks.
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Axx, where xx is a number of characters large enough to fit the date string
specified by out_display_options. A17 is long enough to fit the longest date
string.

Usage Notes for CHGDAT

Since CHGDAT uses a date string (as opposed to a date) and returns a date string
with up to 17 characters, use the EDIT or DATECVT functions or any other means
to convert the date to or from a date character string.

Converting the Date Display From YMD to MDYYX

The EDIT function changes HIRE_DATE from numeric to alphanumeric format.
CHGDAT then converts each value in ALPHA_HIRE from displaying the
components as YMD to MDYYX and stores the result in HIRE_MDY, which has the
format A17. The option X in the output value displays the full name of the month.
COMPUTE ALPHA_HIRE/A17 = EDIT(HIRE_DATE); AND
COMPUTE HIRE_MDY/A17 = CHGDAT('YMD', 'MDYYX', ALPHA_HIRE, 'A17');

DA Functions: Converting a Date to an Integer
The DA functions convert a date to the number of days between December 31,
1899 and that date. By converting a date to the number of days, you can add and
subtract dates and calculate the intervals between them.

There are six DA functions; each one accepts a date in a different format.

Convert a Date to an Integer
function(indate, 'outfield')

where:

function

Is one of the following:

DADMY converts a date in day-month-year format.

DADYM converts a date in day-year-month format.

DAMDY converts a date in month-day-year format.

DAMYD converts a date in month-year-day format.

DAYDM converts a date in year-day-month format.

DAYMD converts a date in year-month-day format.

indate

Integer or Packed

I or P format with date display options.

Is the date to be converted, or the name of a field that contains the date.
The date is truncated to an integer before conversion.

To specify the year, enter only the last two digits; the function assumes the
century component. If the date is invalid, the function returns a 0.

outfield

Integer
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Is the format of the output value enclosed in single quotation marks. The
format of the date returned depends on the function.

Converting Dates and Calculating the Difference Between Them

DAYMD converts the DAT_INC and HIRE_DATE fields to the number of days
since December 31, 1899, and the smaller number is then subtracted from the
larger number:
COMPUTE DAYS_HIRED/I8 = DAYMD(DAT_INC, 'I8') - DAYMD(HIRE_DATE, 'I8');

DATEADD: Adding or Subtracting a Date Unit to or From a
Date

The DATEADD function adds a unit to or subtracts a unit from a date format. A
unit is one of the following:
v Year.

v Month. If the calculation using the month unit creates an invalid date,
DATEADD corrects it to the last day of the month. For example, adding one
month to October 31 yields November 30, not November 31 since November has
30 days.

v Day.

v Weekday. When using the weekday unit, DATEADD does not count Saturday or
Sunday. For example, if you add one day to Friday, the result is Monday.

v Business day. When using the business day unit, DATEADD uses the BUSDAYS
parameter setting and holiday file to determine which days are working days
and disregards the rest. If Monday is not a working day, then one business day
past Sunday is Tuesday.

You add or subtract non day-based dates (for example, YM or YQ) directly without
using DATEADD.

DATEADD works only with full component dates.

Add or Subtract a Date Unit to or From a Date
DATEADD(date, 'unit', #units)

where:

date

Date

Is a full component date.

unit

Alphanumeric

Is one of the following enclosed in single quotation marks:

Y indicates a year unit.

M indicates a month unit.

D indicates a day unit.

WD indicates a weekday unit.

BD indicates a business day unit.

#units
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Integer

Is the number of date units added to or subtracted from date. If this
number is not a whole unit, it is rounded down to the next largest integer.

Adding Weekdays to a Date

DATEADD adds three weekdays to NEW_DATE. In some cases, it adds more than
three days because HIRE_DATE_PLUS_THREE would otherwise be on a weekend.
COMPUTE NEW_DATE/YYMD = HIRE_DATE; AND
COMPUTE HIRE_DATE_PLUS_THREE/YYMD = DATEADD(NEW_DATE, 'WD', 3);

DATECVT: Converting the Format of a Date
The DATECVT function converts the format of a date in an application without
requiring an intermediate calculation. If you supply an invalid format, DATECVT
returns a zero or a blank.

DATECVT turns off optimization and compilation.

Note: You can use simple assignment instead of calling this function.

Convert a Date Format
DATECVT(date, 'infmt', 'outfmt')

where:

date

Date

Is the date to be converted. If you supply an invalid date, DATECVT
returns zero. When the conversion is performed, a legacy date obeys any
DEFCENT and YRTHRESH parameter settings supplied for that field.

infmt

Alphanumeric

Is the format of the date enclosed in single quotation marks. It is one of the
following:
v A non-legacy date format (for example, YYMD, YQ, M, DMY, JUL).
v A legacy date format (for example, I6YMD or A8MDYY).
v A non-date format (such as I8 or A6). A non-date format in infmt

functions as an offset from the base date of a YYMD field (12/31/1900).

outfmt

Alphanumeric

Is the output format enclosed in single quotation marks. It is one of the
following:
v A non-legacy date format (for example, YYMD, YQ, M, DMY, JUL).
v A legacy date format (for example, I6YMD or A8MDYY).
v A non-date format (such as I8 or A6). A non-date format in infmt

functions as an offset from the base date of a YYMD field (12/31/1900).
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Converting a YYMD Date to DMY

DATECVT converts 19991231 to 311299 and stores the result in CONV_FIELD:
COMPUTE CONV_FIELD/DMY = DATECVT(19991231, 'I8YYMD', 'DMY');

or
COMPUTE CONV_FIELD/DMY = DATECVT('19991231', 'A8YYMD', 'DMY');

Converting a Legacy Date to Date Format

DATECVT converts HIRE_DATE from I6YMD legacy date format to YYMD date
format:
COMPUTE NEW_HIRE_DATE/YYMD = DATECVT(HIRE_DATE, 'I6YMD', 'YYMD');

DATEDIF: Finding the Difference Between Two Dates
The DATEDIF function returns the difference between two dates in units. A unit is
one of the following:
v Year. Using the year unit with DATEDIF yields the inverse of DATEADD. If

subtracting one year from date X creates date Y, then the count of years between
X and Y is one. Subtracting one year from February 29 produces the date
February 28.

v Month. Using the month unit with DATEDIF yields the inverse of DATEADD. If
subtracting one month from date X creates date Y, then the count of months
between X and Y is one. If the to-date is the end-of-month, then the month
difference may be rounded up (in absolute terms) to guarantee the inverse rule.
If one or both of the input dates is the end of the month, DATEDIF takes this
into account. This means that the difference between January 31 and April 30 is
three months, not two months.

v Day.

v Weekday. With the weekday unit, DATEDIF does not count Saturday or Sunday
when calculating days. This means that the difference between Friday and
Monday is one day.

v Business day. With the business day unit, DATEDIF uses the BUSDAYS
parameter setting and holiday file to determine which days are working days
and disregards the rest. This means that if Monday is not a working day, the
difference between Friday and Tuesday is one day.

DATEDIF returns a whole number. If the difference between two dates is not a
whole number, DATEDIF truncates the value to the next largest integer. For
example, the number of years between March 2, 2001, and March 1, 2002, is zero. If
the end date is before the start date, DATEDIF returns a negative number.

You can find the difference between non-day based dates (for example YM or YQ)
directly without using DATEDIF.

Find the Difference Between Two Dates
DATEDIF(from_date, to_date, 'unit')

where:

from_date

Date
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Is the start date from which to calculate the difference. Is a full component
date.

to_date

Date

Is the end date from which to calculate the difference.

unit

Alphanumeric

Is one of the following enclosed in single quotation marks:

Y indicates a year unit.

M indicates a month unit.

D indicates a day unit.

WD indicates a weekday unit.

BD indicates a business day unit.

Finding the Number of Weekdays Between Two Dates

DATECVT converts the legacy dates in HIRE_DATE and DAT_INC to the date
format YYMD. DATEDIF then uses those date formats to determine the number of
weekdays between NEW_HIRE_DATE and NEW_DAT_INC:
COMPUTE NEW_HIRE_DATE/YYMD = DATECVT(HIRE_DATE, 'I6YMD', 'YYMD'); AND
COMPUTE NEW_DAT_INC/YYMD = DATECVT(DAT_INC, 'I6YMD', 'YYMD'); AND
COMPUTE WDAYS_HIRED/I8 = DATEDIF(NEW_HIRE_DATE, NEW_DAT_INC, 'WD');

DATEMOV: Moving a Date to a Significant Point
The DATEMOV function moves a date to a significant point on the calendar.

DATEMOV works only with full component dates.

Move a Date to a Significant Point
DATEMOV(date, 'move-point')

where:

date

Date

Is a full component date. Is the date to be moved.

move-point

Alphanumeric

Is the significant point the date is moved to enclosed in single quotation
marks. An invalid point results in a return code of zero. Valid values are:

EOM is the end of month.

BOM is the beginning of month.

EOQ is the end of quarter.

BOQ is the beginning of quarter.

EOY is the end of year.
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BOY is the beginning of year.

EOW is the end of week.

BOW is the beginning of week.

NWD is the next weekday.

NBD is the next business day.

PWD is the prior weekday.

PBD is the prior business day.

WD- is a weekday or earlier.

BD- is a business day or earlier.

WD+ is a weekday or later.

BD+ is a business day or later.

A business day calculation is affected by the BUSDAYS and HDAY
parameter settings.

Determining the End of the Week

DATEMOV determines the end of the week for each date in NEW_DATE and
stores the result in EOW:
COMPUTE NEW_DATE/YYMDWT = DATECVT(HIRE_DATE, 'I6YMD', 'YYMDWT'); AND
COMPUTE EOW/YYMDWT = DATEMOV(NEW_DATE, 'EOW');

DATETRAN: Formatting Dates in International Formats
The DATETRAN function formats dates in international formats.

Format Dates in International Formats
DATETRAN (indate, '(intype)', '([formatops])', 'lang', outlen, 'outfield')

where:

indate

Is the input date to be formatted. Note that the date format cannot be an
alphanumeric or numeric format with date display options.

intype

Is one of the following character strings indicating the input date
components and the order in which you want them to display, enclosed in
single quotation marks and parentheses.

These are the single component input types:

Single Component Input Type Description

'(W)' Day of week component only (original
format must have only W component).

'(M)' Month component only (original format
must have only M component).
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These are the two-component input types:

Two-Component Input Type Description

'(YYM)' Four-digit year followed by month.

'(YM)' Two-digit year followed by month.

'(MYY)' Month component followed by four-digit
year.

'(MY)' Month component followed by two-digit
year.

These are the three-component input types:

Three- Component Input Type Description

'(YYMD)' Four-digit year followed by month followed
by day.

'(YMD)' Two-digit year followed by month followed
by day.

'(DMYY)' Day component followed by month followed
by four-digit year.

'(DMY)' Day component followed by month followed
by two-digit year.

'(MDYY)' Month component followed by day followed
by four-digit year.

'(MDY)' Month component followed by day followed
by two-digit year.

'(MD)' Month component followed by day (derived
from three-component date by ignoring year
component).

'(DM)' Day component followed by month (derived
from three-component date by ignoring year
component).

formatops

Is a string of zeros or more formatting options enclosed in parentheses and
single quotation marks. The parentheses and quotation marks are required
even if you do not specify formatting options. Formatting options are as
follows:
v Options for suppressing initial zeros in month or day numbers.
v Options for translating month or day components to full or abbreviated

uppercase or default case (mixed case or lowercase depending on the
language) names.

v Date delimiter options and options for punctuating a date with commas.

Valid options for suppressing initial zeros in month or day numbers are:

Format Option Description

m Zero-suppresses months (displays numeric
months before October as 1 through 9 rather
than 01 through 09).

d Displays days before the tenth of the month
as 1 through 9 rather than 01 through 09.
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Format Option Description

dp Displays days before the tenth of the month
as 1 through 9 rather than 01 through 09
with a period after the number.

do Displays days before the tenth of the month
as 1 through 9. For English (langcode EN)
only, displays an ordinal suffix (st, nd, rd, or
th) after the number.

Valid month and day name translation options are:

Format Option Description

T Displays month as an abbreviated name
with no punctuation, all uppercase.

TR Displays month as a full name, all
uppercase.

Tp Displays month as an abbreviated name
followed by a period, all uppercase.

t Displays month as an abbreviated name
with no punctuation. The name is all
lowercase or initial uppercase, depending on
language code.

tr Displays month as a full name. The name is
all lowercase or initial uppercase, depending
on language code.

tp Displays month as an abbreviated name
followed by a period. The name displays in
the default case of the specified language
(for example, all lowercase for French and
Spanish, initial uppercase for English and
German).

W Includes an abbreviated day of the week
name at the start of the displayed date, all
uppercase with no punctuation.

WR Includes a full day of the week name at the
start of the displayed date, all uppercase.

Wp Includes an abbreviated day of the week
name at the start of the displayed date, all
uppercase, followed by a period.

w Includes an abbreviated day of the week
name at the start of the displayed date with
no punctuation. The name displays in the
default case of the specified language (for
example, all lowercase for French and
Spanish, initial uppercase for English and
German).

wr Includes a full day of the week name at the
start of the displayed date. The name
displays in the default case of the specified
language (for example, all lowercase for
French and Spanish, initial uppercase for
English and German).
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Format Option Description

wp Includes an abbreviated day of the week
name at the start of the displayed date
followed by a period. The name displays in
the default case of the specified language
(for example, all lowercase for French and
Spanish, initial uppercase for English and
German).

X Includes an abbreviated day of the week
name at the end of the displayed date, all
uppercase with no punctuation.

XR Includes a full day of the week name at the
end of the displayed date, all uppercase.

Xp Includes an abbreviated day of the week
name at the end of the displayed date, all
uppercase, followed by a period.

x Includes an abbreviated day of the week
name at the end of the displayed date with
no punctuation. The name displays in the
default case of the specified language (for
example, all lowercase for French and
Spanish, initial uppercase for English and
German).

xr Includes a full day of the week name at the
end of the displayed date. The name
displays in the default case of the specified
language (for example, all lowercase for
French and Spanish, initial uppercase for
English and German).

xp Includes an abbreviated day of the week
name at the end of the displayed date
followed by a period. The name displays in
the default case of the specified language
(for example, all lowercase for French and
Spanish, initial uppercase for English and
German).

Valid date delimiter options are:

Format Option Description

B Uses a blank as the component delimiter.
This is the default if the month or day of
week is translated or if comma is used.

. Uses a period as the component delimiter.

- Uses a minus sign as the component
delimiter. This is the default when the
conditions for a blank default delimiter are
not satisfied.

/ Uses a slash as the component delimiter.

| Omits component delimiters.

K Uses appropriate Asian characters as
component delimiters.
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Format Option Description

c Places a comma after the month name
(following T, Tp, TR, t, tp, or tr).

Places a comma and blank after the day
name (following W, Wp, WR, w, wp, or wr).

Places a comma and blank before the day
name (following X, XR, x, or xr).

e Displays the Spanish or Portuguese word de
or DE between the day and month and
between the month and year. The case of the
word de is determined by the case of the
month name. If the month is displayed in
uppercase, DE is displayed; otherwise de is
displayed. Useful for formats DMY, DMYY,
MY, and MYY.

D Inserts a comma after the day number and
before the general delimiter character
specified.

Y Inserts a comma after the year and before
the general delimiter character specified.

lang

Is the two-character standard ISO code for the language into which the
date should be translated, enclosed in single quotation marks. Valid
language codes are:

’AR’ Arabic

’CS’ Czech

’DA’ Danish

’DE’ German

’DU’ Dutch

’EN’ English

’ES’ Spanish

’FI’ Finnish

’FR’ French

’EL’ Greek

’IW’ Hebrew

’IT’ Italian

’JA’ Japanese

’KO’ Korean

’LT’ Lithuanian

’NO’ Norwegian

’PO’ Polish

’PT’ Portuguese

’RU’ Russian
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’SV’ Swedish

’TH’ Thai

’TR’ Turkish

’TW’ Chinese (Traditional)

’ZH’ Chinese (Simplified)

outlen

Numeric

Is the length of the output field in bytes. If the length is insufficient, an all
blank result is returned. If the length is greater than required, the field is
padded with blanks on the right.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks.

Usage Notes for the DATETRAN Function
v The type A output field may contain variable length information, since the

lengths of month names and day names can vary. Also month and day numbers
may be either one or two bytes long if a zero-suppression option is chosen.
Unused bytes are filled with blanks.

v All invalid and inconsistent inputs result in all blank output strings. Missing
data also results in blank output.

v The base dates (1900-12-31 and 1900-12 or 1901-01) are treated as though the
DATEDISPLAY setting were ON (that is, not automatically shown as blanks). To
suppress the printing of base dates, which have an internal integer value of 0,
test for 0 before calling DATETRAN. For example:
RESULT/A40 = IF DATE EQ 0 THEN ' ' ELSE

DATETRAN (DATE, '(YYMD)', '(.t)', 'FR', 40, 'A40');

v Valid translated date components are contained in files named DTLNGlng where
lng is a three-character code that specifies the language. These files must be
accessible for each language into which you want to translate dates.

Using the DATETRAN Function

DATETRAN prints the day of the week in the default case for French:
COMPUTE OUT/A8=DATETRAN(DATEW, '(W)', '(wr)', 'FR', 8 , 'A8') ;

DMY, MDY, YMD: Calculating the Difference Between Two
Dates

The DMY, MDY, and YMD functions calculate the difference between two dates in
integer, alphanumeric, or packed format.

Calculate the Difference Between Two Dates
function(begin, end)

where:

function

Is one of the following:

DMY calculates the difference between two dates in day-month-year format.
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MDY calculates the difference between two dates in month-day-year format.

YMD calculates the difference between two dates in year-month-day format.

begin

Integer, Packed, or Alphanumeric

I, P, or A format with date display options.

Is the beginning date, or the name of a field that contains the date.

end

Integer, Packed, or Alphanumeric

I, P, or A format with date display options.

Is the end date, or the name of a field that contains the date.

Calculating the Number of Days Between Two Dates

YMD calculates the number of days between the dates in HIRE_DATE and
DAT_INC:
COMPUTE DIFF/I4 = YMD(HIRE_DATE, FST.DAT_INC);

DOWK and DOWKL: Finding the Day of the Week
The DOWK and DOWKL functions find the day of the week that corresponds to a
date. DOWK returns the day as a three letter abbreviation; DOWKL displays the
full name of the day.

Find the Day of the Week
{DOWK|DOWKL}(indate, 'outfield')

where:

indate

Integer (I6YMD or I8 YMD)

Is the input date in year-month-day format. If the date is not valid, the
function returns spaces. If the date specifies a two-digit year and
DEFCENT and YRTHRESH values have not been set, the function assumes
the 20th century.

outfield

DOWK: Alphanumeric

DOWKL: Alphanumeric

Is the format of the output value enclosed in single quotation marks.

Finding the Day of the Week

DOWK determines the day of the week that corresponds to the value in the
HIRE_DATE field and stores the result in DATED:
COMPUTE DATED/A3 = DOWK(HIRE_DATE, 'A3');

DT Functions: Converting an Integer to a Date
The DT functions convert an integer representing the number of days elapsed since
December 31, 1899 to the corresponding date. They are useful when you are
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performing arithmetic on a date converted to the number of days. The DT
functions convert the result back to a date.

There are six DT functions; each one converts a number into a date of a different
format.

Note: When USERFNS is set to LOCAL, DT functions only display a six-digit date.

Convert an Integer to a Date
function(number, 'outfield')

where:

function

Is one of the following:

DTDMY converts a number to a day-month-year date.

DTDYM converts a number to a day-year-month date.

DTMDY converts a number to a month-day-year date.

DTMYD converts a number to a month-year-day date.

DTYDM converts a number to a year-day-month date.

DTYMD converts a number to a year-month-day date.

number

Integer

Is the number of days since December 31, 1899. The number is truncated to
an integer.

outfield

Integer

I6xxx, where xxx corresponds to the function DTxxx in the above list.

Is the format of the output value enclosed in single quotation marks. The
output format depends on the function being used.

Converting an Integer to a Date

DTMDY converts the NEWF field (which was converted to the number of days by
DAYMD) to the corresponding date and stores the result in NEW_HIRE_DATE:
COMPUTE NEWF/I8 WITH EMP_ID = DAYMD(HIRE_DATE, NEWF); AND
COMPUTE NEW_HIRE_DATE/I8MDYY WITH EMP_ID = DTMDY(NEWF, NEW_HIRE_DATE);

GREGDT: Converting From Julian to Gregorian Format
The GREGDT function converts a date in Julian format to Gregorian format
(year-month-day).

A date in Julian format is a five- or seven-digit number. The first two or four digits
are the year; the last three digits are the number of the day, counting from January
1. For example, January 1, 1999 in Julian format is either 99001 or 1999001.
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DATEFNS Settings for GREGDT

GREGDT converts a Julian date to either YMD or YYMD format using the
DEFCENT and YRTHRESH parameter settings to determine the century, if
required. GREGDT returns a date as follows:

DATEFNS Setting I6 or I7 Format I8 Format or Greater

ON YMD YYMD

OFF YMD YMD

Convert From Julian to Gregorian Format
GREGDT(indate, 'outfield')

where:

indate

Integer (I5 or I7)

Is the Julian date, which is truncated to an integer before conversion. Each
value must be a five- or seven-digit number after truncation. If the date is
invalid, the function returns a 0.

outfield

Integer (I6, I8, I6YMD, or I8YYMD)

Is the format of the output value enclosed in single quotation marks.

Converting From Julian to Gregorian Format

GREGDT converts the JULIAN field to YYMD (Gregorian) format.
COMPUTE GREG_DATE/I8 = GREGDT(JULIAN, 'I8');

HADD: Incrementing a Date-Time Value
The HADD function increments a date-time value by a given number of units.

Increment a Date-Time Value
HADD(value, 'component', increment, length, 'outfield')

where:

value

Date-time

Is the date-time value to be incremented, the name of a date-time field that
contains the value, or an expression that returns the value.

component

Alphanumeric

Is the name of the component to be incremented enclosed in single
quotation marks.

Note: WEEKDAY is not a valid component for HADD.

increment

Integer
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Is the number of units by which to increment the component, the name of
a numeric field that contains the value, or an expression that returns the
value.

length

Integer

Is the length of the returned date-time value. Valid values are:

8 indicates a time value that includes milliseconds.

10 indicates a time value that includes microseconds.

outfield

Date-time

Is the format of the output value enclosed in single quotation marks.

Incrementing the Month Component of a Date-Time Field

HADD adds two months to each value in TRANSDATE and stores the result in
ADD_MONTH. If necessary, the day is adjusted so that it is valid for the resulting
month.
COMPUTE ADD_MONTH/HYYMDS = HADD(TRANSDATE, 'MONTH', 2, 8, 'HYYMDS');

HCNVRT: Converting a Date-Time Value to Alphanumeric
Format

The HCNVRT function converts a date-time value to alphanumeric format for use
with operators such as EDIT, CONTAINS, and LIKE.

Convert a Date-Time Value to Alphanumeric Format
HCNVRT(value, '(fmt)', length, 'outfield')

where:

value

Date-time

Is the date-time value to be converted, the name of a date-time field that
contains the value, or an expression that returns the value.

fmt

Alphanumeric

Is the format of the date-time field enclosed in single quotation marks and
parentheses.

length

Integer

Is the length of the alphanumeric field that is returned. You can supply the
actual value, the name of a numeric field that contains the value, or an
expression that returns the value. If length is smaller than the number of
characters needed to display the alphanumeric field, the function returns a
blank.

outfield

Alphanumeric
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Is the format of the output value enclosed in single quotation marks.

Converting a Date-Time Field to Alphanumeric Format

HCNVRT converts the TRANSDATE field to alphanumeric format. The first
function does not include date-time display options for the field; the second
function does for readability. It also specifies the display of seconds in the input
field.
COMPUTE ALPHA_DATE_TIME1/A20 = HCNVRT(TRANSDATE, '(H17)', 17, 'A20'); AND
COMPUTE ALPHA_DATE_TIME2/A20 = HCNVRT(TRANSDATE, '(HYYMDS)', 20, 'A20');

HDATE: Converting the Date Portion of a Date-Time Value to a
Date Format

The HDATE function converts the date portion of a date-time value to the date
format YYMD. You can then convert the result to other date formats.

Convert the Date Portion of a Date-Time Value to a Date Format
HDATE(value, 'YYMD')

where:

value

Date-time

Is the date-time value to be converted, the name of a date-time field that
contains the value, or an expression that returns the value.

YYMD

Date

Is the output format. The value must be YYMD. YYMD is a constant value
and cannot be changed in this syntax, although you can change the format
in subsequent DEFINEs or COMPUTEs.

Converting the Date Portion of a Date-Time Field to a Date Format

HDATE converts the date portion of the TRANSDATE field to the date format
YYMD:
COMPUTE TRANSDATE_DATE/YYMD = HDATE(TRANSDATE, 'YYMD');

HDIFF: Finding the Number of Units Between Two Date-Time
Values

The HDIFF function calculates the number of units between two date-time values.

Find the Number of Units Between Two Date-Time Values
HDIFF(value1, value2, 'component', 'outfield')

where:

value1

Date-time

Is the end date-time value, the name of a date-time field that contains the
value, or an expression that returns the value.

value2
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Date-time

Is the start date-time value, the name of a date-time field that contains the
value, or an expression that returns the value.

component

Alphanumeric

Is the name of the component to be used in the calculation enclosed in
single quotation marks. If the component is a week, the WEEKFIRST
parameter setting is used in the calculation.

outfield

Floating point or Decimal

Is the format of the output value enclosed in single quotation marks.

Finding the Number of Days Between Two Date-Time Fields

HDIFF calculates the number of days between the TRANSDATE and
ADD_MONTH fields and stores the result in DIFF_PAYS, which has the format
D12.2:
COMPUTE ADD_MONTH/HYYMDS = HADD(TRANSDATE, 'MONTH', 2, 8, 'HYYMDS'); AND
COMPUTE DIFF_DAYS/D12.2 = HDIFF(ADD_MONTH, TRANSDATE, 'DAY', 'D12.2');

HDTTM: Converting a Date Value to a Date-Time Value
The HDTTM function converts a date value to a date-time field. The time portion
is set to midnight.

Convert a Date Value to a Date-Time Value
HDTTM(date, length, 'outfield')

where:

date

Date

Is the date value to be converted, the name of a date field that contains the
value, or an expression that returns the value.

length

Integer

Is the length of the returned date-time value. Valid values are:

8 indicates a time value that includes milliseconds.

10 indicates a time value that includes microseconds.

outfield

Date-time

Is the format of the output value enclosed in single quotation marks.

Converting a Date Field to a Date-Time Field

HDTTM converts the date field TRANSDATE_DATE to a date-time field:
COMPUTE TRANSDATE_DATE/YYMD = HDATE(TRANSDATE, 'YYMD'); AND
COMPUTE DT2/HYYMDIA = HDTTM(TRANSDATE_DATE, 8, 'HYYMDIA');
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HGETC: Storing the Current Date and Time in a Date-Time
Field

The HGETC function stores the current date and time in a date-time field. If
millisecond or microsecond values are not available in your operating
environment, the function retrieves the value zero for these components.

Store the Current Date and Time in a Date-Time Field
HGETC(length, 'outfield')

where:

length

Integer

Is the length of the returned date-time value. Valid values are:

8 indicates a time value that includes milliseconds.

10 indicates a time value that includes microseconds.

outfield

Date-time

Is the format of the output value enclosed in single quotation marks.

Storing the Current Date and Time in a Date-Time Field

HGETC stores the current date and time in DT2:
COMPUTE DT2/HYYMDm = HGETC(10, 'HYYMDm');

HHMMSS: Retrieving the Current Time
The HHMMSS function retrieves the current time from the operating system as an
eight character string, separating the hours, minutes, and seconds with periods.

Retrieve the Current Time
HHMMSS('outfield')

where:

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks. The
field format must be at least A8.

Retrieving the Current Time

HHMMSS retrieves the current time:
COMPUTE NOWTIME/A8 = HHMMSS('A8');

HINPUT: Converting an Alphanumeric String to a Date-Time
Value

The HINPUT function converts an alphanumeric string to a date-time value.
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Convert an Alphanumeric String to a Date-Time Value
HINPUT(inputlength, 'inputstring', length, 'outfield')

where:

inputlength

Integer

Is the length of the alphanumeric string to be converted. You can supply
the actual value, the name of a numeric field that contains the value, or an
expression that returns the value.

inputstring

Alphanumeric

Is the alphanumeric string to be converted enclosed in single quotation
marks, the name of an alphanumeric field that contains the string, or an
expression that returns the string. The string can consist of any valid
date-time input value.

length

Integer

Is the length of the returned date-time value. Valid values are:

8 indicates a time value that includes milliseconds.

10 indicates a time value that includes microseconds.

outfield

Date-time

Is the format of the output value enclosed in single quotation marks.

Converting an Alphanumeric String to a Date-Time Value

HCNVRT converts the TRANSDATE field to alphanumeric format, then HINPUT
converts the alphanumeric string to a date-time value:
COMPUTE ALPHA_DATE_TIME/A20 = HCNVRT(TRANSDATE, '(H17)', 17, 'A20'); AND
COMPUTE DT_FROM_ALPHA/HYYMDS = HINPUT(14, ALPHA_DATE_TIME, 8, 'HYYMDS');

HMIDNT: Setting the Time Portion of a Date-Time Value to
Midnight

The HMIDNT function changes the time portion of a date-time value to midnight
(all zeros by default). This allows you to compare a date field with a date-time
field.

Set the Time Portion of a Date-Time Value to Midnight
HMIDNT(value, length, 'outfield')

where:

value

Date-time

Is the date-time value whose time is to be set to midnight, the name of a
date-time field that contains the value, or an expression that returns the
value.
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length

Integer

Is the length of the returned date-time value. Valid values are:

8 indicates a time value that includes milliseconds.

10 indicates a time value that includes microseconds.

outfield

Date-time

Is the format of the output value enclosed in single quotation marks.

Setting the Time to Midnight

HMIDNT sets the time portion of the TRANSDATE field to midnight first in the
24-hour system and then in the 12-hour system:
COMPUTE TRANSDATE_MID_24/HYYMDS = HMIDNT(TRANSDATE, 8, 'HYYMDS'); AND
COMPUTE TRANSDATE_MID_12/HYYMDSA = HMIDNT(TRANSDATE, 8, 'HYYMDSA');

HNAME: Retrieving a Date-Time Component in Alphanumeric
Format

The HNAME function extracts a specified component from a date-time value in
alphanumeric format.

Retrieve a Date-Time Component in Alphanumeric Format
HNAME(value, 'component', 'outfield')

where:

value

Date-time

Is the date-time value from which a component is to be extracted, the
name of a date-time field that contains the value, or an expression that
returns the value.

component

Alphanumeric

Is the name of the component to be retrieved enclosed in single quotation
marks.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks. The
field format must be at lease A2.

The function converts all other components to strings of digits only. The
year is always four digits, and the hour assumes the 24-hour system.

Retrieving the Week Component in Alphanumeric Format

HNAME returns the week in alphanumeric format from the TRANSDATE field.
Changing the WEEKFIRST parameter setting changes the value of the component.
COMPUTE WEEK_COMPONENT/A10 = HNAME(TRANSDATE, 'WEEK', 'A10');
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Retrieving the Day Component in Alphanumeric Format

HNAME retrieves the day in alphanumeric format from the TRANSDATE field:
COMPUTE DAY_COMPONENT/A2 = HNAME(TRANSDATE, 'DAY', 'A2');

HPART: Retrieving a Date-Time Component in Numeric Format
The HPART function extracts a specified component from a date-time value and
returns it in numeric format.

Retrieve a Date-Time Component in Numeric Format
HPART(value, 'component', 'outfield')

where:

value

Date-time

Is a date-time value, the name of a date-time field that contains the value,
or an expression that returns the value.

component

Alphanumeric

Is the name of the component to be retrieved enclosed in single quotation
marks.

outfield

Integer

Is the format of the output value enclosed in single quotation marks.

Retrieving the Day Component in Numeric Format

HPART retrieves the day in integer format from the TRANSDATE field:
COMPUTE DAY_COMPONENT/I2 = HPART(TRANSDATE, 'DAY', 'I2');

HSETPT: Inserting a Component Into a Date-Time Value
The HSETPT function inserts the numeric value of a specified component into a
date-time value.

Insert a Component Into a Date-Time Value
HSETPT(dtfield, 'component', value, length, 'outfield')

where:

dtfield

Date-time

Is a date-time value, the name of a date-time field that contains the value,
or an expression that returns the value.

component

Alphanumeric

Is the name of the component to be inserted enclosed in single quotation
marks.

value
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Integer

Is the numeric value to be inserted for the requested component, the name
of a numeric field that contains the value, or an expression that returns the
value.

length

Integer

Is the length of the returned date-time value. Valid values are:

8 indicates a time value that includes milliseconds.

10 indicates a time value that includes microseconds.

outfield

Date-time

Is the format of the output value enclosed in single quotation marks.

Inserting the Day Component Into a Date-Time Field

HSETPT inserts the day as 28 into the ADD_MONTH field and stores the result in
INSERT_DAY:
COMPUTE ADD_MONTH/HYYMDS = HADD(TRANSDATE, 'MONTH', 2, 8, 'HYYMDS'); AND
COMPUTE INSERT_DAY/HYYMDS = HSETPT(ADD_MONTH, 'DAY', 28, 8, 'HYYMDS');

HTIME: Converting the Time Portion of a Date-Time Value to a
Number

The HTIME function converts the time portion of a date-time value to the number
of milliseconds if the first argument is eight, or microseconds if the first argument
is ten. To include microseconds, the input date-time value must be 10-bytes.

Convert the Time Portion of a Date-Time Field to a Number
HTIME(length, value, 'outfield')

where:

length

Integer

Is the length of the input date-time value. Valid values are:

8 indicates a time value that includes milliseconds.

10 indicates a time value that includes microseconds.

value

Date-time

Is the date-time value from which to convert the time, the name of a
date-time field that contains the value, or an expression that returns the
value.

outfield

Floating point or Decimal

Is the format of the output value enclosed in single quotation marks.
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Converting the Time Portion of a Date-Time Field to a Number

HTIME converts the time portion of the TRANSDATE field to the number of
milliseconds:
COMPUTE MILLISEC/D12.2 = HTIME(8, TRANSDATE, 'D12.2');

JULDAT: Converting From Gregorian to Julian Format
The JULDAT function converts a date from Gregorian format (year-month-day) to
Julian format (year-day). A date in Julian format is a five- or seven-digit number.
The first two or four digits are the year; the last three digits are the number of the
day, counting from January 1. For example, January 1, 1999 in Julian format is
either 99001 or 1999001.

DATEFNS Settings for JULDAT

JULDAT converts a Gregorian date to either YYNNN or YYYYNNN format, using
the DEFCENT and YRTHRESH parameter settings to determine if the century is
required.

JULDAT returns dates as follows:

DATEFNS Setting I6 or I7 Format I8 Format or Greater

ON YYNNN YYYYNNN

OFF YYNNN YYNNN

Convert From Gregorian to Julian Format
JULDAT(indate, 'outfield')

where:

indate

Integer (I6, I8, I6YMD, I8YYMD)

Is the date or the name of the field that contains the date in
year-month-day format (YMD or YYMD).

outfield

Integer (I5 or I7)

Is the format of the output value enclosed in single quotation marks.

Converting From Gregorian to Julian Format

JULDAT converts the HIRE_DATE field to Julian format.
COMPUTE JULIAN/I7 = JULDAT(HIRE_DATE, 'I7');

TIMETOTS: Converting a Time to a Timestamp
The TIMETOTS function converts a time to a timestamp, using the current date to
supply the date component of its value. The first argument must be in H
(date-time) format. The DATE component will be set to the current date.

Convert a Time to a Timestamp
TIMETOTS (time, length, 'outfield')

where:
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time

Date-time

Is the time in a date-time format.

length

Integer

Is the length of the result. This can be one of the following:

8 for time values including milliseconds.

10 for input time values including microseconds.

outfield

Date-time

Is the format of the output value enclosed in single quotation marks.

Converting a Time to a Timestamp

TIMETOTS converts a time argument to a timestamp:
COMPUTE TSTMPSEC/HYYMDS = TIMETOTS(TMSEC, 8, 'HYYMDS'); AND
COMPUTE TSTMPMILLI/HYYMDm = TIMETOTS(TMMILLI, 10, 'HYYMDm');

TODAY: Returning the Current Date
The TODAY function retrieves the current date from the operating system in the
format MM/DD/YY or MM/DD/YYYY. It always returns a date that is current.
Therefore, if you are running an application late at night, use TODAY. You can
remove the default embedded slashes with the EDIT function.

Retrieve the Current Date
TODAY('outfield')

where:

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks. The
field format must be at least A8. The following apply:
v If DATEFNS=ON and the format is A8 or A9, TODAY returns the 2-digit

year.
v If DATEFNS=ON and the format is A10 or greater, TODAY returns the

4-digit year.
v If DATEFNS=OFF, TODAY returns the 2-digit year, regardless of the

format of outfield.

Retrieving the Current Date

TODAY retrieves the current date and stores it in the DATE field.
COMPUTE DATE/A10 = TODAY('A10');

YM: Calculating Elapsed Months
The YM function calculates the number of months that elapse between two dates.
The dates must be in year-month format. You can convert a date to this format by
using the CHGDAT or EDIT function.
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Calculate Elapsed Months
YM(fromdate, todate, 'outfield')

where:

fromdate

Integer (I4YM or I6YYM)

Is the start date in year-month format (for example, I4YM). If the date is
not valid, the function returns a 0.

todate

Integer (I4YM or I6YYM)

Is the end date in year-month format. If the date is not valid, the function
returns a 0.

outfield

Integer

Is the format of the output value enclosed in single quotation marks.

Note: If fromdate or todate is in integer year-month-day format (I6YMD or
I8YYMD), simply divide by 100 to convert to year-month format and set
the result to an integer. This drops the day portion of the date, which is
now after the decimal point.

Calculating Elapsed Months

The COMPUTE commands convert the dates from year-month-day to year-month
format; then YM calculates the difference between the values in the
HIRE_DATE/100 and DAT_INC/100 fields:
COMPUTE HIRE_MONTH/I4YM = HIRE_DATE/100; AND
COMPUTE MONTH_INC/I4YM = DAT_INC/100; AND
COMPUTE MONTHS_HIRED/I3 = YM(HIRE_MONTH, MONTH_INC, 'I3');

Format Conversion Functions
Format conversion functions convert fields from one format to another.

ATODBL: Converting an Alphanumeric String to
Double-Precision Format

The ATODBL function converts a number in alphanumeric format to decimal
(double-precision) format.

Convert an Alphanumeric String to Double-Precision Format
ATODBL(string, length, 'outfield')

where:

string

Alphanumeric

Is the alphanumeric string to be converted, or a field that contains the
string.

length

Alphanumeric
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Is the two-character length of infield in bytes. This can be a numeric
constant, or a field that contains the value. If you specify a numeric
constant, enclose it in single quotation marks. The maximum value is 15.

outfield

Decimal

Is the format of the output value enclosed in single quotation marks.

Converting an Alphanumeric Field to Double-Precision Format

ATODBL converts the EMP_ID field into double-precision format and stores the
result in D_EMP_ID:
COMPUTE D_EMP_ID/D12.2 = ATODBL(EMP_ID, '09', 'D12.2');

EDIT: Converting the Format of a Field
The EDIT function converts an alphanumeric field that contains numeric characters
to numeric format or converts a numeric field to alphanumeric format. It is useful
when you need to manipulate a field using a command that requires a particular
format.

When EDIT assigns a converted value to a new field, the format of the new field
must correspond to the format of the returned value. For example, if EDIT
converts a numeric field to alphanumeric format, you must give the new field an
alphanumeric format:
DEFINE ALPHAPRICE/A6 = EDIT(PRICE);

EDIT deals with a symbol in the following way:
v When an alphanumeric field is converted to numeric format, a sign or decimal

point in the field is acceptable and is stored in the numeric field.
v When converting a floating-point or packed-decimal field to alphanumeric

format, EDIT removes the sign, the decimal point, and any number to the right
of the decimal point. It then right-justifies the remaining digits and adds leading
zeros to achieve the specified field length. Converting a number with more than
nine significant digits in floating-point or packed-decimal format may produce
an incorrect result.

EDIT also extracts characters from or adds characters to an alphanumeric string.
For more information, see EDIT: Extracting or Adding Characters.

Convert the Format of a Field
EDIT(fieldname);

where:

fieldname

Alphanumeric or Numeric

Is the field name.

Converting From Numeric to Alphanumeric Format

EDIT converts HIRE_DATE (a legacy date format) to alphanumeric format.
CHGDAT is then able to use the field, which it expects in alphanumeric format:
COMPUTE ALPHA_HIRE/A17 = EDIT(HIRE_DATE); AND
COMPUTE HIRE_MDY/A17 = CHGDAT('YMD', 'MDYYX', ALPHA_HIRE, 'A17');
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FTOA: Converting a Number to Alphanumeric Format
The FTOA function converts a number up to 16 digits long from numeric format to
alphanumeric format. It retains the decimal positions of a number and
right-justifies it with leading spaces. You can also add edit options to a number
converted by FTOA.

When using FTOA to convert a number containing decimals to a character string,
you must specify an alphanumeric format large enough to accommodate both the
integer and decimal portions of the number. For example, a D12.2 format is
converted to A14. If the output format is not large enough, decimals are truncated.

Convert a Number to Alphanumeric Format
FTOA(number, '(format)', 'outfield')

where:

number

Numeric F or D (single and double-precision floating-point)

Is the number to be converted, or the name of the field that contains the
number.

format

Alphanumeric

Is the output format of the number enclosed in both single quotation
marks and parentheses. Only floating point single-precision and
double-precision formats are supported. Include any edit options that you
want to appear in the output. The D (floating-point double-precision)
format automatically supplies commas.

If you use a field name for this argument, specify the name without
quotation marks or parentheses. If you specify a format, the format must
be enclosed in parentheses.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks. The
length of this argument must be greater than the length of number and
must account for edit options and a possible negative sign.

Converting From Numeric to Alphanumeric Format

FTOA converts the GROSS field from floating point double-precision to
alphanumeric format and stores the result in ALPHA_GROSS:
COMPUTE ALPHA_GROSS/A15 = FTOA(GROSS, '(D12.2)', 'A15');

HEXBYT: Converting a Decimal Integer to a Character
The HEXBYT function obtains the ASCII, EBCDIC, or Unicode character equivalent
of a decimal integer, depending on your configuration and operating environment.
It returns a single alphanumeric character in the ASCII, EBCDIC, or Unicode
character set. You can use this function to produce characters that are not on your
keyboard, similar to the CTRAN function.

In Unicode configurations, this function uses values in the range:
v 0 to 255 for 1-byte characters.
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v 256 to 65535 for 2-byte characters.
v 65536 to 16777215 for 3-byte characters.
v 16777216 to 4294967295 for 4-byte characters (primarily for EBCDIC).

The display of special characters depends on your software and hardware; not all
special characters may appear.

Convert a Decimal Integer to a Character
HEXBYT(input, 'outfield')

where:

input

Integer

Is the decimal integer to be converted to a single character. In non-Unicode
environments, a value greater than 255 is treated as the remainder of input
divided by 256.

output

Alphanumeric

Is the format of the output value enclosed in single quotation marks.

Converting a Decimal Integer to a Character

HEXBYT converts LAST_INIT_CODE to its character equivalent and stores the
result in LAST_INIT:
COMPUTE LAST_INIT_CODE/I3 = BYTVAL(LAST_NAME, 'I3'); AND
COMPUTE LAST_INIT/A1 = HEXBYT(LAST_INIT_CODE, 'A1');

ITONUM: Converting a Large Binary Integer to
Double-Precision Format

The ITONUM function converts a large binary integer in a data source to
double-precision format. Some programming languages and some data storage
systems use large binary integer formats. However, large binary integers (more
than 4 bytes in length) are not supported in the Master File so they require
conversion to double-precision format.

You must specify how many of the right-most bytes in the input field are
significant. The result is an 8-byte double-precision field.

Convert a Large Binary Integer to Double-Precision Format
ITONUM(maxbytes, infield, 'outfield')

where:

maxbytes

Numeric

Is the maximum number of bytes in the 8-byte binary input field that have
significant numeric data, including the binary sign. Valid values are:

5 ignores the left-most 3 bytes.

6 ignores the left-most 2 bytes.

7 ignores the left-most byte.
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infield

Alphanumeric

Is the field that contains the binary number. Both the USAGE and
ACTUAL formats of the field must be A8.

outfield

Decimal

Is the format of the output value enclosed in single quotation marks. The
format must be Dn.

Converting a Large Binary Integer to Double-Precision Format

ITONUM converts the BINARYFLD field to double-precision format:
COMPUTE MYFLD/D14 = ITONUM(6, BINARYFLD, 'D14');

ITOPACK: Converting a Large Binary Integer to
Packed-Decimal Format

The ITOPACK function converts a large binary integer in a data source to
packed-decimal format. Some programming languages and some data storage
systems use double-word binary integer formats. Large binary integers (more than
4 bytes in length) are not supported in the Master File so they require conversion
to packed-decimal format.

You must specify how many of the right-most bytes in the input field are
significant. The result is an 8-byte packed-decimal field of up to 15 significant
numeric positions (for example, P15 or P16.2).

Limit: For a field defined as ’PIC 9(15) COMP’ or the equivalent (15 significant
digits), the maximum number that can be converted is 167,744,242,712,576.

Convert a Large Binary Integer to Packed-Decimal Format
ITOPACK(maxbytes, infield, 'outfield')

where:

maxbytes

Numeric

Is the maximum number of bytes in the 8-byte binary input field that have
significant numeric data, including the binary sign.

Valid values are:

5 ignores the left-most 3 bytes (up to 11 significant positions).

6 ignores the left-most 2 bytes (up to 14 significant positions).

7 ignores the left-most byte (up to 15 significant positions).

infield

Alphanumeric

Is the field that contains the binary number. Both the USAGE and
ACTUAL formats of the field must be A8.

outfield

Packed
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Is the format of the output value enclosed in single quotation marks. The
format must be Pn or Pn.d.

Converting a Large Binary Integer to Packed-Decimal Format

ITOPACK converts the BINARYFLD field to packed-decimal format:
COMPUTE PACKFLD/P14.4 = ITOPACK(6, BINARYFLD, 'P14.4');

ITOZ: Converting a Number to Zoned Format
The ITOZ function converts a number in numeric format to zoned format.
Although a request cannot process zoned numbers, it can write zoned fields to an
extract file for use by an external program.

Convert to Zoned Format
ITOZ(outlength, number, 'outfield')

where:

outlength

Integer

Is the length of number in bytes. The maximum number of bytes is 15. The
last byte includes the sign.

number

Numeric

Is the number to be converted, or the field that contains the number. The
number is truncated to an integer before it is converted.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks.

Converting a Number to Zoned Format

ITOZ converts the CURR_SAL field to a zoned format:
COMPUTE ZONE_SAL/A8 = ITOZ(8, CURR_SAL, 'A8');

PCKOUT: Writing a Packed Number of Variable Length
The PCKOUT function writes a packed number of variable length to an extract file.
When a request saves a packed number to an extract file, it typically writes it as an
8- or 16-byte field regardless of its format specification. With PCKOUT, you can
vary the field’s length between 1 to 16 bytes.

Write a Packed Number of Variable Length
PCKOUT(infield, outlength, 'outfield')

where:

infield

Numeric

Is the input field that contains the values. The field can be in packed,
integer, floating-point, or double-precision format. If the field is not in
integer format, its values are rounded to the nearest integer.
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outlength

Numeric

Is the length of outfield from 1 to 16 bytes.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks. The
function returns the field as alphanumeric although it contains packed
data.

Writing a Packed Number of Variable Length

PCKOUT converts the CURR_SAL field to a 5-byte packed field and stores the
result in SHORT_SAL:
COMPUTE SHORT_SAL/A5 = PCKOUT(CURR_SAL, 5, 'A5');

Numeric Functions
Numeric functions perform calculations on numeric constants and fields.

ABS: Calculating Absolute Value
The ABS function returns the absolute value of a number.

Calculate Absolute Value
ABS(argument)

where:

argument

Numeric

Is the value for which the absolute value is returned, the name of a field
that contains the value, or an expression that returns the value. If you use
an expression, use parentheses as needed to ensure the correct order of
evaluation.

Calculating Absolute Value

The first COMPUTE command creates the DIFF field, then ABS calculates the
absolute value of DIFF:
COMPUTE DIFF/I5 = DELIVER_AMT - UNIT_SOLD; AND
COMPUTE ABS_DIFF/I5 = ABS(DIFF);

BAR: Producing a Bar Chart
The BAR function produces a horizontal bar chart using repeating characters to
form each bar. Optionally, you can create a scale to clarify the meaning of a bar
chart by replacing the title of the column containing the bar with a scale.

Produce a Bar Chart
BAR(barlength, infield, maxvalue, 'char', 'outfield')

where:

barlength
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Numeric

Is the maximum length of the bar in characters. If this value is less than or
equal to 0, the function does not return a bar.

infield

Numeric

Is the data field plotted as a bar chart.

maxvalue

Numeric

Is the maximum value of a bar. This value must be greater than the
maximum value stored in infield. If infield is larger than maxvalue, the
function uses maxvalue and returns a bar of maximum length.

char

Alphanumeric

Is the repeating character that creates the bars enclosed in single quotation
marks. If you specify more than one character, only the first character is
used.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks. The
output field must be large enough to contain a bar of maximum length as
defined by barlength.

Producing a Bar Chart

BAR creates a bar chart for the CURR_SAL field, and stores the output in
SAL_BAR. The bar created can be no longer than 30 characters long, and the value
it represents can be no greater than 30,000.
COMPUTE SAL_BAR/A30 = BAR(30, CURR_SAL, 30000, '=', SAL_BAR);

CHKPCK: Validating a Packed Field
The CHKPCK function validates the data in a field described as packed format (if
available on your platform). The function prevents a data exception from occurring
when a request reads a field that is expected to contain a valid packed number but
does not.

To use CHKPCK:
1. Ensure that the Master File (USAGE and ACTUAL attributes) defines the field

as alphanumeric, not packed. This does not change the field data, which
remains packed, but it enables the request to read the data without a data
exception.

2. Call CHKPCK to examine the field. The function returns the output to a field
defined as packed. If the value it examines is a valid packed number, the
function returns the value; if the value is not packed, the function returns an
error code.
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Validate a Packed Field
CHKPCK(inlength, infield, error, 'outfield')

where:

inlength

Numeric

Is the length of the packed field. It can be between 1 and 16 bytes.

infield

Alphanumeric

Is the name of the packed field. The field is described as alphanumeric, not
packed.

error

Numeric

Is the error code that the function returns if a value is not packed. Choose
an error code outside the range of data. The error code is first truncated to
an integer, then converted to packed format. However, it may appear on a
report with a decimal point because of the format of the output field.

outfield

Packed

Is the format of the output value enclosed in single quotation marks.

Validating Packed Data

CHKPCK validates the values in the PACK_SAL field, and stores the result in the
GOOD_PACK field. Values not in packed format return the error code -999. Values
in packed format appear accurately.
COMPUTE GOOD_PACK/P8CM = CHKPCK(8, PACK_SAL, -999, GOOD_PACK);

DMOD, FMOD, and IMOD: Calculating the Remainder From a
Division

The MOD functions calculate the remainder from a division. Each function returns
the remainder in a different format.

The functions use the following formula.
remainder = dividend - INT(dividend/divisor) * divisor

v DMOD returns the remainder as a decimal number.
v FMOD returns the remainder as a floating point number.
v IMOD returns the remainder as an integer.

For information on the INT function, see “INT: Finding the Greatest Integer” on
page 420.

Calculate the Remainder From a Division
function(dividend, divisor, 'outfield')

where:

function
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Is one of the following:

DMOD returns the remainder as a decimal number.

FMOD returns the remainder as a floating point number.

IMOD returns the remainder as an integer.

dividend

Numeric

Is the number being divided.

divisor

Numeric

Is the number dividing the dividend.

outfield

Numeric

Is the format of the output value enclosed in single quotation marks. The
format is determined by the result returned by the specific function.

Calculating the Remainder From a Division

IMOD divides ACCTNUMBER by 1000 and returns the remainder to
LAST3_ACCT:
COMPUTE LAST3_ACCT/I3L = IMOD(ACCTNUMBER, 1000, LAST3_ACCT);

EXP: Raising e to the Nth Power
The EXP function raises the value ″e″ (approximately 2.72) to a specified power.
This function is the inverse of the LOG function, which returns an argument’s
logarithm.

EXP calculates the result by adding terms of an infinite series. If a term adds less
than .000001 percent to the sum, the function ends the calculation and returns the
result as a double-precision number.

Raise e to the Nth Power
EXP(power, 'outfield')

where:

power

Numeric

Is the power to which ″e″ is raised.

outfield

Floating point or Decimal

Is the format of the output value enclosed in single quotation marks.

Raising e to the Nth Power

EXP raises e to the 2nd power:
COMPUTE E2/D12.2 = EXP(2, 'D12.2');
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INT: Finding the Greatest Integer
The INT function returns the integer component of a number.

Find the Greatest Integer
INT(argument)

where:

argument

Numeric

Is the value for which the integer component is returned, the name of a
field that contains the value, or an expression that returns the value. If you
supply an expression, use parentheses as needed to ensure the correct
order of evaluation.

Finding the Greatest Integer

INT finds the greatest integer in the DED_AMT field and stores it in
INT_DED_AMT:
COMPUTE INT_DED_AMT/I9 = INT(DED_AMT);

LOG: Calculating the Natural Logarithm
The LOG function returns the natural logarithm of a number.

Calculate the Natural Logarithm
LOG(argument)

where:

argument

Numeric

Is the value for which the natural logarithm is calculated, the name of a
field that contains the value, or an expression that returns the value. If you
supply an expression, use parentheses as needed to ensure the correct
order of evaluation. If argument is less than or equal to 0, LOG returns 0.

Calculating the Natural Logarithm

LOG calculates the logarithm of the CURR_SAL field:
COMPUTE LOG_CURR_SAL/D12.2 = LOG(CURR_SAL);

MAX and MIN: Finding the Maximum or Minimum Value
The MAX and MIN functions return the maximum or minimum value,
respectively, from a list of values.

Find the Maximum or Minimum Value
{MAX|MIN}(argument1, argument2, ...)

where:

MAX

Returns the maximum value.

MIN
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Returns the minimum value.

argument1, argument2

Numeric

Are the values for which the maximum or minimum value is returned, the
name of a field that contains the values, or an expression that returns the
values. If you supply an expression, use parentheses as needed to ensure
the correct order of evaluation.

Determining the Minimum Value

MIN returns either the value of the ED_HRS field or the constant 30, whichever is
lower:
COMPUTE MIN_EDHRS_30/D12.2 = MIN(ED_HRS, 30);

PRDNOR and PRDUNI: Generating Reproducible Random
Numbers

The PRDNOR and PRDUNI functions generate reproducible random numbers:
v PRDNOR generates reproducible double-precision random numbers normally

distributed with an arithmetic mean of 0 and a standard deviation of 1. If
PRDNOR generates a large set of numbers, they have the following properties:
– The numbers lie roughly on a bell curve, as shown in the following figure.

The bell curve is highest at the 0 mark, meaning that there are more numbers
closer to 0 than farther away.

– The average of the numbers is close to 0.
– The numbers can be any size, but most are between 3 and -3.

v PRDUNI generates reproducible double-precision random numbers uniformly
distributed between 0 and 1 (that is, any random number it generates has an
equal probability of being anywhere between 0 and 1).
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Generate Reproducible Random Numbers
{PRDNOR|PRDUNI}(seed, 'outfield')

where:

PRDNOR

Generates reproducible double-precision random numbers normally
distributed with an arithmetic mean of 0 and a standard deviation of 1.

PRDUNI

Generates reproducible double-precision random numbers uniformly
distributed between 0 and 1.

seed

Numeric

Is the seed or the field that contains the seed, up to 9 digits. The seed is
truncated to an integer.

outfield

Decimal

Is the format of the output value enclosed in single quotation marks.

Generating Reproducible Random Numbers

PRDNOR assigns random numbers and stores them in RAND. The seed is 40. To
produce a different set of numbers, change the seed.
COMPUTE RAND/D12.2 = PRDNOR(40, 'D12.2');

RDNORM and RDUNIF: Generating Random Numbers
The RDNORM and RDUNIF functions generate random numbers:
v RDNORM generates double-precision random numbers normally distributed

with an arithmetic mean of 0 and a standard deviation of 1. If RDNORM
generates a large set of numbers (between 1 and 32768), they have the following
properties:
– The numbers lie roughly on a bell curve, as shown in the following figure.

The bell curve is highest at the 0 mark, meaning that there are more numbers
closer to 0 than farther away.
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– The average of the numbers is close to 0.
– The numbers can be any size, but most are between 3 and -3.

v RDUNIF generates double-precision random numbers uniformly distributed
between 0 and 1 (that is, any random number it generates has an equal
probability of being anywhere between 0 and 1).

Generate Random Numbers
{RDNORM|RDUNIF}('outfield')

where:

RDNORM

Generates double-precision random numbers normally distributed with an
arithmetic mean of 0 and a standard deviation of 1.

RDUNIF

Generates double-precision random numbers uniformly distributed
between 0 and 1.

outfield

Decimal

Is the format of the output value enclosed in single quotation marks.

Generating Random Numbers

RDNORM assigns random numbers and stores them in RAND.
COMPUTE RAND/D12.2 = RDNORM('D12.2');

SQRT: Calculating the Square Root
The SQRT function calculates the square root of a number.
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Calculate the Square Root
SQRT(argument)

where:

argument

Numeric

Is the value for which the square root is calculated, the name of a field that
contains the value, or an expression that returns the value. If you supply
an expression, use parentheses as needed to ensure the correct order of
evaluation. If you supply a negative number, the result is zero.

Calculating the Square Root

SQRT calculates the square root of LISTPR:
COMPUTE SQRT_LISTPR/D12.2 = SQRT(LISTPR);

System Functions
System functions call the operating system to obtain information about the
operating environment.

FGETENV: Retrieving the Value of an Environment Variable
The FGETENV function retrieves the value of an environment variable and returns
it as an alphanumeric string.

Retrieve the Value of an Environment Variable
FGETENV(varlength, 'varname', outfieldlen, 'outfield')

where:

varlength

Integer

Is the length of the environment variable name.

varname

Alphanumeric

Is the name of the environment variable.

outfieldlen

Integer

Is the length of the field in which the environment variable’s value is
stored.

outfield

Alphanumeric

Is the format of the output value enclosed in single quotation marks.

Retrieving the Language Locale

Using the LANG environment variable, FGETENV retrieves the object location for
the language locale:
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COMPUTE LANG_LOCALE/A40 = FGETENV(4, 'LANG', 40, 'A40');

GETUSER: Retrieving a User ID
The GETUSER function retrieves the ID of the connected user.

Retrieve a User ID
GETUSER('outfield')

where:

outfield

Alphanumeric

Is the format (at least A8) of the output value enclosed in single quotation
marks. The length depends on the platform on which the function is
issued. Provide a length as long as required for your platform; otherwise,
the output will be truncated.

Retrieving a User ID

GETUSER retrieves the user ID of the person running the request:
COMPUTE USERID/A8 = GETUSER('A8');

HHMMSS: Retrieving the Current Time
The HHMMSS function retrieves the current time from the operating system as an
eight-character string, separating the hours, minutes, and seconds with periods. For
details on how to use this function, see HHMMSS: Retrieving the Current Time.

TODAY: Returning the Current Date
The TODAY function retrieves the current date from the system. For details on
how to use this function, see TODAY: Returning the Current Date.
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Chapter 8. Visualizing Trends in Reports

Describes how to insert visual representations (in the form of bar graphs) of
selected data directly into your report output.

To make your HTML reports more powerful, you can insert visual representations
of selected data directly into the report output. These visual representations are in
the form of vertical or horizontal bar graphs that make relationships and trends
among data more obvious.

Applying Bar Graphs
Vertical or horizontal bar graphs highlight relationships and trends among data.
v Vertical Bar Graph. You can apply a vertical bar graph to report columns

associated with an ACROSS sort field. The report output displays a vertical bar
graph in a new row above the associated data values as shown in the following
image.

Bar graphs that project above the zero line represent positive values, while bar
graphs that project below the zero line represent negative values.

v Horizontal Bar Graph. You can apply a horizontal bar graph to report columns.
The report output displays a horizontal bar graph in a new column to the right
of the associated data values as shown in the following image.
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Bar graphs that project to the right of the zero line represent positive values,
while bar graphs that project to the left of the zero line represent negative
values.

The length of each vertical or horizontal bar graph is proportional to the
magnitude of its associated data value. The shortest bar graph appears for the
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value with the minimum magnitude, the longest bar graph for the value with the
maximum magnitude, and bar graphs of varying length appear for each value
within the minimum-maximum magnitude range. Notice in the figure that a value
of 147,490.00 produces a longer horizontal bar graph than a value of 50,153.00.
Therefore, a complete row of vertical bar graphs or a complete column of
horizontal bar graphs forms a bar chart.

You can only apply data visualization bar graphs to numeric report columns
(integer, decimal, floating point single-precision, floating point double-precision,
and packed). Bar graphs applied to alphanumeric, date, or text field formats are
ignored.

You can display data visualization bar graphs in OLAP-enabled HTML reports,
where bar graphs are applied to Measures. See Associating Bar Graphs With
Measures.

Associating Bar Graphs With Measures
You can associate data visualization bar graphs with any numeric measure that
appears in the report output.

The type of bar graph that you can apply depends on the placement of the
dimensions included in the report:
v If all report dimensions are vertical (By) sort fields (listed in the Drill Down box

in the OCP), you can apply a horizontal bar graph to the specified measures.
v If any dimension is a horizontal (Across) sort field (listed in the Drill Across box

in the OCP), you can apply a vertical bar graph to the specified measures.

For illustrations, see Applying Bar Graphs.

For more information about OLAP reports, see Analyzing Data in an OLAP Report.

Data Visualization Bar Graph Attributes
The following table outlines the default attributes used to display data
visualization bar graphs applied from the OLAP selections pane or the OLAP
Control Panel. The first column lists the bar graph attribute, while the second
column lists the default value.

Bar graph attribute Default value

Color Positive values: Blue

Negative values: Red

Length Vertical bar graph: 60 pixels

Horizontal bar graph: 80 pixels

Width The size of the font in the report output is used to define a
default value for the width of the bar graph.

Note: Currently, you cannot modify bar graph attributes from the OLAP selection
panel or the OLAP Control Panel.
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Applying Bar Graphs to Measures in an OLAP Report
The quickest way to apply data visualization bar graphs to numeric measures is
from the report itself.

Apply Bar Graphs to Measures in an OLAP Report
1. Right-click the title of a measure column.
2. Choose Visualize from the menu.

The report runs automatically, displaying a column of bar graphs following the
selected measures column.

Tip: To remove the bar graphs, right-click the measure column title and choose
Remove Visualization from the menu.

Applying and Sorting Bar Graphs in a Report

In the following OLAP report:
1. Right-click Line Cost of Goods Sold and choose Visualize to apply a data

visualization bar graph to each value in the column, as shown in the following
image.

The display changes instantly, as shown in the following image.
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2. Sort the data by highest value. You can either right-click Line Cost of Goods
Sold and choose Sort by Highest, or click the Up arrow (the tool tip reads Sort
LINE_COG highest to lowest).
The following image shows the results of sorting the data by the highest value.
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Applying Bar Graphs to Measures Using the Selections Pane
or Control Panel

You can apply data visualization bar graphs to any numeric measure.

To indicate the measures for which you want to display bar graphs, you click the
check box located to the left of each measure. This check box has three states that
control the display modes for the measure.

In the following table the first column shows the three check box states and the
second column provides descriptions for the display modes.

Check Box State Display Mode for the Measure

Check mark

Displays the measure.

Graph icon

Applies a bar graph to the measure and displays both the
measure and its associated bar graph.

Blank box

Does not display the measure or an associated bar graph.

You click the check box next to a measure until it reflects the display mode you
want.

If an OLAP report contains a measure that does not appear in the report, the
Measure control shows a blank check box. To display the measure, click the check
box once. To display the associated bar graph, click the check box again.
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Note: The three-state check box is not active when you apply Stack Measures to
your report. These features are mutually exclusive.

Apply Bar Graphs to Measures Using the Selections Pane
1. From the OLAP selections pane, click the arrow to the left of the Measures

control.
2. Click the check box beside each numeric measure to which you want to add a

bar graph. The check mark in the box is replaced with the Graph icon.
3. Click Run. The new report appears with the associated bar graphs.

Apply Bar Graphs to Measures Using the Control Panel
1. Click the OLAP button in the OLAP selections pane to open the OLAP Control

Panel. The Measures box appears in the lower right corner.
2. If Stack Measures is applied to the report, click the Stack Measures check box

to turn off this feature.
3. To apply data visualization bar graphs to a measure, click the check box to the

left of the measure.
To apply data visualization graphs to a non-displaying measure, click the check
box twice.
The check mark in the box is replaced with the Graph icon. This icon indicates
that data visualization bar graphs are applied to the measure. (If you have not
done so in step two, this also deactivates the Stack Measures feature.)
You can apply data visualization bar graphs to as many numeric measures as
you want.

4. After you select all the measures for which you want to display bar graphs,
click Run.
The new report output appears with the associated bar graphs.

5. To continue to modify the report (either data visualization or another OLAP
configuration), click the OLAP button again.

Remove Bar Graphs Using the Selections Pane or Control Panel
1. From the Measures drop-down list in the OLAP selections pane or the

Measures box in the OLAP Control Panel, click the check box for any measure
to which you have applied data visualization bar graphs.
This removes the Graph icon and displays a blank check box indicating that the
measure will not appear in the report output when you run the report.

2. To display the measure, click the same check box again. A check mark appears
in the box.

3. Click Run to display the new report output, where the measure appears
without its associated bar graph.

Applying Data Visualization Bar Graphs to Measures Using the
Selections Pane

Suppose that you want to associate data visualization bar graphs with the Profit
column in the following report in order to represent visually the differences
between the Costs for and the Prices of your various Products.

You have created the following OLAP report, as shown in the following image,
which displays the report data by Product Name.
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To associate data visualization bar graphs with the Profit column:
1. Click the Measures drop-down list in the report (or open the OLAP Control

Panel (OCP) by clicking the OLAP button), as shown in the following image.

The check marks indicate that the measures will appear in the report output.
2. Click the Profit check box again. The following images shows the Measures

drop-down list in the OCP with the Profit check box selected as a Graph icon.
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The Graph icon replaces the check mark. This icon indicates that the measure
will appear with its associated bar graph.

3. Click the Run button to display the new report output, as shown in the
following image, visualizing the Profit values in a bar graph representation.
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Notice that the report now contains a new column to the right of the Profit
measure. This column displays a horizontal bar chart comprised of bar graphs that
represent the individual data values for the Profit measure.

Display Modes in the OLAP Control Panel

The Measures box, from which you select a display mode, is located in the lower
right corner of the Control Panel, as shown in the following image.

The state of each measure’s check box determines how the measure appears in the
report output. In this illustration:
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v The COST and PRICE measures will appear in the report output (check mark in
the boxes).

v The Profit measure and its associated bar graph will appear in the report output
(Graph icon in the box).

Note that the Stack Measures option is inactive when a bar graph is applied to a
measure.
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Chapter 9. Using the DB2 Web Query Viewer

Describes how to use the DB2 Web Query Viewer to view long reports.

The DB2 Web Query Viewer uses the On-demand Paging facility. When
On-demand paging is enabled, DB2 Web Query saves the bulk of your report to
your Web server and delivers one page of report output at a time, decreasing the
amount of time you wait for your report to process. The bulk of your report
remains on the Web server until you request it or close the Viewer.

The DB2 Web Query Viewer improves your ability to handle long reports by
allowing you to view a single page of report output. You can use the Viewer to:
v View single pages of long reports.
v Search for specific pages in a report.
v Search for specific strings of information.
v Deliver a full report to your Web server.

Navigating a Report With the DB2 Web Query Viewer
When you run a report designated for On-Demand Paging, the DB2 Web Query
Viewer opens automatically and displays the first page of the report. The Viewer
consists of two panes: the Report Pane and the Viewer Control Panel as shown in
the following image.
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The Report Pane is the larger pane and contains one page of report output. When
you first run a report, the Report Pane contains the first page of report output. The
Viewer Control Panel contains the controls that allow you to display specific pages,
deliver the entire report to your Web server, and search your document for
particular strings of information.

Using the Viewer Control Panel
The Viewer Control Panel, as shown in the following image, (located at the bottom
of the window) contains the controls you use to navigate through the report and to
search for a string in the report. The Viewer Control Panel’s navigational controls
allow you to display the next or previous page, the first or last page, or a specific
page. You use the searching function to have the Viewer locate a search string you
specify within all report pages.

Note: When specifying a search string, you must specify the actual number of
spaces between characters because HTML displays a single space, even when
multiple spaces are used between characters.
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Navigate Through a Report

The Viewer Control Panel offers several ways to view pages in your report:
v To display a specific page:

1. Enter a page number in the Page input box as shown in the following image.

2. Click Go to Page as shown in the following image.

v To display the previous or the next page in sequence, click Previous or Next as
shown in the following image.

v To display the first or last page of the report, click First Page or Last Page as
shown in the following image.

v To download the entire report to the browser as a single document, click All
Pages as shown in the following image.

v To close the DB2 Web Query Viewer, click Close as shown in the following
image.

Searching a Report
The Viewer Control Panel contains controls that offer several ways to search your
report. Using the Viewer’s search controls, you can select a string of information,
such as a phrase that occurs in your report or a group of numbers, and search for
each occurrence of that string. You can further customize your search by matching
capitalization of words exactly (a case-sensitive search) or by controlling the
direction of your search (either forward or backward from your starting point in
the report). Use these controls to search your report:
v To perform a case-sensitive search, click Match Case as shown in the following

image.
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v To search backward in a report, click Search Backward as shown in the
following image.

v To locate a specific string, type the string you want to search for and click Find
as shown in the following image.

Search the Report
1. Required: Enter the string in the Search input box.
2. Required: Click Match Case if you want to perform a case-sensitive search.

Notice that the DB2 Web Query Viewer displays the Match Case button with a
red line across it to indicate that it is active.

3. To begin your search, click:
a. Search Backward to search for the string from the current page back to the

first page, or
b. Find to search from the current page to the end of your report.
The DB2 Web Query Viewer searches the report and underlines the first
occurrence of the string.

4. Click Find again to search for another occurrence of the string.

Using the Viewer Control Panel to Search

You want to use the Viewer Control Panel to navigate a long report called Coffee
Sales to find occurrences of the string ″Kona,″ a type of coffee that you sell. After
you run the report, DB2 Web Query displays the first page of the report in the
Viewer.
1. To search for sales of Kona, type Kona in the input box and click Find as

shown in the following image.
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The DB2 Web Query Viewer returns your report with the first occurrence of
your search string underlined as shown in the following image.
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2. Click Find again to locate the next occurrence of Kona.

Creating On-demand Paging Reports
You can create your own On-demand Paging report from Report Assistant. Note
that On-demand Paging is not currently available with OLAP-enabled reports.

Create an On-demand Paging Report
1. Required: From the Domains list window, select the Reports folder.
2. Required: Select a report from the list.
3. Click Report Assistant.

Report Assistant opens.
4. Add fields and customize your report. For more information on creating

reports with Report Assistant, see Chapter 4, “Creating a Report With Report
Assistant,” on page 71.

5. Click the Report Options tab and check the On-demand Paging check box.
6. Click Run to view your report.

DB2 Web Query displays your report within the Viewer.
Note: The Viewer is launched over a blank browser window. This window is
necessary for the operation of the Viewer. It must be closed separately from the
Viewer.
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7. To return to Report Assistant, close the DB2 Web Query Viewer and close the
blank browser page.

8. Close Report Assistant.
DB2 Web Query prompts you to save your report before exiting.

Creating an On-demand Paging Report

You want to select On-demand Paging for a report on the sale of coffee products
called Coffee Sales.
1. Navigate to the Domains view.
2. Open the Regional Sales domain.
3. From the Reports folder, expand the Product Sales group folder and select

Coffee Sales.
4. Open Report Assistant.

Report Assistant displays the Fields dialog box with the fields already selected
for the report.

5. Select the Report Options tab. The Report Options window opens.
6. Check the On-demand Paging check box to enable On-demand Paging.
7. Click Run to run Coffee Sales immediately.

DB2 Web Query displays the first page of Coffee Sales in the Viewer as shown
in the following image.

8. Click Close on the DB2 Web Query Viewer.
DB2 Web Query notifies you that the report has been deleted from the server.

Chapter 9. Using the DB2 Web Query Viewer 445



446 System i: Database IBM DB2 Web Query for System i



Chapter 10. Understanding User Interface Basics

Introduces user interface design in DB2 Web Query and describes the components
of a typical user interface.

A user interface for a Web application is a collection of HTML files that display
pages in a browser.

You can design a user interface by using the HTML Layout Painter to create HTML
forms and procedures in one integrated process. For details, see Designing a User
Interface for a Web Application With the HTML Layout Painter.

Note: The HTML Layout Painter is accessible only through the DB2 Web Query
Developer Workbench.

User Interface Basics
A user interface is the means by which you enable communication between a user
and your application.

A DB2 Web Query user interface allows a user to supply information, choose
options, and run reports. A simple one typically consists of:
v A launch page, which enables a user to run one or more reports.
v An HTML display page, on which a report appears.

User interface design is one of the most creative phases of application
development. Developer Workbench provides many tools that support it.

Modify WFSIGNON.HTML
1. Modify WFSIGNON.HTML by using the Developer Studio text editor (TED).

Note: For details on this editor, see Editing Application Components as Text in
Developer Studio.

2. Modify the lines with letters on the left, as explained in the notes following the
code.

<!DOCTYPE HTML PUBLIC "-//IETF//DTD HTML//EN">
<html>
<head>
<title>WebFOCUS signon screen</title>
</head>
<body bgcolor="#FFFFFF" alink="#0000FF">
<font size=4>

a. <form action="/ib_apps/WFServlet" method="POST">
<a href="http://www.informationbuilders.com"><img border="0"
src="ib_logo_home.gif" align="left" placement="break"
id="image_AED3B8DFBD244B27A511729EB6D221CA" />

If a manager selects Midwest and clicks Run, the report appears.
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At minimum, a launch page is a simple form that contains a Run and Clear button,
allowing the user to run a report. More often, it is a form, like the one shown,
containing controls that prompt for user input.

Controls include text boxes, check boxes, radio buttons, drop-down menus, push
buttons, and hyperlinks. A launch page usually displays default values or valid
values to help the user provide input. The Reporting Server uses the input to
process the procedure and return the desired output.

When a launch page is complete, deploy it to the Web server using the Deploy
Wizard. Supporting files such as procedures are deployed to the Reporting Server.
Once the files are stored on the appropriate servers, users can access the launch
page by typing the URL in the browser.

Adding a Control to a Form
A control prompts a user for a value required by a procedure. You can add a single
control, or a combination of controls, to a form on a launch page.

You must add a Submit button. Submitting a form calls DB2 Web Query and
passes the supplied values to the procedure.

DB2 Web Query Controls

The following table describes types of controls.

Control Enables a user to...

One-Line Text Box Enter a single value for a variable, such as
user name or password on a custom logon
page.

Radio Button Choose one value from a group.

Check Box Choose multiple values.

Drop-Down List Choose a value from a drop-down list. You
can add text to describe the values.

Multi-Select Drop-Down List Choose multiple values from a drop-down
list. Allows a user to report on several field
values at one time.

Dynamic Multi-Select Drop-Down List Choose multiple values from a drop-down
list populated by field values retrieved live
from a data source.

Text Area Enter an ad hoc report request.
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Control Enables a user to...

Submit Button Run a report. You must include a Submit
button on a form. You may optionally
include a button that clears the form of
current values and restores the defaults.

Push Button Trigger an action.

Hyperlink Run a procedure using fixed values.

Types of Launch Pages
A launch page can be a single page or a frameset. A single page is a one-page
display that is replaced by report output when a user submits a request. A
frameset is a multiple-page display, and any page (frame) can be replaced by
report output.

Ways to Create a Launch Page
A launch page calls the DB2 Web Query Client to pass the name of a report to run,
with any required values.

You can create a launch page using the HTML Layout Painter. The HTML Layout
Painter allows you to create a launch and display page in an integrated process
within Developer Workbench. See Designing a User Interface for a Web
Application With the HTML Layout Painter.

About an HTML Display Page
Report output from a Reporting Server appears on an HTML page in a browser.
You have many design options for report display. For example, you can display a
report on a page by itself or in a frame on a page, or you can design a custom
page with multiple reports.

Your application will probably include different types of reports, which may
influence the display pages you design. Some types of reports include:
v Dynamic. A report created and formatted at the time a user requests it. This

type of report displays the most current information from live data retrieval.
v Drill-Down. A dynamic, multilevel report consisting of a parent (summary)

component and a child (detailed) component.
v Static. HTML file created and formatted before a user requests it. Ready for

access without live data retrieval. Called by HTML code (A HREF).

You can create a report using the Report Assistant or Power Painter.
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Chapter 11. Creating a Reporting Procedure With SQL Report
Wizard

Describes how to use the SQL Report Wizard.

The SQL Report Wizard assists you with SQL passthru, which allows you to
execute SQL code that retrieves data from an RDBMS. You can use the resulting
extract file in the Report Assistant or the Graph Assistant.

Note: The SQL Report Wizard is accessible only through the DB2 Web Query
Developer Workbench.

Using the SQL Report Wizard
The SQL Report Wizard supports DB2 cli engines.

Include SQL Commands From an External .sql File
1. Access the SQL Report Wizard by doing one of the following:

In the Explorer, right-click a group folder under the Reports folder and select
New, Procedure. In the New Report dialog box, enter a file name and then
select SQL Report Wizard from the Create with drop-down list. Click Create.
The SQL Report Wizard - Welcome window opens.
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2. Click the option button next to Included from an external ’.sql’ file. This
enables you to browse and select external procedures that exist in the DB2
Web Query repository. This enables sites to leverage pre-existing SQL
procedures.

3. Required: Click Next to see the SQL Report Wizard - Data access information
window.

4. In the Select the SQL database engine area, select a database engine from the
drop-down list. The list consists of available engines in the edasprof.prf file.

5. In the Select the connection area, choose a connection from the drop-down list
generated from the engine that you selected. You can choose the default value,
which is the first connection in the edasprof.prf file for the selected engine, or
choose another connection defined in edasprof.prf.

6. Click Next to see the SQL Report Wizard - Include external SQL file window.
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7. Enter the external SQL file name in the field, or click Browse to select it.
8. Optionally, you can run with limited records by clicking Run SQL. By default,

the Run with limited records check box is selected so you can test your
procedure with a readlimit if the engine supports it. There is a field box next
to the check box in which you can enter the number of records to be read. 100
is the default limit.

9. Click Next to see the SQL Report Wizard - Summary of SQL options window.
Do one of the following:
v To create a report, select the Create Report option button. This option is

selected by default.
v To create a graph, select the Create Graph option button.

10. Click Finish to run the SQL procedure. The Report Assistant or Graph
Assistant opens. When you have completed the procedure, you can run it
from the group folder in the Explorer view.

Pass SQL Commands to the RDBMS Using SQL Passthru
1. Required: Access the SQL Report Wizard by doing one of the following:

In the Explorer, right-click a group folder under the Reports folder and select
New, Procedure. In the New Report dialog box, enter a file name and then
select SQL Report Wizard from the Create with drop-down list. Click Create.
The SQL Report Wizard - Welcome window opens.

2. Click the option button next to Type SQL statements in the report request.
This enables you to enter SQL commands that will be passed on to the
RDBMS with the SQL Passthru feature.

3. Click Next to see the SQL Report Wizard - Data access information window.
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4. In the Select the SQL database engine area, select a database engine from the
drop-down list. The list consists of available engines in the edasprof.prf file.

5. In the Select the connection area, choose a connection from the drop-down list
generated from the engine that you selected. You can choose the default value,
which is the first connection in the edasprof.prf file for the selected engine, or
choose another connection defined in edasprof.prf.

6. Click Next to see the SQL Report Wizard - Enter SQL statements window.

7. In the field box, type the SQL statements you want to pass to the RDBMS.
8. Optionally, you can run with limited records by clicking Run SQL. By default,

the Run with limited records check box is selected so you can test your
procedure with a read limit if the engine supports it. There is a field box next
to the check box in which you can enter the number of records to be read. 100
is the default limit.

9. Click Run SQL to run your report.
10. Click Next to see the SQL Report Wizard - Summary of SQL options window.

Do one of the following:
v To create a report, select the Create Report option button. This option is

selected by default.
v To create a graph, select the Create Graph option button.

11. Click Finish to run the SQL procedure.The Report Assistant or Graph
Assistant opens. When you have completed the procedure, you can run it
from the group folder in the Explorer view.
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Import SQL Commands From an Existing .sql File
1. Access the SQL Report Wizard by doing one of the following:

In the Explorer, right-click a group folder under the Reports folder and select
New, Procedure. In the New Report dialog box enter a file name and then
select SQL Report Wizard from the Create with drop-down list. Click Open.
The SQL Report Wizard - Welcome window opens.

2. Click the option button next to Import from an existing .sql file. This enables
you to modify SQL code after importing it from an external file to the
procedure being built. It enables you to modify the request using bits of code.

3. Click Next to see the SQL Report Wizard - Data access information window.
4. In the Select the SQL database engine area, select a database engine from the

drop-down list. The list consists of available engines in the edasprof.prf file.
5. In the Select the connection area, choose a connection from the drop-down list

generated from the engine that you selected. You can choose the default value,
which is the first connection in the edasprof.prf file for the selected engine, or
choose other connections defined in edasprof.prf.

6. Click Next to see the SQL Report Wizard - Import external SQL file window.

7. Type the SQL file name that you want to import or click Browse to select it.
8. Optionally, you can run with limited records by clicking Run SQL. By default,

the Run with limited records check box is selected so you can test your
procedure with a readlimit if the engine supports it. There is a field box next
to the check box in which you can enter the number of records to be read. 100
is the default limit.

9. Click Run SQL to run your report.
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10. Click Next to see the SQL Report Wizard - Enter SQL statements window. You
can edit the imported SQL code if necessary.

11. Click Run SQL to run your report.
12. Click Next to see the SQL Report Wizard - Summary of SQL options window.

Do one of the following:
v To create a report, select the Create Report option button. This option is

selected by default.
v To create a graph, select the Create Graph option button.

13. Click Finish to run the SQL procedure. The Report Assistant or Graph
Assistant opens. When you have completed the procedure, you can run it
from the group folder in the Explorer view.
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Chapter 12. Designing a User Interface for a Web Application
With the HTML Layout Painter

Describes how to create a user interface in the local development environment
using the HTML Layout Painter.

The HTML Layout Painter allows you to graphically create an HTML page that
incorporates forms, reports, graphs, and Web objects. You can also directly edit
HTML code in the HTML Editor or a third party editor. The HTML Layout Painter
is fully integrated with JavaScript and Cascading Style Sheets (CSS).

Note:The HTML Layout Painter does not support OLAP-enabled reports.The
HTML Layout Painter is accessible only through the DB2 Web Query Developer
Workbench.

Uses for the HTML Layout Painter
You can do the following when creating an HTML layout:
v Build an HTML launch page. The HTML Layout Painter allows you to add push

buttons, hyperlinks, and other objects that launch other DB2 Web Query reports
in your application.

v Create a launch page for one or more reports that contain parameters.
v Create a complete report by adding multiple reports and graphs into a single

HTML formatted report.
v Create an advanced report layout by including images, frames, and other Web

elements. You can change the location, size, and properties of all objects in your
layout.

v Directly edit an HTML page in the HTML Editor or in a third party editor.
v Set background, font, and other properties in the Style Composer tool.

Getting Started With the HTML Layout Painter
Note: The HTML Layout Painter does not support OLAP-enabled reports. If you
execute a report from the HTML Layout Painter with this option, the output
window will not display the OLAP controls and you will receive a scripting error.
In order to execute this type of report, you must use a frame. For more
information, see Adding a Frame to the Layout.

Access the HTML Layout Painter
1. Required: Create a new HTML file by completing one of these actions:

v With the HTML folder highlighted, select New from the File menu, then
select HTML file.
or

v Click Layout Reports and Graphs in the QuickLinks pane.
The Add HTML File dialog box opens.
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2. Enter a name for the new procedure in the File name field.
3. Select HTML Layout Painter from the Create with drop-down list.
4. Click Open.

The HTML Layout Painter opens.

HTML Layout Painter Windows and Toolbars

The following image is an example of the HTML Layout Painter.
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The main elements of the HTML Layout Painter are:

Menu Bar

Displays pull-down menus for the HTML Layout Painter.

Developer Workbench

Displays tool buttons such as Open and Run.

Standard Toolbar

Displays buttons such as Cut and Paste that allow you edit the layout.

Components Toolbar

Contains buttons that add objects and form controls to the layout.

Positioning Toolbar

Contains buttons that control the appearance of the layout. For details, see
Positioning Toolbar.

Formatting Toolbar

Displays buttons that format and align text when using a text element in
the layout.

Properties Window

Displays the properties and events of objects in the layout. For details, see
Working With the Properties Window.

Events Tab

Displays the events associated with objects in the layout. For details, see
Working With the Properties Window.

QuickLinks Window
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Displays links to information on Help, configuration options, metadata
creation, and reports and procedures.

Parameters Tab

Displays information about the parameters in your report or graph. For
details, see Working With the Parameters Tab in the Properties Window.

Thumbnails Tab

Select an image from the Thumbnails tab to jump to the selected object in
the HTML layout.

Standard Toolbar

The Standard toolbar contains the following buttons:

Button Description

Saves the existing procedure (.fex) and HTML files to the
current project. This button is grayed out once the layout is
saved and no new changes have been made. When a
change has been made to the layout, the Save button is
active until the report is saved again.

Removes the highlighted object(s) and saves it to the
clipboard.

Copies the highlighted object(s) to the clipboard.

Pastes the object(s) to the specified location.

Deletes the highlighted object(s).

Resets the layout by reversing the last action performed.

Repeats the last action performed.

The Refresh All option enables you view any edits or
changes that you made to your document. Refresh All
reloads all pages and reruns the reports and graphs in
Design View.

Note: Refresh also shows changes made to reports and
graphs that are referenced in your document.

Components Toolbar

The Components toolbar contains the following buttons:

Button Description

Inserts a report object to the layout.
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Button Description

Inserts a graph object to the layout.

Tip: You may right-click a graph object to open the
Advanced Graph Assistant.

Inserts a placeholder for a form control.

Inserts a placeholder for an IFRAME. An IFRAME can have
its own URL and contain HTML content, and it can be a
placeholder for a drill-down report.

Inserts a placeholder for an image.

Inserts text.

Inserts a line.

Adds a group box.

Adds a text box.

Adds a hidden text box.

Adds a drop-down list.

Adds a list box (a drop-down list that allows multiple
selections).

Inserts a placeholder for a double list parameter control.

Adds a push button.

Adds a reset button.

Adds a radio button.

Adds a check box list.

Inserts a text area.

Inserts a tree control.

Inserts a hyperlink.
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Button Description

Adds a calendar.

Adds an ActiveX control.

Saves a selection.

Inserts a panel to group objects together. The panel is
invisible at run time.

Inserts a slider parameter control bar.

Inserts a tab control.

Formatting Toolbar

The Formatting toolbar contains options that can be applied to individual strings
of text as well as to the entire text element; with the exception of the alignment
options. The alignment options can only be applied to the text element.

For more information about using text elements, see Adding Text to the Layout.

Button Description

Applies bold formatting to the text.

Applies italic formatting to the text.

Applies underline formatting to the text

Applies superscript typography to the text.

Font style opens the Font dialog box where you can set the
Font, Font Style, Size, Color, and Effect of the text.

Aligns the text element to the left.

Aligns the text element to the center.

Aligns the text element to the right.

Aligns the text to fill the width of the text element.
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Creating a Report Page Layout
You can use the HTML Layout Painter to create an HTML page that launches and
displays your report or graph. You can add elements to the HTML page including
a report or graph, text, form controls, and so on.

You can also set properties for the HTML page in the HTML Layout Painter. For
details, see Setting HTML Page Properties.

Adding a Report or Graph to the HTML Layout
You can add a report or graph to the HTML Layout that will display when you
run the procedure. You can add an existing report or graph that resides on an
available server.

You can also include parameters in a report whose values can be assigned with
forms that are added with the HTML Layout Painter. For information, see Using
Form Controls to Supply Parameter Values.

You can set the graphic used as a placeholder for a report or graph in the layout
using the Settings dialog box. For details, see Set Page Properties.

Add an Existing Report or Graph to a Layout
1. Insert a report or graph object by doing one of the following:

v Click the Report or Graph button from the Components toolbar.
The cursor changes into a crosshair. Click and drag the crosshair to create a
report or graph object and adjust it to the size you want.
A report or graph object is created in the layout and assigned the name
report(n) or graph(n), where (n) is a number. The object will appear in gray
and white to indicate that the placeholder does not have a report or graph
associated with it. Once a report or graph is associated with the object, the
object displays the contents of the report or graph.

v From the Insert menu, select Import Existing Procedure.
Note: If you want to access the Manage Layout dialog box, choose this
method.

v Right-click in the layout and select New Report or New Graph from the
pop-up menu.

2. Do one of the following:
For a report:

Right-click the report object and select Import existing report.
For a graph:

Right-click the graph object and select Import existing graph.
The Get source file dialog box opens.
Enter the name of the procedure you want to add to the layout.

3. Click Open.
The report or graph object appears in the Design View of the HTML Layout
Painter.

4. Optionally, change the properties by adjusting the properties displayed in the
Properties tab of the Properties window. For details, see Report Properties in
the Properties Window.
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Report Properties in the Properties Window

When a report is selected, the Properties tab in the Properties window contains
options that control the properties of your report.
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Click a property to display a description of the selected property at the bottom of
the Properties window.

Graph Properties in the Properties Window

When a graph is selected, the Properties tab in the Properties window contains
options that control the properties of your graph.
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Click a property to display a description of the selected property at the bottom of
the Properties window.
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Selecting Components to Import Into a Procedure
You can select to include or exclude components to be imported into your
procedure with the Manage Layout dialog box. The Manage Layout dialog box
allows you to select from components of your request such as TABLE, SET, and
GRAPH.

If you have several requests in one procedure, you can use the Manage Layout
dialog box to suppress the display of individual TABLE, SET, and GRAPH
components (for example, temporary HOLD files). By default, the last TABLE is set
to display.

Select Components to Import Into a Procedure
1. Select Import Existing Procedure from the Insert menu.

The Get source file dialog box opens.
2. Select a File name and click Open.

The Manage Layout dialog box opens. For details, see Manage Layout Dialog
Box.

Manage Layout Dialog Box

The following image is the Manage Layout dialog box.
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The Manage Layout dialog box contains the following fields/options:

Components

Displays all the components (SET, DEFINE, etc.) in the request.

Data

Displays the contents of the selected component.

Component Legend

Determines whether the request is included in the procedure, outside of
the procedure, or in the procedure and layout.

In focexec and layout

Activates the component and displays the component in the layout.

In focexec only

Deactivates the component and does not display the component in
the layout. This is a good method for hiding report requests that
produce temporary files.

Not in focexec

Removes the component from the procedure.

Show layout items only (reports and graphs)

Displays the layout’s reports and graphs in the Data field.

This check box only displays when you access the Manage Layout dialog
box from the Insert menu. When accessing it from the pop-up menu, only
the report or graph component displays, and the check box does not apply.

Adding a Frame to the Layout
You can use a frame to embed additional Web sources or run reports. You can also
use a frame as the output location or target for a drill-down report. You can also
use a frame to run a table of contents report, an OLAP report, a PDF report, or an
Excel report.

Add a Frame to the Layout
1. Required: Insert a frame by doing one of the following:

v Click the Frame button.
v From the Insert menu, select Frame.
The cursor changes into a crosshair.

2. Click and drag the crosshair to create a frame and adjust it to the size you
want.
A frame is created in the layout and assigned the name iframen, where n is a
number.

3. Optionally, change the frame’s properties by adjusting the properties displayed
in the Properties tab of the Properties window. For details, see Frame Properties
in the Properties Window.

Assign a URL, HTML Form, or Report to a Frame
1. Insert a frame by doing one of the following:

v Click the Frame button.
v From the Insert menu, select Frame.
The cursor changes into a crosshair.
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2. Click and drag the crosshair to create a frame and adjust it to the size you
want.
A frame is created in the layout and assigned the name iframe(n), where (n) is
a number.

3. Right-click the frame, and select Frame Properties from the pop-up menu.
The Hyperlink Properties dialog box opens.

4. Click the New icon to create a new action. From the drop down list in the
Action field you can select:
v URL: To assign a URL address to the frame, select URL and enter the fully

qualified URL in the Source field.
v HTML File: To assign an HTML file to the frame, click select HTML File and

enter the file’s location in the Source field, or click the browse (...) button to
browse to the location. An HTML file refers to the HTML files in your
application.

v External Procedure: To assign an external procedure to the frame, select
External Procedure and enter the procedure’s location in the Source field, or
click the browse (...) button to browse to the location.

5. Click OK.
6. Optionally, change the frame’s properties by adjusting the properties displayed

in the Properties tab of the Properties window. For details, see Frame Properties
in the Properties Window.

Show/Hide a Frame in the Layout
1. Required: From the HTML Layout Painter, use form controls to supply

parameter values for a report.
Note: A report with parameters requires that you to select values (at run time)
in order to generate the output.
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2. Click the frame (report object) and select False from the Auto Execute
drop-down list in the Properties tab of the Properties window.

Note: False is the default Auto Execute option for reports with parameters.
3. Right-click the frame (report object) in the Design View and select Style from

the context menu.
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The Style Composer opens.
4. Select Layout from the left-side of the Style Composer to view the layout

options for the selected frame.
5. From the Flow control area, select Do not display from the Display drop-down

list.

This option hides the frame at run time until the values are selected.
6. Click OK to close the Style Composer.
7. Run the HTML page.

In the example below, the frame is not shown before the values are selected.
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In the same example below, parameter values have been selected and the frame
appears showing the output results.

472 System i: Database IBM DB2 Web Query for System i



Frame Properties in the Properties Window

When a frame is selected, the Properties tab in the Properties window contains
options that control the properties of your frame.
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Click a property to display a description of the selected property at the bottom of
the Properties window.

Adding a Line to the Layout
You can add a horizontal or vertical line to the layout. This is useful for
distinguishing between sections of your launch or display page.
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Add a Line to the Layout
1. Do one of the following:

v Click the Line button.
v From the Insert menu, select Line.
The cursor changes into a crosshair.

2. Click and drag the crosshair to create a horizontal or vertical line.
A line is created in the layout.

3. Optionally, change the line’s properties by adjusting the properties displayed in
the Properties tab of the Properties window. For details, see Line Properties in
the Properties Window.

Line Properties in the Properties Window

When a line is selected, the Properties tab in the Properties window contains
options that control the properties of lines.
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To view a description of a property at the bottom of the Properties window, click
the desired property.

Adding an Image to the Layout
You can add an image to the layout. This is useful for including graphics such as a
company logo.

You can insert an image into your report layout and add a hyperlink to it. After
you run your report and click the image you can launch a URL or run a report the
same way you can by clicking a hyperlink or push button. For more information,
see Add a Hyperlink to a Push Button or an Image.

Note: When inserting images, images must be referenced from a specific directory
location. Links to images are not supported.

Add an Image to a Layout
1. Do one of the following:

v Click the Image button.
v From the Insert menu, select Image.
The Get source file dialog box opens.

2. Navigate to the directory where the image is located using the Look in menu,
then select the image you want to add to the layout.

3. Click Open.
4. Optionally, change the image’s properties by adjusting the properties displayed

in the Properties tab of the Properties window. For details, see Image Properties
in the Properties Window.
Note: You can always return an image to its original size by right-clicking the
image and selecting Image properties from the pop-up menu, then selecting
Restore size.

Image Properties in the Properties Window

When an image is selected, the Properties tab in the Properties contains options
that control the properties of images.
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Click a property to display a description of the selected property at the bottom of
the Properties window.
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Adding Text to the Layout
You can add text to the layout. This is useful for including headings for your Web
page, or adding directions or explanation for your report or graph.

Add Text to a Layout
1. Insert text to the layout by doing one of the following:

v Click the Text button.
v From the Insert menu, select Text.
A text object appears.

2. Replace the text with the text you want to appear in the layout.
3. Optionally, change the text’s properties by adjusting the properties displayed in

the Properties tab of the Properties window. For details, see Text Properties in
the Properties Window.

Format Text in the Layout

You may apply various formatting and style options to words and individual text
characters within the text element. The formatting options are available from the
Formatting toolbar in the HTML Layout Painter.

Note: Any formatting and styling that you may have applied to individual text
strings within the text element will remain unchanged. Changes made to the entire
text element are only applied to part of the text string that has not been formatted.
1. Required: Insert a text element into the layout and type text in the text element.
2. Required: Select the text that you wish to format:

v To format the entire text element, single click the text object in the layout.
v To format an individual word or text character, highlight part of the text

within the text element.
The Formatting toolbar is activated.
Note: The Bold, Italic, Underline, Superscript, and Font Style options are
available when formatting individual words or text characters. The Font Style
and Alignment options are available when the entire text element is selected.

3. Select from the formatting options available from the Formatting Toolbar.
4. Select Font Style from the Formatting toolbar to open the Font dialog box, from

which you can change the type, style, color, size, and effect of the Font.
Tip: You may also access the Font Style dialog box from the Font ellipse button
of the Styling Font field in the Properties window.

5. Click OK to close the Font dialog box.

The format options are applied to the text selected.

Text Properties in the Properties Window

When text is selected, the Properties tab in the Properties window contains options
that control the properties of text in your report.
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Adding a Hyperlink to the Layout
You can create a hyperlink for your HTML page. A hyperlink can execute a report,
link to a URL, or open an HTML page. You can create a hyperlink in two ways:
v Insert a hyperlink. For details, see Create a Hyperlink.
v Add a hyperlink to a push button or image. For details, see Add a Hyperlink to

a Push Button or an Image.

Create a Hyperlink
1. Do one of the following:

v Click the Hyperlink button.
v Select Hyperlink from the Insert menu.
The Hyperlink Properties dialog box opens.
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2. Enter the text you want to display as the hyperlink in the Display Text field.
3. Required: Set the action of the hyperlink:

v To link to a URL, select URL in the Action section, and enter the URL in the
Source field.

v To open an HTML page, click select HTML in the Action section, and enter
the HTML page in the Source field.

v To execute an embedded procedure, select Embedded procedure and enter
the procedure name in the Source field, or click the browse (...) button to
browse to the procedure.

v To execute an external procedure, select External procedure and enter the
procedure name in the Source field, or click the browse (...) button to browse
to the procedure.

v To refresh or repopulate Active Reports based on selected values in Active
Report controls, select Refresh Active Reports and specify the source or
which Active Report(s) should be refreshed.
For more information about Active Report controls, see Creating Active
Dashboards.

4. Optionally, direct the output to a specific location by selecting Window or
Frame in the Target Type field.

5. Specify a name for the target window by selecting one of the default values
from the Target/Template Name drop-down list or by typing the name of a
new or existing window in the Target/Template Name field.

6. Click OK.
7. Execute the request and click the image to launch the web page of the URL

Address you typed in the Source field.
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Add a Hyperlink to a Push Button or an Image

To add a hyperlink to a push button or image, complete the following steps.
1. Right-click the push button or image, and select Create hyperlink. The

Hyperlink Properties dialog box opens.
2. Click the New icon to generate a new request and select URL from the Action

drop-down list.
3. Type a URL in the Source field.
4. Optionally, in the Target Type field, direct the output to a specific location by

selecting Window or Frame from the drop-down list.
5. In the Target/Template Name field, specify a target window by selecting one of

the default values from the drop-down list or by typing the name of a new or
existing window.

6. Click OK.
7. Execute the request and click the image to launch the web page of the URL

Address you typed in the Source field.

Adding a Group Box to the Layout
A group box can be used to create a border around a group of objects, for example,
forms or reports and graphs.

Add a Group Box
1. Insert a group box by doing one of the following:

v Click the Group box button.
v From the Insert menu, select Group box.
The cursor changes into a crosshair.

2. Click and drag the crosshair to create a group box and adjust it to the size you
want.
A group box is created in the layout and assigned the name groupbox(n),
where (n) is a number.

3. Optionally, you may change the default name of the group box and format the
text, as shown in the image below.

For more information about formatting text, see Format Text in the Layout.
4. Optionally, change the group box’s properties by adjusting the properties

displayed in the Properties tab of the Properties window. For details, see Group
Box Properties in the Properties Window.

Group Box Properties in the Properties Window

When a group box is selected, the Properties tab in the Properties window contains
options that control the properties of a group box.
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Click a property to display a description of the selected property at the bottom of
the Properties window.

Adding a Push Button to the Layout
You can add a push button to the layout. A push button enables you to execute a
report, or link to a URL or HTML form. This behavior is similar to a hyperlink.

For information on adding a hyperlink to a push button, see Add a Hyperlink to a
Push Button or an Image.

Create a Submit Button
1. If the submit button is deleted from the layout, a push button can be used to

replace the button. Insert a push button by doing one of the following:
v Click the Push button from the Components toolbar.
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v From the Insert menu, select Push Button.
The cursor changes into a crosshair.

2. Click and drag the crosshair to create a push button and adjust it to the size
you want.
A push button is created in the layout and assigned the name button(n), where
(n) is a number.

3. Assign an action to the push button by using the Hyperlink Properties dialog
box. Right click on the push button and select Hyperlink properties from the
context menu.
The Hyperlink Properties dialog box opens. Use the Hyperlink Properties
dialog box to assign a target and action to the push button.

4. Click OK to close the Hyperlink Properties dialog box.
5. Run the HTML page.
6. Click the push button to submit your request.

Run Multiple Reports with One Submit Button
1. Right click on the submit button, or the frame for the whole control, and select

Hyperlink properties from the context menu.
The following image is an example of the submit button selected.

The following image is an example of the whole control selected.
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The Hyperlink Properties dialog box opens.

2. Required: Click the New icon and use the drop-down lists to add the second
report request to be executed with the submit button.

Repeat these steps for multiple procedures.
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Push Button Properties in the Properties Window

When a push button is selected, the Properties tab in the Properties window
contains options that control the properties of your buttons.

Click a property to display a description of the selected property at the bottom of
the Properties window.
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Adding a Reset Button to the Layout
You can add a reset button to the layout. A reset button enables you to reset the
form back to its initial settings.

Create a Reset Button
1. If the reset button is deleted from the layout, you may create a new reset

button. Insert a reset button by doing one of the following:
v Click the Reset button from the Components toolbar.
v From the Insert menu, select Reset Button.
The cursor changes into a crosshair.

2. Click and drag the crosshair to create a reset button and adjust it to the size
you want.
A reset button is created in the layout and assigned the name reset(n), where
(n) is a number.

3. Run the HTML page.
4. When selecting criteria to submit a report, click the reset button to reset the

form back to its initial settings.

Reset Button Properties in the Properties Window

When a Reset button is selected, the Properties tab in the Properties window
contains options that control the properties of your buttons.
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Click a property to display a description of the selected property at the bottom of
the Properties window.

Adding a Tab Control to the Layout
You can add a tab control to the layout. Tab controls enable you to create multiple
pages in one HTML form and present a better display of viewing secondary
information.
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When a tab control object is added to the layout, each tab control consists of:
v A tab item.

A tab item is the tab label. You may edit the name of the tab item, style the tab
item, and add multiple tab items. Each tab item is associated with a tab body.

v A tab body.
A tab body is the tab page where you associate your components such as
report/graph objects, images, and lines.

The Tab control can be displayed as a full screen or part of an HTML page.

In the example below, the selected tab shows a report and a second tab that
contains a graph.

Create a Tab Control
1. Insert a tab control to the layout by doing one of the following:

v Click the Tab control button from the Components toolbar.
v Select Tab Control from the Insert menu.
The cursor changes into a crosshair.

2. Click and drag the crosshair to create a tab control object and adjust it to the
size you want.
Tip: You should make the object large enough to associate report/graph
components within the tab control.
A tab control object is created in the layout and assigned the Properties name
tab(n), where(n) is a number of the tab. By default, the tab control has one tab
page. Each tab page consists of a tab item (tabitem(n)) and tab body
(tabitembody(n)).
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3. Optionally, change the tab control’s properties by adjusting the properties
displayed in the Properties tab of the Properties window.

Enable Full Screen Mode for the Tab Control

You may resize the tab control to fit the full screen of your layout, making the tab
control the full background of your browser window at run time. When set to full
screen mode, scroll bars will not be applied to the output window. Therefore, you
may have to adjust the tab control (and any items on the tab) in the layout to
ensure that they appear appropriately for display at run time.

Note: It is recommended to set the tab control to full screen mode at the beginning
of the development process. If there are existing components on the layout that are
not part of the tab control, these components will become inaccessible if the tab
control is changed to full screen mode.
1. Select tab control from the Insert menu.

The cursor changes into a crosshair.
2. Click and drag the crosshair in the layout to create the tab control object.
3. Right-click the tab control and select Full screen mode from the context menu,

as shown in the image below.

The tab control displays as a full screen in the layout, as shown in the image
below.
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Note: This setting can be applied only to one tab control in your application. If
one tab control is set to full screen mode, the full screen mode item will be
greyed out for any additional tab controls.

4. To resize the tab control, right-click and uncheck the Full screen mode option,
as shown in the image below.
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Add Additional Tabs
1. Required: Select the tab control object in the layout.
2. Required: Right-click and select Add tab item from the context menu.

A tab is added to the tab control object.
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3. To align multiple tab items, select the tab control object and click AutoArrange
from the context menu,

The tab items are resized to the size of the widest tab item and evenly spaced.

Tab Control Properties in the Properties Window

When a Tab control is selected, the Properties tab in the Properties window
contains options that control the properties of your tabs.

Note: You may set options for the Tab control, individual tab items, and the tab
body.
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Click a property to display a description of the selected property at the bottom of
the Properties window.

Modify and Style the Tabs

You may modify and style the tab item(s) and tab body properties.
1. Use the Formatting toolbar to format the text in the tab item.
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2. Click the tab item/tab body and use the right-click context menu to edit the
text (if applicable), Font Style, Style, and Properties.

Modify the Size, Appearance, and Location of the Tabs

When the tab control is selected, you may change the default size of the tab labels,
the appearance of the tabs, and the location of the tab items on the tab control.

Note: These properties are available from the Properties tab of the Properties
window when the tab control is selected. The tab control appears as tab(n) in the
Properties window drop-down list.
1. To change the default size of the tab labels, adjust the Tab: default distance,

Tab: default height, and Tab: default width properties.
2. To change the appearance of the tabs, select Straight or Round from the Tab:

edges properties field.
Note: The default tab edge is Straight.

3. To change the location of the tab items on the tab control, select Top, Bottom,
Left, or Right from the Tab: location properties field.
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The default tab location is Top.
Note: If the tab location is changed, any background images applied to the tabs
will not be rotated. You will have to reinsert a different image that is rotated
appropriately.

Use the Tab Item Background Properties Field

In addition to using the Style Composer, you can add background images to tab
items by using the Background properties field.

The Background properties field is available from the Properties tab of the
Properties window when the tab item is selected. The tab item appears as
tabitem(n) in the Properties window drop-down list.
1. Select the tab item in the layout, or click the tabitem(n) property from the

Properties window drop-down list.
2. Click the Background ellipse button from the tab item properties window.

The Get source file dialog box opens, as shown in the image below.

3. Select a File name and click Open.
The background image is added to the tab item.
Note: You may have to manually resize the tab item to fit the image.
Tip: If the tab location is changed (from Top to Left for example), any
background images applied to the tabs will not be rotated. You will have to
reinsert a different image that is rotated appropriately.
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Add Background Images to Tabs

You may add background images to a tab item or tab body using the Style
Composer. For example, you may add a small icon with text to a tab item; or your
company logo as the background image for a tab body.

Note: Background images can also be applied to tab items by using the
Background Property setting. For more information, see Use the Tab Item
Background Properties Field.
1. Select Style from the right-click context menu of the tab item/tab body.

The Style Composer dialog box appears.
2. Select Background to show the Background image options.
3. Select a source file in the Image field and adjust the Tiling, Scrolling, and

Position options.
Tip: If adding an icon to a tab item, select a small image and do not tile the
image.
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4. If using text in addition to a background image for a tab item, select Text from
the Style Composer to view and change the Alignment options.

5. Click OK to close the Style Composer.
The background image is added to the tab item/tab body.

Associate Components to the Tab Body

You may associate any component from the Insert menu (such as an image, line,
and so on) to the tab body. This procedure details how to add a report/graph
object component to the tab body.
1. To add a new report/graph object to the tab body:

v Select New Report or New Graph from the Insert menu.
The cursor changes into a crosshair.

v In the tab control body, click and drag the crosshair to create the
report/graph object and adjust it to the size you want.

v Open, import, or reference a report or graph procedure.
2. To associate an existing component in the layout to a tab body:

v Select the component in the layout.
v Hold down the Alt key on your keyboard and drag the component into the

tab body.
The component is associated to the tab body.

Using Form Controls to Supply Parameter Values
Form controls allow you to prompt users for a parameter value. When you create a
parameter as part of a report or graph, the HTML Layout Painter automatically
adds a form control, Submit button, and Reset button for the parameter to your
layout, and the parameter appears in the parameters box. You can also add a form
control and then associate it with a parameter.

When you delete a parameter in the Report Assistant that was assigned a form
control in the HTML Layout Painter, you must delete the associated controls
individually.

Form controls, with the exception of a text box which does not supply a list of
possible values, can supply values with a dynamic or static list of values:
v A dynamic list retrieves values from a specified data source when the request is

run.
v A static list consists of a list of values you supply. These values do not change

unless you change them.
v An active report control lists Active Report values that mimic Active Report

menu items.
Note: Active Report Controls cannot be associated to any parameters in the
layout. This type of control can only be associated with an Active Report in the
Layout.

The properties of a form control, as well as the parameters associated with each
form control, can be controlled with the Properties tab and Parameters tab of the
Properties window. For details, see Working With the Properties Window and
Working With the Parameters Tab in the Properties Window, respectively.
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For details about static and dynamic form controls, see Creating a Static List of
Parameters and Creating a Dynamic List of Parameters.

For details about Active Report form controls, see Creating Active Dashboards.

Types of Form Controls

Form controls can be single or multi-select.

Examples of single-select form controls are:
v A text box. For details, see Using a Text Box.
v A drop-down list. For details, see Using a Drop-Down List.
v Radio buttons. For details, see Using Radio Buttons.
v A text area. For details, see Using a Text Area.

Examples of multi-select form controls are:
v A list box. For details, see Using a List Box.
v Check boxes. For details, see Add a List Box.
v A tree control. For details, see Using Tree Controls.

The default control type for all single select parameters is a drop down list. The
default control type for all multi-select parameters is a list box.

You can change the type of form control using the Parameters tab. For details, see
Change the Type of Form Control Associated With a Parameter.

Note: Individual multi-select parameters must be designated as multi-select in the
Report Assistant in order to process multiple values.

Using a Text Box
A text box enables you to enter a parameter’s value in a text entry field.

Create a Text Box
1. Add a text box by doing one of the following:

v Click the Text Box button.
v From the Insert menu, select Text box.
The cursor changes to a crosshair.

2. Click and drag the crosshair to create a text box and adjust it to the size you
want.
A text box is created in the layout and assigned the name editn, where n is a
number.

3. To associate an existing parameter with the text box, click the Parameters tab of
the Properties window, find the row with the name of the text box (editn), click
the Parameter field in that row, click the down arrow to the right of
Unassigned at the edge of the Parameter field, and select the parameter you
want to associate with the text box.

4. Optionally, enter a value for the text box.
5. Optionally, change the text box’s properties by adjusting the properties

displayed in the Properties tab of the Properties window. For details, see Text
Box Properties in the Properties Window.
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Enter Masked Text in a Text Box

When entering a value in a text box at run time, you may set the mask text
property so that the text is not displayed as text, but masked by default characters.
This is recommended when using passwords or other sensitive information.
1. Select the Text Box object to view the associated properties.

You may also select the text box properties from the drop-down list of the
Properties window. The properties for the text box appears as editn <INPUT>.

2. Required: From the Mask text property field, select Yes.

3. Run the report and enter a value in the text box.

The value being entered appears as masked text, as shown in the image below.
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Text Box Properties in the Properties Window

When a text box is selected, the Properties tab in the Properties window contains
options that control the properties of your text box.
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Click a property to display a description of the selected property at the bottom of
the Properties window.
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Using a Text Area
A text area is a single-select form control that enables you to enter multiple lines of
text that can be assigned to a single variable. The behavior is similar to a text box,
but you are not restricted to entering just one line of text. For example, if you want
to assign a paragraph (multiple lines of text) to a variable that can be referenced by
a procedure, you can add the paragraph to a text area from the Parameters tab of
the Properties window.

The following image shows the text area component in the HTML Layout Painter.

Create a Text Area

1. Required: Click the Text Area button.
or
From the Insert menu, select Text Area.
The cursor changes to a crosshair.

2. Click a location on the layout page, drag the crosshair to create a rectangular
text area, release the left mouse button, and adjust the text area to the desired
size.
A text area is created in the layout and assigned the name textarea(n), where n
is a number.
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3. To associate values from an existing parameter with the text area, click the
Parameters tab in the Properties window, find the row with the name of the
text area (textarean), click the Parameter field in that row, click the down arrow
to the right of Unassigned at the edge of the Parameter field, and select the
parameter you want to associate with the text area.

4. To associate static text values or dynamically retrieved data source values,
select the Static or Dynamic option in the Control Values section of the
Parameters tab.
v Static - To add one or more lines of text as static values, type or paste text in

the area below the Static values label in the Parameters tab.
v Dynamic - To add dynamic values, select the Data source option to retrieve

values from a data source, or select the Procedure option to retrieve values
from a procedure. Click the browse (...) button, select a source file from the
Get source file dialog box, and click Open. For the Data source option only,
select a data field from the tree structure displayed at the bottom of the
Parameters tab.

5. Optionally, you can change the text area’s properties in the Properties tab of the
Properties window.

Text Area Properties and Events in the Properties Window

When a text area is selected on the layout page and the Properties tab is selected in
the Properties window, properties are listed in the left column that can be
controlled from the right column. Selecting an option in the left column displays a
description at the bottom of the Properties window.

A text area is associated with the following properties:

Access key, Class identifier, Columns, Direction of text, Disabled, break style,
Language information, Name, Read only, Rows, Tabs Index, Title Unique
Identifier

When a text area is selected on the layout page and the Events tab is selected
within the Properties tab in the Properties window, events are listed in the left
column that can be assigned an action from the right column.

A text area is associated with the following events:

onblur, onchange, onclick, ondblclick, onfocus, onkeydown, onkeypress,
onkeyup, onmousedown, onmousemove, onmouseout, onmouseover,
onmouseup, onselect

Optionally, you can change the text area’s properties and parameters. For details,
see Working With the Properties Window and Working With the Parameters Tab in
the Properties Window.

Using a Drop-Down List
A drop-down list enables you to select a single value from a list of supplied
values. You can use either a dynamic drop-down list, or a static drop-down list.

Add a Drop-Down List
1. Required: Add a drop-down list by doing one of the following:

v Click the drop-down list button.
v From the Insert menu, select drop-down list.
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The cursor changes to a crosshair.
2. Required: Click and drag the crosshair to create a drop-down list, and adjust it

to the size you want.
A drop-down is created in the layout and assigned the name combobox(n),
where n is a number.

3. Required: To associate an existing parameter with the drop-down list, click the
Parameters tab of the Properties window, find the row with the name of the
drop-down list (combobox(n)), click the Parameter field in that row, click the
down arrow to the right of Unassigned at the edge of the Parameter field, and
select the parameter you want to associate with the drop-down list.

4. In the Control Values section of the Parameters tab, select static or dynamic
values for the drop-down list. For details, see Associating Form Controls With
Parameters.

5. Optionally, change the drop-down list’s properties by adjusting the properties
displayed in the Properties tab of the Properties window. For details, see
Drop-Down List Properties in the Properties Window.

Drop-Down List Properties in the Properties Window

When a drop-down List is selected, the Properties tab in the Properties window
contains options that control the properties of your drop-down list.
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Click a property to display a description of the selected property at the bottom of
the Properties window.

Using a List Box
A list box enables you to select single or multiple values at one time:
v A single select list enables you to select only one value for each time a request is

run.
v A multi-select list enables you to select multiple values by using the Ctrl key

while selecting values. In order to provide multiple values, the procedure must
be set up to accept multiple values.
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List box values can be dynamic or static.

Add a List Box
1. Add a list box by doing one of the following:

v Click the list box button.
v From the Insert menu, select List box.
The cursor changes to a crosshair.

2. Click and drag the crosshair to create a list box, and adjust it to the size you
want.
A list box is created in the layout and assigned the name listbox(n), where n is
a number.

3. To associate an existing parameter with the list box, click the Parameters tab of
the Properties window, find the row with the name of the list box (listbox(n)),
click the Parameter field in that row, click the down arrow to the right of
Unassigned at the edge of the Parameter field, and select the parameter you
want to associate with the list box.

4. In the Control Values section of the Parameters tab, select static or dynamic
values for the list box. For details, see Associating Form Controls With
Parameters.

5. Optionally, change the list box’s properties by adjusting the properties
displayed in the Properties tab of the Properties window. For details, see List
Box Properties in the Properties Window.

List Box Properties in the Properties Window

When a list box is selected, the Properties tab in the Properties window contains
properties of your list box.
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Click a property to display a description of the selected property at the bottom of
the Properties window.

Using a Double List Control
You may add a double list form control for displaying multi-select parameter
values. This enables you to view a list of the available values and add or remove
them from one list to another. At run time, a report is generated based on the
values that are added.
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Add a Double List Form Control
1. Add a double list control by doing one of the following.

v Click the Double List control button from the Components toolbar.
v From the Insert menu, select Double List Control.
The cursor changes to a crosshair.

2. Click and drag the crosshair to create a double list control, and adjust it to the
size you want.
A double list control is created in the layout and assigned the name
customselect(n)_selectfrom and customselect(n)_selectto, where n is a number.

3. To associate an existing parameter with the double list control, click the
Parameters tab of the Properties window, find the row with the name of the
double list control (listbox(n)), click the Parameter field in that row, click the
down arrow to the right of Unassigned at the edge of the Parameter field, and
select the parameter you want to associate with the double list control.
Note: You may also add a double list control from the New Parameters dialog
box that appears when creating a report with multi-select parameters. For more
information about the New Parameters dialog box, see Setting Form Controls
for New Parameters.

4. In the Control Values section of the Parameters tab, select Static or Dynamic
values for the double list control. For details, see Associating Form Controls
With Parameters.

5. Optionally, change the double list control’s properties by adjusting the
properties displayed in the Properties tab of the Properties window. For details,
see Double List Box Properties in the Properties Window.

6. Run the HTML page and select values by using the arrows to add or remove
values to the selected column.
Note: The selected values appear in the second column. The output is
generated based on the selected values in the second column. In the example
below, Action and Classic are the selected values for the report.
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Double List Box Properties in the Properties Window

When a double list box is selected, the Properties tab in the Properties window
contains properties of your double list control.
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Click a property to display a description of the selected property at the bottom of
the Properties window.

Using Check Boxes
Check boxes enable you to select values from a list of values. You can select single
or multiple values at one time:
v A single select list enables you to select only one value each time a request is

run.
v A multi-select list enables you to select multiple values. In order to provide

multiple values, the procedure must be set up to accept multiple values.

Check box list values can be dynamic or static.

Add Check Boxes
1. Add check boxes by doing one of the following:

v Click the Check box button.
v From the Insert menu, select Check box.
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The cursor changes to a crosshair.
2. Click and drag the crosshair to create a check box list and adjust it to the size

you want.
A check box is created in the layout and assigned the name checkbox(n), where
n is a number.

3. To associate an existing parameter with the check box, click the Parameters tab
of the Properties window, find the row with the name of the check box
(checkbox(n)), click the Parameter field in that row, click the down arrow to the
right of Unassigned at the edge of the Parameter field, and select the parameter
you want to associate with the check box.

4. In the Control Values section of the Parameters tab, select static or dynamic
values for the check boxes. For details, see Associating Form Controls With
Parameters.

5. Optionally, check box list’s properties by adjusting the properties displayed in
the Properties tab of the Properties window. For details, see Check Box
Properties in the Properties Window.

Check Box Properties in the Properties Window

When a check box is selected, the Properties tab in the Properties window contains
properties of your check box.
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Click a property to display a description of the selected property at the bottom of
the Properties window.

Using Radio Buttons
Radio buttons enable you to select a single value from a list of supplied values.
Radio button values can be static or dynamic.

Add Radio Buttons
1. Add radio buttons by doing one of the following:

v Click the Radio button.
v From the Insert menu, select Radio button.
The cursor changes to a crosshair.

2. Click and drag the crosshair to create a radio buttons list and adjust it to the
size you want.
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A radio button placeholder is created in the layout and assigned the name
radio(n), where n is a number.

3. To associate an existing parameter with the radio buttons, click the Parameters
tab of the Properties window, find the row with the name of the radio buttons
(radio(n)), click the Parameter field in that row, click the down arrow that
appears to the right of Unassigned at the edge of the Parameter field, and
select the parameter you want to associate with the radio buttons.

4. In the Control Values section of the Parameters tab, select static or dynamic
values for the radio buttons. For details, see Associating Form Controls With
Parameters.

5. Optionally, change the radio buttons’ properties by adjusting the properties
displayed in the Properties tab of the Properties window. For details, see Radio
Buttons Properties in the Properties Window.

Radio Buttons Properties in the Properties Window

When a radio button is selected, the Properties tab in the Properties window
contains options that control the properties of your radio buttons.
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Click a property to display a description of the selected property at the bottom of
the Properties window.

Using Tree Controls
You can show hierarchical data from a multi-dimensional data source (for example,
SAP BW), by using a tree structure in an HTML report. This feature is only
available for hierarchies that use the parent/child model; level hierarchies are not
supported.

The behavior of the tree control is integrated with the parameter definition. If a
parameter is defined as a single value and that parameter is assigned to a tree
control, the control uses option buttons for each node in the hierarchy. If the
parameter is defined as MULTIPLE OR then the control uses check boxes for each
node in the hierarchy, enabling you to select multiple nodes.
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The following image shows the Tree Control component in the HTML Layout
Painter.

Add a Tree Control to an HTML Page Using a Data Source

1. Required: In the HTML Layout Painter, click the Tree Control icon from
the toolbar.

2. Required: Click and drag your cursor over the canvas to select the area for the
tree control.

3. Select the tree control and click the Parameters tab on the Properties window.
4. In the Control Values field, select Dynamic.
5. Select the Data Source option button and click the browse (...) button adjacent

to the text box.
6. Select a multi-dimensional data source and click OK.
7. Expand the Dimensions folder, a Dimension, and the Hierarchies folder.
8. Select a field from the hierarchy and add it to the Value field text box and the

Display field text box.

Add a Tree Control to an HTML Page Using an Existing
Procedure

You can select an existing procedure to add to the tree control in an HTML report.
When you select a procedure, it should use fields from the parent/child hierarchy
and be set up as follows:
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TABLE FILE file
SUM FST.dispfield
BY ParentUniqueField
BY UniqueField
BY datafield
ON TABLE PCHOLD FORMAT XML
END

where:

file

Is the name of the data source.

dispfield

Is the field whose values display in the tree control.

ParentUniqueField

Is the field that represents the parent for the parent/child hierarchy
(PROPERTY = PARENT_OF).

UniqueField

Is the field that represents the unique IDs for the hierarchy members
(PROPERTY=UID).

datafield

Is the field whose values are passed as the parameter value.

After the procedure is set up, follow these steps:

1. In the HTML Layout Painter, click the Tree Control icon from the toolbar.
2. Click and drag your cursor over the canvas to select the area for the tree

control.
3. Select the tree control and then click the Parameters tab on the Properties

window.
4. In the Control Values field, select Dynamic.
5. Select the Procedure option button and click the browse (...) button adjacent to

the text box.
6. Select a procedure and click Open.

Properties and Events for the Tree Control

The tree control has the following properties:

Class identifier, Direction of text, break style, Language information, Title,
Unique Identifier

The tree control is associated with the following events:

onclick, ondblclick, onkeydown, onkeypress, onkeyup, onmousedown,
onmousemove, onmouseout, onmouseover, onmouseup

Using a Slider Control
You may add a slider control for numeric range values in a report or graph. This
enables you to use a slider bar to select from a range of values.
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Add a Slider Control
1. Required: Add a slider control by doing one of the following.

v Click the Slider button from the Components toolbar.
v From the Insert menu, select Slider.
The cursor changes to a crosshair.

2. Required: Click and drag the crosshair to create a slider control, and adjust it to
the size you want.
A slider control is created in the layout and assigned the name slider(n), where
n is a number.
Note: The Slider control is determined by the default slider control type
selected from the Settings Dialog Box. For details about changing the slider bar,
see How to Change the Default Slider Bar.

3. To associate an existing parameter with the slider control, click the Parameters
tab of the Properties window, find the row with the name of the slider control
(slider(n)), click the Parameter field in that row, click the down arrow to the
right of Unassigned at the edge of the Parameter field, and select the parameter
you want to associate with the slider control.
Note: You may also add a slider control from the New Parameters dialog box
that appears when creating a report or graph with numeric range values. Slider
is automatically selected as the control type if a numeric range parameter is
detected. For more information about the New Parameters dialog box, see
Setting Form Controls for New Parameters.

4. You may modify the static minimum and maximum values for the range by
using the Parameters tab of the Properties window.
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Note: Step indicates how the numbers increment on the slider bar.
5. In addition, you may change the range of values from static to dynamic by

using the Parameters tab of the Properties window. Select a data file to retrieve
values from.
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Note: Click Ctrl + Shift to add a value to the Display field.
6. Optionally, change the slider control’s properties by adjusting the properties

displayed in the Properties tab of the Properties window. For details, see Slider
Control Properties in the Properties Window.
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7. Run the HTML page and use the slider bar to slide the parameter values up or
down. You may also use the end arrows to increase or decrease the numbers in
the range. The output is generated based on the selected number from the
slider bar.

Change the Default Slider Bar

The default slider type is determined from the Settings dialog box.
1. To change the default slider type, select Settings from the Tool menu. The

Settings dialog box opens.
2. Click the Form’s Settings button to open the Form settings dialog box.
3. Use the drop-down list to change the default slider control type. You may select

from:
v Horizontal or Vertical Slider Simple bar. The slider bar has no end arrows,

just a bar with the slider.
v Horizontal or Vertical Slider with Color Bar and Arrows. Arrows appear at

each end of the slider bar.
v Horizontal or Vertical Slider with Color Bar, Arrows, and Edit. Arrows and

an edit box appear at the end of the slider bar, showing the current value.
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Note: Once a slider control is inserted into the HTML Layout, changing these
options will not affect the existing sliders, the option is only applied to new
slider controls. To change the existing slider bar type, delete the slider object
and insert a new slider control.

Slider Control Properties in the Properties Window

When a slider control is selected, the Properties tab in the Properties window
contains properties of your slider control.

Click a property to display a description of the selected property at the bottom of
the Properties window.
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Adding a Dynamic Calendar
Date parameters can utilize a built-in calendar control that enables you to select
the desired date or range of dates in a pop-up dynamic calendar. A procedure that
is added to or referenced in the HTML Layout Painter and contains date
parameters will have a Calendar control type available in the Properties tab of the
Properties window.

When the Calendar control type is selected, a text box with a calendar icon will
display in the Design View of the Layout. The text box is the only control available
for the calendar, and the icon will always display to the right of the text box. The
icon cannot be positioned independently from the text box.

Note that when programmatically returning a date to the calendar, the date must
be in a FOCUS date format that specifies the complete date from the list of
supported data types in Calendar Properties.

Set Calendar Properties
1. Right-click the calendar icon, and select Calendar Properties.

The following menu appears.

This menu enables the developer to set the range of dates available to the user
at run time. Available dates will be represented as an active hyperlink (blue
and underlined) and unavailable dates will be static (black without underlines).

2. Select an option for setting the range of dates:
v Static. This option will set a static date range in which the developer will

select a start date and an end date using a pop-up calendar or by clicking the
month, day, or year from the controls. This setting is the default.
By default, the current date is selected and circled in red. As you scroll
through the calendar with the left/right arrows, the currently selected day
will remain highlighted for each month. Clicking a date will add that date to
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the control. Dates can be selected by scrolling left to right, entering the
month, day, and year as text, or by selecting the month, day, and year from
the drop-down list and spin boxes.

v Relative. This option allows the developer to set a specific number of days,
months, and years relative to the current date. The current date (at run time)
will always be the reference or starting point and the calendar will show a
number of days, months, and years relative to the current date. The range
could be all in the past (for example, five years prior to the current date) or
all in the future (for example, five years in the future).

v Dynamic. This option allows the developer to point to a procedure that
returns a range of dates. Clicking the browse (...) button allows the developer
to choose a preexisting procedure located in the current APP (data server) or
Domain (MR). The procedure must return two date values on the same data
line in XML format. The date values must be returned in a format that
returns two digits for the month and day, and four digits for the year, for
example MM/DD/YY.

Calendar Properties in the Properties Window

When a calendar is selected in the HTML Layout Painter, the Properties tab in the
Properties window contains properties of that calendar.
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Click a property to display a description at the bottom of the Properties window.
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Working With the Properties Window
The Properties window is a dockable window that consists of several tabs and
components.
v A Properties tab consists of the following components:

– Contains a hierarchical drop-down list of objects that are currently in the
layout. For the selected object, there are additional subtabs on the Properties
tab.

– A Properties subtab that lists attributes for the selected object. The attributes
appear on the left. Click in the right column to set the properties for the
attribute.
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– An Events subtab lists all events that can be assigned an action for an object.
Note: To code an event for an object, select an event and click the ellipse
button in the Events tab. The HTML Layout adds the event to the HTML
code and switches from Design to HTML view. In the HTML view, you are
prompted to define the event. Add the appropriate JavaScript code.
The following image is an example of the HTML code that appears when the
Events tab is selected in the HTML Layout Painter.
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v A Parameters tab enables you to assign parameters to controls. For details on the
properties than can be set for an object, see the topic on that object.
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v A Thumbnails tab enables you to view thumbnails of each page in the layout.
Thumbnails work similar to thumbnails in Adobe PDF, and enable you to scroll
to different pages. You may also refresh the Thumbnails tab, and enlarge or
reduce the thumbnails.
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Move the Properties Window

To undock the Properties window, double-click the Properties title bar, then move
the window to the desired location in the layout.

To dock the Properties window, double-click the Properties title bar.

Setting Form Controls for New Parameters
When a report contains one or more new amper variable parameters created in the
Report Assistant, the New Parameters dialog box appears when you save the
report. You can set the Control Type for each parameter prior to returning to the
HTML Layout Painter. This eliminates the need to select each parameter
individually to edit the associated Control Type setting using the Parameters tab of
the Properties window.

The following image shows the New Parameters dialog box. For each parameter,
you will find Name and Type fields, a Create control check box, and a drop-down
menu to set the Control Type to either text box, calendar, list box, drop-down list,
radio button, check box, hidden, text area, or tree control. The Type field is set to
Unresolved unless the amper variable parameter is created with the Dialogue
Manager using the �DEFAULT command (which sets the Type field to Default).
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The Parameter grouping options menu in the New Parameters dialog box provides
options for the placement of the form controls associated with new amper variable
parameters created in the Report Assistant. Select Do not create a form to insert
the form controls for each of the new parameters in separate locations on the
HTML page. Select New form element to insert the form controls for all of the
new parameters inside one form element you can position anywhere on the HTML
page. This form element also contains submit (run) and reset buttons.

Working With the Parameters Tab in the Properties Window
The Parameters tab is a component of the Properties window. The Parameters tab
consists of the following components:
v The top pane contains information on the controls in the layout.
v The bottom pane contains information on parameter values.

For more detailed information, see Associating Form Controls With Parameters.

Associating Form Controls With Parameters
When a parameter is created in the Report Assistant, a text box is automatically
added to the layout and associated with the parameter. However, you can change
the form control and form control type associated with the parameter.

530 System i: Database IBM DB2 Web Query for System i



Change the Type of Form Control Associated With a Parameter
1. In the Parameters tab, select the parameter name listed in the Parameter

column.
2. Select the form control you want to use from the drop-down list in the Control

Type column to the right, and your change is reflected in the report layout.

Unassign or Reassign a Parameter to an Existing Form Control
1. In the Parameters tab, select the desired form control in the Control Name

column.
2. To the right of the desired form control, click the Parameter field, then select

the down arrow that appears at the right edge of the Parameter field.
All existing parameters are shown in the drop-down list, along with
Unassigned.

3. Select an existing data field to assign the parameter to, or select Unassigned to
remove the association to the control.
Note: Unassigned parameters may result in no data returned for the request.
An unassigned parameter must have a default value assigned in the underlying
DB2 Web Query code.

Creating a Static List of Parameters
When creating a list of static parameters, you can select from the following
options:
v Add new value.
v Add ignore value.
v Add everything value.
v Use values from procedure.
v Use values from external file.

When the options are added to the Value list, the display text can be customized,
but the value cannot be changed.

Parameters Tab in the Properties Window (Static Values)

The following image is the Parameters tab in the Properties window with Static
control values.
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The Parameters tab contains the following fields and options when Static is
selected in the Control Values section:

Control Name

Contains the name of the form control associated with each parameter.

Parameter

Contains the name of each parameter in the current procedure.

Unassigned - Specifies the parameter is not associated with a form control.

Control Type

Contains the type of form control associated with each parameter.

The options are: Calendar, Check box, Drop down list, Hidden, List box,
Radio button, Text Area, Text box, Tree Control

Control Values

Determines whether parameter values are obtained from a static, dynamic,
or active report control list.

532 System i: Database IBM DB2 Web Query for System i



Static - Uses a static list of parameter values you supply. A list of static
values can also be created in the Report Assistant. For an example of
importing static values that were created in Report Painter, see Adding
Static Field Values From Report Painter.

Static values

Is a list of supplied values for a static list.

Value - Is the value to be passed to the selected parameter.

Display - Is the text that represents the parameter value in the form
control the user views. Note: Click Ctrl + Shift to add a value to the
Display field.

Selected - Is the value to act as the default value. If the form control is
multi-select, more than one value can be selected.

New - Creates a new parameter value.

Delete - Deletes a supplied parameter value from the list.

Move Up - Moves the selected value up in the list.

Move Down - Moves the selected value down in the list.

The XML output is:

Add a New Static Value

To manually add new static values, do the following in the Parameters tab:
1. In the Control Values section, select Static.
2. Click the New icon, and enter parameter value information in the Static values

section:
a. In the Value column, enter the value to be passed to the selected parameter.
b. In the Display column, enter the text that represents the parameter value in

the form control the user views.
c. In the Selected column, check the box for the value you want to be selected

by default. If the form control is multi-select, more than one value can be
selected.

3. Repeat Step 2 until the list contains all of the values you want to include.
4. Optionally, click the Delete button to eliminate any values, and the up and

down arrows to rearrange the order of the values.

Adding Static Field Values From Report Painter

Instead of adding new static values, you may also import static value parameters
that you created from the Variable Editor. Parameter values can be data values to
limit your data or fieldnames to select the fields in your report. Both type of static
lists can be created in Report Painter. This example details how to supply field
values to a report through the HTML Layout Painter and Report Painter.

Note: For the purposes of this example, use the CAR Master File (car.mas) that is
supplied with Developer Studio.
1. From the HTML Layout Painter, select New Report from the Insert menu.

The cursor changes into a crosshair.
2. Click and drag the crosshair to create a report object and adjust it to the size

you want.
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3. Right-click the report object and select Open report.
The Open dialog box appears.

4. Open the car.mas file and click Open.
The Report Painter opens.

5. From Report Painter Object Inspector, right-click on Report Variables and
select New Report Variable Field.
The Variable Editor opens.
v Enter SORTVAR in the Name and Prompt input fields, and keep the

Variable Type as Single Select.
v Select Static List from the Accept List section.
v Double-click COUNTRY and BODYTYPE from the Fields from database

Data Context area.
The fields are added to the Static Accept List.

v Click OK to save the variable.
6. Create a second variable:

v Right-click on Report Variables and select New Report Variable Field.
The Variable Editor opens.

v Enter MEASURES in the Name and Prompt input fields.
v Select Multiselect AND from the Variable Type drop-down list.
v Select Static List from the Accept List section.
v Double-click CAR, DEALER_COST, RETAIL_COST, and SALES from the

Fields from database Data Context area.
The fields are added to the Static Accept List.

v Click OK to save the variable.
7. Double-click &SORTVAR and &MEASURES from the Report Variables in the

Object Inspector.
The variables are added to the report.

8. Click &SORTVAR and select By from the Columns toolbar.
Note: If the parameter is to be used as a By field in a report, it must be the
single select variable type.

9. Save and close the report.
You are returned to the HTML Layout Painter and since you are adding a
report with parameters, the New Parameters dialog box appears.

10. From the New Parameters dialog box:
v Select Double list control from the Control Type drop-down list for

MEASURES.
v Select Do not create a form from the Parameter grouping options

drop-down list.
v Click OK to close the New Parameters dialog box.
The report and associated parameters are added as static field values. You
may rearrange or lengthen the controls in the layout.

11. Save and run the layout.
Select the static field values (By field and the associated measures) and run the
report.
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Add an Ignore Value

The add ignore value option sends FOC_NONE to the server at run time and is
intended for use with complex applications.
1. From the HTML Layout Painter, use form controls to supply parameter values

for a report.
Note: A report with parameters requires that you to select values (at run time)
in order to generate the output.

2. Required: Click the Parameters tab in the Properties window.
The properties of a form control, as well as the parameters associated with each
form control, can be controlled with the Properties tab and Parameters tab of
the Properties window.

3. Select Add ignore value from the Static values drop-down list.
4. Run the HTML page and select the Ignore All value to ignore the parameter

values.

Note: Sending FOC_NONE to a compound WHERE statement will result in the
entire WHERE criteria being ignored. Therefore, when working with multiple
parameters that may be chained together, each parameter should be created in an
individual WHERE statement as follows:
WHERE ( REGION EQ &REGION.(OR(Midwest,Northeast)).Region:. );
WHERE ( ST EQ &STATE.(OR(CA,CT)).State:. );
WHERE ( CITY EQ &CITY.(OR(Atlanta,Boston)).City:. );

Add an Everything Value

The add everything value option uses JavaScript to send every value present in the
parameter list to the server at run time.
1. From the HTML Layout Painter, use form controls to supply parameter values

for a report.
2. Click the Parameters tab in the Properties window.
3. Select Add everything value from the Static values drop-down list.

Note: The Add everything value option is only available with a Multiselect OR
variable type.

4. Run the HTML page and click the Select All parameter value to view all the
parameter values.

Use Values From a Procedure

This is the default option which populates the static list with values predefined in
the procedure.
1. From the HTML Layout Painter, use form controls to supply parameter values

for a report.
2. Click the Parameters tab in the Properties window.
3. Select Use values from procedure from the Static values drop-down list.
4. Run the HTML page and select the parameter values from the procedure.

Import Values From an External File

This option enables you to use a local external file to provide a query limit for the
selected data.
1. From the HTML Layout Painter, use form controls to supply parameter values

for a report.
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2. Required: Click the Parameters tab in the Properties window.
3. Highlight the static parameter that you want to import external values for.

4. Required: Select Use values from external file from the Static values
drop-down list.
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The Open dialog box appears.
5. Select a text file from your local machine and click Open.
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Note: The external file can be a file with single values on each line, or two
values per line, comma delimited.
For example, in the following text file, BOS is the return value and Boston is
the display value.

The imported values are loaded into the Static values area of the Parameters
tab.
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Note: If there is only one value, the value will populate both the return and the
display values.

6. Run the HTML page to see the imported values for the selected parameter.

Creating a Dynamic List of Parameters
Dynamic values are available by default if a data field used in the procedure is
associated with the selected form control. The Parameter field at the top of the
Parameters tab displays this data field (or displays Unassigned if there is no
associated parameter).

Parameters Tab in Properties Window (Dynamic Values)

The following image is the Parameters tab in the Properties window with Dynamic
control values.
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The Parameters tab contains the following fields and options when Dynamic is
selected in the Control Values section:

Control Name

Contains the name of the form control associated with each parameter.

Parameter

Contains the name of each parameter in the current procedure.
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Unassigned - Specifies the parameter is not associated with a form control.

Control Type

Contains the type of form control associated with each parameter.

The options are: Calendar, Check box, Drop down list, Hidden, List box,
Radio button, Text Area, Text box, Tree Control

Control values

Determines whether parameter values are obtained from a static, dynamic,
or active report control list.

Dynamic - Uses a list of values retrieved from a selected data source when
the request is executed. This is the default if you use an Accept clause in a
Master File to create an amper variable parameter within a procedure. For
more information, see Select a Dynamic List of Values.

Data Source

Is the data source from which the values will be retrieved.

Procedure

Is the procedure that will be called.

Value field

Is the data source field from which the values will be retrieved.

Display field

Is the text that represents the parameter value in the form control the user
views.

Note: Click Ctrl + Shift to add a value to the Display field.

Selected Value

Enter the value(s) to be selected as the default value whenever the
procedure is run. For more information, see Use Selected Values as the
Default Value.

Add ″ALL″ Option

Adds the option to select ALL data source values to the control. Alternate
text can be substituted for ″ALL″ using the text field to the right. For more
information, see Parameter List Options.

Limit values returned

Indicates that a specific number of field values will be retrieved from the
data source. The specific number of fields is selected with the menu to the
right.

Select a Dynamic List of Values

To add or select a different dynamic list of values to populate a form control, do
the following in the Parameters tab of the Properties window:
1. Select the Dynamic option in the Control Values section.
2. To find the desired source file you want to retrieve values from, select the Data

source option to retrieve values from a .mas file, or select the Procedure option
to retrieve values from a .fex file. Click the browse (...) button, select a source
file from the Get source file dialog box that opens, and click Open.

Chapter 12. Designing a User Interface for a Web Application With the HTML Layout Painter 541



For the Data source option only, select the data field that has the desired values
from the tree structure displayed at the bottom of the Parameters tab. The data
field you select will be populated in the Value field.

3. Optionally, type a new name in the Display field for the data field populated in
the Value field.

4. Optionally, select Limit values returned, and select or type the number of field
values you want to retrieve from the data source in the box to the right of this
option.

Parameter List Options
When creating a static or dynamic list of parameters, you may add an all value to
the list of parameter values and show the display value in the report output.

The ALL feature allows developers to automatically add an ALL value to a list of
parameter values. An ALL value does the following:
v For dynamic parameters, the ALL feature sends a value of FOC_NONE to the

reporting server alerting the server to bypass or ignore the parameter altogether.
(Ignoring the parameter would return all values in the data source.)

v With static parameters, the ALL value typically uses JavaScript to return all of
the values displayed in the list. This prevents you from having to select every
value in the list manually. When using the ALL feature with static parameters,
you can select from the following options:
– Add ignore value. This option sends FOC_NONE to the server at run time,

alerting the server to bypass or ignore the parameter altogether. It is intended
for complex applications.

– Add everything value. This option uses JavaScript to send every value
present in the parameter list to the server at run time. The Add everything
value option is only available with a Multiselect OR variable type.

When using Dynamic or Active Report control values, you may enter the value(s)
to be selected as the default value whenever the procedure is run. For more
information, see Use Selected Values as the Default Value.

Send the Display Value for Static and Dynamic Controls

From the HTML Layout Painter, you may show the display value, rather than the
actual data, for headings and footings in the report output.
1. From the HTML Layout Painter, import a report that contains a parameter.

When importing a report with parameters, the New Parameters dialog box
appears prompting you to create the control type.
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The report and control type is added to the HTML Layout Painter.
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2. To show the display value for the parameter selection, use the Parameters tab
of the Properties window and choose Static or Dynamic as the type of control
value.

3. For a Static control type, use the Parameters tab to manually change the
display value for the Static control.

Note: You may also update the display values from the Variable Editor in the
Report Assistant.

4. Select the Send display value check box from the Parameters tab.
The display values are shown in the control type of the HTML Layout.
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5. For a Dynamic control type, use the Parameters tab to set both the Value Field
and the Display Field.
Note: Setting the display value for Dynamic controls is only applicable if you
are using a Data source that contains both a code and description field.
v Double-click a field from the Fields list to add it as the Value Field.
v Select a field from the Fields list, click Ctrl + Shift to add it as the Display

Field.
v Ensure that Send display value is checked.
The following image is an example of the Parameters tab with Send display
value selected.
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The display values are shown in the control type of the HTML Layout.
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6. Add a heading to the report to show the display value. Double-click the
report from the HTML layout to open and edit the report.
The report opens in the ReportAssistant.

7. Manually add &Variable_TEXT to the report heading or footing.
8. Save and close the report to return the HTML Layout Painter.

Note: When you create the Text variable (&Variable_TEXT), you are not
prompted to set a control type for this variable when returning to the HTML
Layout, as no control type is needed.

9. Run the HTML page.
10. Select the parameter for the report and run the report.

The display value is shown in the report heading.
For example, in the image below, Gotham 40 is selected as the Store Code and
shows the display value in the report heading. The actual value, R1040, is
shown in the Store ID column.
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Use Selected Values as the Default Value

When using Dynamic or Active Report control values, you may enter the value(s)
to be selected as the default value whenever the procedure is run.

If you import a procedure (.fex) that has a dynamic prompt value then the input
box is populated with values retrieved from the data source. If the selected value is
available for the report output, the value(s) are selected by default. If the selected
value is not available in the report results, then the value(s) that you entered are
ignored and the first value retrieved from the data source is selected.
1. Enter the exact parameter value in the Selected Value input field, as it appears

in the report output.
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Note: Parameter values are case sensitive.
2. Optionally, you may enter more than one value by using a comma between the

values.
For example: CT, GA are entered as the Selected Value fields for the Dynamic
State parameter in the image below.

3. Run the report.
The selected value, if available from the report results, is automatically selected
(highlighted) in the parameter list.
For example, the example below shows CT, GA as the selected values in the
State parameter list in the report output.
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4. Click the Run button to run the report with the selected value parameters.
The report output appears.
Note: If the selected value is not available in the report results, then the value
that you entered is ignored and the first value retrieved from the data source is
shown.

Filtering Dynamic Parameter Values
Use the chain feature to associate two or more related parameters. When you chain
parameters together, chained dynamic values are filtered as selections are made to
each parameter control. For example, if you chain the PLANT parameter to the
STATE parameter, only PLANT values for the currently selected STATE parameter
will be available instead of all the plants in the data source. Each time a selection
is made, all chained parameters will be dynamically updated. The chain feature
also allows you to add, remove, and reverse the order of parameters in the chain.
See other topics in this section for details.

Dynamic parameters are processed with a caching mechanism that gathers all of
the necessary values prior to loading the page. This method automatically
combines all of the necessary requests into a single HTTP request and maps the
result sets to the appropriate controls, greatly reducing the load time involved with
sending multiple requests for data.

Filter Parameter Values
1. In the Control Values section of the Parameters tab, click the Dynamic radio

button.
2. Press the Shift key and then click two or more parameters to select them

simultaneously and activate the chain feature buttons on the positioning
toolbar.

3. Click the Add to chain button. The parameters you selected are labeled
with numbers to indicate the order in which they will be chained when you
run your report.
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You can also reverse the order of parameters in the chain. See Reverse the
Order of Chained Parameter Values for details.

Reverse the Order of Chained Parameter Values

1. Click the Chain order button in the positioning toolbar.
2. Click the parameter you want to display first in the chain.

You can continue to reverse the order in the chain by clicking the numeric labels
on the chained parameters. If you would like to see the numeric labels on the
chained parameters, select the Chain order button. Double-click a parameter to
designate it as the first parameter in the chain.

Remove a Parameter from the Chain
1. Click the parameter you want to remove from the chain.

2. Click the Delete chain button in the positioning toolbar.
3. Press the Shift key and click the remaining chained parameters.

4. Click the Chain order button in the positioning toolbar. You will no
longer see a numeric label on the parameter that you removed.

Enable Cached Processing for Chained Parameters
1. Create a report with parameters in the HTML Layout Painter:

a. From the HTML Layout Painter, select New Report from the Insert menu.
The cursor changes into a crosshair.

b. Click and drag the crosshair to create a report object and adjust it to the
size you want.

c. Right-click the report object and select Import existing report.
Tip: You may create parameters directly in your report or add them later in
the HTML Layout Painter.

2. To create dynamic parameters for your report in the HTML Layout Painter,
right-click the report object and select Add a filter from the context menu.
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The Filter options dialog box opens.
3. Select the field to be used for the parameter, the Multiselect option, and click

OK.

The New Parameters dialog box appears.
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You may select a control type for the parameter from this dialog box, or adjust
them later using the Parameters tab.
Note: If the New Parameters dialog box does not appear, ensure that Show
New Parameters dialog is selected from the Settings dialog box.

4. Click OK to close the New Parameters dialog box.
5. The filter appears above the report object.

Repeat this procedure for each additional parameter for the report.

6. Select two or more controls from the parameters and click Add to chain
from the Positioning toolbar.
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The parameters are chained together.

7. To view the chained parameters in the Design View, select Chain order
from the Positioning toolbar.
The parameters are numbered in the logical order that they were chained.

8. Select a numbered parameter, right-click and select Cache run time data.

When executing the document, data for the chained parameter is cached to
improve performance.
Note: Cache run time data is the default option.

Applying Chaining Logic Options in the HTML Layout Painter
Previously, parameters could only be chained together with an Equal logic
scenario, mainly suited for hierarchical data filtering. For example, only seeing
cities within the selected state.
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Additional chaining logic scenarios include such options as Not Equal to, Greater
than, Less than, and so on. This is useful when reusing existing code to populate
parameters that may be used multiple times in the same layout, and in different
locations of the hierarchy of the chain.

For example, a form offers two lists of dates so that you can select a FROM / TO
date range. By chaining these parameters together and applying the Greater than
chaining logic, this ensures that when a date is selected for the FROM parameter,
only dates that follow the FROM date display in the TO date control, eliminating
the possibility of selecting an invalid date range.

Apply Chaining Logic to a Parameter
1. Create a report with parameters in the HTML Layout Painter.

2. Select two or more controls from the parameters and click Add to chain
from the Positioning toolbar.

The parameters are chained together.
3. Select a parameter, right-click, and select Chaining logic from the context

menu.
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4. Select a chaining logic option from the submenu.
Note: Equal is the default chaining logic option.
The chaining logic is applied to the parameter selected.

Customizing Dynamic Parameters
You have the option to allow customized retrieval of dynamic parameter values.
By using a custom procedure, you can use the FOCUS language to utilize
temporary HOLD files, filtering, etc. This allows the HTML Layout Painter to
better integrate with a multitude of large and/or proprietary data sources that may
require unique retrieval methods. The procedure must meet the following criteria:
v The procedure must return a name and value pair for each parameter value that

will populate the list. The first value is the submission value which is passed to
the form control when you click the Submit button. The second value is the
display value which is what you will see in the control. These two values can be
the same or different.

v The procedure must return the two data values on a single data line in XML
format (PCHOLD FORMAT XML).

Note: Different parameters in the same procedure can use both this option and the
data source method.

For chained parameters, there are two options based on whether caching is
enabled:
v By default, caching of parameter values in not enabled. Each parameter control

must be mapped to its own procedure and the developer is responsible for
writing filters or WHERE criteria to properly filter the hierarchy of controls.

v If caching is enabled for the chained parameters, a single procedure can be used
to populate the controls of the chained variables. In this case, the HTML Layout
Painter writes the WHERE criteria.

Hidden Parameters
You can select a HIDDEN control type in the HTML Layout Painter. This allows
parameter name value pairs to be passed in the form control without the user
seeing them. This option can be chosen in the Parameters tab in the Control Type
column. When this control type is selected, the current control assigned to the
parameter will be removed. The value of the parameter can be entered in the Value
column of the Parameters tab.

Automatically Populating Fields With Parameter Values
When the name of a dynamic parameter matches a corresponding field name in a
data source, the HTML Layout Painter automatically populates the field name for
the parameter.

The data source is populated by a default based on the first data source specified
by a TABLE FILE or GRAPH FILE command. The data source field is populated
for the Value and Display field controls in the Parameters tab. This generates a
″run ready″ Layout report as long as the parameter names match the field names.
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Supplying Parameter Values to External Reports
You can supply parameters to external reports the same way you apply them to
reports created with the Report Assistant. The report layout can also contain
multiple reports associated with a common set of parameters. Launch mechanisms
such as a push button, hyperlink, or image can be associated to external reports
that contain different sets of parameters. You can also update and target
parameters for an external report to a frame or window directly within your report
layout.

Before you can supply parameter values to an external report, you must create a
hyperlink to the report and associate a launch mechanism to it. After you associate
a launch mechanism, such as a push button, hyperlink, or image, to the external
report, the report layout is populated with the parameters.

Supply Parameter Values to External Reports With a Push
Button

In this procedure you will create a push button to launch an external report and
target the output to a window.
1. From the Insert menu, select Push Button.

The cursor changes into a crosshair.
2. Click and drag the crosshair to create a push button and adjust it to the size

you want.
3. Right-click the button and select Create hyperlink.

The Hyperlink Properties dialog box opens.
4. Specify the text you want to display as the hyperlink in the Display Text input

field.
5. To set the action of the hyperlink to execute an external report, select the New

icon, then select External procedure from the Action drop-down list.
6. Enter the external report’s procedure name in the Source field, or click the

browse (...) button to browse to the procedure.
7. Optionally, direct the output to a specific location by selecting Window or

Frame in the Target Type field.
8. Specify the Target/Template Name for the target frame or window.
9. Click OK.

The parameters for the report are automatically added to objects in the layout
and displayed in the Parameters tab.

10. From the File menu, click Run.
11. Click the push button to view the external report.

The report opens in a separate window as you specified in the Hyperlink
Properties dialog box for that push button.
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Supply Parameter Values to an External Report With an Image

In this procedure you will insert an image that will launch an external report when
you click it. You will target the output to a window.
1. From the Insert menu, select Image.

The cursor changes into a crosshair.
2. Click and drag the crosshair to position the image.

The Get source file dialog box opens.
3. Navigate to the image using the Look in menu, select the image, and click

Open.
4. Adjust the image to the desired size and location.
5. Right-click the image and select Create hyperlink.

The Hyperlink Properties dialog box opens.
6. To set the action of the hyperlink to execute an external report, select the New

icon, then select External procedure from the Action drop-down list.
7. Enter the external report’s procedure name in the Source field, or click the

browse (...) button to browse to the procedure.
8. Direct the output to a window by selecting Window in the Target Type field.
9. Specify the Target/Template Name for the target frame or window.

10. Click OK.
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The parameters for the report are automatically added to objects in the layout
and displayed in the Parameters tab.

11. From the File menu, click Run.
12. Click the image to view the external report.

The report opens in the window you specified in the Hyperlink Properties
dialog box for that hyperlink.

Supply Parameter Values to an External Report With a
Hyperlink

In this procedure, you will create a frame and target report output from an
external report to it. You will also create a hyperlink to launch the external report.
1. From the Insert menu, select Frame. Click and drag the crosshair to create a

frame and adjust it to the size you want. Enter a name for the frame by
double-clicking the Name field in the Properties tab of the Properties window.

2. From the Insert menu, select Hyperlink. Click and drag the crosshair to create
a hyperlink and adjust it to the size you want.
The Hyperlink Properties dialog box opens.

3. Specify the text you want to display as the hyperlink in the Display Text input
field.

4. To set the action of the hyperlink to execute an external report, select the New
icon, then select External procedure from the Action drop-down list.

5. Enter the external report’s procedure name in the Source field, or click the
browse (...) button to browse to the procedure.

6. Direct the output to the frame you inserted by selecting Frame in the Target
Type field.

7. Select the name of the frame you created from the Target/Template Name
drop-down list.
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8. Click OK.
The parameters for the report are automatically added to objects in the layout
and displayed in the Parameters tab.

9. From the File menu, click Run.
10. Click the hyperlink to view the external report.

The report opens in the frame you specified in the Hyperlink Properties
dialog box for that hyperlink.

Supplying Parameter Values to Multiple External Reports

In this example, you will add two reports to a layout. You will associate a push
button to one report and target the output to a window. You will associate a
hyperlink to the second report and target the output to a frame.
1. From the Insert menu, select Push Button.

The cursor changes into a crosshair.
2. Click and drag the crosshair to create a push button and adjust it to the size

you want.
A push button is created in the layout and assigned the name buttonn, where
n is a number.

3. Right-click the button, and select Create hyperlink.
The Hyperlink Properties dialog box opens.

4. Type Run report in the Display Text input field.
5. Set the action of the hyperlink to execute a report by clicking the New icon

and selecting External procedure from the Action drop-down list.
6. Enter the external report’s procedure name in the Source field, or click the

browse (...) button to browse to the procedure.
7. In the Target Type field, select Window from the drop-down list.
8. In the Target/Template Name field, select New window frame from the

drop-down list.
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9. Click OK.
The parameters for the first report are automatically added to objects in the
layout and displayed in the Parameters tab.

10. From the Insert menu, select Frame. Click and drag the crosshair to create a
frame and adjust it to the size you want.

11. Double-click the Name field in the Properties tab of the Properties window
and enter frame1.

12. From the Insert menu, select Hyperlink. Click and drag the crosshair to create
a hyperlink and adjust it to the size you want.
The Hyperlink Properties dialog box opens.

13. Type Run report 2 in the Display Text input field.
14. Set the action of the hyperlink to execute a report by clicking the New icon

and selecting External procedure from the Action drop-down list.
15. Enter the external report’s procedure name in the Source field, or click the

browse (...) button to browse to the procedure.
16. In the Target Type field, select Frame from the drop-down list.
17. In the Target/Template Name field, select the name of the frame you created

(frame1).
18. Click OK.
19. From the File menu, select Run.
20. Click the push button to view the first external report.

The report opens in a separate window as you specified in the Hyperlink
Properties dialog box for that push button.
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21. Click the hyperlink to view the second external report. The report opens in
the frame you specified in the Hyperlink Properties dialog box for that
hyperlink.
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Styling Your Layout
When you create an HTML page in the HTML Layout Painter, the objects in the
layout will display in your browser using the browser’s default styles. You can
customize the appearance of your HTML page by adding a theme or template. A
template can be any HTML file containing styling information and other elements.

Adding a CSS or Script to the Layout
Cascading Style Sheets (CSS) or scripts can be added to your layout to determine
the look of the Web page. This is a good way to quickly apply corporate styling to
your layout or to assign global styling to a layout. It is also an easy method of
assigning default styling to all elements in the entire layout with one action.
Styling included in a CSS or script will display only in Preview mode.

Add a CSS or Script to the Layout
1. From the Insert menu, select CSS/Scripts.

The Insert Web Files dialog box opens.
2. Click the New icon and navigate to the directory in which your CSS or script

resides, select the file, and click Open.
3. Add additional files if desired. Click OK to add the specified files.

Setting HTML Page Properties
You can set properties for the HTML page you create in the HTML Layout Painter
in the Properties tab of the Properties window.

Properties set for the HTML page will be inherited by most objects added to the
layout. Once a style has been changed for an object in the layout, it cannot be
styled with a template or theme. It is recommended that global styling of the
HTML page be set before properties are set for individual objects.

Chapter 12. Designing a User Interface for a Web Application With the HTML Layout Painter 563



HTML Page Properties in the Properties Window

When the background of a report is selected, the Properties tab in the Properties
window contains options that control the body of the HTML page.

Click a property to display a description of the selected property at the bottom of
the Properties window.

Specifying Browser Defaults with Style Composer
You can use the Style Composer to control default settings for font, background
properties, position mode, flow control, margins, list styles, and visual effects.
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Note: On the following pages, the images of the Style Composer windows show
many blank fields. You may actually see the words ″Not Set″ populated in these
blank fields when viewing these Style Composer windows in Developer
Workbench.

Access the Style Composer

To access the Style Composer, complete the following steps.
1. Right-click the background of an HTML page in the HTML Layout Painter.
2. From the pop-up menu, select Style.

The Style Composer window opens.

Specifying Font Styles Using the Style Composer

To specify the font styles that will be used in the browser for your HTML report,
make your selections in the Font window of the Style Composer.

The Font window of the Style Composer is comprised of the following elements:
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Font name

Determines the font displayed in a browser.

You can specify: Family (launches the Font Picker dialog box) or System
Font.

Font attributes

Determines the attributes of the font displayed in a browser.

The options include: Color, Italics, Small Caps.

Size

Determines the size of the font displayed in a browser.

The options include: Specific, Absolute, Relative.

Bold

Determines whether the font is displayed as bold in a browser.

The options include: Absolute, Relative.

Effects

Determines whether the font effects displayed in a browser.

The options include: None, Underline, Strikethrough, Overline,
Capitalization.

Specifying Background Properties Using the Style Composer

To specify the background styles that will be used in the browser for your HTML
report, make your selections in the Background window of the Style Composer.

566 System i: Database IBM DB2 Web Query for System i



The Background window of the Style Composer is comprised of the following
elements:

Background color

Determines the font displayed in a browser.

You can specify: Color, Transparent.

Background image

Determines the properties of the background image displayed in a browser.

The options include: Image, Tiling, Scrolling, Position (Horizontal and
Vertical), Do not use background image.

Specifying Text Styles Using the Style Composer

To specify the text styles that will be used in the browser for your HTML report,
make your selections in the Text window of the Style Composer.
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The Text window of the Style Composer is comprised of the following elements:

Alignment

Determines the alignment of a text.

You can specify: Horizontal, Vertical, Justification.

Spacing Between

Determines the spacing.

You can specify spacing between the following text elements: Letters,
Lines.

Text Flow

Determines the flow of the text.

You can specify: Indentation, Text Direction.
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Specifying Position Mode Using the Style Composer

To specify the position mode that will be used in the browser for your HTML
report, make your selections in the Position window of the Style Composer.

The Position window of the Style Composer is comprised of the following
elements:

Position Mode

From which you can specify: Position in normal flow, Offset from normal
flow, Absolutely position.

Height/Width

When Absolutely Position is selected, you can specify position indicators in
the measurements.

You may specify: Top, Left, Z-Index.
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Note: Z-Index is optional. It sets or retrieves the stacking order for absolute
or relatively positioned objects.

Specifying Layout Styles Using the Style Composer

To specify the layout styles that will be used in the browser for your HTML report,
make your selections in the Layout window of the Style Composer.

The Layout window of the Style Composer is comprised of the following elements:

Flow Control

From which you can specify: Visibility, Allow Text to Flow, Display,
Allow Floating Objects.

Content

From which you can specify: Overflow.

Clipping
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From which you can specify whether or not to clip the layout from the
following positions: Top, Bottom, Left, Right.

Printing page breaks

From which you can specify: Before, After.

Specifying Margin Styles Using the Style Composer

To specify the margin styles that will be used in the browser for your HTML
report, make your selections in the Margins window of the Style Composer, which
is shown in the following image.

The Edges window of the Style Composer is comprised of the following elements:

Margins

From which you can specify: Top, Bottom Left, Right margins.

Padding
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From which you can specify: Top, Bottom, Left, Right padding.

Borders

From which you can specify: Select the edge to be changed, Style, Width,
Color.

Note: Borders are displayed as a single solid line in the Style Composer preview
window, regardless of whether you select a single or double line border. Borders
are accurately displayed in the Style Composer Design View and in the HTML
output of an application.

Specifying List Styles Using the Style Composer

To specify the list styles that will be used in the browser for your HTML report,
make your selections in the Lists window of the Style Composer.

The Lists window of the Style Composer is comprised of the following elements:

Lists
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From which you can specify: Bulleted, Unbulleted.

Bullets

From which you can specify: Style, Position, Custom bullet.

Specifying Interface Effects Using the Style Composer

To specify the interface styles and visual effects that will be used in the browser for
your HTML report, make your selections in the Other window of the Style
Composer.

The Other window of the Style Composer is comprised of the following elements:

User Interface

From which you can specify: Cursor.

Tables

From which you can specify: Borders, Layout.
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Laying Out Objects With the HTML Layout Painter
You can change the size and position of objects in your layout in the following
ways:
v Set relationships between objects. This is done by setting relationships between

objects and a controlling, or dominant, object. The controlling object is the last
object selected. For details, see Setting Relationships Between Objects.

v Click and drag with your mouse.

Setting Relationships Between Objects
You can set relationships between underlying objects and a controlling, or
dominant, object. The controlling object is the last object or placeholder selected.
You can use these relationships to set properties of the selected objects according to
the controlling object. Any object on the HTML page layout can be the controlling
object.

You can set the following types of relationships:
v Relationships that maintain a distance between objects. This is useful since a

report or graph may take up more or less room when your procedure is run
than is accounted for in the layout. When setting relationships between objects
in this way, you should select the corners of the objects that are closest to each
other. This will ensure that the reports do not overlap if either report takes up
more room than anticipated.

v Relationships that affect the positioning of objects. This allows you to ensure
that objects remain aligned regardless of a change in size or position of one of
the objects and that objects remain the same size even when an object’s size is
changed.

Set Object Size
1. Highlight multiple objects with your mouse by holding the Shift key to select

items contiguously, or the Control key to select items non-contiguously. The
controlling object is the last object selected.
The size buttons on the positioning toolbar are active.

2. Click the button in the positioning toolbar that corresponds to what you want:
Make same width sets the width of the highlighted objects to the width of the
controlling object.
Make same height sets the height of the highlighted objects to the current
height of the controlling object.
Make same size sets the height and width of the highlighted objects to the
height and width of the controlling object.

All selected objects change in size according to the size of the controlling object. If
an image becomes distorted when you resize it, you can restore its original size.
Right-click the image, select Image Properties, and then Restore Size.

Set the Distance Between Objects
1. Highlight multiple elements with your mouse holding the Shift key to select

items contiguously, or the Control key to select items non-contiguously. The
controlling object is the last object selected.

2. Click the button in the positioning toolbar that corresponds to the relationship
you want. The selected objects’ position will be set according to the controlling
object, which is the last object selected. The options are:
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Relate top left maintains the distance between the controlling object’s top left
corner and the highlighted objects’ top left corners.
Relate top right maintains the distance between the controlling object’s top
right corner and the highlighted objects’ top left corners.
Relate bottom right maintains the distance between the controlling object’s
bottom right corner and the highlighted objects’ top left corners.
Relate bottom left maintains the distance between the controlling object’s
bottom left corner and the highlighted objects’ top left corners.
For details on the buttons in the positioning toolbar, see Positioning Toolbar.

Break Relationships

Click Break in the toolbar.

Positioning Toolbar

The positioning toolbar contains the buttons listed in the following table.

For buttons that use relationships, the relationship is controlled by the controlling
object, or dominant object, which is the last object or placeholder selected. These
buttons are only highlighted when more than one object is selected.

Button Descriptions

Toggles the grid on and off. Use the grid to assist in lining
up objects in the layout. This button is recessed when the
grids are enabled.

Toggle visibility shows hidden objects.

The hidden visibility option is set in the Layout section of
the Style Composer.

Specifies Tab Order.

Aligns the highlighted objects’ left edge with the left edge
of the controlling object.

Aligns the highlighted objects’ right edge with the right
edge of the controlling object.

Aligns the highlighted objects’ top edge with the top edge
of the controlling object.

Aligns the highlighted objects’ bottom edge with the
bottom edge of the controlling object.

Aligns objects at the horizontal center point of the canvas
in Design View.

Aligns objects at their vertical center (or middle) point of
the canvas in Design View.

Sets the width of the highlighted objects to the width of the
controlling object.

Sets the height of the highlighted objects to the current
height of the controlling object.
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Button Descriptions

Sets the height and width of the highlighted objects to the
height and width of the controlling object.

Maintains the distance between the controlling object’s top
left corner and the highlighted objects’ top left corners.

Maintains the distance between the controlling object’s top
right corner and the highlighted objects’ top left corners.

Maintains the distance between the controlling object’s
bottom right corner and the highlighted objects’ top left
corners.

Maintains the distance between the controlling object’s
bottom left corner and the highlighted objects’ top left
corners.

Breaks the relationship set between highlighted objects.
This button is only highlighted when selected objects have
relationships set.

Toggles the display of arrows illustrating the relationships
between objects. This button is only highlighted when
selected objects have relationships set. This button will stay
highlighted when relationships are displayed. It will not be
highlighted when relationships are not displayed.

Adds a parameter to a chain. Chained dynamic values are
filtered as selections are made to each parameter control.
Each time a selection is made, all chained parameters will
be dynamically updated. For details about chained
parameters, see Filtering Dynamic Parameter Values.

Removes a chained parameter from a chain. For details
about chained parameters, see Filtering Dynamic Parameter
Values.

Activates chained parameters for viewing and editing. For
details about chained parameters, see Filtering Dynamic
Parameter Values.

Synchronizes and report/graph object to an Active Report
when using Active Dashboards. For more information, see
Creating Active Dashboards.

Shows the synchronized report groups when working with
Active Dashboards in the HTML Layout Painter. For more
information, see Creating Active Dashboards.

Customizing the Layout
All changes to your layout be can made in the Design mode of the HTML Layout
Painter or the HTML editor. The changes made to a layout in an editor will be
preserved when you re-enter the HTML Layout Painter.

Creating Active Dashboards
An HTML Active Report (AHTML) is a report that is designed for offline analysis.
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The HTML Layout Painter has extended the functionality of Active Reports by
providing the features to build an Active Dashboard; an HTML Form with one or
more Active Report procedures and controls to mimic Active Report menu options,
to allow global modification of multiple Active Reports in HTML Layout created
pages.

The process of creating Active Dashboards in the HTML Layout Painter consists of:
v Adding an Active Report to the HTML Layout.
v Binding, or synchronizing, other report and graph objects to the Active Report in

the layout.
v Configuring Active Report controls that mimic Active Report menu options at

run-time.
v Exporting the HTML Layout as a FOCUS procedure (.fex) for scheduling and

distributing Active Dashboards.

Binding Objects to an Active Report
You can create multiple views of an Active Report by binding a report or graph
object to an Active Report. Binding, or synchronizing, is the act of configuring an
association between an Active Report and other report/graph objects in the HTML
Layout.

You may synchronize report/graph objects and show the synchronized report
groups in the HTML Layout. The synchronize options are available from the
Positioning toolbar in the HTML Layout Painter.

Note: You may only synchronize objects to one Active Report at a time. If you try
to synchronize an object to a second Active Report, the first synchronization is
removed.

Synchronize Report and Graph Objects to Active Reports
1. In the HTML Layout Painter, you may add an Active Report to the layout by

using any of the following methods:
v Select New Report from the Insert menu.

Double-click the report object to create the Active Report in Report Painter.
v Select New Report from the Insert menu.

Right-click the report object and select Reference existing procedure from
the context menu to add the Active Report.

v Select Import Existing Procedure from the Insert menu to add the Active
Report.

2. Add a report or graph object to the layout:
v Select New Report or New Graph to from the Insert menu.

The cursor changes into a crosshair.
v Click and drag the crosshair to create a report or graph object and adjust it

to the size you want.
3. Required: Select the objects to be synchronized:

v Select the report/graph object as the object to be synchronized.
v While pressing and holding the Ctrl key on your keyboard, select the Active

Report as the report that you want to bind to.
The synchronize buttons on the Positioning toolbar are activated.
In the example below, the Active Report is the binding object and the graph
object is about to be synchronized to the Active Report.
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Note: The binding object (Active Report) is indicated by clear boxes around
the edges. The synchronized object (report/graph object) is indicated by solid
black boxes around the edges.

4. Click the Synchronize to Active Report button on the Positioning toolbar.

The report or graph object is synchronized and refreshed with data from the
Active Report.
Note: There is no separate procedure associated with these Active Report
objects. If you right-click on these items, there are no option to edit the
procedure.
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Show Synchronized Active Report Groups

Select Show synchronized reports from the Positioning toolbar.
The synchronized groups are shown in the layout.

In the example below, there are two synchronized report groups. The Production
Units Analysis graph is synchronized to the Production Units Analysis Active
Report and the Sales by Category graph is synchronized to the Sales by Category
Active Report.

Select Properties for Synchronized Reports

You may change the Active Report object properties by using the Properties tab in
the Properties window.
1. Select the synchronized Active Report object in the layout and click the

Properties tab.
The Active Report object properties appear.
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2. Select the Active report type drop-down list to change the type of Active report
for the object.
The options are: <Not Set>, Grid, Pivot, Bar, Line, Pie.

3. Optionally, If you select Bar, Line, or Pie as the Active Report type, additional X
and Y axis selections are available for the synchronized report.
v Select the Active report X axis drop-down list.
v Select the Active report Y axis drop-down list.

Note: If you change the X and Y values for a graph object, the selections are
not reflected in the Design View of the HTML Layout Painter. These values are
applied at run-time.

Delete An Active Report Object

An Active Report object can only be populated if it is synchronized with an Active
Report. To break the synchronization between a report or graph with an Active
Report, delete the object.
1. Select the synchronized report or graph object in the layout.
2. Click Delete from Edit menu.
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The Active Report object is deleted.

Configuring Active Report Controls
To add an Active Report Control, it is required that you insert a new control to the
layout and configure it as an Active Report control on the Parameters tab. Selecting
Active Report as the control type creates an association between the HTML Layout
control and an Active Report, thereby linking actions to directly affect bound
Active Reports.

Note: Active Report controls are only applicable if there are Active Reports
embedded or referenced in the HTML Layout. Active Report Controls cannot be
associated to any parameters in the layout. This type of control can only be
associated with an Active Report in the Layout.

Add an Active Report Control to the Layout

Any HTML layout control can be configured as an Active Report control, but the
following controls are the most applicable: Check box, Drop down list, List box,
Radio button, and Push button.

Add a HTML Layout control that mimics an Active Report menu option:
1. Select the control type (Drop Down List, List Box, and so on), from the Insert

menu.
The cursor changes into a crosshair.

2. Click and drag the crosshair to create a the control object and adjust it to the
size you want.

The HTML layout control is added as the Active Report control. You may now
configure the control by using the Parameters tab.

Parameters Tab in Properties Window (Active Reports)

The following image is the Parameters tab in the Properties window with Active
Report control values.
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The Parameters tab contains the following fields and options when Active Report
is selected in the Control Values section:

Control Name

Contains the name of the form control associated with each parameter.

Parameter
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Contains the name of each parameter in the current procedure.

Unassigned - For an Active Report control, this should always be
unassigned.

Control Type

Contains the type of form control associated with each parameter.

The following control types are recommended form controls when using
Active Report controls: Check box, Drop down list, List box, Radio
button.

Control values

Determines whether parameter values are obtained from a static, dynamic,
or active report control list.

Active Report - Selecting the Active Report control will require you to bind
the HTML Layout control to an Active Report.

Refresh for Active Reports

Enables Active Report controls to automatically modify current views of
bound Active Reports when you select a new value at run-time.

Note: Refresh Active Reports is enabled by default when you select an
Available Active Report from the Parameters window.

For more information about the Refresh for Active Reports option, see
Refreshing Active Reports.

Available Active Reports

The Available Active Reports list binds Active Report controls to an Active
Reports in the layout. Thereby, at run-time, when the Refresh Active
Reports setting is triggered; the Active Reports selected in the Available
Active Reports list are modified based on the current state of each Active
Report control it is bound to.

Note: Available Active Reports lists all Active Reports currently embedded
in the HTML Layout Painter. No Active Reports are selected by default.

Menu Option Types

The Menu Option Types determine how Active Reports are modified when
the Refresh Active Reports setting is triggered. Menu Option Types
configure Active Dashboard controls to sort columns, filter content and
change the Active Report presentation. Multiple Active Report controls,
each with different Menu Option Types settings, can be used in
combination to modify the Active Dashboard.

Menu Option Types presents a list of options to designate which Active
Report menu option an Active Report control inherits. To set the behavior
of the current Active Report control, select only one Menu Option Types
item.

Note: If no option is selected, the Active Report control will have no affect
on the Active Dashboard.

List of columns

At run time, the Active Report control lists all common columns found in
each bound Active Report. When the Refresh Active Reports setting is
triggered, the data is sorted by the selected column.
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Note: If using AS Names for a field in a report, all common columns must
have the same name across all reports.

Column value

At run-time, the Active Report control lists all unique values found in a
specified column, common in each bound Active Report. When the Refresh
Active Reports setting is triggered, the Active Report control filters bound
Active Reports based on the column value selected.

List of filters

At run-time, the Active Report control lists multiple filtering actions. This
type of control does not affect bound Active Reports by itself, but only
when used in conjunction with Active Report controls set to Column Value.
When the Refresh Active Reports setting is triggered, the Active Report
control instructs how to filter bound Active Reports based on the value
selected in the Column Valued control.

The available list of filters are: Equals, Not equal, Greater than, Greater
than or equal to, Less than, Less than or equal to, Between, Contains,
Contains (match case), Omits, Omits (match case).

Sort order

At run-time, the Active Report control lists two sorting actions; Sort
Ascending and Sort Descending. When the Refresh Active Reports setting
is triggered, the Active Report control sorts bound Active Reports based on
the sorting action selected.

By default, the Active Report control sorts the first common column in
each of the bound Active Reports.

Report type

At run-time, the Active Report control lists different Active Report
presentation types; Grid, Pie Chat, Line Chart, Bar Chart, and Pivot Table.
When the Refresh Active Reports setting is triggered, this Active Report
control changes bound Active Reports to the presentation type selected.

Common Columns

The Common Columns list only appears when the Column value Menu
Option Type is selected. Common Columns lists all common columns
found in each bound Active Report. Select one field to bind to the Active
Report control. At run-time, the Column value control lists all unique
values across each bound Active Report’s Common Columns field selected.

Note: The Common Column selection can be overridden at run-time when
the Column Value control is chained to the List of columns Menu Option
Type.

Selected Value

Enter the value(s) to be selected as the default value whenever the
procedure is run. For more information, see Use Selected Values as the
Default Value.

Note: The Selected Value option is only available for Active Report controls
when the Column Value Menu Option Type is selected.

Add ″ALL″ Option
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Adds the option to select ALL data source values to the control. Alternate
text can be substituted for ″ALL″ using the text field to the right. For more
information, see Parameter List Options.

Configure an Active Report Control

Once the Active Report control is added to the layout, you may configure the
Active Dashboard control by using the Parameters tab of the Properties window.
1. Select the Active Report control in the layout and click the Parameters tab in

the Properties window.
2. Select Active Report as the Control Value.

The Active Report controls appear.

3. Bind the Active Report control to an Available Active Report in the layout:
v Select one or more Active Reports from the list of Available Active Reports.
v When an Active Report is selected, Refresh for Active Reports is enabled by

default.
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The Active Report(s) selected in the Available Active Reports list are modified
based on the current state of each Active Report control it is bound to. Refresh
for Active Reports refreshes current views of bound Active Reports when you
select a new value at run-time.
For more information about the Refresh for Active Reports option, see
Refreshing Active Reports.

4. Select the Menu Options Types for the Active Report control to sort, filter, list
or select columns, and/or change presentations styles of the bound Active
Report and the associated report and graph objects synchronized to the Active
Report.

Note: If no option is selected, the Active Report control will have no affect on
the Active Dashboard.
a. Select List of columns from Menu Option Types to list all common columns

found in each bound Active Report. At run-time, the bound Active Report
output is sorted by the selected column.
For example, the following Active Report control shows a list of all the
columns in the bound Active Report.

b. Select Column value from the Menu Option Types to list all unique values
found in a specified column, common in each bound Active Report at
run-time.
When Column Value is selected, the Active Report control panel
dynamically presents Common Columns in each of the selected Active
Reports in the Available Active Reports list.
Select one column from the Common Columns list.
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You may also use the Selected Value field to enter the value(s) to be
selected as the default value whenever the procedure is run. The Add ″All″
option adds the option to select ALL data source values to the control at
run-time.
For example, the following Active Report control shows RATING as the
selected common column for the bound Active Report.

c. Select List of filters from the Menu Option Types to list multiple filtering
actions at run-time.
Note: List of filters is used in conjunction with the Column value. Both
controls should be bound to the same Active Reports. The Active Report
control instructs how to filter bound Active Reports based on the value
selected in the Column value control.
For example, the following Active Report control shows a list of filters in
the bound Active Report.
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d. Select Sort order from the Menu Option Types to list sorting options
(Ascending or Descending) at run-time. The Active Report control sorts
bound Active Reports based on the sorting action selected.
Note: By default, the Active Report control sorts the first common column
in each of the bound Active Reports.
For example, the following Active Report control shows a list sort order
options in the bound Active Report.

e. Select Report types from the Menu Option Types to list different Active
Report presentation types at run-time. The Active Report control changes
bound Active Reports to the presentation type selected.
For example, the following Active Report control shows report type options
in the bound Active Report.
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Refreshing Active Reports
The Refresh Active Reports setting enables Active Report controls to automatically
modify current views of bound Active Reports when you select a new value. Each
bound Active Report is modified not only by the new selection in the Active
Report control with the Refresh Active Reports setting, but is based on the current
state of all Active Report controls in the Active Dashboard. This action is triggered
at run-time when you select a new value in an Active Report control with Refresh
Active Reports set.
v Enabled (or checked) empowers the Active Report control, only after you make a

new selection, to modify bound Active Reports.
v Disabled (or unchecked) prevents any bound Active Report from being modified

when you select a new value in the Active Report control.

In order to update Active Reports when a value in the Active Report control
changes, you must check the Refresh Active Reports check box on the Active
Reports Control Panel.

Note: Refresh Active Reports is selected by default.

You may want to disable the Refresh option if there are multiple Active Report
controls that require each control to be set before you refresh your output. If you
are using multiple controls, you can associate the refresh option with a Push
Button or Hyperlink, enabling you to refresh the output once all the controls are
selected.

Refresh Active Reports in the Active Report Control Panel:

1. Required: From the Parameters tab of the Properties window, select Active
Report as the Control Value.
The Active Report controls appear.

2. Required: Select the Refresh for Active Reports check box.
Note: When an Active Report is first selected, Refresh for Active Reports is
enabled by default.

Refresh Active Reports With a Push Button or Hyperlink:

1. Insert a Push Button or Hyperlink to the layout:
v Select Push Button from the Insert menu.
v Select Hyperlink from Insert menu.
The cursor changes into a crosshair.

2. Click and drag the crosshair to add the Push Button\Hyperlink object to the
layout and adjust it to the size you want.
v If inserting a Push Button, right-click the push button object and select

Create hyperlink from the context menu.
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The Hyperlink Properties dialog box opens.
v If inserting a Hyperlink, the Hyperlink Properties dialog box opens.

3. Optionally, you may change the name of the Push Button\Hyperlink in the
Display Text field.

4. From the Hyperlink Properties dialog box, select the New icon to add a request
to execute.

5. Select Refresh Active Reports from the Action drop-down list.
6. Select the Source drop-down list to select which Active Reports should be

refreshed.
Note: The Source drop-down will only lists the embedded or referenced Active
Reports in the layout.

7. Click OK to close the Hyperlink Properties dialog box.

Exporting the Active Dashboard
A benefit of Active Reports is the ability to run these reports off-line. You may
export an HTML Layout as a FOCUS procedure (.fex) to provide the ability to
schedule and distribute Active Dashboards, so these too can be run off-line.

Export As Procedure converts the HTML page and embeds the code into a FOCUS
procedure. The layout is no longer a Webpage or HTML file, but a FOCUS
procedure with embedded HTML code. The procedure (.fex) is added to the
Procedures folder (in your local projects) or in your Standard Reports group folder
(Managed Reporting environment).

Once the HTML Layout is saved as a procedure, it cannot be converted back to an
HTML Layout.
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Note: The Export as procedure is recommended for saving Active Dashboards only,
as many layout controls and report formats are not supported.

Use Export as Procedure

Once the HTML Layout is exported as a procedure, it cannot be converted back to
an HTML Layout.
1. After creating an Active Dashboard in the HTML Layout Painter, select Export

as procedure from the File menu.
The New Procedure File dialog box opens.

2. Type a File name and click Create.
Note: If the layout contains any parameter controls other than an Active Report
control, the Export as procedure option is unavailable.

Conversions of Export as Procedure

Export As Procedure converts the HTML page and embeds the code into a FOCUS
procedure. The layout is no longer a webpage or HTML file, but a focus procedure
with embedded HTML code. This conversion requires conversion of each object on
the HTML page.

The purpose of creating a procedure from an HTML Layout is to provide the
ability to run these forms off-line. Because you may not be connected to an
environment, the new procedure removes all referenced objects and adds them to
the procedure; and layouts with controls that require multiple requests to the
server will not be supported.

The following conversions occur when exporting as a procedure:
v Referenced procedures get read and written/embedded into the saved

procedure.
v Report and Graph objects - Display format is converted to HTML format. For

example, If the layout has embedded/referenced Excel, PowerPoint, or PDF
documents, these will all be converted to HTML formatted output.
Note: Active Reports (AHTML) format is preserved.

v Images - The reference to the image file is removed, and the image is embedded
in the procedure as inline HTML code.
Note: This code can become very long and it is recommended that only small
images be used in layouts that will be exported as procedures.

Limitations of Export As Procedure

Note the following limitations when applying the Export As Procedure in the
HTML Layout Painter:
v If using Static and Dynamic Parameter controls.

The Export as Procedure menu item is disabled for any Layouts with static or
dynamic parameter controls. Any scheduled report supports only one request to
the server at run-time. These types of controls require multiple requests to the
server, and cannot be supported off-line.

v If exporting a procedure with background images.
Background images will not be embedded into the procedure due to size. The
procedure will keep the reference. In off-line mode, if this reference cannot be
resolved, no image will be displayed.

v If exporting a procedure and using CSS stylesheets.
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The referenced stylesheets will not be embedded into the procedure and the
procedure will keep the reference. In offline mode, if this reference cannot be
resolved, no style from the CSS file will be applied.

Scheduling and Distributing Active Dashboards
If an HTML Layout has been exported as a procedure (.fex), it is now available to
be scheduled with Report Broker.

For information about scheduling, see “Adding Report Broker Schedule Capability
to the HTML Layout Painter” on page 597.

Controlling the HTML Layout Painter Environment
You can set properties for the HTML Layout Painter with the Settings dialog box.
This dialog box allows you to set page properties such as the location of reports
and graphs, as well as the display of a grid in your layouts. The changes that are
made in the Settings dialog box are saved to the registry. This allows a customized
environment to be created for various users.

Set Page Properties
1. Select Settings from the Tools menu. The Settings dialog box opens. For details,

see Settings Dialog Box.
2. Make your changes, and click OK.

Select Form Settings From the Settings Dialog Box
1. From the HTML Layout Painter, select Settings from the Tools menu.

The Settings dialog box opens.
2. Click the Form’s Settings button.

The Form Setting dialog box opens.
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3. Select the orientation for the form object in the layout.
4. Use the spin buttons to increase or decrease the distance between the prompt,

horizontal and vertical controls of the form, and the number of columns for the
form.
or
Position the cursor in the input box and type a number.

5. Use the slider control type options to select how the slider bar appears.
Note: Slider bars are available when using numeric range value parameters in
your report or graph.

6. The Add schedule button option adds a schedule button for referenced
procedures with parameters in the Managed Reporting environment. For more
information, see “Adding Report Broker Schedule Capability to the HTML
Layout Painter” on page 597.

7. Click OK to close the Form settings dialog box.
The form settings are applied and shown in the HTML Layout Painter Design
view.

8. To reset the default form settings, right-click the form object and select
AutoArrange from the context menu.
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The form is auto arranged on the layout, using the default form settings.

Settings Dialog Box

The following options are available from the Settings dialog box of the HTML
Layout Painter.
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Grid Settings

Show Grid

Displays a grid. If this is not selected, the grid is turned off for all layouts.

Snap to Grid

Causes objects in the layout to snap to grid lines when being positioned.
For detailed positioning, deselect this option.

Width

The width of the grid in pixels.

Height

The height of the grid in pixels.

Change current layout only

Select this check box to apply the grid settings to the current layout.

Preview Settings

Report and Graph Preview

Previews report and graph data in the Design View. If checked, additional
options are available (Simulated Data or Live Data).

Note: This option is selected by default.

If unchecked, icons are used to represent the area in the Design View for
reports and graphs. This is the fastest method of loading reports since no
request are made to the server.

Simulated Data

Selecting to preview simulated data sends a request to the reporting server
that gathers formatting information from the Master file. The database is
not accessed, but rather mock data is used to visually represent the report.
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Note: This option is only available when previewing reports and graphs.

Live Data

Selecting to preview live data sends a request to the reporting server, and
to the database, to get a snapshot of the actual data in the report.

Note: This option is only available when previewing reports and graphs.

Record limit for reports

Enables you to limit the number of records used to gather data for
previewing the report in live data mode. For example, if you set 500 as the
record limit for the report, then 500 rows of data are gathered for the
report results.

Note: This option is only available if the Live Data option is selected.

Record limit for input controls

Sets the number or records to be shown for the input controls when
gathering data for reports and graphs.

Note: This option is only available if the Live Data option is selected.

Show New Parameters Dialog

Controls whether or not the New Parameters dialog box shows when
adding parameters in the HTML Layout Painter.

Note: The New Parameters dialog box is shown by default.

Form’s Settings button

Options are available so that you may customize how the forms are
populated and arranged in the document.

Form’s Settings Dialog Box

The following options are available from the Form’s Settings dialog box of the
HTML Layout Painter.

Prompt orientation

Prompt refers to the descriptive text used to label the control/parameter in
the output.

To the left of the input

Places the descriptive text used to label the control/parameter to
the left of the input.

Above the input

Places the descriptive text used to label the control/parameter
above the input.

Distance between the prompt and input

Sets the distance between the prompt and input.

Horizontal distance between controls

Sets the horizontal distance between controls.

Vertical distance between controls

Sets the vertical distance between controls.
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Number of columns

Determines when the form will wrap and start laying controls out in a
new row.

Default slider control type

Sets how the slider control appears. Select from the following types of
slider bars:

Note: Slider controls are available when using numeric range value
parameters in your report or graph.
v Horizontal or Vertical Slider Simple bar. The slider bar has no end

arrows, just a bar with the slider.
v Horizontal or Vertical Slider with Color Bar and Arrows. Arrows appear

at each end of the slider bar.
v Horizontal or Vertical Slider with Color Bar, Arrows, and Edit. Arrows

and an edit box appear at the end of the slider bar, showing the current
value.

Note: Once a slider control is inserted into the HTML Layout, changing
these options will not affect the existing sliders, the option is only applied
to new slider controls. To change the existing slider bar type, delete the
slider object and insert a new slider control.

Add Schedule Button

Automatically adds a schedule button for referenced procedures with
parameters. This option is selected by default. For more information about
adding schedule capability to HTML Layout forms, see “Adding Report
Broker Schedule Capability to the HTML Layout Painter.”

Adding Report Broker Schedule Capability to the HTML Layout Painter
You may create a form control that adds a schedule button in the HTML Layout
Painter. A schedule button enables you to schedule a report, or graph, using Report
Broker. Once you have created the schedule, you can access the Report Broker
HTML User Interface to edit and maintain information about the schedule.

Note: The Schedule option is only available from the HTML Layout Painter in the
Managed Reporting environment if you are licensed to use Report Broker.
Managed Reporting provides access to Report Broker, where you can schedule and
distribute Standard Reports.

Only procedures referenced in the HTML Layout Painter are able to be scheduled.

When referencing an existing procedure with parameters in the HTML Layout
Painter, the schedule button is automatically added. You may also manually create
schedule buttons for your report or graph.

Add or Disable the Schedule Button for Form Controls

Form controls appear when you reference a report or graph with parameters. The
HTML Layout Painter automatically adds a form control, Run button, Reset button,
and Schedule button for the parameters in your layout; if your environment is
licensed to use Report Broker.
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The Form Settings dialog box sets when the schedule button appears with the
Form controls.

Note: The Schedule button is selected by default.

To change the default behavior:
1. Select Settings from the Tools menu.

The Settings dialog box opens.
2. Click the Form Settings button.

The Form settings dialog box opens.
3. Deselect the Add schedule button.

Note: If you deselect this option, you have the ability to manually add a schedule
button, for more information, see Manually Add a Schedule Button.

Add a Schedule Button to a Referenced Existing Procedure
With Parameters

This procedure provides instructions on how to automatically add a schedule
button to a HTML page for a referenced procedure in the layout.

Note: Access the Standard Reports folder of your Managed Reporting environment
to begin this procedure.
1. From the HTML Layout Painter, select New Report, or New Graph, from the

Insert menu.
The cursor changes into a crosshair.

2. Click and drag the crosshair to create a report (or graph) object and adjust it to
the size you want.

3. Right-click the object and select Reference existing procedure from the context
menu.
The Get source file dialog box opens.

4. Select an existing report or graph with parameters and click Open.
The New Parameters dialog box appears.
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5. Click OK to add the new parameters and the form controls to the HTML page.
The run, reset, and schedule buttons appear with the parameters on the HTML
page.
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6. Optionally, select the schedule button on the HTML page to view or edit the
properties. The properties appear in the Properties window of the HTML
Layout Painter.

7. Double-click in the Title properties value field to set the title of the schedule
page window.
The default title for the schedule page window is domain\standard
reports\folder\foldername. You may change this to the text of your choice.

8. Optionally, you may launch the Hyperlink properties for the schedule button to
change the template for the schedule page.

For more information about changing the template for the schedule page, see
Change the Default Template for the Schedule Page.

Manually Add a Schedule Button

This procedure provides instructions on how to manually add a schedule button to
a HTML page. This is useful for adding new, or additional, schedule buttons to a
report or graph that has already been referenced to the HTML page, or if you are
referencing a report or graph without parameters.

Note: Access the Standard Reports folder of your Managed Reporting environment
to begin this procedure.
1. From the HTML Layout Painter, select a form control from the Insert menu.

You may insert a push button, image, or hyperlink as a schedule button.
a. If inserting a push button as a schedule button:

v Select Push Button from the Insert menu.
The cursor changes into a crosshair.

v Click and drag the crosshair to add the push button object and adjust it
to the size you want.

v Right-click the push button object from the HTML page and select Create
hyperlink from the context menu.
The Hyperlink Properties dialog box opens.

v You may change the name of the push button in the Display Text field.
b. If inserting an image as a schedule button:

v Select Image from the Insert menu.
The cursor changes into a crosshair.

v Click and drag the crosshair to add the image object.
The Get source file dialog box opens.

v Select an image and click Open.
The image is added to the HTML page. You may adjust the image object
to the size you want.
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v Right-click the image object from the HTML page and select Create
hyperlink from the context menu.
The Hyperlink Properties dialog box opens.

c. If inserting a hyperlink as the schedule button:
v Select Hyperlink from the Insert menu.

The cursor changes into a crosshair.
v Click and drag the crosshair to create a hyperlink object and adjust it to

the size you want.
The Hyperlink Properties dialog box opens.

v You may change the name of the hyperlink in the Display Text field.
2. From the Hyperlink Properties dialog box, select the New icon to add a request

to execute.

Note: The Display as Text field on the Hyperlink Properties dialog box is only
available when inserting a push button or hyperlink as a schedule button.

3. Select the Action, Source, and Target/Template Name:
v Select Schedule Report from the Action drop-down list.
v Select the Source drop-down list to select the source of your Schedule

Report.
The Source drop-down will only lists the referenced procedures in the layout.

v The Target Type option is disabled and defaults to Report Broker when the
Schedule Report action is selected.

v The Target/Template Name defaults to Email Library FTP when the Schedule
Report action is selected.
For more information on changing the template for the schedule page, see
Change the Default Template for the Schedule Page.
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4. Click OK to close the Hyperlink Properties dialog box.
The schedule button, image, or hyperlink is added to the HTML page.

5. Optionally, select the schedule object to view or edit the properties. The
properties appear in the Properties window of the HTML Layout Painter.

6. Double-click in the Title properties value field to set the title of the schedule
page window.
The default title for the schedule page window is domain\standard
reports\folder\foldername. You may change this to the text of your choice.

Change the Default Template for the Schedule Page

This procedure provides instructions on how to change the template for the
schedule page by using the Hyperlink Properties dialog box. This is the template
that appears when the schedule page is run from the report output.
1. Right-click a schedule button, image, or hyperlink from the HTML page and

select Hyperlink properties from the context menu
The Hyperlink Properties dialog box opens.

2. Select the Target/Template Name drop-down list to change the default template
for the schedule. The options are:
v Email Library FTP - This is the default template.
v All
v Email
v Library
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Note: The template names represent the type of distribution option for the
schedule in Report Broker.

3. Click OK to close the Hyperlink Properties dialog box.
The selected template appears when the schedule page is run from your report
output.

Report Broker Schedule Page

When you run your report, select the parameters (if applicable), and click the
schedule button, the Report Broker schedule page appears.
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Tip: To change the schedule template that appears at run time, use the Hyperlink
Properties dialog box to change the Target/Template Name.

The report and the selected parameters are scheduled to Report Broker. From
Report Broker, the values entered or selected are stored with the schedule
information.

Note: You must have the Schedule user privilege to submit the schedule.

604 System i: Database IBM DB2 Web Query for System i



Chapter 13. Describing and Accessing Data: Overview

Introduces data source descriptions and explains how to use them.

Developer Workbench provides a set of graphical tools that you can use to describe
and access many types of data sources, including:
v Relational, such as DB2.
v Multi-dimensional, such as SAP BW and Essbase.
v Procedures, such as Web Services and CICS® Transactions.
v XML, such as XML and Tamino.
v Hierarchical, such as IMS™ and FOCUS.
v Sequential, both fixed-format and free-format.
v Indexed, such as ISAM and VSAM.
v Network, such as CA-IDMS.
v Other popular data sources, such as Lotus Notes® and LDAP.

These graphical tools are designed to:
v Translate the schema of the data source into metadata that DB2 Web Query can

read and report against.
v Optionally, enable you to customize and enhance the generated metadata,

without having to know the subtleties of the underlying DB2 Web Query data
description language.

A Note About Data Source Terminology
Different types of data sources make use of similar concepts, but refer to them
differently. For example, the smallest meaningful element of data is called a field by
many hierarchical database management systems and indexed data access
methods, but called a column by relational database management systems.

There are other cases in which a common concept is identified by a number of
different terms. For simplicity, we have standardized on a single set of terms. For
example, we usually refer to the smallest meaningful element of data as a field,
regardless of the type of data source. However, when required for clarity, we use
the term specific to a given data source. Each time we introduce a new standard
term, we define it and compare it to equivalent terms used with different types of
data sources.

How Applications Interpret Data
When your application accesses a data source, it needs to know how to interpret
the data that it finds. To accomplish this it reads a synonym, which is a term for
the generated metadata associated with the particular data source.

Your application needs to know about:
v The overall structure of the data. For example, is the data relational, hierarchical,

multi-dimensional, sequential? Depending upon the structure, how is it arranged
or indexed?
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v The specific data elements. For example, what fields are stored in the data
source, and what is the data type of each field—character, date, integer, or some
other type?

The synonym provides an alias for the data source that tells the server how tables
are described and where to find them.

The primary component of a synonym is a Master File. The Master File describes
the structure of a data source and its fields. For example, it includes information
such as field names and data types.

For some types of data sources, an Access File supplements the Master File. An
Access File includes additional information that completes the description of the
data source. For example, it includes the full data source name and location. The
nature of the information in the Access File is specific to each data source. You
need one Master File—and, for some types of data sources, one Access File—to
describe a data source.

How to Obtain a Synonym
You can generate synonyms using the Metadata menu option in Web Query, which
enables you to explore DBMS catalogs and select the objects for which you wish to
create synonyms. The tool prompts for all the information it needs to create a
synonym for a particular data source and stores the generated synonym on the
server.

There are some prerequisites: you must be authorized to use the data against
which you plan to report and you must have configured an adapter to access that
type of data. In fact, when you begin to create a synonym, Developer Workbench
opens the adapter configuration window. The option to create the synonym
becomes available only after the adapter is successfully configured.

Adapters are available for many data sources. Every adapter is specifically
designed for the data source that it accesses, and, as a result, is able to translate
between SQL or DB2 Web Query and the data management language (DML) of the
data source. Adapters provide solutions to product variations, including product
differences in syntax, functionality, schema, data types, catalogs, data
representations, message processing, and answer set retrieval. It is the adapter that
manages the synonym creation process. For related information, see How an
Adapter Works.

How an Adapter Works

The adapter manages the communication between the data interface and the data
source, passing data management requests to the data source and returning either
answer sets or messages to the requestor. To perform these functions, the adapter:
v Translates the request to the applicable DML.
v Attaches to the targeted data source, using standard attachment calls. The

adapter then passes the request to the data source.
v The data source processes the request.
v The results or error conditions are returned to the client application for further

processing.
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What You Can Do With a Synonym
Once you have generated a synonym, you can report against it using all of Web
Query’s reporting tools. In many instances, the configured adapter and the
generated synonym are all you need to access your data and create reports and
graphs.

However, you may wish to enhance the synonym in order to implement particular
capabilities that are supported in the DB2 Web Query data description language.
To do this, you can use a second data description tool, the Synonym Editor.

When you use the Synonym Editor, there is no need to know the data description
language since the graphical tool displays all viewable and editable attributes of
the synonym components. If you make changes to the generated synonym, the
Synonym Editor validates your entries and displays messages if they violate the
underlying syntax of the data description language.

Ways to Enhance a Synonym
Here are just a few of the attributes you might want to add to the synonym to
enhance your data access and reporting capabilities. You can:
v Create a cluster Join view by linking available synonyms to create a

multi-segment (multi-table) file for reporting.
v Add dimensions for OLAP analysis.
v Add virtual columns (DEFINEs) and columns for aggregated values

(COMPUTEs).
v Add filters to specify data selection criteria.
v Add group definitions for data sources that support groups.
v Add meaningful titles and descriptions, including Multilanguage variations.
v Change the format of fields (for example, the size of an alpha field or the format

of a date field).
v Create business views of the metadata in order to limit the fields available to

any retrieval request that references the business view and to group fields
together based on their roles in an application.

v Define parent/child hierarchies for cube data sources such as SAP BW and
Essbase.

The Synonym Editor is fully described in Using the Synonym Editor.

How an Application Uses a Synonym
Synonyms are stored apart from the associated data source. Your application uses a
synonym to interpret the data source in the following way:
1. It identifies, locates, and reads the Master File for the data source named in a

request.
2. It locates and reads the Access File for the data source named in the request, if

that type of data source requires an Access File.
3. It locates and reads the data source(s).

The data source contents are interpreted based on the information in the synonym.
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Chapter 14. Using the Synonym Editor

Describes the Synonym Editor and how you may use it to view and edit
synonyms.

This chapter describes the Synonym Editor and how you may use it to view and
edit synonyms.

Note: The Synonym Editor is accessible only through the DB2 Web Query
Developer Workbench.

Accessing the Synonym Editor
The following image is an example of how to access the Synonym Editor from
DeveloperWorkbench.

A synonym consists of a set of attributes that describe the data source. It provides
the metadata for a data source, which enables an adapter to access and interpret
the corresponding data.

Synonym Editor Layout
The Synonym Editor occupies the Developer StudioWorkbench workspace and
displays Tree View, Modeling View, Synonym Text View, and Access File Text View
tabs.
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Synonym Editor - Tree View Tab

The Tree View tab shows a hierarchy of segments and columns on the left, with the
attributes and values of the selected item on the right.

Note: The attributes available depend on the type of synonym.

The image below is an example of an SQL data source with a key column selected.

Note: Information about the attribute that has focus is displayed at the bottom of
the attribute list. In this case, an explanation of the FIELDNAME attribute appears.

The following objects may appear on the Tree View tab.

Object Function

Synonym.

General icon used to indicate synonyms, visible on top of
the Tree View tab. It provides information about the file
name used and the application it resides in.
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Object Function

Segment.

Indicates a segment in a synonym. The root or parent
segment appears first in the tree.

Key Column.

Indicates a key column.

Column.

Indicates a general column.

Virtual Column (Define).

Indicates a virtual or defined column.

For more information about virtual columns, see Adding
Virtual Columns (DEFINE) in a Synonym.

Index Column.

Indicates the native DBMS has an index for quick retrieval
of values for this field.

Filter.

Indicates a Master File filter.

Compute field.

Indicates a computed field.

Synonym Editor - Segment Pop-up Menu

When you right-click a segment in the Synonym Editor, the following pop-up
menu appears in the Tree View tab.

The image below is an example of an SQL data source with the root segment
selected.
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The following options are available:

Add

Enables you to add one of the following:

Segment From Existing Synonym

Adds an existing synonym to the current synonym.

Segment Via Metadata Import

Enables you to create and add a new synonym to the current
synonym through the Create Synonym tool.

Segment Manually

Adds a synonym that must by coded manually.

Column

Adds a column to the segment.

Virtual Column

Adds a virtual column to the segment.

Filter

Adds a filter to the segment.

Compute

Adds a calculated value to the file.
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Group

Adds a group column to the segment.

Data Profiling

Provides the characteristics of the data for a segment.

Data Profiling is available from the right-click context menu for all
columns in the Master File hierarchy tree.

Sample Data

Displays sample data in the workspace.

Sample data is available from the Synonym Editor toolbar, the right-click
context menu for all columns in the Master File hierarchy tree, and from
the Modeling View.

The following image is an example of the sample data that appears for a
segment:

Note: Sample Data is a great way to test the synonym for field data and to
view the type of records returned. This can assist when performing Joins,
testing connectivity to data sources, and so on.

Delete

Deletes the segment.

Rename

Enables you to rename the segment.

Synonym Editor - Column/Field Pop-up Menu

When you right-click a column in the Synonym Editor, the following pop-up menu
appears in the Tree View tab.
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The image below is an example of an SQL data source with a column selected.

The following options are available:

Add

Enables you to add one of the following:

Column

Adds a column to the synonym.

Virtual Column

Adds a virtual column to the synonym.

Filter

Adds a filter to the segment.

Compute

Adds a calculated value to the file.

Group

Adds a group column to the synonym.

Impact Analysis

Displays an Impact Analysis report for the particular column in the
workspace. An Impact Analysis report identifies the procedures that access
a Master File or field within a Master File. For detailed information on
Impact Analysis, see Chapter 15, “Analyzing Metadata and Procedures,” on
page 673.

Data Profiling
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Provides the characteristics of the data for a column. Data Profiling is
available from the right-click context menu for all columns in the Master
File hierarchy tree.

Sample Data

Displays sample data in the workspace.

Sample data is available from the Synonym Editor toolbar, the right-click
context menu for all columns in the Master File hierarchy tree, and from
the Modeling View.

The following image is an example of the sample data that appears for a
column.

Note: Sample Data is a great way to test the synonym for field data and to
view the type of records returned. This can assist when performing Joins,
testing connectivity to data sources, and so on.

Decompose Date

Decomposes date fields into virtual columns representing Year, Month,
Day, and Quarter fields.

Note: Decompose date is visible for date fields.

Delete

Deletes the column.

Rename

Allows you to rename the column.

Synonym Editor - Modeling View Tab

The Modeling View tab shows a graphical representation of the synonym. Use the
Modeling View to define dimensions for OLAP analysis, view join properties,
create cluster joins, and add or edit segments.
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The image below is an example of an SQL data source in the Modeling View.

For more information about the Modeling View, see Enhancing Synonyms Using
the Modeling View.

Synonym Editor - Synonym Text View Tab

The Synonym Text View tab shows the description of the underlying table.

You can print the Master File code by selecting Print from the File menu.

Synonym Editor - Access File Text View Tab

The Access File Text View tab shows the description of a synonym’s Access File,
which is used to access the database.

Note: You can print the Master File code by selecting Print from the File menu.

The image below is an example of an SQL data source in the Access File Text View
tab.
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Note: The text views are read-only. You cannot edit the underlying description
from these tabs.

Synonym Editor Toolbar

The Synonym Editor toolbar contains buttons that provide quick access to
commonly performed functions. The behavior of the button is determined by the
selected object. Therefore, certain toolbar buttons may be inactive.

Button Definition

Saves the edits made to the synonym.

Enables you to add segments from an existing synonym by
using the Select Synonym dialog box.

Enables you to add segments via metadata import by using
the Create Synonym tool. This tool creates a synonym and
includes it as a segment in the synonym from which the
tool was launched.

Enables you to add segments manually, assigning values to
segment attribute fields in the Synonym Editor.

Note: You would only use this approach if you are coding
a Master File from scratch, as you would for a FOCUS data
source.

Adds a column field.

Adds a virtual column (DEFINE) field.

For more information about virtual columns, see Adding
Virtual Columns (DEFINE) in a Synonym.

Adds a Master File filter.

For more information about filters, see Creating Filters in a
Synonym.
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Button Definition

Adds a COMPUTE field.

For more information about computed fields, see Adding
Computed Fields (COMPUTE) in a Synonym.

Adds a group.

For more information about groups, see Adding Group
Fields in a Synonym.

Deletes the selected item.

Enables you to view and refresh sample data for the object.

Enables you to create a business view and create a custom
Master File that can use selected fields from the original
synonym. In addition, you may customize field names,
titles, and descriptions.

For more information about business views, see Creating
Business Views in Developer Studio.

Viewing and Editing Synonym Attributes
The Synonym Editor enables you to view and edit a synonym’s attributes.

View and Edit Synonym Attributes

To view and edit synonym attributes:
1. From the Data Servers area, open a synonym by double-clicking a Master File

from the Master Files folder.
The Synonym Editor opens to the Tree View tab, which shows a hierarchy of
segments and columns on the left, with the attributes and values of the selected
item on the right.
Note: The attributes available depend on the type of synonym.
The image below is an example of an SQL data source with a key column
selected.
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Note: The Format, Expression, Description, and Nulls values are viewable in
the hierarchy with the columns. To edit these values, use the corresponding
attribute fields on the right-hand side of the Synonym Editor.

2. You can change the attribute values by typing in new values or by using the
drop-down menus and check boxes.
Note: The Synonym Editor does not let you make any changes that would
render the Master File unusable. Therefore, you cannot edit any value field that
is highlighted gray. In addition, if a change does not have proper
syntax/format applied, the field may appear in red text. Messages and
warnings appear if trying to save a file with an error.

3. Save changes by clicking Save from the File menu.
4. To close the Synonym Editor, select Close from the File menu or click the

control button in the upper right corner.

Note: If you close the Synonym Editor without saving your changes, you are
prompted to do so.

File Attributes Summary

The image below is an example of an SQL data source with the synonym file name
selected.
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Note: Information about the attribute that has focus is displayed at the bottom of
the attribute list. In this case, an explanation of the SUFFIX attribute appears.

Synonyms can have the following file attributes:

General

SUFFIX

Identifies the type of synonym or data source.

FDEFCENT

Defines the default century value, specifying a century number for
handling cross-century dates.

Note: Use the default setting (0) unless you wish to retrieve data
from a earlier century. For example, 19xx.

FYRTHRESH

Defines the base years—to represent the lowest year to which the
century value applies (FDEFCENT).

Note: Use the default setting (0) unless you wish to retrieve data
from a earlier century. For example, 19xx.

REMARKS

Enables you to include descriptive information at the file level and
specify multiple language descriptions for the synonym. Remarks
are displayed along with the file name during reporting.

For more information about multilingual descriptions, see Setting
Up Multilingual Titles and Descriptions.

DATASET

Identifies the physical location of the data source to be used in the
file name, including the extension and the location of the data file.

Note: The attributes available depend on the type of synonym.
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Segment Attributes Summary

The image below is an example of an SQL data source with a segment selected.

Note: Information about the attribute that has focus is displayed at the bottom of
the attribute list. In this case, an explanation of the SEGMENT attribute appears.

Segments in a synonym can have the following attributes:

General

SEGMENT

Is the name of the segment.

SEGTYPE

Specifies the type or relationship that a segment has to its parent
and indicates which of the segment’s fields are key fields, and in
what order they are sorted.

Type - Identify the segment type and sorting options from the
Type drop-down list.

Keys - Records are sorted in a data source by key fields. Enter the
number of key fields that you want to use for sorting. For example,
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no two employees can have the same employee ID number, so you
can use that field as the key. A segment instance can have more
than one field that makes up the key; that is, two or more field
values may be used to distinguish records.

SEGSUF

SEGSUF is used when part of the data source being described by
the Master File is of a different data source type than that declared
for the entire structure.

Note: SEGSUF is the data source type of a segment and any
descendants it might have, where that type differs from the
SUFFIX value.

Miscellaneous

DESCRIPTION

Contains a description or comments about the segment.

For more information about multilingual descriptions, see Setting
Up Multilingual Titles and Descriptions.

CRFILENAME

Is the name of the cross-referenced data source.

CRSEGNAME

Is the name of the cross-referenced segment.

CRKEY

Identifies the common join field for the cross-referenced segment.

Note: These cross-referenced values (CRFilename, CRSegname,
CRKey) are available for FOCUS data sources.

Adapter Specific

Note: Adapter Specific fields are shown if an Access File component has
been generated with the synonym.

CONNECTION

Indicates the host server or data source for synonyms.

TABLENAME

Identifies the table or view. It may contain the owner ID, as well as
the table name. For some synonyms, it must also contain the data
source name.

KEYS

Identifies how many columns constitute the primary key.

KEYORDER

Identifies the logical sort sequence of data by the primary key.

WRITE

Specifies whether write operations are allowed against the table.

CARDINALITY

Defines the number of records that are found in the original data
source when the synonym was created.
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DBSPACE

Identifies the storage area in which the table resides.

Note: The attributes available depend on the type of synonym.

Column/Field Attribute Summary

The image below is an example of an SQL data source with a key column selected.

Note: The attributes available depend on the type of synonym.

Note: Information about the attribute that has focus is displayed at the bottom of
the attribute list. In this case, an explanation of the FIELDNAME attribute appears.

Columns in a synonym can have the following attributes:

General

FIELDNAME
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Is the name of the column.

ALIAS

Assigns an alternative name for a column, or the real column name
for a DBMS synonym.

MISSING

Controls how null data is handled, that is, if no transaction value is
supplied.

TITLE

Supplies a title to replace the column name that is normally used
in reports and enables you to specify multiple language titles for
the column or field.

For more information about multilingual titles, see Setting Up
Multilingual Titles and Descriptions.

USAGE

Describes the data type and format for the column for usage or
display.

Note: Additional attributes, DEFCENT and YRTHRESH, are
available if the Usage field is set to Date, Time, or DateTime
(Timestamp) format. Use these attributes to enter the century and
year threshold values for the column/field.

Miscellaneous

DESCRIPTION

Contains a description or comments about the column or field.

For more information about multilingual descriptions, see Setting
Up Multilingual Titles and Descriptions.

ACCEPT

Specifies criteria for validating data.

OR enables you to specify an acceptable value.

FROM-TO enables you to specify a range of acceptable value
fields.

FIND enables you to supply file and field names to instruct DB2
Web Query where to search for a data source and for a list of
acceptable values. You supply the field name of the data field for
which the validation criteria are being assigned, the file name of
the target FOCUS data source where the field can be found, and
the field name of the target data field that contains the validation
criteria.

Note: Find is only available for FOCUS data sources and does not
apply to OLAP-enabled Master Files. Note also that, in the
Maintain environment, Find is not supported when developing a
Master File.

WITHIN

Contains the name of a field to be included in a dimension.
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These WITHIN statements are added to the synonym through the
Dimension Builder to OLAP enable FOCUS files and relational
tables. This enables you to perform OLAP analysis using the OLAP
Control Panel, or to use it with the FML Painter.

FIELDTYPE

Identifies an indexed column.

Note: FIELDTYPE=R indicates a read-only column, which will not
be updated by DM flows. This setting is useful for columns are
that automatically assigned a value by the RDBMS.

ACCESS_PROPERTY

Specifies access options for the column’s data.

INTERNAL defines a column that does not appear in sample data
or in the list of available columns. Restricts the field from showing
in any of the Field Lists in the reporting tools.

NEED_VALUE defines a column that requires a value to access the
data.

Select By defines a column by value, range, or multivalues.

AUTHRESP defines a column that describes the result of an
authentication operation. Correct response values must be
provided in the ACCEPT attribute (using the OR predicate if more
than one value is acceptable).

AUTHTOKEN defines a column that contains a response token to
be passed as an input value to the operation to be executed.

HELPMESSAGE

Appends a help message to a column.

Note: The attributes available depend on the type of synonym.

Setting Up Multilingual Titles and Descriptions
You can open a synonym in the Synonym Editor and provide text for the title,
caption, and description in multiple languages. These descriptions appear in the
specified language in reports generated against the synonym.

The Multilingual Titles dialog box is available from the Remarks, Title, and
Description attribute value fields in the Synonym Editor.

Note: The attributes available depend on the type of synonym.

Set Up Multilingual Titles and Descriptions
1. From the Data Servers area, double-click the Master File or select Edit in

Synonym Editor from the File menu.
The Master File opens to the Tree View tab in the Synonym Editor.

2. To add multilingual text:
v For Title, click a column from the Master File hierarchy of columns on the

left.
v For Remarks, click the root level of the Master File (application/filename)

on the left.
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v For Descriptions, click a column, segment, or custom field from the Master
File hierarchy of fields on the left.

The corresponding attributes and values appear on the right.
3. Click the browse (...) at the end of the value field for either Remarks, Title, or

Description.
The Multilingual dialog box opens.

4. From the Specify Titles/Descriptions for different languages drop down list,
choose the language in which you want the remarks (descriptions) and/or
titles to be displayed.

5. Click Add.
The selected language is added below the default language (which is
determined by your code page selection).
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6. Type in a description/title in the Text field.
7. Required: You may add, edit or delete additional titles/descriptions:

To add an additional language:

a. Required: Select another language from the drop-down list.
b. Required: Click Add.
c. Required: Type in a title/description for the field.
To edit an existing specified title/description:

a. Select the title/description and click Edit.
You may also double-click the title.

b. Manually type a title/description name.
To delete a specified title:

a. Select the title/description and language to be deleted.
b. Click Delete.

8. Required: Click OK to close the Multilingual Titles dialog box.
9. Required: Click Save from the File menu to save the synonym.

10. To close the synonym, select Close from the File menu or click the control
button in the upper right corner.
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Enhancing Synonyms Using the Modeling View
The Synonym Editor Modeling View tab provides a visual presentation for the
synonym for which positioning is preserved and stored in the Access file. Use the
Modeling View to define dimensions for OLAP analysis, view join properties,
create cluster joins, and add or edit segments. For more information about using
the Dimension Builder in the Modeling View, see Defining Dimensions for OLAP
Analysis.

Note: The Modeling View is not available for Cube data sources.

Enhance Synonyms Using the Modeling View

Use the Modeling View to enhance a synonym by adding a segment.
1. From the Data Servers area, open a synonym by double-clicking a Master File

from the Master Files folder.
The Synonym Editor opens.

2. Click the Modeling View tab.
The Synonym Editor Modeling View tab opens in the workspace.

3. Right-click a segment in the workspace.
The following pop-up menu appears.

4. Add segment through one of the methods listed:
v Add Segment From existing synonym adds an existing synonym as a

segment to the current synonym.
v Adding Segment Via metadata import enables you to add segments by using

the Create Synonym tool. This tool creates a synonym and includes it as a
segment in the synonym from which the tool was launched.

v Add Segment Manually enables you to add segments manually to the
current synonym.

Note: You would only use this approach if you are coding a Master File from
scratch, as you would for a FOCUS data source.

5. Required: Optionally, you can double-click the arrowed lines between tables to
open the Join Properties dialog box and determine how the tables are linked.
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Tip: You may also right-click a file icon and select Join Properties from the
context menu.
In addition, when creating a Cluster Join, there are two additional options for
linking tables: Join All (default) is shown by a double arrow and Join Unique is
shown as a single arrow.

Note: Join options are not available for FOCUS files.

Edit Synonyms Using the Modeling View

To edit synonyms using Modeling View:
1. From the Data Servers area, open a synonym by double-clicking a Master File

from the Master Files folder.
The Synonym Editor opens.

2. Click the Modeling View tab.
3. Right-click a segment icon.

A pop-up menu appears, providing options for adding segments.
Note: Options for adding segments are also available from the icons above the
workspace.
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To Add a Segment From an Existing Synonym:

a. Required: Select Add Segment From Existing Synonym from the pop-up
menu.
The Select Synonym dialog box opens.
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b. Click a synonym and click Select.
The segment is added to the synonym.

To Add a Segment Via Metadata import:

a. Select Add Segment Via metadata import from the pop-up menu.
This method enables you to launch the Create Synonym tool, create a
synonym, and incorporate it as a new segment in the synonym from which
you initiate the import.
The Create Synonym dialog box opens.

b. Create a synonym.
The segment is added to the synonym.

To Add a Segment Manually:

a. Select Add Segment Manually.
The segment is added to the Modeling View and a default field is created,
using a default name SEG name.

b. Right-click the segment and select Properties.
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The Segment Properties dialog box opens.
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c. Required: Edit the segment’s properties, if needed, and click OK.
d. Switch to the tree view to add or change attributes for the new segment(s).

The following image shows a synonym which has had several segments added in
the Modeling View tab.
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You can select the Synonym Text View or Access File Text View tab to see the
resulting segment attributes.

Modeling View Pop-up Menu

When you right-click a synonym or segment in the Synonym Editor Modeling
View tab, the following pop-up menu appears.

The following pop-up menu appears.
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The pop-up menu has the following options:

Toggle

Changes the view from a file icon to a table view, which enables you to see
columns, sample data, and sample data parent keys.

Tip: You may also double-click a file icon to open the table view.
Double-click the table to close the table view, or click the X button from the
toggle toolbar to close.

Join Properties

Provides access to the Join Properties window.

Note: Join options are not available for FOCUS files.

Add Segment From Existing Synonym
Enables you to add an existing synonym as a segment to the current
synonym.

Add Segment Via metadata import

Enables you to create a new synonym through the Create Synonym tool
and add it to the current synonym.
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Add Segment Manually

Adds a segment to the current synonym, that must by coded manually.

Delete

Deletes the segment.

Rename

Enables you to rename the segment.

Properties

Launches the Segment Properties dialog box where you can edit the
segment.

Join Properties Dialog Box

When you select Join Properties from a segment in the Synonym Editor Modeling
View tab, the Join Properties dialog box appears.

The Join Properties dialog box contains Left and Right Source Columns, Join Type,
and Join Condition options. Use the left and right source columns to create join
maps and view sample data.

Note: Join options are not available for FOCUS files.
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Creating Cluster Joins
Cluster Joins enable you to create a new file structure by linking existing
synonyms of two or more relational tables using the same or mixed data sources.
For example, you may join a DB2 table and an Oracle table, and so on. Use Cluster
Joins to create new views in the metadata by linking together physical tables and
easily report against the new view/structure. You can create cluster joins by using
the Modeling View of the Synonym Editor.

The Master File description that is created combines the fields of the joined tables
within a single file. The Access File from the combined file contains information
about the actual location of the data sources, the Join information, and shows how
the tables are linked.

The total number of tables that you can add to the tool is 64 (using 63 joins) that
results in a new Master File that has a maximum of 64 segments.

Create a Cluster Join by Enhancing Existing Synonyms

Use the Modeling View to enhance an existing synonym by adding a segment.
1. From the Projects or Data Servers area, open a synonym by double-clicking a

Master File from the Master Files folder.
The Synonym Editor opens.

2. Click the Modeling View tab.
The Synonym Editor Modeling View tab opens in the workspace.

3. Right-click a segment in the workspace.
The following pop-up menu appears.

4. Add tables (segments) through one of the methods listed:
a. Add Segment From Existing synonym.

Select a synonym to be added and click Select.
Note: Use this method if you are creating a cluster join with an existing
table/synonym.
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Tip: Click Save As from the Modeling View File menu if you do want to
modify the original synonym.

b. Required: Adding Segment Via metadata import enables you to add
segments by using the Create Synonym tool. This tool creates a synonym
and includes it as a segment in the synonym from which the tool was
launched.
Note: Use this method if you are creating a cluster join and need to use a
synonym that does not exist. This option enables you to create the synonym
and continue to create the cluster join.

c. Add Segment Manually enables you to add segments manually, assigning
values to segment attribute fields in the Synonym Editor.

Note: Use this method if you are coding a Master File from scratch, as you
would for a FOCUS data source.

The segment is added in the Modeling View.
5. Right-click the arrowed lines between tables to view the join options.
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Note: These join options are not available, and do not appear, for FOCUS
tables. The only way to view these options are by using Relational tables.
v Join All indicates a multiple instance (one-to-many) type of join. At run time,

each host record can have many matching records in the cross-referenced file.
Note: Join all is the default option.

v Join Unique indicates a single instance (one-to-one) type of join. At run time,
each host record has, at most, one matching record in the cross-referenced
file.

v Join Properties opens the Join Properties dialog box, from which you can
determine how the tables are linked. You may:
– Create Inner, Outer, or Cross Joins.

Note: Outer joins are subdivided into Left Outer Joins, Right Outer Joins,
or Full Outer Joins.

– Combine records from the selected tables by mapping source columns.
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Use the Tree and Text View tabs of the Synonym Editor to view or edit the
details of these tables (segments).
Tip: Click Save As from the Modeling View File menu if you do want to
modify the original synonym.

Create a Cluster Join Using a New Synonym

Another way to create a cluster join is to start with an empty synonym:
1. Right-click a Master Files folder, select New, then Synonym via Synonym

Editor. The Add Master File dialog box opens.
2. Enter a unique file name in the File name field.
3. Click Open.

The Synonym Editor opens to the Modeling View tab.
4. Right-click in the workspace and select from one of the available options to

start building the new view.
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Defining Dimensions for OLAP Analysis
Synonyms can be modified to support Online Analytical Processing (OLAP). The
Synonym Editor provides tools to create OLAP hierarchies and dimensions. OLAP
enables you to drill down or roll up on hierarchical data, pivot fields from
columns to rows (or vice versa), and slice-and-dice information by filtering or
querying data sources based on specified criteria thresholds.

You OLAP-enable the Master File by using the Synonym Editor to create
dimension(s) at the field level and associate fields with each dimension.

Note: OLAP is a reporting facility; it is not relevant to data maintenance projects.

Using the Dimension Builder in the Synonym Editor Modeling
View

The Dimension Builder enables you to create logical views based on enterprise
data (relational or legacy data sources) for multi-dimensional analysis without
manually editing metadata. The Dimension Builder works with relational and
FOCUS data sources.

Add a Parent/Child Hierarchy
1. From the Synonym Editor, click the Modeling View tab.

The Dimension Builder appears on the right side of the window.
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Note: If the Dimension Builder is not visible, ensure that Dimension Builder is
selected from the Synonym menu.

2. Right-click the dimension and select Parent/Child from the Add Hierarchy
submenu.
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Note: You may also select this option by clicking the Add Parent/Child
Hierarchy button from the Dimension Builder toolbar.
The Mandatory Properties for Parent/Child Hierarchy dialog box appears.

3. Select a field from the Field Tree and click Assign to assign a Unique ID for the
hierarchy.

4. Repeat Step 3 for the Caption and Parent hierarchy properties.
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5. Required: Click OK to close the Mandatory Properties for Parent/Child
Hierarchy dialog box.
The Mandatory Properties are added to the Dimension Builder.

6. Use the right-click menu to rename the dimension, view properties, or view
sample data for the dimension.

7. Click Save from the File menu to save the dimension.

Delete a Dimension

To delete a dimension, right-click a dimension and select Delete, or click the
Delete button from the Dimension Builder toolbar.

Add Levels to the Hierarchy

This process enables you to edit an existing Master File, add tables (for
non-FOCUS Master Files), and create and modify dimensions.
1. From the Synonym Editor, click the Modeling View tab.
2. Select the Add Levels Hierarchy button from the Dimension Builder toolbar.

A level is added to the hierarchy. Use the right-click menu to rename the
dimension or keep the default name.

3. Right-click the file icon in the Modeling View to toggle to the table view, which
enables you to see columns, sample data, and sample data parent keys.
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The table view appears in the Modeling View.
Tip: You may also double-click a file icon to open the table view.

4. Using the Columns tab of the table view, drag and drop selected fields to the
Dimension Builder hierarchy folder.

You may also drag and drop fields to and from other hierarchies using the
Dimension Builder.
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5. Click Save from the File menu to save the dimension.
The dimension is saved and store in the Master File.

Dimension Builder Toolbar

You can access the following commands from the Dimension Builder toolbar:

Button Definition

Adds a level hierarchy.

Enables you to create a parent/child hierarchy and assign
mandatory properties for the hierarchy.

Deletes the selected item.

Enables you to view and refresh sample data for the
selected field.

Enables you to switch back to properties in the Tree View
tab of the Synonym Editor.

Creating Business Views
By defining a Business View of a Master File, you can limit the fields available or
create a subset of fields from the original Master File. Fields can be grouped into
meaningful folders and field names, titles, and descriptions can be customized for
each Business View. The Business View points to its underlying Master File, and all
of the actual field information comes from the original Master File when the
Business View is used in DB2 Web Query tools (such as Joins and Defines) and in
reports.

Fields in a Business View are organized into folders. Each folder contains a group
of fields. The fields in a folder can come from different segments in the original
Master File. The Business View may contain existing fields and can include existing
custom fields (DEFINEs), COMPUTES, and Filters. Custom fields are associated
with a specific segment in the original Master File and are subject to the same rules
as real fields. A report can reference fields from multiple folders if they all lie
along a single path in the original Master File.

The Business View Master File is stored as if it were a real Master File. However, it
has no SUFFIX attribute. Instead, it contains a VIEW_OF attribute that identifies it
as a Business View. It can be saved to a different application from the original
Master File.

Note: Impact Analysis searches Business Views in addition to FOCUS procedures.
This enables you to see if changes in the original Master File will impact fields
used in the Business View. For detailed information on Impact Analysis, see
Chapter 15, “Analyzing Metadata and Procedures,” on page 673.

You may create a Business View for an existing Master File by using the Synonym
Editor.
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Create a Business View Using the Synonym Editor
1. From the Data Servers area, navigate to the Master Files folder where you wish

to create the Business View and highlight the Master File to be altered.
Note: You may create a Business View anywhere where you can select a Master
File.

2. Required: Double-click the Master File or select Edit in Synonym Editor from
the File menu.
The Master File opens to the Tree View tab in the Synonym Editor.

3. Select Create Business View from the Synonym menu.
The Business View window opens to the Business View Tree tab.
A default File name and folder appears. Additional folders may be created for
grouping fields.
Note: A Business View Master File may contain only one root folder.

The Properties Bar on the bottom of the Business View window shows
information for the selected fields and folders.
Tip: Use the Properties bar to change the title and descriptions for the field
names. Items that cannot be edited are grayed out.

4. To add additional folders for the Business View, select New Folder from the
BusinessView menu.
Note: Multiple sub-folders can be created and folder may be empty for
organizational purposes.
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5. Required: Select fields from the Master File listed on the right and drag to the
appropriate folder on the left. Use Shift-click and Ctrl-click to select multiple
fields.
Note: If needed, fields may be duplicated and placed under multiple folders.
The selected fields appear in the Business View Tree tab.

6. Select Save As from the File menu to save the Business View as a Business
View Master file.
Note: The Business View Master File may be saved in a different application
then the main files.

7. Select Close from the File menu to return to the Synonym Editor.

Business View Menu Options

The following menu items are available from the Business View window.
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New Folder

Adds a new folder to the Business View. You may also access this option
from the right-click context menu and from the new folder icon, located on
the Business View toolbar.

Delete Items

Deletes the selected item.

Rename Item

Enables you to rename a selected field or folder. You may also rename
items from the Properties bar and the from the right-click context menu.

Refresh

Refreshes the Business View. A Refresh icon is also available on the
Business View toolbar.

Use Application Directory Names

Specifies the application name where the original file exists. Information is
written in the new master file. The following image is an example of the
application directory name for the business view.

Note: This option is turned off by default and is only available during the
creation of the business view.

Sample Data

Test the business view for field data and view the type of records returned.

Impact Analysis
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Opens the Impact Analysis tool which enables you to analyze data, control
search criteria, save reports, and interactively open and edit procedures
based on search results. For detailed information on Impact Analysis, see
Chapter 15, “Analyzing Metadata and Procedures,” on page 673.

Exposed Synonym

Shows the Synonym referenced by the Business View.

Properties Bar

Shows the Properties Bar where you may edit properties for the selected
fields and folders. Items that cannot be edited are grayed out.

Note: The Properties Bar may be moved or docked anywhere on the
Business View window.

Business View Tree

Shows the contents of the Business View in the Business View Tree. This is
the default option.

Text View

Shows the contents of the Business View in the Text View. You may also
select this option by clicking the Text View tab from the bottom of the
Business View window.

Note: The text view is read-only. You cannot edit the underlying
description from this tab.

Usage Notes for Business Views
v The detailed information about fields, such as USAGE and ACTUAL formats or

indexes remain in the original Master File.
v All information about Cluster Master Files remain in the original Master File.
v When a Master File description contains more than one field with the same

name, as can occur when files are joined, the BELONGS_TO_SEGMENT
attribute identifies which instance of the field name is being referenced in the
Business View.

v Folders can be empty for organizational purposed. For example, Region can
have empty folders called North, South, East, and West.

v You can issue an SQL SELECT command against a Business View. However, a
Direct SQL Passthru request is not supported against a Business View.

v Business Views support alternate file views and fully qualified field names.
v The SEG. operator against a Business View folder displays all of the fields in

that folder, not all of the fields in the real segment.
v Requests against a Business View cannot reference any fields or segments not in

the Business View.
v All HOLD formats are supported against a Business View.
v All adapters for non-FOCUS data sources support retrieval requests against a

Business View.
v Business Views are not supported with data source maintenance commands such

as Maintain or REBUILD.
v Business Views are not available for Cube Data Sources.
v For OLAP enabled Master Files, dimensions are not visible while creating a

business view. Only fields from the original Master File will be visible.
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v When using Business Views, the following SET command must be specified: SET
FOCTRANSFORM=ON. This SET command can be placed in a procedure or can
be set in the global server profile or specified in a user profile and can be set
while using the Business View or regular Master Files. For thin client tools
(Power Painter, HTML tools, and so on), it needs to be in the profile as
end-users do not have access to the SET tool or ability to access an editor and
manually enter the required command.
Adding this SET command in the profile is a good practice as it will avoid
errors during reporting in case command is missing and users will not need to
be concerned about what type of file they are using during reporting (Business
View or existing master file).

Using a Business View Master File

When you use the Business View Master File in the DB2 Web Query tools and
reports, the Field formats, descriptions and titles will be retrieved from the original
Master File, unless they are customized and a title and description is available
through the Business View.

You may access the Business View Master Files from all development areas of
Developer Workbench.

The Table list shows all available Master Files including the Business Views that
are available. The Remarks column shows a description from original Master File
unless the Business View file contains it own remarks.

The following image is an example of a Business View Master File in the DB2 Web
Query Table List, that appears when creating a report in the Data Servers area.

In the Report Assistant, when using a Business View Master File with the Report
Assistant, only fields from the Business View are shown in the Fields list.
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The following image is an example of a Business View Master File in the Report
Assistant.

Adding Virtual Columns (DEFINE) in a Synonym
You may create a DEFINE field as a custom field in the Synonym Editor. A custom
field can be used in a request as though it is a real data source field. Virtual
columns (DEFINES) are available when the data source is used for reporting.

A virtual column can contain an expression, a constant, or a column name.
v If the virtual column is a complex expression, you can create the expression with

the Virtual Column Calculator or just type it into the Expression field.
v If the virtual column is a simple expression, like a constant value, you can type

the value in the Expression field.

Virtual columns are designated by the following icon:

After creating a virtual column, you can test it by right-clicking the synonym and
selecting Sample Data. Sample Data appears in a separate dialog box.
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Create a Virtual Column in a Synonym

To create a virtual column in a synonym:
1. From the Data Servers area, open a synonym by double-clicking a Master File

from the Master Files folder.
The Synonym Editor opens.

2. Right-click a segment (or column) and click Add.
3. Select Virtual Column from the Add submenu.

The Virtual Column Calculator opens.

4. From the Virtual Column Calculator, type a name for the column in the
Column input field, or use the default define name.

5. Required: You may enter a descriptive title for the virtual column (DEFINE) in
the Title input field.
Tip: From the Synonym Editor, click the browse (...) button at the right of the
TITLE and DESCRIPTION value fields to specify multiple language titles.

6. Use the Expression tab and the calculator buttons to build the expression for
the virtual column (DEFINE).
or
Use the Filter Builder tab to build the expression.
a. From the Filter Builder tab, use the drop-down lists to select the filter

Column, Relation, and Type.
Note: Parameters are not supported.

b. Click the browse (...) button at the right of the Value input field.
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The Value Selection dialog box opens.

c. Select from the available value(s) and use the arrows to add or remove
values.

d. Click OK to close the Value Selection dialog box and return to the Filter
Builder tab.
The expression is added to the value field.
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e. To add another filter, double-click a column or variable from the
Columns/Variables tab on the right side of the Virtual Column Calculator.
The filter is added to the Filter Builder. Add the expression value.

f. To delete an expression from the Filter Builder, click the red X in the row of
the filter that you are deleting. The filter is removed from the Filter Builder.

7. You may select the Check expression and Sample Data buttons, located on the
top right of the Virtual Column Calculator, to verify that the expression is
valid and to view sample data for the filter.

8. Click OK to close the Virtual Column Calculator and return to the Synonym
Editor.
Note: To edit the DEFINE, Title, or Expression, you may do so directly from
the Synonym Editor or you may click the browse (...) button at the right of the
EXPRESSION value field to relaunch the Virtual Column Calculator.

9. If no columns from the synonym are used in the expression or have been
defined, you can use the WITH option to identify the logical home of the
defined calculation. You can also use the WITH option to move the logical
home for the virtual column to a lower segment than it would otherwise be
assigned to (for example, to count instances in a lower segment).
Tip: You can click and drag the DEFINE field and move it to a different
segment in the Tree View tab, which also changes the segment association.

10. Specify the Missing Data options for columns that allow null data. You can
allow all missing data.

11. Click Save from the File menu to save the synonym.
12. To close the Synonym Editor, select Close from the File menu or click the

control button in the upper right corner.

For more information about expressions and virtual column (DEFINE) attributes,
see Defining Attributes and Creating Expressions for Custom Fields.
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Creating Filters in a Synonym
Filters are created in the Master File through the Synonym Editor and can be used
in a Business View file or in reporting tools such as Power Painter, HTML Report
Assistant, and so on. You can also use filters to perform other data checking and
validation, and sort data based on the conditions that you create.

Filters are created under a specific segment and by default they have association
with the selected segment. Filters can also be created without segment association.

Create Filters in a Synonym
1. Required: From the Data Servers area, double-click a synonym from the

Master Files folder, or right-click the synonym and select Edit in Synonym
Editor.
The Synonym Editor opens.

2. Required: Right-click a segment or field and select Filter from the Add
submenu. The Filter Calculator opens.

3. From the Filter Calculator, type a name for the filter in the Column input
field, or use the default Filter name.
Note: It is recommended that filters have a descriptive name to help identify
the filter action during reporting.

4. The Format field shows a default value of I1.
Note: The format field cannot be changed. Values for filters return 0 for false
and 1 for true.

5. You may enter a descriptive title for the filter in the Title input field.
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Tip: From the Synonym Editor, click the browse (...) button at the right of the
TITLE and DESCRIPTION value fields to specify multiple language titles.

6. Use the Expression tab and the calculator buttons to build the expression for
the filter. or Use the Filter Builder tab to build the expression.
a. From the Filter Builder tab, use the drop-down lists to select the filter

Column, Relation, and Type.
Note: Parameters are not supported with Master File Filters.

b. Click the browse (...) button at the right of the Value input field.
The Value Selection dialog box opens.

c. Select from the available value(s) and use the arrows to add or remove
values.

d. Click OK to close the Value Selection dialog box and return to the Filter
Builder tab. The expression is added to the value field.
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e. To add another filter, double-click a column or variable from the
Columns/Variables tab on the right side of the Filter Calculator. The filter
is added to the Filter Builder. Add the expression value.

f. To delete an expression from the Filter Builder, click the red X in the row of
the filter that you are deleting. The filter is removed from the Filter Builder.

7. You may select the Check expression and Sample Data buttons, located on the
top right of the Filter Calculator, to verify that the expression is valid and to
view sample data for the filter.

8. Click OK to close the Filter Calculator dialog box to return to the Synonym
Editor.
Note: To edit the Filter, Title, or Expression, you may do so directly from the
Synonym Editor or you may click the browse (...) button at the right of the
EXPRESSION value field to relaunch the Filter Calculator.

9. Required: To create a Filter without segment association, use the WITH
drop-down list to select a blank segment.
Note: Filters are created under a specific segment and by default they have
association with the selected segment. Filters can also be created without
segment association.
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Note: If using a field that appears in multiple segments, the WITH segment
associated should be the lowest level segment, or it should be left empty to
prevent errors.
In addition, If no fields from the synonym are used in the expression or have
not been computed, you can use the WITH option to identify the logical home
of the Filter calculation. You can also use the WITH option to move the logical
home for the Filter field to a lower segment than it would otherwise be
assigned to (for example, to count instances in a lower segment).

10. Click Save from the File menu to save the synonym. The filter is saved as part
of the synonym.

11. To close the Synonym Editor, select Close from the File menu or click the
control button in the upper right corner.

Adding Computed Fields (COMPUTE) in a Synonym
You may create a Computed field as a custom field in the Synonym Editor. The
procedure for adding a custom field is similar to the procedure used to add a
Defined field. The Computed field is identified as the Master File Computed Field
and is differentiated from the Defined fields and the other Computed Fields.

Note: Computed fields from the Master File appear in the Windows versions of the
Graph Assistant and in the Report Assistant fields list.

Create a Computed Field in the Synonym Editor

To create a computed column in a synonym:
1. Required: From the Data Servers area, open a synonym by double-clicking a

Master File from the Master Files folder.
The Synonym Editor opens.

2. Required: Right-click a segment (or column) and click Add.

3. Required: Select Compute from the Add submenu.
The Compute Calculator opens.
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4. From the Compute Calculator, type a name for the column in the Column
input field, or use the default compute name.

5. You may enter a descriptive title for the computed field (COMPUTE) in the
Title input field.
Tip: From the Synonym Editor, click the browse (...) button at the right of the
TITLE and DESCRIPTION value fields to specify multiple language titles.

6. Use the Expression tab and the calculator buttons to build the expression for
the computed field (COMPUTE). or
Use the Filter Builder tab to build the expression.
a. From the Filter Builder tab, use the drop-down lists to select the filter

Column, Relation, and Type.
Note: Parameters are not supported.

b. Click the browse (...) button at the right of the Value input field.

The Value Selection dialog box opens.
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c. Select from the available value(s) and use the arrows to add or remove
values.

d. Click OK to close the Value Selection dialog box and return to the Filter
Builder tab.
The expression is added to the value field.
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e. To add another filter, double-click a column or variable from the
Columns/Variables tab on the right side of the Compute Calculator. The
filter is added to the Filter Builder. Add the expression value.

f. To delete an expression from the Filter Builder, click the red X in the row of
the filter that you are deleting. The filter is removed from the Filter Builder.

7. You may select the Check expression and Sample Data buttons, located on the
top right of the Compute Calculator, to verify that the expression is valid and
to view sample data for the filter.

8. Click OK to close the Compute Calculator and return to the Synonym Editor.
Note: To edit the Compute, Title, or Expression, you may do so directly from
the Synonym Editor or you may click the browse (...) button at the right of the
EXPRESSION value field to relaunch the Compute Calculator.

9. Specify the Missing Data options for columns that allow null data. You can
allow all missing data.

10. Click Save from the File menu to save the synonym.
11. To close the Synonym Editor, select Close from the File menu or click the

control button in the upper right corner.

For more information about expressions and COMPUTE attributes, see Defining
Attributes and Creating Expressions for Custom Fields.

Defining Attributes and Creating Expressions for Custom Fields
A custom field is a field whose value is not stored in the data source but can be
calculated from the data that is there. You can create a custom field in your
synonym by adding a virtual column (DEFINE), Master File filter (FILTER) and a
Computed Field (COMPUTE). The fields are available whenever you access the
corresponding data source in a reporting tool.
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You can define attribute values and create expressions for custom fields by using
the Synonym Editor.

Custom Field Attributes

The following attributes may be available for custom fields (DEFINE, FILTERS, and
COMPUTE) in the Synonym Editor.

Note: The attributes available depend on the type of synonym and the type of
custom field selected. The image below is an example of an SQL data source with
the virtual column (DEFINE) selected.

Custom fields (DEFINE, FILTER, COMPUTE) typically have the following
attributes:

General

DEFINE

Is the name of the virtual column.

Note: This attribute only appears when a virtual column (DEFINE)
is selected.

FILTER

Is the name of the Master File filter field.

Note: This attribute only appears when a virtual Filter field is
selected.
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COMPUTE

Is the name of the computed field.

Note: This attribute only appears when a virtual computed field is
selected.

EXPRESSION

Is the calculation that creates the virtual column.

TITLE

Supplies a title to replace the column name that is normally used
in reports and enables you to specify multiple language titles for
the virtual column.

FORMAT

Describes the data type and format for the virtual column.

Note: This attribute only appears for DEFINE and COMPUTE
custom fields.

Allow Missing Data

Allows missing data if not, transaction value is supplied.

Note: This attribute only appears for DEFINE and COMPUTE
custom fields.

All

Allows all missing data if not transaction value is supplied.

Note: This attribute only appears for DEFINE and COMPUTE
custom fields.

Miscellaneous

WITH

If no columns from the synonym are used in the expression or
have been defined, you can use the WITH option to identify the
logical home of the defined calculation. You can also use the WITH
option to move the logical home for the virtual column to a lower
segment than it would otherwise be assigned to (for example, to
count instances in a lower segment).

Note: This attribute only appears for DEFINE and FILTER custom
fields.

DESCRIPTION

Contains a description or comments about the virtual column.

WITHIN

Contains the name of a field to be included in a dimension.

These WITHIN statements are added to the synonym through the
Dimension Builder to OLAP enable FOCUS files and relational
tables. This enables you to perform OLAP analysis using the OLAP
Control Panel, or to use it with the FML Painter.

Note: This attribute only appears for DEFINE and FILTER custom
fields.

SCD Type
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Sets slowly changing dimensions. This option is only available for
existing relational targets.

A surrogate key is the first column in the table and has an SCD
type of blank. Other columns with a blank SCD type have no SCD
processing done to them.

Logical Key Field is the database key.

Activation Flag indicates that the row is current.

Begin Date/End Date indicates date range for the row values. A
null end date indicates the row is current.

Type I (overwriting history) designates columns whose database
values are overwritten with new values.

Type II (preserving history) designates columns that whose
database rows are flagged as inactive or assigned an end date; new
rows are inserted with the new values.

blank (non-key columns) indicates that database values are not
changed.

Note: The attributes available depend on the type of synonym.

Calculators for Custom Fields

To launch the Virtual Column Calculator, Filter Calculator, or Compute Calculator,
click the browse (...) button at the right of the EXPRESSION value field in the
Synonym Editor.

The selected calculator opens., depending on the type of custom field that you are
creating.
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The calculator has the following fields/options:

Column

The name of the object being created (virtual field, filter, computed field).

Format

Is the fields format.

Expressions tab

Location for typing an expression. You can add data source fields from the
Columns/Variables tab, functions from the Functions tab, and numbers
and operators from the calculator as you type.

Filter Builder tab

Displays the filter building window from which you can add and delete
columns, choose the relation, type, and select values for your filter.

Columns/Variables tab

Displays a hierarchical list of available source columns, and System
Variables folders that you can use in creating an expression.

Functions tab

A function is a program that returns a value. This tab lists the built-in
functions that you can use to derive the value of a temporary field.

Function Assist button

Enables you to specify parameters for the function through a dialog box
when creating or editing a transformation.

Calculator buttons

Insert numbers and operators.
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The following operators are available:

| (single concatenation bar)

Concatenates two values, retaining any trailing blanks after the
first one. For example, if FIRST_NAME and LAST_NAME were
both in A15 format, the expression
FULL_NAME = FIRST_NAME | LAST_NAME

would produce a column like the following:
MICHAEL SMITHSONJANE JONES
.
.
.

|| (double concatenation bar)

Concatenates two values, suppressing any trailing blanks in the
first. For example, to construct the full name and insert a comma,
the syntax
FULL_NAME = LAST_NAME || (', ' | FIRST_NAME)

would produce a column like the following:
SMITHSON, MICHAEL JONES, JANE
.
.
.

The concatenation in the parentheses is done first (preserving the
blank space after the comma), and the result is then concatenated
to LAST_NAME, suppressing the trailing blanks of LAST_NAME.

IF

Establishes a conditional test.

THEN

Specifies the action to perform if the result of a conditional test is
TRUE.

ELSE

Specifies the action to perform if the result of a conditional test is
FALSE.

LT

Returns the value TRUE if the value on the left is less than the
value on the right.

NOT

Returns the value TRUE if the operand is false.

LE

Returns the value TRUE if the value on the left is less than or
equal to the value on the right.

EQ

Returns the value TRUE if the value on the left is equal to the
value on the right.

AND
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Returns the value TRUE if both operands are true.

GT

Returns the value TRUE if the value on the left is greater than the
value on the right.

GE

Returns the value TRUE if the value on the left is greater than or
equal to the value on the right.

NE

Returns the value TRUE if the value on the left is not equal to the
value on the right.

OR

Returns the value TRUE if either operand is true.

**

Raises a value to the specified power.

( )

Adds parentheses.

’’

Inserts two single quotation marks. Enter alphanumeric test values
between these.

a->A

Converts selected text to uppercase.

A->a

Converts selected text to lowercase.

Check expression button

Verifies the validity of the expression.

Sample data button

Produces sample data for the expression.

Adding Group Fields in a Synonym
For data sources that support groups, you can assign a unique name to multiple
fields to create a group field. A group field is created by two or more
alphanumeric fields, physically next to each other. A group field provides an
efficient means for grouping similar or logically connected fields that will be
accessed as a single unit, but do not warrant a separate segment.

Note: In the Maintain environment group fields are supported in a Master File as
long as they are not group keys, that is groups that are actual fields, as supported
by VSAM. If you create a group field in the Maintain environment, the group will
not be visible, only the fields that make up the group will be visible.

Add a Group Field to a Segment
1. Required: From the Data Servers area, open a synonym by double-clicking a

Master File from the Master Files folder.
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The Synonym Editor opens.
2. Required: Right-click a segment (or column) and click Add.

3. Required: Select Group from the Add submenu.
Note: The groups option may not be available for some data sources.
A group is added to the synonym and its attributes and values appear on the
right.

4. Type a name for the group in the GROUP field.
5. Select the USAGE Type value for the group. Specify the length, the decimal

places (if applicable) and any display options for the group.
6. Click the I - Index box if you want the group to be indexed.
7. Select the ACCESS_PROPERTY values to specify access options for the

group’s data.
8. Optionally, you can specify the TITLE and DESCRIPTION display options.
9. Click Save from the File menu to save the synonym.

10. To close the Synonym Editor, select Close from the File menu or click the
control button in the upper right corner.

Add a New Field to a Group Field
1. Required: Right-click the group field to which you want to add a new field and

select Add.

2. Required: Select Column from the Add submenu.
A field is added to the group and its attributes and values appear on the right.
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3. Supply the required information for the group field. For more information
about field attributes, see Viewing and Editing Synonym Attributes.

Add an Existing Field to a Group Field
1. Click the field you want to add to the group field.
2. While holding the left mouse button down, drag the field and drop it on the

group field name.
The field is added to the group field.

Delete a Group Field From a Segment
1. Required: Right-click the group and select Delete.

A confirmation appears stating that all fields \ columns within the group will
be deleted.

2. Required: Click Yes to delete the group and move the fields (within the group)
under the root segment of the synonym.
Click No to delete the group and all of the fields within the group.
Click Cancel to close the Confirmation Delete dialog box and return to the
Synonym Editor.
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Delete a Field From a Group Field

Right-click the field, then select Delete.

Group Field Attributes

Group fields in a synonym can have the following attributes:

General

GROUP

Is the name of the group.

ALIAS

Assigns an alternative name for a group.

If you create a report, the group name appears as a column
heading unless you have specified an alternate title for the group.
Aliases cannot be used as column titles.

TITLE

Supplies a title to replace the group name that is normally used in
reports and enables you to specify multiple language titles for the
group.

USAGE

Contains the format for the group field. Since the group field is
made by concatenating together several other fields, the Synonym
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Editor determines what this format needs to be. For example, if the
group field has two alphanumeric fields in it, each 20 characters
long (A20), then the group field must be alphanumeric and 40
characters long (A40). The group field is always alphanumeric,
regardless of what the fields that make it up are.

Miscellaneous

DESCRIPTION

Contains a description or comments about the group. The
description displays in Field lists and on the status bar.

Field descriptions also appear as bubble help in OLAP-enabled
reports. If you do not include a description, bubble help shows the
field name (column title).

FIELDTYPE

Identifies an indexed group. You can index the values of a field to
enhance data retrieval performance. To do so, select the Index
check box when you add a field and before you add the data. An
index is an internally stored and maintained table of data values
and locations that enhance the performance of data retrieval. A
Master File can have several associated indexes, but the combined
total of indices and segments cannot exceed 64.

Note: FIELDTYPE=R indicates a read-only column. This setting is
useful for columns are that automatically assigned a value by the
RDBMS.

Tip: You can turn on the index after adding data to a field,
however, you will have to use the Rebuild Index option to create
the index.

ACCESS_PROPERTY

Specifies access options for the column’s data.

INTERNAL defines a column that does not appear in sample data
or in the list of available columns. Restricts the field from showing
in any of the Field Lists in the reporting tools.

NEED_VALUE defines a column that requires a value to access the
data. Indicates that a selection is needed in the Report Request
(WHERE condition).

Select By defines a column by value, range, or multivalues.
v If Value is checked, only one value should be defined for

selection in the Report request.
v If Range is checked, a range selection should be defined in the

Report request.
v If Multivalues is checked, multiple values are allowed for

selection in the Report request.

Note: The attributes available depend on the type of synonym.
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Chapter 15. Analyzing Metadata and Procedures

Describes how to analyze procedures using Impact Analysis, and how to view
Data Profiling for the columns in a synonym.

Describes how to analyze procedures using Impact Analysis, and how to view
Data Profiling for the columns in a synonym.

Note: Impact Analysis is accessible only through the DB2 Web Query Developer
Workbench.

Analyzing Procedures With the Impact Analysis Tool
You can use the Impact Analysis tool to generate a report that identifies the
procedures that access a specific Master File or field within a Master File. This tool
helps you analyze the potential impact of modifying or deleting Master Files or
fields. The Impact Analysis tool enables you to analyze data, control search criteria,
save reports, and interactively open and edit procedures based on search results.

Impact Analysis searches Business Views in addition to FOCUS procedures. This
enables you to see if changes in the original Master File will impact fields used in
the Business View. For more information about Business Views, see Creating
Business Views in Developer Studio.

The Impact Analysis tool is accessible from Developer Workbench or from within
the tools in the Synonym Editor and Business Views. When Impact Analysis is
launched from the Synonym Editor or Business Views, it searches files based on
the application path of the reporting server. From the interface, it enables you to
select applications/domains to be searched.

View Impact Analysis Results from the Synonym Editor

When Impact Analysis is launched from within the Synonym Editor, it searches
files based on the application path of the reporting server.
1. From the Projects or Data Servers area, double-click the Master File or select

Edit in Synonym Editor from the File menu.
The Master File opens to the Tree View tab in the Synonym Editor.

2. Select the Synonym File name, or a column field, right-click and select Impact
Analysis from the context menu.
The following image shows the context menu used to launch the Impact
Analysis tool.
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Note: Impact Analysis is also available from the Business View tab.
The Impact Analysis results are displayed in a report spreadsheet.

3. You may use the results toolbar to view server messages, print the report, copy
data as text, and export the report.

4. Click Save from the File menu to save the Impact Analysis results.
5. Click Close from the File menu to close the Impact Analysis results window

and return to the Synonym Editor.

Use the Impact Analysis Tool From the Interface
1. From the Projects or Data Servers area, highlight a Master File and select

Impact Analysis from the File menu.
Note: You may also select a Impact Analysis from the right-click context menu
of a Master File. This interface enables you to select applications or domains to
search.
The Impact Analysis tool opens with the New Report tab displaying the
selected (Master) File Name and default Search Paths.

2. To search for all procedures that access a specific Master File or field, perform
one of the following:
v For the Master File you selected when opening the tool, it will be searched

by default. (Go to the next numbered step.)
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v For a different Master File, click the ellipsis button to the right of the File
Name search field and select a different Master File in the Open dialog box
that opens.

v For a single field within a Master File, after you select the desired Master
File, click the ellipsis button to the right of the Field Name search field and
double-click a field name in the Master File pop-up box.

3. Optionally, to search for procedures in directory paths not listed by default in
the Search Paths pane, add more search paths by clicking the folder icon above
the Search Paths area and selecting one or more folders in the Browse for
Folder dialog box that opens.
Note: You can also delete search paths by highlighting a search path and
clicking the Delete icon above the Search Paths area.

4. Click Analyze to display a report in the Impact Analysis Results pane.
The following image shows the New Report tab of the Impact Analysis dialog
box populated with File Name search criteria, multiple Search Paths, and a
report displayed in the Impact Analysis Result pane.
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You have options to edit procedures, print the report, delete an item in the
report, and export a report.
Exported reports are XML formatted, have an .IAR extension, and are saved in
the following default directory (unless you specify a different location):
drive:\ibi\DevStudioreleasenumber\bin

5. Click the Saved Reports tab to access all previously created reports.
All Impact Analysis reports are automatically saved in the following XML
formatted file (unless you manually delete a report):
drive:\ibi\DevStudioreleasenumber\bin\IARepository.dita
Information is appended to this file as new analysis reports are performed. You
have options to view reports, import previously exported reports, and delete
reports.

Viewing Data Profiling Characteristics
Data Profiling provides data characteristics for the columns in a synonym. You can
display the characteristics for all the columns in a synonym or segment, or for an
individual column.

Note: Data Profiling is not available if your adapter is not configured correctly.

For alphanumeric columns, Data Profiling provides the segment, format, count of
distinct values, total count, patterns count, maximum, minimum, and average
length, minimum and maximum values, and number of nulls. Patterns count
shows the number of patterns found in each alphanumeric column.

For numeric columns, Data Profiling provides the segment, format, count of
distinct values, total count, maximum, minimum, and average value, and number
of nulls.

Data Profiling for an individual column provides access to Statistics, Patterns,
Values, and Outliers reports.

Data Profiling a Synonym or Segment
Data Profiling provides information on all the columns in a synonym or segment.
You can also drill down to the Values or Patterns reports for an individual column
from a synonym or segment’s Data Profiling report.

View Data Profiling for a Synonym or Segment

To view the data profiling information for a synonym or segment’s columns:
1. From the Projects or Data Servers area, open a synonym by double-clicking a

Master File from the Master Files folder.
The Synonym Editor opens to the Tree View tab.

2. Right-click the synonym or segment name and, select Data Profiling.
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The Data Profiling information displays in the workspace.

You may use the data profiling results toolbar to view server messages, print
the report, copy data as text, and export the report.

3. Optionally, you can click a column name or patterns count (for alphanumeric
columns) to drill down to the Values or Patterns reports, respectively.
This is a partial Values report produced by clicking a column name.
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This is a Patterns report produced by clicking a Patterns Count value.
The image below is an example of an address column.

For pattern analysis, a ″9″ represents a digit, an ″A″ represents any upper case
letter, and an ″a″ represent any lower case letter. All printable special characters
are represented by themselves, and unprintable characters are represented by
an ″X″.

Data Profiling a Single Column
Data Profiling for an individual column provides access to four reports:
v Statistics shows the same information as a Data Profile report for a synonym or

segment.
For alphanumeric columns, the Statistics report provides the segment, format,
count of distinct values, total count, patterns count, maximum, minimum, and
average length, minimum and maximum values, and number of nulls.
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For numeric columns, the Statistics report provides the segment, format, count of
distinct values, total count, maximum, minimum, and average value, and
number of nulls.

v Patterns, which is only available for alphanumeric columns, shows patterns of
letters, digits, and special characters, as well as counts and their percent.

v Values shows unique values and their percents.
v Outliers shows the ten highest and lowest distinct values and their counts.

These reports are available by right-clicking a column in the Synonym Editor and
selecting Data Profiling.

The Patterns report shows the number of patterns found for each alphanumeric
column.
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Clicking on a patterns count displays the actual patterns.

The image below is an example of an address column.

For pattern analysis, a ″9″ represents a digit, an ″A″ represents any upper case
letter, and an ″a″ represent any lower case letter. All printable special characters are
represented by themselves, and unprintable characters are represented by an ″X″.

View Data Profile Statistics

To view the statistical data profiling information for a single column:
1. From the Projects or Data Servers area, open a synonym by double-clicking a

Master File from the Master Files folder.
The Synonym Editor opens to the Tree View tab.

2. Right-click a column and, select Statistics from the Data Profiling submenu.
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The Statistical Data Profiling information displays in the workspace.

3. Optionally, you can click a column name or patterns count (for alphanumeric
columns) to drill down to the Values or Patterns reports, respectively.
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View Data Profile Patterns

Data Profile Patterns shows patterns of letters, digits, and special characters, as
well as counts. This is only available for alphanumeric columns.

To view the patterns data profiling information for a single column:
1. From the Projects or Data Servers area, open a synonym by double-clicking a

Master File from the Master Files folder.
The Synonym Editor opens to the Tree View tab.

2. Right-click a column and, select Patterns from the Data Profiling submenu.

The Patterns Data Profiling information displays.
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For pattern analysis, a ″9″ represents a digit, an ″A″ represents any upper case
letter, and an ″a″ represent any lower case letter. All printable special characters are
represented by themselves, and unprintable characters are represented by an ″X″.

View Data Profile Values

Data Profile Values shows unique values.

To view the values data profiling information for a single column:
1. From the Projects or Data Servers area, open a synonym by double-clicking a

Master File from the Master Files folder.
The Synonym Editor opens to the Tree View tab.

2. Right-click a column and, select Values from the Data Profiling submenu.
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The Values Data Profiling information displays.

View Data Profile Outliers

Data Profile Outliers shows the 10 highest and lowest distinct values.

To view the outliers data profiling information for a single column:
1. From the Projects or Data Servers area, open a synonym by double-clicking a

Master File from the Master Files folder.
The Synonym Editor opens to the Tree View tab.

2. Right-click a column and, select Outliers from the Data Profiling submenu.
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The Outliers Data Profiling information displays.

Note: Outliers produce a maximum of 10 highest and lowest distinct values, if
they exist.
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Chapter 16. Using Report Broker

Describes how to access and use Report Broker and the Report Broker Scheduler
tool.

Report Broker is a report scheduling and distribution tool that provides a central
point from which you can automatically distribute essential and current
information to select people in an organization.

Through Report Broker, you can schedule a report to run at specific times or
intervals and be distributed through either e-mail, to a printer, or to Web Query.
You have the option to distribute the report to a single address, or to a group of
recipients using a distribution list.

You can distribute an entire report, or you can break a report into sections using
the Report Broker burst feature. When you burst a report, you send only the
relevant report sections to the users you specify.

The Report Broker Scheduler tool is the interface through which you create
schedules. It offers all of the scheduling options you need to define the parameters
of a schedule.

In the main Report Broker interface, you can create and maintain Distribution
Lists, create, edit, clone, and delete schedules, run log reports, and purge log files.
Additionally, you can check the status of scheduled jobs that are in the Report
Broker Distribution Server queue.

Preparing Report Broker for Use
Once Report Broker is installed and the table space is created, the Report Broker
administrator must:
v Set up the user profile.
v Start the Distribution server.
v Configure the connection information to DB2.
v Test the connection to the repository.
v Create the Repository tables.

The following sections explain how to create the repository and verify
configuration settings in the Web Query Administration Console.

Note: Until the repository is created, the Distribution Server will start in Console
mode.

Setting Up the User Profile
To enable named users with Report Broker privileges based on the tasks they will
perform, add one of the following groups to the user profile. (The user profile can
not contain both groups.)
v MRSCHEDULE enables the named user to create Report Broker schedules.
v MRADMIN enables the named user to create schedules and perform

administrative tasks, such as setting Report Broker server configuration options.
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Note: A named user is a user ID that exists in the License Manager entry for the
base Web Query product.

Starting or Stopping the Distribution Server
When you are ready to use the Distribution Server, use the following commands to
start and stop the server:
v To start the Distribution Server:

STRWEBQRY START(*DSTSRV)

v To stop the Distribution Server:
ENDWEBQRY END(*DSTSRV)

Configuring the DB2 Connection
Use the following procedure to configure the connection information to DB2, so
that Web Query can connect to the Report Broker repository.

Configure the DB2 Connection
1. In left pane of the Web Query Administration Console, click Repository, then

Connection.
The Report Broker - Connection information appears in the right pane, as
shown in the following image.

2. In the Server Password field, type the password to connect to DB2, then click
Save.
The following message appears:
Report Broker Configuration changes have been saved.

Do you want to restart Report Broker?
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Note: The Distribution server must be restarted to implement any changes
made to the configuration.

3. Click OK.
The following message appears:
Report Broker restart completed.

4. Click OK.

Test the Repository Connection

To verify that DB2 can connect to the Report Broker repository:

In left pane of the Web Query Administration Console, click Repository, then Test
Repository.

The right pane displays the test results. A status of Pass indicates the Distribution
server can connect to the Report Broker repository.

Creating the Report Broker Repository
Once the connection configuration and testing are complete, you can created the
Report Broker repository tables using the following procedure.

Create the Report Broker Repository
1. In the left pane of the Web Query Administration Console, click Repository,

then Create All Tables.
A confirmation window opens with the following message:
Do you wish to create the Report Broker repository tables?

2. Click OK.
The right pane displays the status of the repository. A status of Pass indicates
the repository has been created successfully.

The repository tables have been created and Report Broker is ready for use.

Verifying the Report Broker Configuration Settings
This section explains how to access and verify the configuration settings.

To access the configuration settings, from the Web Query Administration Console,
click Report Broker, then Configuration. The right pane displays the configuration
settings, as shown in the following image.
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Change the Mail Host setting to your mail host server. Review the other settings
and make any appropriate changes. When you have completed all changes, click
Save.

The following message appears:
Report Broker Configuration changes have been saved.

Do you want to restart Report Broker?

Click OK to restart the Report Broker Distribution server. A message appears when
the restart is complete. In the message window, click OK.

Report Broker Configuration Settings

The Report Broker configuration settings are:

Default Mail From

Default value for the From field in a schedule using e-mail distribution.
This can be any value.

Default Mail Reply Address

Default value for the Reply Address field in a schedule using e-mail
distribution.

Default Notify Type

Specifies whether to send notification of the schedule status to a specified
e-mail address. Possible values are:

690 System i: Database IBM DB2 Web Query for System i



Never - This is the default value. Report Broker does not send notification
of the schedule status under any circumstance.

Always - The specified user is always notified when the schedule runs.

On Error - The specified users are notified when errors are encountered
while running the schedule. We recommend using the On Error notification
option.

Mail Host

Name of the default mail server used for a schedule using e-mail
distribution.

You can also specify a port for the Mail Host using hostname[:port]. If you
do not specify a port or the port you specify is not present, the default
port is used.

Notify Mail Host

Name of the mail server that handles notification e-mail. If left blank, the
mail server specified in the Mail Host setting is used as the notification
mail server.

You can also specify a port for the Notify Mail Host using hostname[:port].
If you do not specify a port or the port you specify is not present, the
default port is used.

Tip: We recommend using different mail servers for notification and e-mail
distribution in case there is a problem with the default mail server
(notification e-mails are still sent). Having separate mail servers ensures
you are informed if the default mail server falters.

Dserver Codepage

The code page of the platform, where the Distribution Server is running, is
passed to the Reporting Server to enable its communication back to the
Distribution Server. Used for National Language Support (NLS).

WF Trans In Out

Configures the Servlet WFTRANSINOUT plug-in. This is a custom-written
program that, when configured, is called by the Distribution Server as the
last step prior to sending each request to the Reporting Server and again as
the first step when receiving output from the Reporting Server.

In the WFTransInOut field, type the fully qualified name of the package
and class that implements the WFTransInOut interface.

To configure the exit jar file and classpath:
1. Copy the jar that contains the implementation of the WFTransInOut

exit to your_Distribution_Server_root/lib directory.
2. Edit the claspath.bat file to add this jar file to the list of existing jar

files.
3. For the Report Broker service, make the same change to the classpath

in the Registry Key (HKEY_LOCAL_MACHINE\SOFTWARE\
Information Builders\ReportCaster\76x\CLASSPATH).

4. Restart the Distribution Server.

Webserver Codepage

Code page of the platform where the Web server is installed.

Log Purge Period
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Automatically purges individual log reports when they are older than a set
number of days. The default value is 30.

Log Purge Time

Time at which log purging occurs. The default value is 1:00 A.M.

Maximum Thread

Controls how many simultaneous connections (threads) the Distribution
Server can utilize to process scheduled jobs.

Reader Interval

Polling interval (in minutes) for the Distribution Server to check for
scheduled jobs. The default value is 1 minute.

Recovery

Recovers scheduled jobs. Possible values are:

ON - During startup, the Distribution Server recovers scheduled jobs that
were processed but not completed.

OFF - This is the default value. During startup, the Distribution Server does
not recover any scheduled jobs.

Scan Back

If the Distribution Server is unavailable for a period of time, any jobs
scheduled during that period are not run. By default, when the
Distribution Server is restarted, it searches for and runs all jobs with a next
run time that is less than the current time, then resets the next run time
according to the job’s next scheduled run time. The Scan Back value and
Scan Back Type settings allow you to control the period of time the
Distribution Server will look for jobs and whether or not it will run them.

The Scan Back value is an integer value that represents the number of 24
hour periods, beginning when the Distribution Server is restarted, that the
Distribution Server scans back to look for, and run, jobs that have not yet
run. The maximum integer value for Scan Back is 365. The default value is
15 (periods of 24 hours).

Scan Back Type

Possible Scan Back Type values are:

ON - This is the default value. Turns on Scan Back functionality. The
Distribution Server searches for all jobs with a next run time that is less
than the current time, runs only those jobs found within the time period
set in the Scan Back setting, and resets the next run time of all of the jobs
initially found.

OFF - Turns off Scan Back functionality, which results in the Distribution
Server following its default behavior to locate, run, and reset all jobs with
a next run time that is less than the current time.

RESET_NEXTRUNTIME - Searches for all jobs with a next run time less than the
current time and resets the next run time to the job’s next scheduled run
time. A Scan Back value of zero defaults to this Scan Back Type.

Zip Encoding
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Enables Report Broker administrators to specify an encoding other than the
default encoding of the Distribution Server platform. It must match the
encoding used by WinZip or any other Zip utility installed on the
Distribution Server.

Accessing the Report Broker User Interface
To access the Report Broker user interface, click the Report Broker tab in DB2 Web
Query.

The Report Broker user interface opens, displaying all of the schedules you have
created. The following image shows the options and data fields available when
first accessing the interface.

From this interface you can:
v Create and maintain a Distribution List that you can then assign to scheduled

reports. For more information, see Creating and Maintaining a Distribution List.
v Check the status of a scheduled job. For more information, see Checking the

Status of a Scheduled Job.
v Globally update certain schedule values, such as the schedule owner or the mail

server. See Globally Updating Schedule Field Values.
v Edit, clone, or delete schedules that you own. For more information, see

Maintaining a Schedule.
v Run a log report to obtain information about a schedule and purge the log file to

conserve space. For more information, see Viewing a Log Report and Purging
the Log File.

v Move data from one Report Broker repository to another using the Change
Management tool. For more information, see Report Broker Change
Management.

v View the dates on which schedules cannot run or be set to run. For more
information, see Schedule Blackout Dates.

v Open the online Help.

Considerations When Using Report Broker
The following are important considerations when using Report Broker:
v Although Report Broker end users can only view and perform actions on their

own objects (schedules, Distribution Lists, and log files), Report Broker
Administrators can view and perform actions on all user’s objects.
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v When you select a schedule in the Report Broker interface, the Open, Log,
Delete, and Copy options are enabled. As an alternative to the toolbar icons, you
can use Alt-O for Open, Alt-L for Log, Alt-D for Delete, and Alt-C for Clone.

Specifying Multiple E-mail Addresses
When creating a schedule or distribution list, you can specify multiple e�mail
addresses within a single field, row, or record.

When creating a schedule or distribution list, you can separate each e-mail address
with a comma or a semicolon. The multiple e-mail addresses will appear in the To:
line of a single e-mail when the scheduled output is distributed.

Note: To distribute separate e-mails for each address, specify the e-mail addresses
on separate lines within the distribution list.

Specifying Multiple Burst E-mail Addresses

If you are using the default configuration (Packet Email = YES), one e-mail is
distributed for multiple burst values specified for the same e-mail address. The
e-mail address values specified on each row are treated as a string that is a key. If
there are multiple rows with the same address value (key), one e-mail is
distributed with all the burst values. For example, consider the following
distribution list:

Burst Value Address

A user1@abcd.com;user2@abcd.com

B user1@abcd.com

C user1@abcd.com

In this example, user1@abcd.com receives two e-mails when the scheduled output
is distributed. In the first e-mail, user1@abcd.com; user2@abcd.com appears in the
To: line and one attachment is distributed for burst value A. In the second e-mail,
user1@abcd.com appears in the To: line and two attachments are distributed, one
for burst value B and one for burst value C.

If you are using the configuration that specifies to distribute a single e-mail for
each row (Packet Email = NO), then the following behavior occurs for the above
example. Three separate e-mails are distributed. In the first e-mail,
user1@abcd.com; user2@abcd.com appears on the To: line and one attachment is
distributed for burst value A. The second e-mail is sent to user1@abcd.com with
one attachment for burst value B. The third e-mail is sent to user1@abcd.com with
one attachment for burst value C.

Another consideration is when using the default configuration (Packet Email =
YES) and the same burst value is specified multiple times for the same Address
(key) value. For example, consider the following Distribution List:

Burst Value Address

A user1@abcd.com;user2@abcd.com

B user1@abcd.com

B user1@abcd.com
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In this Distribution List, only two e-mails are distributed for user1@abcd.com. In
the first e-mail, user1@abcd.com; user2@abcd.com appears in the To: line and the
attachment is for Burst Value A. In the second e-mail, user1@abcd.com appears in
the To: line and the attachment is for Burst Value B. The third row in the
Distribution List is ignored since it contains the same key and the same burst
value, B, as the second row.

As a best practice, be sure to review your distribution information to make sure
you have not duplicated the same burst and address value pairs multiple times.

Specifying Multiple Non-Burst E-mail Addresses

Consider the following sample Distribution List, which does not contain any burst
values:

Address
user1@abcd.com;user2@abcd.com

user1@abcd.com

user2@abcd.com

user3@abcd.com

user1@abcd.com;user2@abcd.com;user3@abcd.com

In this Distribution List, an e-mail is distributed for each address line regardless of
whether Packet Email is set to YES or NO. This is because each address value is
unique. For the first e-mail, user1@abcd.com; user2@abcd.com appears in the To:
line and the attachment is for the full report. The second e-mail is distributed to
user1@abcd.com, and so on.

If one of the address lines is repeated in the Distribution List (for example, if
user3@abcd.com is added as the sixth line in the above list), the behavior would
work as follows. If Packet Email = YES, only one e-mail is distributed for
user3@abcd.com. However, if Packet Email = NO, two separate e-mails are
distributed to user3@abcd.com.

Creating and Maintaining a Distribution List
When creating a schedule, you can distribute report output to a single recipient or
several recipients. If you are creating a schedule to be distributed to several
recipients, you may want to create a Distribution List consisting of multiple
recipients. The Distribution List may then be assigned to any schedule.

If the entire report is not relevant to those receiving it, you can specify sections of
the report to be sent using the burst option. Each person on your Distribution List
can receive different sections of the report depending on the individual burst
values you specify. For more information see Bursting a Report.

Accessing the Distribution List Interface
From the Report Broker interface, click the Distribution List option. All Distribution
Lists to which you have access (public lists and your own private lists) appear.
Each Distribution List contains columns specifying its properties. Sorting is
available for each column by clicking the column heading. In addition, the
interface includes toolbar icons that enable you to perform functions on each
Distribution List.
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The following image shows the available options and data fields in the
Distribution List pane of the Report Broker interface.

From the Distribution List pane, you can:
v Create a new Distribution List. For more information, see Creating a Distribution

List.
v Edit the properties of a Distribution List. For more information, see Editing a

Distribution List.
v Delete a Distribution List. For more information, see Deleting a Distribution List.
v Refresh the window so that it contains the latest Distribution List information.
v Open the online Help.

Creating a Distribution List
When you create a Distribution List, you specify a name for the Distribution List,
the distribution method (e-mail or printer), the destinations to which the report is
distributed, the optional burst values, and whether public or private access is
applied.

Create a Distribution List

To create a Distribution List:
1. From the Distribution List pane, click New.

The options, fields, and drop-down lists that enable you to specify the
properties of the Distribution List appear, as shown in the following image.

696 System i: Database IBM DB2 Web Query for System i



2. In the Distribution List field, type a name for your Distribution List (for
example, Sales Team).

3. From the Access drop-down list, select Public (default) or Private.
Only the owner and Report Broker Administrators can view a Private
Distribution List, whereas every Report Broker user can view a Public
Distribution List.

4. From the Distribution Method drop-down list, select Email (default) or Printer.
5. If you are bursting a report, type individual sort values in the Burst Value field.

The burst value is case-sensitive and may be a maximum of 75 characters.
Note: The burst value for a tabular report is the first BY field, which is the
primary sort field. The burst value for a graph report is the second BY field.
The burst value specified must exist in the data source that the scheduled job
reports against.
For more information about bursting a report, see Bursting a Report.

6. In the Destination field, type the destinations to which the report is distributed.
v If you selected Email as the distribution method, type the e-mail addresses of

the recipients (for example, chuck_hill@ibi.com). Be careful typing this
information because there is no edit checking.

v If you selected Printer as the distribution method, use the following format
to specify the printer:
queue@printserver

where:

queue

Is the name of the printer queue

printserver

Is the host name or IP address of the printer.
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Report Broker can differentiate between the printer queue and the printer
host name/IP address due to the presence of the ’@’ separator. We
recommend specifying both the printer queue and host name/IP address
when distributing Report Broker output to a printer. However, Report Broker
supports specifying only the host name or IP address of the printer.

You can use a maximum of 800 characters in a single Destination line.
Note:

v If you specified burst values, be sure to match the specified e-mail or printer
destinations with the appropriate burst values.

v The maximum number of e-mail addresses or printers you can specify in a
Distribution List is 9999.

v If you are specifying more than ten e-mail addresses or printers in your
Distribution List, click Insert to insert additional rows.

v You can specify multiple e-mail addresses within a single Destination field.
For more information, see Specifying Multiple E-mail Addresses.

v For more information about creating a printer Distribution List, see
Considerations When Creating a Printer Distribution List.

7. Click Save to save the Distribution List and return to the Distribution List
pane.
The Distribution List you created (for example, Sales Team) is added to the list
of available Distribution Lists, as shown in the following image.

Considerations When Creating a Printer Distribution List

When printing on Windows and UNIX®, Report Broker uses the lp (line printer)
protocol, which runs on top of TCP/IP to communicate with printers. lp printing
with the Novell Client is not supported. For printing on z/OS®, Report Broker uses
the lpr (line printer remote) UNIX command, which has special options on the
mainframe for sysout dest and class.

When creating a printer Distribution List on z/OS, the printer should be a
SYSOUT class (such as A) that has been routed to a printer. For example, you can
indicate that scheduled report output be distributed to a specific network printer
by typing the following printer identification
A DEST printserver

where:

A

Is the SYSOUT class to be assigned to a network printer.

printserver

Is the printer host name (for example, IBVM.P24E2).
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Note: Before creating a Distribution List, we recommend verifying that you can
connect to your printer by test printing a document outside of Report Broker.

Editing a Distribution List
From the Distribution List pane in the Report Broker HTML User Interface, you
can edit your own previously created Distribution Lists at any time by performing
the following steps.

Edit a Distribution List

To edit a Distribution List:
1. Select the Distribution List you want to edit.

The following image shows a selected Distribution List named Sales Team.

2. Click Open.
The following image shows the properties of the selected Distribution List.

3. Make the necessary edits. You can:
v Copy the Distribution List by changing its name. The original Distribution

List remains unaltered.
v Change the values of already existing entries. For example, you can make the

Distribution List Private instead of Public, or you can change the
destinations.

v Insert additional Burst values and Destinations by clicking Insert. A new row
appears where your cursor is positioned, enabling you to insert additional
entries.

v Delete Burst Values and Destinations by selecting the row and clicking
Delete.
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4. Click Save to save the changes.

Deleting a Distribution List
From the Distribution List pane in the Report Broker interface, you can delete your
own Distribution Lists at any time.

Delete a Distribution List

To delete a distribution list:
1. Select the Distribution List you want to delete.

The following image shows a selected Distribution List named Sales Team.

2. Click Delete.
A message appears asking for confirmation that you want to delete the list.

3. Click OK to confirm that you want to delete the Distribution List.

Bursting a Report
Instead of distributing an entire report, you can use the Report Broker burst feature
to break a report into sections to be distributed separately. Bursting enables you to
target relevant sections of a report to individual users. Each report section is saved
as a separate file.

If you are distributing a burst tabular report, the burst value is determined by the
first BY field. If you are distributing a burst graph report, the burst value is
determined by the second BY field. The burst value is automatically determined by
the internal matrix, which is a memory area that stores each database field value
and calculates values referenced by the TABLE or GRAPH request.

You can send several report sections to one recipient by specifying that recipient’s
destination (e�mail address or printer) for each section you want to send. You can
send several report sections to one destination, or you can send one report section
to several destinations. The burst values you specify in the Distribution List must
exist in the data source you are reporting against.

If you want to burst a report, you must select the Enable Report Bursting check
box when you create the schedule. The burst values specified in the Burst Value
column in the Distribution List pane are ignored unless the schedule specifies to
burst the report. For more information, see Creating a Schedule.
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Bursting a Sales Report

You can specify sort field Burst Values and Destinations (e-mail addresses or
printers) when creating or editing a Distribution List. The following image shows
burst values and e-mail addresses specified in the Distribution List pane.

Using the primary sort field values (Northeast, Southeast, and Southwest), each
representative’s e-mail address is associated with the relevant sales report data.
Since Adam Abernathy needs only the data for the Northeast branch, the sort
value Northeast is listed in the Burst Value column opposite his e-mail address
which is in the Destination column.

However, Chuck Hill works in both the Northeast and Southeast regions. Since he
requires data for both regions, his e-mail address is listed in the Distribution
column twice, with a Burst Value column entry for each region opposite his e-mail
address.

Tip: You can specify multiple e-mail addresses on a single Address line. For
details, see Specifying Multiple E-mail Addresses.

Creating a Schedule
This section explains how to schedule a report using the Scheduler tool, and
describes all of the options available in the tool.

Accessing and Using the Report Broker Scheduler Tool
To create a new schedule for a report, in DB2 Web Query, click the Domain View
tab, and expand the Reports folder to display your reports. Right-click the report
you want to schedule and select Schedule, as shown in the following image.
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The Scheduler tool opens, as shown in the following image.

702 System i: Database IBM DB2 Web Query for System i



The Scheduler Tool is partitioned into the following sections:
v Distribution. Provides a drop-down list of distribution methods and

corresponding distribution options.
v Frequency. Provides the options related to the time interval to run the schedule.
v Report Options. Provides options for the report format, burst option, and report

parameters.
v Notification. Provides the options to set up notification of the schedule status.
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v Advanced. Provides options to set the schedule priority level, and selections to
enable or delete the schedule.

An asterisk indicates a required field.

When working in the Scheduler tool, you can expand or collapse sections, as
needed. For example, the following image shows the Frequency, Report Options,
and Notification sections collapsed.

Creating a Schedule Using the Scheduler Tool
A report schedule directs the execution of a report. It defines the format that the
report output will take and how, when, and where it will be distributed. All
options associated with scheduling a report are available in the Scheduler tool.

This section provides the overall procedure to create a new schedule for a report.
Some steps in the procedure contain details on the associated options, while other
steps direct you to a separate section that contains detailed descriptions of the
options and additional information, such as tips in making a selection.
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Create a Schedule
1. Open the Scheduler tool as explained in “Accessing and Using the Report

Broker Scheduler Tool” on page 701.
2. In the Description field at the top of the tool, type a name for the schedule.

This field is required.
3. In the Distribution section, select the method to distribute the report from the

Distribute report by: drop-down list. The distribution methods are:
v Email
v Printer
v Web Query
For options related to each distribution method, see Distribution Options.

4. Make the following selections in the Frequency section.
a. From the Run Interval drop-down list, select the time interval that the

schedule will use to run the report.
You can set the interval to run the schedule once, or every specified
minutes, hours, days, weeks, months, and years.

b. From the Start Schedule options, select the date (from the drop�down
calendar) and time you want the schedule to begin running.
Note: To change the time setting, select either the hour or minutes and use
the arrows to increase or decrease the value.

c. If applicable, from the End Schedule options, select the date and time you
want the schedule to stop running.

d. If applicable, from the Every option, use the up and down arrows to set the
number of times you want the schedule to run for the selected interval, for
example, 3 times each month.

e. Select the remaining options associated with the chosen run interval. For a
description of the run interval options, see Frequency Options.

5. In the Report Options section:
a. Select the format of the report. The valid formats are AHTML, DHTML,

DOC, EXL2K, EXL2K FORMULA, EXL97, HTML, JPG, PDF, PNG, PS, SVG,
and WP. For information on these formats, see Chapter 18, “Report Broker
Formats for Scheduled Output,” on page 765.

b. Select whether or not you want to burst the report.
For details on bursting reports, see Bursting a Report.

c. If needed, change the value of an existing report parameter
For details on changing a report parameter, see Report Parameters.

6. In the Notification section, select whether or not you want to send a
notification when the schedule runs and under what conditions to send it. The
notification options are:
v Never.

v Always. Send a notification each time the schedule runs.
v On Error. Only send a notification when there is an error running the

schedule.
7. In the Advanced Options section, select the following options:

v Priority Level for the Job. Use the drop-down list to select the priority for
running the job, with 1 being the highest priority and 5 the lowest priority.
The default priority is 3.
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The Report Broker Distribution Server queue sorts scheduled jobs by priority
and then by time. If multiple jobs share the same priority and time, Report
Broker arbitrarily schedules the jobs.

v Enabled. Select this option to activate the schedule to run.
v Delete this schedule if it is not scheduled to run again. This option is

useful for test purposes.
8. To save the schedule, click Save at the top of the Scheduler tool.

The Scheduler tool validates the fields and displays a status message in a
separate window. If the schedule was successfully created, the status message,
Your Schedule has been created., appears, as shown in the following image.
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If the Scheduler could not create your schedule, the following message appears
in a separate window:
Please enter valid information in all required fields.

An alert icon appears next to the field that is invalid, and the field name
appears in red. The following image shows an invalid schedule with the Reply
Address option appearing in red to indicate this value is missing.
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Re-enter the information in the fields that have alerts and click Save.

Running the Schedule from the Scheduler Tool
To run the schedule you just created from the Scheduler tool, click Run at the top
of the tool.

Distribution Options
The Distribution section of the Scheduler tool provides the options available for
distributing the scheduled report. You can distribute a report using one of the
following methods:
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v Email
v Printer
v Web Query

This section describes the options available for each distribution method.

Distributing a Report Using E-mail
When you distribute a report through e-mail, you can include the report in the
body of the e-mail (known as an inline e-mail message) or send it as an
attachment. Distributing a report as an inline e-mail message is particularly useful
when the report is distributed to mobile devices, fax machines, or through e-mail
systems that do not support attachments. You can also distribute a report to a Fax
machine, as explained later in this section.

The following image shows the e-mail distribution options in the Distribution
Options section of the Scheduler tool.

Distribute a Report Using E-mail:

1. From the Distribute report by: drop-down list, select Email.
2. From the drop-down list under Distribute report by:, select the form of the

e-mail address and type or select the accompanying value in the text box next
to the selection. The options are:
v Single Address. The report will be sent to a single e-mail address. Type the

e-mail address in the accompanying text box. Report Broker cannot validate
the e-mail address. An incorrect or unresolved address may not be noted in
the log file. This is dependent upon the ability of the SMTP mail server to
validate the e-mail address. The SMTP mail server returns undeliverable
e-mail messages to the reply address you specify for the schedule. The burst
option is not supported with this distribution option.
Tips:
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– You can specify multiple e-mail addresses within a Single Address.
Separate each e-mail address with a comma or a semicolon. The e-mail
addresses will appear in the To: line of a single e-mail when the scheduled
output is distributed. Each individual e-mail address can be a maximum
of 130 characters according to the SMTP specification. The total maximum
length of this field is 800 characters.

– Additionally, you can use group mail lists (defined on your mail server)
with the Single Address option. Group mail lists enable you to distribute a
report or notification to multiple recipients without having to maintain
multiple e-mail addresses in the Report Broker Repository. The format of
the group mail list is dependent upon the mail server being used. For
example, if you are using a Microsoft Exchange Server and your group
mail list is defined as #group1, you would enter group1@listdomain in the
Single Address field. If the group mail list contains a space within its
name, it must be enclosed within quotation marks. For more information,
see your mail server administrator.

v Distribution List. The report will be sent to all e-mail addresses on the
selected distribution list. Select a distribution list from the drop-down list,
which is activated when you select the Distribution List option. For
information on creating a distribution list, see Creating and Maintaining a
Distribution List.

3. In the From field, type any value (for example, the name of the person creating
the schedule). This field is not required by Report Broker, but may be required
by your e-mail system.

4. In the Reply Address, type a valid e-mail address. If recipients reply to the
e-mail, their messages are sent to this address. If your e-mail system is unable
to deliver the content, the undeliverable output message is also returned to this
address. This field is required by Report Broker.

5. In the Subject field, type the text you want to appear in the message subject
line. This information is not required by Report Broker, but may be needed by
your e-mail system. The value you entered in the schedule Description field is
used as the default Subject value.
When creating a schedule, you can place multiple parameters and burst values
from the scheduled procedure in an e-mail subject line. This allows the subject
to be dynamically created in order to personalize e-mails to recipients.
Parameters referenced in the subject line must be stored with the schedule
information in the Report Broker tables.
Parameters must be specified in the format ’&parmname’ (where parmname is the
name of the parameter). Burst values must be specified using the syntax
’%BURST’.
Note:

v The parameter name cannot also be the name of an existing report
procedure. You may specify an unlimited number of parameters.

v If you have multiple burst values in a Distribution List, only the first value
sent to the Report Broker Distribution Server is included in the subject.

For an example of specifying parameters and burst values in an e-mail subject
line, see E-Mail Distribution Examples.

6. Specify whether or not you want the report to be sent as an e-mail attachment
by selecting or de-selecting the Send Report as an Attachment option.
If you select the Send Report as an Attachment option, you can also:
a. Type a message to appear in the e-mail body.
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b. Select the option Add the Reports to Zip File, and provide a name for the
file in the Zip File Name field.

Consideration When Distributing a Report Using E-mail:

Report Broker transfers e-mail asynchronously to your e-mail system. The delivery
time depends upon your e-mail system.

Exchange Mail Server Considerations:

v If Report Broker end users do not see a From value that is specified in the
schedule information for the e-mail they receive in the e-mail client inbox, this is
due to their mail server configuration. For more information on how to control
this setting for a Microsoft Exchange Server, see the following URLs:
– http://support.microsoft.com/default.aspx?scid=kb;en-us;288635
– http://support.microsoft.com/kb/174755/EN-US/
– http://support.microsoft.com/default.aspx?scid=kb;en-us;242301
Alternatively, you can contact Microsoft customer support for assistance. If you
are using a mail server other than a Microsoft Exchange Server, refer to that
vendor’s documentation or contact their customer support for assistance.

v When distributing a report to an Exchange Server, attachment names have a .txt
extension added to WP and DOC format output. This occurs because WP and
DOC formats are not mapped to a standard MIME type. The Exchange Server
interprets WP and DOC output as a text/plain MIME type and adds the .txt
extension to the end of the file name. For example, hold.wp.txt or hold.doc.txt.

v Exchange Server individual recipient names (person@company.com) and Exchange
Server-defined distribution lists (list@company.com) can be specified in Report
Broker Distribution Lists. However, Exchange Server user-defined distribution
lists cannot be referenced in a Report Broker Distribution List. They are defined
internally on the user’s machine. The Report Broker Distribution List is parsed
by the Exchange Server and not the user’s mail client. Since a Report Broker
Distribution List is parsed by the Exchange Server, when an external server
submits an Exchange Server distribution list, it must contain the proper prefix
and the proper domain (which is prefaced by an @ sign). Consult your Exchange
Server Administrator for these values.

CC:Mail Considerations:

When you distribute Report Broker generated e-mail attachments greater than 20K
in size to users of cc:Mail, cc:Mail renames the attachment textitm.txt, ignoring the
file name and extension supplied by the user. This change affects DOC, HTML,
and WP formats on UNIX and Windows platforms. However, despite the naming
convention issue, the attachments contain the correct output and can be viewed if
the attachment is saved to disk with the correct extension.

E-Mail Distribution Examples:

This section provides an example of using burst values and multiple parameters
when sending the report in an e-mail, and distributing a report to a Fax machine
using e-mail.

Specifying Parameters and Burst Values in an E-mail Subject Field

This schedule specifies burst values and multiple parameters in the e-mail subject
line:
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The following image shows an example of a resulting e-mail subject line.

Distributing a Report to a Fax Machine Using E-mail

To distribute an inline e-mail message to a fax machine, you must register your
e-mail address with a third-party e-mail distribution provider. The features offered
by providers, (such as supported area codes and file formats), in addition to
requirements on the structure of e-mail parameter values, may vary. It is important
that you select a provider whose features are compatible with Report Broker.

Note: You cannot distribute an e-mail attachment to a Fax machine.

The following example shows how to distribute a report directly to a fax machine.
The e-mail address, john_doe@xyz.com, was registered with the e-mail distribution
provider called emfax.com. During the processing of the request, Report Broker
generates the scheduled report output and then distributes it using the e-mail
address of emfax.com. The reply address specified in Report Broker is the registered
e-mail address that is validated by emfax.com. If the e-mail address is valid,
emfax.com distributes the report to the fax number 12129999999. The validation of
the registered e-mail address is performed by emfax.com, not by Report Broker.

Note: The syntax used in this illustration is specific to this example. The required
syntax for your provider may be different.

The following image shows the Distribute section of the Scheduler tool, which
contains the name of the report to be distributed, fields, drop-down lists, and
option buttons that enable you to specify the destination(s) for the scheduled
report, and an e-mail address to which report recipients can reply.
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1. From the Distribute report by drop-down list, select Email.
2. From the mail drop-down list, select Single Address.

In the accompanying text box, type the e-mail address to be used by the e-mail
provider according to their requirements. In this example, it is
phone-number@emfax.com or 12129999999@emfax.com (where emfax.com is the
name of your e-mail provider).
Note: You can also select a Distribution List. However, be sure to use the
syntax required by your provider.

3. In the From field, type any value (for example, the name of the person creating
the schedule). This field is not required by Report Broker, but may be required
by your e-mail system or by the e-mail provider.

4. In the Reply Address field, type your registered e-mail address. If your e-mail
system is unable to deliver the content, the undeliverable output message is
returned to this address. This field is required by Report Broker.

5. In the Subject field, type the text you want to appear in the message subject
line. This information is not required by Report Broker, but may be needed by
your e-mail system or e-mail provider.

6. Continue selecting other schedule options, then click Save to save the schedule.

Distributing a Report to a Printer
The following image shows the printer distribution options in the Distribution
Options section of the Scheduler tool.

Distribute a Report to a Printer:
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1. From the Distribute report by drop-down list, select Printer.
2. From the drop-down list that appears under the Distribute report by option,

select the form of the e-mail address and type or select the accompanying value
in the text box next to the selection. The options are:
v Single Printer. Specify the printer using the following format.

queue@printserver

where:

queue

Is the name of the printer queue.

printserver

Is the host name or IP address of the printer.

Report Broker can differentiate between the printer queue and the
printer host name/IP address due to the presence of the ’@’
separator. Although Report Broker supports specifying only the host
name or IP address of the printer, Information Builders recommends
specifying both the printer queue and host name/IP address when
distributing Report Broker output to a printer. The maximum length
of this field is 800 characters.

v Distribution List.

The field next to Distribution List provides a drop-down list of all printer
Distribution Lists that you are the owner of, and all public printer
Distribution Lists. For more information about creating a Distribution List,
see Creating and Maintaining a Distribution List.

Note: If the printer you specify is unrecognized, the ″Cannot connect to
specified printer″ message is recorded in the log file when the Report Broker
Distribution Server tries to distribute the report.

Distributing a Report to Web Query
The following image shows the Web Query distribution options in the Distribution
Options section of the Scheduler tool.

Distribute a Report to Web Query:

To distribute a report to Web Query:
1. From the Distribute report by drop-down list, select Web Query.
2. In the Folder Name field, type a name for the folder on Web Query to which

you will distribute the report.
This description must not exceed 90 characters.

Considerations When Distributing a Report to Web Query:

When distributing a report to Web Query, consider the following:
v You cannot distribute Standard Reports back to Web Query.
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v Multiple Web Query reports are distributed to the same folder if they both run
at the same time. We recommend assigning each Web Query report a different
start time.

v When distributing a report to Web Query, you can only drill-down to another
report if it is a procedure on the Reporting Server. There is currently no support
for drill-down functionality to Web Query procedures.

v If you are distributing a large report to Web Query, take into consideration the
amount of memory configured on your application server. The report output
returned to Web Query will be stored in memory by the Client (Servlet) and
then written to the Web Query Repository. If there is not enough memory
available on your application server, the Report Broker servlet trace file will
contain the message ″return code not found. See your application server trace
for information″. The log report will include the message ″Unable to distribute
to Web Query: return code not found″. The problem can be resolved by one or
more of the following:
– Increase the memory available on your application server. Contact your

Report Broker Administrator.
– Modify your report so that it returns a smaller report or less output.
– Limit the number of scheduled jobs distributing to Web Query during the

same time period.

Frequency Options
You can schedule a report to run just once or repeatedly, for example, twice a week
or the last Thursday of every month. This section describes the options available in
the Scheduler tool Frequency section when the schedule is set to the following run
intervals:
v Once
v Minute(s)
v Hour(s)
v Day(s)
v Week(s)
v Month(s)
v Year(s)

Note: Report Broker Administrators can define dates on which schedules cannot
run or be set to run. These are known as schedule blackout dates and can be
viewed from the DB2 Web Query Report Broker tab. For more information, see
Schedule Blackout Dates.

The Once Run Interval
The Once option in the Run Interval drop-down list sets the job to execute
immediately. You can modify the date or time if you do not want the schedule to
run immediately. You can specify the date and time you want the schedule to run
using the Start Schedule options, as shown in the following image.
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To select a date, choose a date from the drop-down date calendar. To select a time,
select either the hour or minutes and use the up and down arrows to increase or
decrease the value.

The Minutes Run Interval
The Minute(s) option in the Run Interval drop-down list, sets the schedule to run
every n minutes.

In the Every minute(s) field, type or select the minutes interval (1 to 59), check the
days of the week on which you want to run the schedule, and select the Start
Schedule and End Schedule date and time to define the time period in which the
schedule will run. For example, the following schedule will run every 30 minutes
on Mondays and Fridays beginning at noon May 16, 2008 and ending 6:00 PM
October 30, 2010.

Tip: Selecting this option may affect system performance if you choose to run the
schedule every 5 minutes or less. We recommend specifying a minimum of 30
minutes. The minute interval option is primarily useful for alert schedules.

The Hourly Run Interval
The Hour(s) option in the Run Interval drop-down list, sets the schedule to run
every n hours.

In the Every hour(s) field, type or select the hours interval (1 to 24), check the days
of the week on which you want to run the schedule, and select the Start Schedule
and End Schedule date and time to define the time period in which the schedule
will run. For example, the schedule shown in the following image will run every 3
hours on Mondays and Fridays beginning at noon May 16, 2008 and ending 6:00
PM October 30, 2010.
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The Daily Run Interval
The Day(s) option in the Run Interval drop-down list, sets the schedule to run
every n days. In the Every day(s) field, type or select the days interval to run the
schedule and select the Start Schedule and End Schedule date and time to define
the time period in which the schedule will run. For example, the schedule shown
in the following image will run every 5 days beginning at noon May 16, 2008 and
ending 6:00 PM October 30, 2010.

You can also set a secondary run interval. For information about this setting, see
Applying a Secondary Run Interval.

The Weekly Run Interval
The Week(s) option in the Run Interval drop-down list, sets the schedule to run
every n weeks.

In the Every week(s) field, type or select the weekly interval to run the schedule,
check the days of the week on which you want to run the schedule, and select the
Start Schedule and End Schedule date and time to define the time period in which
the schedule will run. The following schedule will run every two weeks on both
Monday and Friday beginning at noon May 16, 2008 and ending 6:00 PM October
30, 2010.

Chapter 16. Using Report Broker 717



Important: When selecting the Week(s) interval, set the Start Schedule to the date
of the first day (current or future) of the week you want the schedule to run. If
you select the current date, then you must make sure that the Start Schedule time
is later than the current time when you save the schedule. If the Start Schedule
time is less than or equal to the current time, the calculation for the next run time
results in the schedule not running on the current date.

You can also set a secondary run interval. For information about this setting, see
Applying a Secondary Run Interval.

The Monthly Run Interval
The Month(s) option in the Run Interval drop-down list, sets the schedule to run
every n months. You can then refine the monthly interval with one of the following
options (Note that these options are mutually exclusive.):
v Every first, second, third, fourth, or last n day of the week (where n is Monday,

Tuesday, Wednesday, Thursday, Friday, Saturday, or Sunday) every n months.
v Specific days every n months.

Also select the Start Schedule and End Schedule date and time to define the time
period in which the schedule will run. The following image shows a schedule set
to run on the first Monday of every month beginning at noon May 16, 2008 and
ending 6:00 PM October 30, 2010.
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The following image shows a schedule set to run on the 2nd, 9th, 16th, 23rd, and
30th of every month, regardless of the day of the week those dates fall on.

You can also select the Last Day of the Month option at the end of the calendar to
run the schedule on the last day of the month.

Note: When selecting the Month(s) interval, set the Start Schedule to the date of
the first day (current or future) of the month you want the schedule to run. If you
select the current date, then you must make sure that the Start Schedule time is
later than the current time when you save the schedule. If the Start Schedule time
is less than or equal to the current time, the calculation for the next run time
results in the schedule not running on the current date.

You can also set a secondary run interval. For information about this setting, see
Applying a Secondary Run Interval.

The Yearly Run Interval
The Year(s) option in the Run Interval drop-down list, sets the schedule to run
every n years during a specific time period. The following image shows a schedule
set to run every 2 years beginning at noon May 16, 2008 and ending 6:00 PM
October 30, 2010.

You can also set a secondary run interval. For information about this setting, see
Applying a Secondary Run Interval.
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Applying a Secondary Run Interval
The Apply secondary run interval option allows you to create a secondary run
interval within the day the schedule runs. You can apply the secondary run
interval every n minutes or hours for a specified number of hours/minutes or until
a specified time. This option is available for schedules that run every day(s),
week(s), month(s), or year(s).

When you select Apply a secondary run interval, the options related to this setting
appear in the Frequency section. The following image shows an example of set
secondary run interval options.

The Apply secondary run interval options are:
v Every n [minutes|hours]. Applies the secondary run interval every n minutes or

hours (in this example every 10 minutes) within the day the schedule runs.
v Until Time. The time up until which the secondary run interval will be applied.

In this example, the schedule will be rerun every 10 minutes until 4:00 P.M.
v Lasts for n hour(s) n minute(s). The duration, specified in hours and minutes,

during which the secondary run interval will be applied. This option and the
Until time option are mutually exclusive, so this option is inactive in this
example.

Note: The secondary run interval will not be validated when the schedule is
created. Instead, validation is performed every time the schedule’s next run time is
calculated when running within the secondary run interval. The secondary run
interval cannot exceed the next run time for the primary run interval. For example,
a daily schedule cannot have a secondary run interval greater than Every 1 day(s).
If a secondary run interval is scheduled to run after the schedule’s next primary
run interval, the secondary run interval is stopped and an error message is
displayed to the user and written to the log file.

Report Options
This section describes the options available in the Report Options section of the
Scheduler tool. You can set these options to send the report in a specific format (for
example (HTML, EXL2K, and so on), whether or not you want to burst the report
and if so, the burst values the report will use, and specify parameter values to pass
to the report when it runs.

The following images shows the Report Options section of the Scheduler tool.
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Report Formats
Select the format of the report from the Send the Report in this Format drop-down
list of the Scheduler, Report Options area. The formats available to a scheduled
report are:
v AHTML
v DHTML
v DOC
v EXL2K
v EXL2K FORMULA
v EKL97
v HTML (This is the default value.)
v JPG
v PDF
v PS
v PNG
v SVG
v WF

There are limitations on what formats are valid for certain options. Not all formats
are supported for bursting or for printing. If the report format statement in the
coded procedure is a styled report format, then you must select a styled report
format (for example, AHTML, EXL2K, EXL97, HTML, PDF). The report format
specified in this field overrides the format statement in the procedure.

If the report format statement in the coded procedure is a specialized report
format, such as EXL2K FORMULA, or if it is Coordinated Compound PDF Report,
it is required that you select the same report format that is specified in the
procedure.

If a TABLE request containing an unstyled binary format is scheduled for
distribution as a styled ASCII format (for example, EXL2K, HTML, or PDF), the
report is not created by the Reporting Server and the Report Broker log report
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contains a ″No destination found for this distribution″ message. This also occurs if
a TABLE request containing a styled ASCII format is scheduled for distribution as
an unstyled binary format.

For details on each format, see Chapter 18, “Report Broker Formats for Scheduled
Output,” on page 765.

Bursting a Report
The burst feature enables you to break a report into sections and distribute
relevant sections to individual users. To burst the report, select the Burst this
Report check box. Burst values may be specified in a Distribution List.

Bursting Guidelines and Limitations:

Each section of a burst report is saved as a separate file. If you are distributing a
burst tabular report, the burst value is determined by the first BY field. If you are
distributing a burst graph report, the burst value is determined by the second BY
field. The burst value is automatically determined by the internal matrix of the
Reporting Server. The internal matrix is a memory area that stores each database
field value and calculates values referenced by the TABLE or GRAPH request.

When a report is burst, all data values generated for each burst section are
returned to the Report Broker Distribution Server.
v For the Web Query distribution methods, each burst section is distributed to

Web Query. Each burst section may be viewed by the owner of the schedule.
v For the e-mail and printer distribution methods, specific burst sections are

distributed based on the burst values specified when creating the Distribution
List, single location, or dynamic address list used by the schedule.

The following are guidelines and limitations that apply to the Report Broker burst
feature:
v Case. Burst values are case-sensitive.
v Formats. AHTML, DHTML, EXL2K, EXL97, EXL2K FORMULA, HTML, JPG,

PDF, PNG, and SVG support bursting. Each burst section of the report will be
named burstvalue.format (for example, Northeast.pdf).

v ACROSS command. This command is not evaluated as a primary sort field. To
burst a report, you must also include a BY field. Bursting occurs on the BY field.

v FML reports. Bursting an FML report is supported only if the request has a BY
field.

v Coordinated Compound Reports. Report Broker can burst and distribute
coordinated compound reports developed using the PDF Layout Painter in
Developer Studio in DHTML and PDF formats. Compound reports that are not
coordinated cannot be burst.

v TABLEF. No internal sort processing is performed. The specification of a BY
field requires that the data already be sorted in the data source.

v ON TABLE SUBHEAD/ON TABLE SUBFOOT. Creates a SUBHEAD for only
the first page of the report, and a SUBFOOT for only the last page of the report.
When bursting a report, the SUBHEAD and SUBFOOT should occur for each
sort break. Therefore, specify the primary sort field in place of TABLE in the ON
command. For example:
ON primarysortfield SUBHEAD

v AnV field types. Bursting is not supported on a field with the AnV (where n is
an integer value) field type.
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Report Parameters
If the report you are scheduling contains parameters, they are listed in the Report
Options section of the Scheduler tool. The following images shows the Report
Options section for a report with parameters.

The report parameter name automatically appears in the Name column. The value
or possible values of the parameter available to you in the Reports Options section
depends on the report procedure. The report procedure either assigns no value to a
parameter, assigns a default value, or provides a selection of values from which
you can choose. For considerations when specifying parameter values for a
procedure and for examples of the report procedure code that determines the
available values, see Considerations When Specifying Parameter Values.

The possible presentation of report parameters in the Report Options section are:
v no value, where you assign the value in the schedule.
v A default value.
v A static list of values from which you can select one value.
v A dynamic list (generated from the database the report is using) of values from

which you can select one value.
v A static list of values from which you can select multiple values.
v A dynamic list (generated from the database the report is using) of values from

which you can select multiple values.

When you access the report Scheduler tool, parameters with default values have a
check next to their name and parameters with a choice of values have a grayed-out
check mark next to their name. The following image shows a parameter with a
default value (Enter a Region) and parameters that provide a choice of values
(Store Code and Product name).
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To select the default value for a parameter, uncheck the box next to the parameter
name. If you want all parameters in the list to use their default values, uncheck the
Name option. The default value for the unchecked parameters appear in the Value
column. The following image shows the Enter a Region parameter unchecked and
its default value displayed in the Value column.

Define a Parameter Value in the Scheduler Tool:

Parameters with an active check mark next to their name have a default value or
no value assigned. To change a default value or assign a new value for a report
parameter:
1. In the Name column, click the parameter name that you want to assign a value

to. The Parameter Editor window opens, as shown in the following image.
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2. Type a value for the parameter.
3. Click OK.

The value appears in the Value column next to the parameter, as shown in the
following image.

Select Parameter Values From a List:

Parameters with a grayed-out check mark next to the parameter name provide a
list of values from which you can choose.
1. In the Name column, click the parameter name that you want to assign a value

to.
2. From the Parameter Editor window, select the values you want, as follows. Use

standard Windows methods to select individual or contiguous items.
v From the single-select list, select the value for the parameter. The following

image shows the Value drop-down list from which you can choose the value.
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v From the multi-select list, select either No Selection or one or more values, as
shown in the following image.

v From the multi-select list, select either Select All or one or more values, as
shown in the following image.

Considerations When Specifying Parameter Values:

The following are considerations when specifying parameter values for a
procedure:
v The maximum number of characters for each individual parameter value is 3200.

You can store multiple values for a single parameter. Multiple values for a
parameter is stored as one entry which must not exceed the 3200 maximum
character limit.

v Report Broker displays the description for the parameter when it is specified in
the procedure. Otherwise, Report Broker displays the parameter name.

v Report Broker performs field validation for numeric and alpha formats, and
range value validation.

v Report Broker displays default variable values, as well as static or dynamic
single-select and multi-select lists.
Note:

– The ’Select All’ option is displayed for static multi-select lists. When selected,
this option includes every value for the selected parameter. The ’No Selection’
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option is displayed for dynamic multi-select lists. When selected, this option
does not perform any data selection test on that field.

– Using the -HTMLFORM command to create a dynamic selectable list of
parameter values is not supported in Report Broker.

– As an alternate method of creating a dynamic selectable list of parameter
values, you can use the schedule technique in the HTML Layout Painter.

v The Specify All Parameter Values check box is always enabled if there is any
parameters available for the report (Standard Report, My Report, or WF Server
Procedure). You can check or uncheck this option to quickly enable or disable
the check boxes for each individual parameter. If the check box for an individual
parameter is unchecked, the input field for the parameter value is disabled, the
default parameter value(s) are displayed (but cannot be changed), and no
parameter data is saved to the Report Broker Repository.

v Report Broker will not prompt for variables with defaults set by the
-DEFAULTH command. The purpose of the -DEFAULTH command is to be able
to assign amper variables a default value and not be dynamically prompted for
that variable.

v When specifying parameters with special characters (for example, %, &, |):
If you are specifying the entire WHERE condition as the parameter value, you
must enclose the value within two single quotation marks rather than a double
quotation mark. For example: ’’WHERE CAR NOT LIKE MOTO%’’
If you are only specifying a value as the parameter value, you do not need to
enclose the parameter value within quotation marks. For example: O&DINFO

Note: You can only schedule saved procedures using Report Broker; HTML forms
cannot be scheduled using Report Broker. Parameter prompting is not available in
pre or post processing procedures.

Notification Options
The Notification area of the Scheduler tool provides the options to send a
notification of the schedule status to specific e-mail recipients. You can send
notification:
v Never. Report Broker will not send a notification of the schedule status under

any circumstances. This is the default value.
v On Error. The specified users are notified when errors are encountered while

running the schedule. We recommends using the On Error notification option.
v Always. The specified users are always notified when the schedule runs.

Setting On Error and Always Notification
When you select the On Error or Always notification option, additional options
become available, as shown in the following image.

Chapter 16. Using Report Broker 727



The On Error and Always notification options are:
v Type. Select if you want a brief or detailed notification. follows.

– Full Notification. A full notification sends a complete log report as an e-mail
attachment.

– Brief Notification. A brief notification sends the ID and job description of a
schedule, as well as messages about the schedule (such as ″Completed
Successfully″).

– Full & Brief Notification. Sends both types of notifications.
Tips:

– We recommend using the Brief Notification option when you are sending
notification to devices that have limited memory, such as pagers and cell
phones. If you want to notify multiple recipients, you can use group mail lists
defined on your mail server provided that you append an @ sign followed by
a valid domain.

v Full Notification. When the notification type is Full Notification or Full & Brief
Notification, type the e-mail address to which you want a full notification sent.
There is no syntax error checking for this field.

v Brief Notification. When the notification type is Brief Notification or Full &
Brief Notification, type the e-mail address to which you want a full notification
sent. There is no syntax error checking for this field.

v Reply Address. Type the sender’s e-mail address. If report recipients reply to the
report sender, their messages are sent to this address. If your e-mail system is
unable to deliver a report, the undeliverable report message is also returned to
this address.

v Subject. Type the text you want to display in the subject line of the e-mail
notification. There is a limit of 255 alphanumeric characters. By default, this field
contains the report name and data and time stamp.

Notification and Log Information for Unavailable Options

When schedules with unavailable Task Types and/or distribution methods are not
permitted to run, error notification is triggered. The full and brief notifications and
the log report informs you that the Report Broker Administrator or the owner of
the schedule must change the unavailable Task Types and/or distribution methods
in the schedule.

When schedules with unavailable Task Types and/or distribution methods are
permitted to run, normal job execution occurs and a message appears in the log
report indicating that your Report Broker Administrator is allowing existing
schedules using the unavailable Task Types and/or distribution methods to run.
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Running a Schedule from Control Language (CL)
Once you have created a schedule in Report Broker, you can run it at any time
from the Web Query Report Broker application. There are times when a business
user is not logged into Web Query, but may want to run a schedule as part of a
business workflow process. The Report Broker CL program allows you to run
schedules from outside of Web Query.

If you are a Web Query named licensed user or developer, you can run the
schedules that you own. If you are a Report Broker administrator, you can run any
schedule.

To run a Report Broker schedule outside of Web Query, type the following in a
5250 emulation session CL command line:
RUNBRSCHED

At the prompt, type the ID of the schedule you want to run, and the user ID for
the job being submitted.

Note: The Schedule ID is a unique 12-alphanumeric string assigned to a schedule
when it is created. The Schedule ID is found in the schedule list of the Web
Query’s Report Broker tab.

A message informs you that the job was submitted.

Maintaining a Schedule
This section explains how to edit the properties of an existing schedule and to
clone, delete, and check the status of a schedule. It also explains how to run a log
report to obtain information about a schedule, and to globally update schedule
properties, such as the schedule owner.
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Maintenance Options in the Report Broker Interface
After you create a schedule, you can edit its properties at any time or delete the
schedule when it is no longer needed. If a schedule contains properties you want
to use in a new schedule, the clone option creates a template with those properties
for the new schedule. You can also check the status of a schedule and run a log
report to obtain detailed information about the schedule. Additionally, you can
purge log records to conserve space in the log file and view the dates on which
schedules cannot run or be set to run.

The maintenance options are available in the Report Broker interface. To view a list
of your schedules, click Schedules.

The Schedules pane opens and displays a list of your schedules along with
information about the schedule, such as its next run time. The following image
shows how each scheduled job contains information displayed under column
headings for Schedule Id, Description, Next Run Time, Method, Distribution,
Active, Owner, and Priority. The pane includes toolbar of icons that enable you to
perform functions on each scheduled job. Sorting is available for each column by
clicking the column heading.

If you want a list of schedules with specific properties, such as those with an
e-mail distribution, use the Filter options. For details, see Filtering the Schedule
List.

From the Schedule pane, you can:
v Open the Scheduler tool to edit the properties of a selected schedule. For more

information, see Editing a Schedule.
v View a log report for one or more selected schedules. For more information, see

Viewing a Log Report.
v Delete one or more selected schedules. For more information, see Deleting a

Schedule.
v Purge log file information for one or more selected schedules or for all schedules

in your list. For more information, see Purging the Log File.
v Clone a selected schedule. For more information see, Cloning a Schedule.
v Run one or more selected schedules.
v View the dates on which schedules cannot run or be set to run. For more

information, see Schedule Blackout Dates.
v Refresh the current schedule list with any newly created schedules.
v Open the online Help.
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Filtering the Schedule List
To focus the types of schedules that appear in the Schedule list, for example to list
only those schedules with a certain priority level or distribution method, use the
filter option.

Use the Schedule Filter:

To focus the list of schedules:
1. From the Report Broker interface Schedule pane, click Filter.

The Schedule Chooser dialog box opens, as shown in the following image.

2. Select the filter parameters as needed. the parameters are:
v Owner. List all schedules by the selected owner.
v Method. List all schedules by this report distribution method.
v Priority. List all schedules by this schedule priority level.
v Pending Interval. List all schedules using these date and time parameters:

Start Date, Start Time, End Date, and End Time. To set the Start Date and
End Date, click the calendar icon next to the date and select the date you
want in the calendar dialog box.

Editing a Schedule
You can edit the schedules that you own at any time by using the following
procedure.

Edit a Schedule

To edit a schedule:
1. Select the schedule you want to edit.

When you select a schedule, the schedule function icons become available. The
following image shows the Sales schedule and the Open icon selected in the
Schedule pane.
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2. Click Open or double-click the schedule.
The Scheduler tool opens. The following image shows the Scheduler tool with
all information previously entered for the Sales schedule.
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3. Make the necessary changes to the schedule.
For more information about navigating through the Scheduler tool, see Creating
a Schedule.

4. Click Save.
A window opens with a message that the schedule has been created.

5. Click OK.

Considerations When Editing a Schedule

The following are considerations when editing a schedule using the Scheduling
Wizard:
v If a schedule already exists and your Report Broker Administrator changes the

available options, the existing schedule runs as previously configured, regardless
of the changes. However, if you attempt to specify unavailable options (Task
Types, distribution methods, or report formats) when editing a schedule, a
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message is displayed informing you that the options available for scheduling
have been changed by your Report Broker Administrator. Information is then
displayed that describes the change(s) that you must make for the schedule to
use available options. Changes to the schedule cannot be saved until the
schedule uses available options.

v If you selected once for the run interval, the schedule runs immediately unless
you change the Start Time to a time later than the current time. All other run
intervals run at the next run time of the schedule.

v If you want your selected schedule(s) to run immediately, click Run. A new
schedule ID is created for the job.

Cloning a Schedule
From the Schedule window in the Report Broker interface, you can clone existing
schedules that you own using the following procedure.

Clone a Schedule

To clone a schedule:
1. In the Schedule pane, select the schedule you want to clone.

The following image shows the Sales schedule and Clone icon selected in the
Schedule pane.

2. Click Clone.
The Clone selected schedule -- Web Page Dialog box that opens, as shown in
the following image. This dialog box prompts you to type a description for the
cloned schedule.
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3. Type a description for the new schedule (for example, Southern Territory Sales)
and click OK.
The following image shows the new cloned schedule in the Schedule window.
Note that the cloned schedule is disabled by default, as specified in the Next
Run Time column.

4. To edit the settings and enable the schedule, perform the following steps:
a. Click Open or by double-clicking the schedule.

The Scheduler tool opens, displaying the schedule settings.
b. Make the necessary changes to make this schedule unique from the original

schedule.
c. In the Advanced area, check the Enabled check box.
d. Click Save.

The Your schedule has been created message appears.
e. Click OK.
f. In the Report Broker interface, click Refresh.

The following image shows that the Southern Territory Sales schedule is
active, as noted in the Next Run Time column of the Schedule pane. If the
only change you made was setting the schedule to enabled, it contains the
same properties as the schedule from which it was cloned.
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Deleting a Schedule
You can delete a schedule you own at any time using the following procedure.

Delete a Schedule

To delete one or more schedules:
1. Select the schedule(s) you want to delete.

Note: To select multiple schedules, use the Shift key and Control (Ctrl) key as
in a standard Windows interface.
The following image shows the West Coast Sale and Southern Territory Sales
schedules selected in the Schedule pane.

2. Click Delete. A message appears asking for confirmation that you want to
delete the selected schedule(s).

3. Click OK to delete the schedule(s).
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Viewing a Log Report
A log report provides information about the schedule date, time, execution status,
and recipients of a distributed report. It also includes whether or not the job
executed successfully, when and in what format the report output was distributed,
and the method of distribution. Log reports are stylized HTML format, and appear
in a separate browser window. You can search, print, or save the log report.

View a Log Report

From the Schedule pane in the Report Broker interface, you can view one or more
log reports for a schedule using the following procedure.
1. Select the schedule(s) for which you want to view the log report(s).

Note: To select multiple schedules, use the Shift key and Control (Ctrl) key as
in a standard Windows interface.
The following image shows the East Coast Sales and Sales schedules selected in
the Schedule pane.

2. Click Log.
The following image shows the Report Broker Web Page Dialog box that opens,
with the Selected Schedule check box active and checked and the Last Executed
option button selected.
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To switch from the schedule you selected to viewing information about all of
your schedules, uncheck the Selected Schedule check box. If you want to
change your selection criteria, click Cancel and reselect another schedule from
the list.

3. Select one of the following option buttons:
v Last Executed. Produces a log report containing the most currently run

process for the selected schedule(s) or for all schedules (if you did not select
a schedule). This is the default option.

v All Executed. Produces a log report containing all run processes for the
selected schedule(s) or for all schedules (if you did not select a schedule).

v Date Executed. Activates the Start Date and Start Time fields.
If you have selected the Date Executed option, proceed to the following step.
Otherwise, proceed to step 6.

4. In the Start Date field, specify the date on which you want the log report to
begin. The report displays all processes for the selected schedule (or schedules)
that were run on or after the specified Start Date. You can select a Start Date
from the pop-up calendar, or you can accept the default Start Date, which is the
current date.

5. In the Start Time field, specify a start time for the Start Date by using the
drop-down lists. 1:00 AM is the default value for the Start Time field.

6. Click OK to view the log report.

The Job Process Log Report opens.

Reading a Log Report

The log report displays information according to your specifications in a separate
browser window. One log record is produced for each scheduled job run in the
specified time frame. The following image provides an example of a typical log
report.
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If you chose to view log reports for multiple schedules, the Job Process Log Report
contains a log record for each schedule you selected. The following images shows
an example of a log report for multiple schedules.

The log report first lists the job description for the record, which is the unique
description identifier that you specified when you created the schedule.
Underneath the Job Description, the left column of the log report includes the
following information:
v User. Report Broker user ID, indicating the owner of the schedule.
v Procedure. Unique key generated by Report Broker that identifies a specific

execution of a scheduled job.
v Schedule ID. Unique key generated by Report Broker that was assigned to the

job when it was scheduled.
v Start Time. Date and time the job started running.
v End Time. Date and time the job finished running.
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In the second column, the log report specifies messages consisting of the following:
v General information, such as the method of distribution for a particular job (for

example, e-mail distribution).
v Processing information, indicating that the request started, distribution was

successful, and the request was completed. Processing information also includes
reasons why a request failed, such as the unavailability of a data source.

&ECHO and -TYPE Support in Log Reports

Values from &ECHO variables and –TYPE commands in report procedures appear
in log reports. The &ECHO variable displays command lines as they execute in
order to test and debug procedures. The -TYPE command enables you to comment
and evaluate your code for informational and debugging purposes. For example, if
the following procedure is scheduled using Report Broker, it may produce a log
report similar to the example that follows this procedure:
-SET &ECHO=ALL;
-TYPE Country Sales and Growth
-TYPE Parameter RATE is passed into report to forecast potential sales growth
TABLE FILE CAR
HEADING
"Sales Growth Forecast using Rate: &RATE "
SUM SALES AS 'Sales'
COMPUTE GROWTH/D12.2 = (SALES * &RATE) + SALES; AS 'Sales, Forecast'
BY COUNTRY AS 'Country'
END

The following image shows an example of the log report.
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Considerations When Viewing a Log Report

When viewing a log report, be aware of the following considerations.

E-mail Addresses:

Report Broker cannot validate e-mail addresses since e-mail validation is
performed by the mail server. The log report will include any e-mail addresses
validated by the mail server and returned to Report Broker.

Burst Reports:
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v If a valid burst value is omitted in a Distribution List or Dynamic Address List,
Report Broker treats the blank value as if it is a valid burst value, and no entries
indicating a blank burst value appear in the log file. This will significantly
reduce the size of the log file, particularly when the database contains many
values for the primary field and only a small subset of those values are burst.

v If a burst value is specified in a Distribution List or Dynamic Address List and it
is not found in the database, the following message appears in the log file:
Burst Value: value is not in the database.

v When a report is successfully burst, the log file will include the following
message for each burst value:
FILE filename SUCCESSFULLY DISTRIBUTED TO destination FOR burst value.

Unavailable Options:

When schedules with unavailable Task Types and/or distribution methods are not
permitted to run, error notification is triggered and information is included in full
and brief notifications and in the log report that your Report Broker Administrator
or the owner of the schedule must change the unavailable Task Types and/or
distribution methods in the schedule.

When schedules with unavailable Task Types and/or distribution methods are
permitted to run, normal job execution occurs and a message appears in the log
report indicating that your Report Broker Administrator is allowing existing
schedules using the unavailable Task Types and/or distribution methods to run.

Troubleshooting Report Broker Log Reports

If you do not receive a log report because there is an insufficient amount of
memory available, this may be because the report is too large or you have too
many windows open. We recommend closing all windows and attempting to run
the log report again. If you are still unsuccessful, rerun a schedule that successfully
created a log report. If you are successful in running the log report, this confirms
that the original log report that did not run was too large to be processed. Contact
your Report Broker Administrator to help you troubleshoot this issue.

Purging the Log File
The log file accumulates information and can become difficult to navigate. we
recommend that you periodically purge log records to conserve space.

There is a configuration setting that Report Broker Administrators can configure
that automatically purges log reports when they are older than a set number of
days. To find out how long your log reports will be available, see your Report
Broker Administrator.

You can purge the log file in one of two ways:
v Purge log file information for specific schedules. Select one or more schedules

and then click Purge. The Purge Log Web Page Dialog box opens.
The Purge Log Web Page Dialog box opens with the Selected Schedule check
box active and checked, and the Delete Items through check box inactive and
unchecked, as shown in the following image.
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To switch from purging the selected schedule(s) to purging all schedules,
uncheck the Selected Schedule check box.

v Purge log file information for all schedules. Without selecting a schedule, click
Purge. The Purge Log Web Page Dialog box opens.
The Purge Log Web Page Dialog box opens with the Selected Schedule check
box inactive and unchecked, and the Delete Items through check box active and
checked, as shown in the following image.

Selecting the Delete Items through check box activates the End Date field, where
you can specify the date through which you want to purge the log records. The
current date is the default value for the End Date. To change the End Date, click
the calendar to the right of the End Date field. The Calendar Web Page Dialog box
opens.

The following image shows the Calendar Web Page Dialog box, where you can
select the month and year using drop-down lists, and a day by clicking a day on
the calendar.
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Click OK to purge the log file, or click Cancel to cancel the purge request.

Note: To verify that the specified log files have been deleted, you may want to run
a log report again to note the new log output. The deletion of log files is
immediate.

Schedule Blackout Dates
Schedule blackout dates are those dates on which schedules will not run and
cannot be set to run. Only Report Broker Administrators and Web Query Group
Administrators can define, update, and delete schedule blackout dates.

To view schedule blackout dates, click the Blackout Dates option in the Report
Broker interface Schedule pane. The Schedule Blackout Dates interface opens to a
calendar of the current year with the blackout dates shaded in gray. An example of
the Schedule Blackout Dates interface is shown in the following image.

You can change the year using the arrows at the top right corner of the screen.
Click Refresh to load the latest blackout dates. Dates only appear as available or
unavailable.

Click Close to exit the Schedule Blackout Dates interface.
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Schedule Behavior for Blackout Dates

Blackout dates are enforced during schedule creation and at runtime:
v When creating or editing one of the date fields in a schedule, Report Broker

dynamically checks the first upcoming date on which the schedule will run to
ensure that this date has not been blacked out. If there is a conflict with the
date, an error message appears and the schedule cannot be saved until the
conflict is resolved by either changing the schedule date or by not blacking out
the date.

v At run time, each schedule is checked against the list of blackout dates. If a
blackout date has been defined for the scheduled date, the schedule will not run.
If notification is enabled, a notification is distributed indicating that the schedule
did not run because of a defined blackout date.

Checking the Status of a Scheduled Job
From the Report Broker interface, click the Status option to generate a list of your
scheduled jobs that are currently running or in the Report Broker Distribution
Server queue.

The following image shows how each scheduled job contains information
displayed under column headings for Schedule Id, Description, Priority, Start Time,
Owner, and Status. Sorting is available for each column by clicking the column
heading.

The Status column contains one of the following values:
v Run. The scheduled job is currently running.
v Queue. The scheduled job is waiting for a thread to become available to run the

request.

From the list of scheduled jobs, you can:
v Delete a scheduled job. To do this, select a scheduled job with a status of Queue

and click Remove. The schedule is removed from the queue if it is still in the
queue, and the Status list is refreshed.
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v Change the priority level of a scheduled job. To do this, select a scheduled job
with a status of Queue to enable the Update Priority button. In the New Priority
field, select a priority level from the drop�down list and click Update Priority.

v Refresh the current list of schedules with any new jobs that are in the Report
Broker Distribution Server queue by clicking Refresh.

v Automate the refresh process by selecting the time period from the Auto Refresh
drop�down list in which you want the schedule job list to be automatically
refreshed (for example, 10 Seconds).

v Click Help to open the online Help.
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Chapter 17. Report Broker Administration

Provides information to Report Broker Administrators on how to configure for
Report Broker access, schedule for blackout dates, move data between
environments, and globally update schedule properties.

This is intended for Report Broker Administrators. Before Report Broker can be
used, the administrator must confirm the connection to DB2 and create the Report
Broker repository tables, as described in Preparing Report Broker for Use. As an
administrator, you can also set schedule blackout dates (dates on which reports
cannot run or be scheduled to run), move Report Broker data between Report
Broker environments, and globally update schedule properties, such as the
schedule owner.

Setting Schedule Blackout Dates
Schedule blackout dates are those dates on which schedules cannot be run or be
set to run. Only Report Broker administrator can set up or change schedule
blackout dates.

When managing schedule blackout dates, you can add new blackout dates, delete
and replace the description of existing blackout dates, and extract existing blackout
dates to a file for future use. Report Broker provides the following ways for you to
access these management options:
v Report Broker user interface.
v Schedule Blackout Dates Import and Extract Utilities. This method provides an

alternative to using the Report Broker user interfaceDevelopment and
Administration GUI, and unlike the interface, does not require that the
Distribution server be running.
These utilities are available for Windows and UNIX systems, as follows:
– In Windows, the utilities are provided in the rcbdimport.bat and

rcbdextract.bat files, located in the ibi\ReportCaster76\bin directory on the
drive and under the directory where Web Query is installed.
If you do a full Web Query client installation, the import and extract options
are available from the Windows Start Programs menu.
You can also run the utilities from a command line.

– In UNIX, the utilities are provided in the rcbdimport and rcbdextract scripts,
located in the ibi/ReportCaster76/bin directory under the directory where
Web Query is installed. The scripts are run from a command line.

The Import and Extract Utilities are run in an interactive mode.

Schedule Behavior for Blackout Dates

Blackout dates are enforced during schedule creation and at run time:
v When creating or editing one of the date fields in a schedule, Report Broker

dynamically checks the first upcoming date on which the schedule will run to
ensure that this date has not been blacked out. If there is a conflict with the
date, an error message appears and the schedule cannot be saved until the
conflict is resolved by either changing the schedule date or by not blacking out
the date.
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v At runtime, each schedule is checked against the list of blackout dates. If a
blackout date has been defined for the scheduled date, the schedule will not run.
If notification is enabled, a notification is distributed indicating that the schedule
did not run because of a defined blackout date.

About the Schedule Blackout Dates Import Utility
The Import Utility allows you to import a file that contains the desired schedule
blackout dates, and can also include instructions to insert, delete, or replace date
ranges and descriptions of blackout dates. You can import a file that you created or
a file that was created using the Extract Utility. For information about extract files,
see “About the Schedule Blackout Dates Extract Utility” on page 749. The import
of blackout dates can be done through the Report Broker Schedule Blackout Dates
user interface or the Import Utility.

To create an import file, use a standard text editor. This section provides an
example of an import file.

At a minimum, the import file need only consist of the dates (following the format
below) you want to black out. You can also include comments about the file or
specific dates, and add flags that specify how to process individual dates or a
range of dates.

Use the following rules to create the content of a Schedule Blackout Dates import
file:
v Start a comment line with the pound sign (#). Comment lines are optional.
v Enter dates in the YYYYMMDD format. For example, May 1, 2007 = 20070501.
v Each date must be on a separate line. Dates do not have to be in chronological

order.
v To add a comment about a specific date, add a space after the date entry, then

type your comment. For example, 200070101 New Years Day. Comments are
optional.

v Include the following instruction flags, as needed. Flags can be used multiple
times in a file.
– $INSERT
– $DELETE
– $REPLACE
– $RANGE BEGIN and $RANGE END

The flag before $RANGE BEGIN determines the action performed on the date
range. The $RANGE END flag must be the next flag after $RANGE BEGIN.

Note: Use the flags when you want to perform different tasks on different dates
within a single import file. Otherwise, you can choose to add or delete all dates
specified in the import file while using the import utility, described later in this
section.

The following is an example of an import file that includes a comment, an insert,
and a date range:
#Schedule Blackout Dates Update - Import File
$INSERT
20070101 New Years Day
20070115 Martin Luther King Day
$INSERT
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$RANGE BEGIN
20070226 Winter School Break Begins
$RANGE END
20070302 Winter School Break Ends

Trace information is written to the Report Broker trace file.

About the Schedule Blackout Dates Extract Utility
The extract option allows you to save existing schedule blackout dates in a text file
to use as reference documentation or as a schedule blackout dates import file. The
extract utility generates an extract file that includes a comment line with
information about the extract followed by a list of the extracted blackout dates. The
date format is the same as that in the import file (YYYYMMDD). Extracting
blackout dates can be done through the Report Broker Schedule Blackout Dates
user interface or the Extract Utility.

The default name of an extract file is rcbdextract_YYMMDD_HHMMSS.txt, which
includes the date and time stamp, as follows:
v YY is the year.
v MM is the month.
v DD is the day.
v HH is the hour.
v MM is the minute.
v SS is the second.

The following is an example of an extract file:
#Report Broker Schedule Blackout Date Extract created
#070208 180618 by admin for date range:(All)
#Dates extracted from Group: Sales_NE
20070101
20070115 Martin Luther King Day
20070125
20070219
20070220
20070221
20070222
20070223
20070226 Winter School Break Begins
20070227
20070228
20070301
20070302 Winter School Break Ends
20070425

Trace information is written to the Report Broker trace file.

Managing Schedule Blackout Dates From the Report Broker
User Interface

To access the Schedule Blackout Dates interface, click Blackout Dates in the DB2
Web Query Report Broker tab.

The Schedule Blackout Dates interface opens to a calendar of the current year with
the blackout dates shaded in gray. The following image shows an example of an
initial view of the Schedule Blackout Dates interface.

Chapter 17. Report Broker Administration 749



When defining schedule blackout dates, you can only flag a date as available or
unavailable. By default, all dates are available. Calendars are only applicable for
the year they are defined. If you define dates only for 2007, when 2008 arrives you
must set the blackout dates for the new year.

If a blackout date was defined through a file import and that date included a
description, you can view that description by positioning the cursor over the date
in the calendar. Updates to a description are made in an import file, which is
brought into the Schedule Blackout Dates through the Import Utility.

Note: Non-administrators can view the information in the Schedule Blackout Dates
interface, but they cannot define blackout dates.

The options available from the Schedule Blackout Dates user interface are:
v Year Display. Appears in the top-right corner. Allows you to select a calendar

year.
v Save. Saves changes to blackout date selections.
v Refresh. Refreshes the view to show the most current blackout dates.
v Import. Opens the Import Blackout Dates utility from which you can import a

file that contains blackout dates.
v Extract. Opens the Extract Blackout Dates utility from which you can extract all

or selections of the existing blackout dates and save them in a file.
v Close. Closes the Schedule Blackout Dates interface.
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The following procedures explain how to define, import, and extract schedule
blackout dates using the Schedule Blackout Dates interface.

Define Blackout Dates Using the Interface Calendar

To define blackout dates from the Report Broker Schedule Blackout Dates calendar:
1. Select the year using the arrows next to the year display that appears in the top

right corner.
2. In the calendar, click the dates you want to black out.
3. Click Save.

A confirmation window opens to tell you that the dates have been saved.
4. Click OK.

The blackout dates you saved appear in the Schedule Blackout Dates calendar.

Import Schedule Blackout Dates in the User Interface

To import schedule blackout dates in the user interface:
1. In the Schedule Blackout Dates interface, select Import from the options that

appear in the top left corner.
The Import Blackout Dates dialog box opens, as shown in the following image.

2. In the File Name field, type the full path to the file, or click Browse and
navigate to the file you want to import.

3. Select an Import Action.
v Add. Add the dates specified in the import file to the blackout dates.
v Remove. Delete the dates specified in the import file from the blackout dates.
v Replace. Updates the description of the specified dates.
v Use the actions specified in the file. Use this option when the import file

contains a combination of commands (add, remove, replace) and date ranges.
4. Click Import.
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The following confirmation message is displayed:
Blackout Dates have been successfully imported.
Select Save on the Schedule Blackout Dates toolbar to save the changes.

5. Click OK.
6. In the Schedule Blackout Dates option menu, click Save.

Note: The imported blackout date changes do not take effect until you save
them.

7. Required: In the save confirmation window, click OK.

The Schedule Blackout Dates calendar is updated with the blackout date changes.

Extract Schedule Blackout Dates in the User Interface

To extract schedule blackout dates from existing blackout dates in the user
interface:
1. In the Schedule Blackout Dates interface, select Extract from the options that

appear in the top left corner.
The Extract Blackout Dates dialog box opens, as shown in the following image.

2. Select All to extract all currently saved blackout dates, or select Date Range to
specify the range of dates you want to extract.
If you select Date Range:
a. Click the calendar icon to the right of the Start Date field.

A calendar dialog box opens, as shown in the following image.
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b. Choose the date that begins your date range by selecting the month and
year from the drop-down menus, then clicking the day in the calendar.
The Start Date calendar closes and your selection appears in the Start Date
field.

c. Click the calendar icon to the right of the End Date field.
d. Choose the date that ends your date range by selecting the month and year

from the drop-down menus, then clicking the day in the calendar.
The End Date calendar closes and your selection appears in the End Date
field.

3. Click Extract.
A window opens asking if you want to open or save the file.
If you choose to save the file:
a. Click Save.
b. In the Save As window, browse to the directory where you want to save the

extract file, and click Save.

Note: The default extract file name is rcbdextract_YYMMDD_HHMMSS.txt, where
YYMMDD and HHMMSS are the date (year, month, day) and time (hour, minute,
second) that the file was created.

Using the Import and Extract Utility
You can run the Import and Extract Utility in an interactive mode in a Windows or
UNIX environment using a customized .bat file or UNIX script. The following
procedures describe how to import and extract schedule blackout dates using the
utility in interactive mode.

Use the Import Utility

Use the following procedure to run the Schedule Blackout Dates Import Utility for
both Windows and UNIX systems. The images shown in this procedure are from
the Windows version of the utility. Although Windows and UNIX interactive
dialog boxes may vary in the look and feel, they contain the same options and
buttons described here.
1. Run the Import Utility, as follows:
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v In Windows, do one of the following:
From the Start menu, select Information Builders, ReportCaster76, Database
Management and Utilities, then Import Schedule Blackout Dates.
In a command line window, navigate to the ibi\ReportCaster76\bin
directory, then type rcbdimport.
In Windows Explorer, navigate to the ibi\ReportCaster76\bin directory and
double-click the rcbdimport.bat file.

v In UNIX, on the command line, run the following script:
rcbdimport

The Import Blackout Dates dialog box opens, as shown in the following
image.

2. In the File name field, type the path to the file you want to import, or click
Browse to navigate to the file.

3. Select one of the import actions:
v Add. Inserts the blackout dates noted in the import file.
v Remove. Deletes the blackout dates noted in the import file.
v Replace. This option allows you to add or edit a description for an existing

blackout date.
v Use the action specified in the file. Act on the blackout dates according to

the instructions in the import file. This option allows you to use add,
remove, and replace in one file, and to use date ranges.

4. Click Import.
The Report Broker Schedule Blackout Dates Import Log window opens,
displaying information about the import, such as the name of the imported file,
and the time and date of the import. The following image shows an example of
an import log file.
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5. In the log window, click Close.
You are returned to the Import Blackout Dates dialog box.

6. Click Close to exit the Import Blackout Dates utility.

Use the Extract Utility

Use the following procedure to run the Schedule Blackout Dates Extract Utility for
both Windows and UNIX systems. The images shown in this procedure are from
the Windows version of the utility. Although Windows and UNIX interactive
dialog boxes may vary in the look and feel, they contain the same options and
buttons described here.
1. Run the Extract Utility, as follows:

v In Windows, do one of the following:
From the Start menu, select Information Builders, ReportCaster76, Database
Management and Utilities, then Extract Schedule Blackout Dates.
In a command line window, navigate to the ibi\ReportCaster76\bin
directory, then type rcbdextract.
In Windows Explorer, navigate to the ibi\ReportCaster76\bin directory and
double-click the rcbdextract.bat file.

v In UNIX, in the command line, navigate to the ibi\ReportCaster76\bin
directory, then run the following script:
rcbdextract

The Extract Blackout Dates dialog box opens, as shown in the following
image.

Chapter 17. Report Broker Administration 755



2. Select either All or Date Range.
All. Extract all currently saved schedule blackout dates.
Date Range. Extract the blackout dates within the specified date range.
If you select Date Range:
a. Click the arrow next to the Start Date field.

The Extract Blackout Dates Calendar opens, as shown in the following
image.
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b. In the calendar, click the date you want to begin the date range.
c. Click the arrow next to the End Date.

The Extract Blackout Dates Calendar opens.
d. In the calendar, click the date you want to end the date range.

3. Click Extract.
The following message appears:
Extract of schedule blackout dates successfully created.

4. Click OK.

A file containing the extracted blackout dates with the following file name format
is saved in the \ReportCaster76\log directory:
rcbdextract_YYMMDD_HHMMSS.txt

Where YYMMDD is the year, month, and day the file was created, and HHMMSS is the
hour, minute, and second the file was created.

Report Broker Change Management
The Report Broker Change Management user interface provides a way for you to
select specific Report Broker Repository data belonging to specific users and move
that data to another Report Broker environment. The Repository objects you can
move are schedules and schedule distribution lists. Typically, you would move
data between:
v Development and testing environments.
v Test and production environments.
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Using the Change Management Interface
This section describes how to use the Report Broker Change Management user
interface to transfer Report Broker data to another Repository. The interface allows
you to move only one type of repository object for one user at a time.

Move Data Between Report Broker Environments

To move Report Broker data to another Report Broker Repository:
1. Log onto Report Broker in the target environment (the environment that will

receive the data).
2. Access the Change Management interface by clicking Change Mgmt in the

Report Broker tab.
The Change Management Source Properties window opens. The following
image shows the Source Properties window populated with example values.

The Change Management Source Properties window displays the information
needed to connect to the source Report Broker Repository. When you access
Change Management for the first time, you must set the source Repository
properties. For instructions on setting or changing the source connection
information, see Setting the Connection Properties.

3. From the Repository Object drop-down list, select the type of data you want to
move. The selections are:
v Schedules
v Distribution Lists

4. Click OK.
The Report Broker interface displays a list of users found in the source
repository, as well as a series of headings related to the type of Repository
object you selected.
The following image shows the Change Management interface when you select
Schedules as the Repository Object.
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The following image shows the Change Management interface when you select
Distribution Lists as the Repository Object.

5. In the left pane, select a user whose repository data you want to move.
Note: You can select only one user for each transfer of data.
The right pane displays the related repository objects owned by the selected
user. The following image is an example of a list of schedules for a specific
user.

6. Select the items you want to move to the target repository. (Select multiple
items using the Shift and Ctrl keys.)

7. Click one of the following:
v Insert - to add the selected source records to the target repository if that

record does not already exists.
v Update - to add the selected source records to the target repository and

overwrites any corresponding records that exist in the target repository.
Note: Duplicate records cannot exist in the Report Broker Repository.
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A window opens and displays the status of and summary of operations on
each repository table that was involved in the data transfer. The information
includes the operation (insert or update), whether or not the operation was
successful, and if it failed, a brief explanation. See Change Management Logs
for examples of this window.
This information is saved in a log file (changemgmt.log) on the Distribution
Server in ibi\ReportCaster76\log. A new log is created each time you click
Insert or Update, so the latest log file is time stamped and renamed with a .bak
file extension.

8. To continue transferring the selected Repository object for another user, select a
user in the left pane. If you want to transfer a different Repository object, click
Source Properties in the Change Management interface toolbar to open the
Source Properties window, and follow Steps 3 through 7 .

Change Management Logs

This section provides examples of the Change Management log files that indicate:
v A successful transfer of Report Broker data to the target Repository.
v An error in the transfer because the data being transferred already exists in the

target repository.

Log of Successful Data Transfer

The following is an example of a log file indicating a successful transfer of records.
It provides details for each repository table involved in the transfer.
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Log of Failed Data Transfer

The following is an example a log file indicating that a record already exists in the
target Repository.
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Setting the Connection Properties
The first time you access the Report Broker Change Management interface, the
Change Management Source Properties window opens and displays the target
Repository information, and blank fields related to the source Repository
information. You must provide the source Repository information needed to make
the connection between the two Repositories.

Once this connection information is saved, you will always connect to the
repository designated in the source fields when you access the Change
Management interface. Once in the Change Management interface, you can change
the source connection information whenever you want to connect to a different
source repository.

Set Connection Properties

Use the following procedure to set or change the connection properties to the
source Report Broker Repository.
1. If the Change Management Source Properties window is not already open, click

Source Properties in the Change Management interface.
The Report Broker Change Management Source Properties window
automatically displays the target Repository information and if previously
saved, the source Repository information. The following image is an example of
the Source Properties window that opens when using the Change Management
interface for the first time from the target environment.
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Information about the Report Broker Repository you are currently logged into
(Target URL and Target Class Name) automatically displays in the Source
Properties window. Once you save the source Repository information (Source
URL, Source Class Name, User ID, and Password) you will enter in this
procedure, that will also be displayed whenever you open the Source Properties
window.

2. Required: From the Version drop-down list, select the release version of the
source Report Broker Repository data.
Note: Currently, the only available release version is 7.6.x.

3. In the Source URL field, type the URL to the source Report Broker Repository.
4. In the Source ClassName field, type the name of the Java™ class to connect to

the Report Broker database.
5. Required: Click OK.

The connection properties are saved and you can now work in the Change
Management interface.

Globally Updating Schedule Field Values
You can update the following schedule field values using the Global Update
options available in the Web Query Report Broker tab.
v Mail Server. Replaces the mail server name in every schedule that is using the

specified e-mail server.
v Printer. Replaces the printer name in every occurrence of any Distribution List

or schedule that is using the specified printer.
v EMail Address. Replaces the e-mail address in every occurrence of any

Distribution List or schedule with e-mail distribution using the e-mail address.
Notification e-mail addresses are not changed.

v Mail From. Replaces the optional From field in every schedule that uses e-mail.
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v Owner. Replaces the owner user ID in every occurrence of any Distribution List
or schedule that is owned by the user ID. This option does not change the
owner for log reports.

Globally Update Schedule Properties
1. In the Web Query Report Broker tab, click Global Update.

The Global Schedule Update pane opens, as shown in the following image.

2. Click in the Old Value field column next to the property you want to update,
and type the current value.

3. Click in the New Value field column next to the property you want to update,
and type the new value for the property.

4. Click Update.
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Chapter 18. Report Broker Formats for Scheduled Output

Provides descriptions, suggested uses, and considerations about each Report
Broker output format.

When you create a schedule, you specify the format for the scheduled output. The
following topics describe the different types of available Report Broker formats.
They also suggest the best usage for each Report Broker format, and provides
considerations that you should be aware of when distributing each format type
using Report Broker.

AHTML
Format: AHTML (.htm)

Description: Provides customizable options for creating HTML formatted reports
that enable users to experience features normally found in Excel workbooks.

Suggested Uses: e-mail for display in a Web browser

Considerations: Can only be distributed as an e-mail attachment. Inline e-mail
messages are not supported.

DHTML
Format: DHTML

Description: Supports hyperlinks and other World Wide Web features. Retains
StyleSheet formatting.

Along with the features of HTML format, DHTML supports the Web archive
format (.mht). An .mht file can contain multiple reports and graphs and is utilized
for Coordinated Compound Reports.

Suggested Uses: e-mail for display in a Web browser

Considerations: Can be distributed as an e-mail attachment and be sent as an
inline e-mail message when the output is .htm, but not when the output is .mht.

Will return two possible formats:
v The scheduled procedure (FOCEXEC) outputs an HTML file when the request

does not contain the SET HTMLARCHIVE=ON command.
v The scheduled procedure (FOCEXEC) outputs a Web archive file (.mht) when

the SET HTMLARCHIVE=ON is specified.

DOC
Format: DOC (.txt)

Description: Scheduled output opens as a plain-text word processing document.
Text can be opened by any word processing application. Retains ASCII form feed
characters to correctly display page output.
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Suggested Uses: Word Processing applications, printing unformatted reports,
e-mail.

Considerations: Does not retain most formatting. Does not support hyperlinks or
alerts.

Can be distributed as an e-mail attachment or as an inline e-mail message.

Bursting is supported.

EXL2K
Format: EXL2K (.xls)

Description: Scheduled output opens within Excel 2000 or higher.

Supports most StyleSheet attributes, allowing for full report formatting.

Suggested Uses: E-mail

Considerations: Microsoft Excel 2000 or higher must be installed. The format is
ASCII.

All EXL2K output with an .xht extension is dynamically changed to .xls for e-mail.
You must edit your Web server MIME table so that the .xls extension is
ascii/application data instead of binary.

Bursting is supported.

EXL2K FORMULA
Format: EXL2K FORMULA (.xls)

Description: Scheduled output opens within Excel 2000 or higher.

Contains Excel formulas that calculate and display the results of any type of
summed information (such as column totals, row totals, and sub-totals).

Suggested Uses: E-mail

Considerations: Microsoft Excel 2000 or higher must be installed. The format is
ASCII.

All EXL2K output with an .xht extension is dynamically changed to .xls for e-mail.
You must edit your Web server MIME table so that the .xls extension is
ascii/application data instead of binary.

Bursting is not supported.

EXL97
Format: EXL97 (.xls)
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Description: Scheduled output opens as an Excel97 spreadsheet file, an
HTML-based display format that supports report formatting and drill-downs.

Suggested Uses: E-mail

Considerations: Microsoft Excel 97 or higher must be installed.

Bursting is supported.

HTML
Format: HTML (.htm)

Description: Supports hyperlinks and other World Wide Web features. Retains
StyleSheet formatting.

Suggested Uses: e-mail for display in a Web browser

Considerations: Can be distributed as an e-mail attachment or as an inline e-mail
message.

JPG
Format: JPG (.jpg)

Description: Scheduled output opens as a graph image in JPG format.

Suggested Uses: E-mail

Considerations: Only works with procedures that contain GRAPH FILE syntax.

Bursting is supported and is performed on the second BY field in the GRAPH FILE
request.

Drill downs are not supported since the JPG format creates a static image.

PDF
Format: PDF (.pdf)

Description: Appearance of the scheduled output is preserved in an electronic
document when printed using Adobe Acrobat. Retains all relevant StyleSheet
formatting.

Suggested Uses: E-mail

Considerations: Does not support hyperlinks in e-mail attachments. Recipient must
have an Adobe Acrobat application to view.

The z/OS USS (UNIX System Services) platform requires the Web server
configuration file to have the MIME setting for PDF set to binary in mime.wfs.

Bursting is supported.
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When Report Broker distributes PDF reports created with a TABLE request
containing BY HIGHEST primarysortfield syntax, the report contains page breaks on
each primary sort field value.

When distributing a PDF report to a Web Query Repository on z/OS, the PDF
report cannot be viewed in Web Query. As a workaround, save the PDF file to
your local machine and then view the PDF using Adobe Acrobat. This limitation is
due to z/OS being an EBCDIC-based platform and PDF being an ASCII-based
format.

The PDF Drill Through feature is supported.

PNG
Format: PNG (.png)

Description: Scheduled output opens as a graph image. These graphs are
bitmapped and can support 16 million colors. In addition, PNG graphs have
lossless compression (data is decompressed 100% back to the original). Therefore,
saving, altering, and re�saving a PNG does not degrade its overall quality.

Suggested Uses: E-mail

Considerations: Only works with procedures that contain GRAPH FILE syntax.

Bursting is supported and is performed on the second BY field in the GRAPH FILE
request.

Drill downs are not supported, as this format creates a static image.

PS
Format: PS (.ps)

Description: Appearance of the scheduled output is preserved in an electronic
document when printed using PostScript. Retains all relevant StyleSheet
formatting.

Suggested Uses: Printing

Considerations: Does not support hyperlinks. Printers must support PostScript.
Recipient must have an application (for example, GhostView) that supports
PostScript.

Distribution to Web Query is not supported.

Bursting is supported.

SVG
Format: SVG (.svg)

Description: Scheduled output opens as a graph image. This file format, based on
Extensible Markup Language (XML), presents powerful, interactive images.

Suggested Uses: E-mail
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Considerations: Recipient must have an SVG viewer, such as Adobe SVG Viewer
for Windows. To download Adobe SVG Viewer for Windows, go to
http://www.adobe.com.

Only works with procedures that contain GRAPH FILE syntax.

Bursting is supported and is performed on the second BY field in the GRAPH FILE
request.

Drill downs are not supported, as this format creates a static image.

SVG graphs delivered by e-mail or to Web Query from a z/OS Report Broker
Distribution Server cannot be opened. To resolve this issue, edit the Report Broker
Distribution Server sendmodes.dita file (located in the /cfg directory) and change
the <mode> value from binary to text. For example:
<sendmode> <extension>svg</extension > <mode>text</mode>
<mime>image/svg+xml</mime > </sendmode>

WP
Format: WP (.txt)

Description: Scheduled output opens as a plain-text word processing document in
the Web browser. Text can be opened by any word processing application.

Suggested Uses: Word processing applications, printing unformatted reports,
e-mail.

Considerations: Does not retain page breaks or most formatting. Does not support
hyperlinks or alerts.

Can be distributed as an e-mail attachment or as an inline e-mail message.

Bursting is supported.
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Appendix. Running Web Query Reports Using the Java Batch
Run Utility

Describes how to run Web Query Reports using the Java Batch Run Utility.

The Java Batch Run utility (RUNWEBQRY) enables you to run a Web Query report
from the command line so that the request can be submitted to a batch queue,
without having to physically log on to DB2 Web Query. The utility accepts a single
report procedure (FOCEXEC) that is in the DB2 Web Query installation and
executes the FOCEXEC via a Java program.

Java Batch Run Utility Prerequisites
The following are prerequisites for running the utility:
v DB2 Web Query must be installed and running on the system where the

reporting and application servers are running.
v FOCEXECs which exist in the DB2 Web Query environment.
v An available user ID that is licensed for DB2 Web Query.

Invoke the Java Batch Run

To invoke the utility from the command line:
1. Log in to the i5 system via a 5250 terminal emulator.
2. At the command line, execute the following command:

QWEBQRY76/RUNWEBQRY

3. Press the F4 key.
The Run Java batch in WebQuery (RUNWEBQRY) screen opens as shown in
the following image.
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4. On the screen, type values for the following input parameters:

Domain href

Is the domain name in Dashboard or an href. An href is an internal
name given to an object. The href can be displayed via the Properties
option in the Dashboard menu, which is available by right-clicking the
mouse. You do not need to use the href if the name is exactly 8
characters. You need to use the href if the name is less than 8 characters
or more than 8 characters. This input parameter can be retrieved from
the Properties page by right-clicking on the report name and choosing
Properties from the drop-down menu.

Folder href

Is the folder name in Dashboard or an href. An href is an internal name
given to an object. The href can be displayed via the Properties option
in the Dashboard menu, which is available by right-clicking the mouse.
You do not need to use the href if the name is exactly 12 characters.
You need to use the href if the name is less than 12 characters or more
than 12 characters. This input parameter can be retrieved from the
Properties page by right-clicking on the report name and choosing
Properties from the drop-down menu.

File Name (fex)
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Is the name of the report FOCEXEX (fex) as displayed in the
Dashboard. This input parameter can be retrieved from the Properties
page by right-clicking on the report name and choosing Properties
from the drop-down menu.

Output Format

Is the report format. Possible values are DOC or WP. WP is the default
value.

Output Queue

Is the name of the outq on the i5 system where the report will be sent.
QPRINT is the default value.

Run with User ID

Enables you to submit the job using another user ID. The default value
is *CURRENT which means that the current user ID will be used to
submit the job.

Note: The RUNWEBQRY command can be part of a job stream using SBMJOB to
run multiple requests.

Retrieving Input Parameters for the RUNQUERY Command

The following is an example of a Properties page for retrieving parameter
information. This page is accessed by right-clicking on a report name in a report
folder, and choosing Properties from the drop-down menu.
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The following image shows the input parameters populated from the example
properties page.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION ″AS IS″
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact: IBM Corporation
_Department number/Building number_ _Site mailing address_ _City, State; Zip
Code_ _U.S.A. (or appropriate country)

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM’s suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs.
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Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights
reserved.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
The following terms are trademarks of International Business Machines
Corporation in the United States, other countries, or both:

1-2-3
CICS
DB2
i5/OS
IBM
IMS
Informix
iSeries
Lotus
Lotus Notes
System i
z/OS

Adobe, Acrobat, Portable Document Format (PDF), PostScript, and all Adobe-based
trademarks are either registered trademarks or trademarks of Adobe Systems
Incorporated in the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Microsoft, Windows, Windows NT®, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, or service names may be trademarks or service marks of
others.
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Terms and conditions

Permissions for the use of these publications is granted subject to the following
terms and conditions.

Personal Use: You may reproduce these publications for your personal,
noncommercial use provided that all proprietary notices are preserved. You may
not distribute, display or make derivative works of these publications, or any
portion thereof, without the express consent of IBM.

Commercial Use: You may reproduce, distribute and display these publications
solely within your enterprise provided that all proprietary notices are preserved.
You may not make derivative works of these publications, or reproduce, distribute
or display these publications or any portion thereof outside your enterprise,
without the express consent of IBM.

Except as expressly granted in this permission, no other permissions, licenses or
rights are granted, either express or implied, to the publications or any
information, data, software or other intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its
discretion, the use of the publications is detrimental to its interest or, as
determined by IBM, the above instructions are not being properly followed.

You may not download, export or re-export this information except in full
compliance with all applicable laws and regulations, including all United States
export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED ″AS-IS″ AND WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.

© Copyright IBM Corp. 2007 779



780 System i: Database IBM DB2 Web Query for System i



Index

Special characters
-TYPE commands 740
&ECHO variables 740

Numerics
3D graphs 279

A
About link 7
ABS function 416
absolute value 416
ACCEPT list 228
Access File Text View tab 616
Access Files 605, 607
ACROSS fields 79, 81, 305
ACROSS fields:selecting 190
ACROSS fields:selecting;sorting in OLAP

reports 192
Across tab 296
active report control 589
active report control list 581
Active Report control values 581
active report controls 581, 585
active report properties 579
Active Reports 130
Active Reports:formatting 130
ad hoc reports 449
add/disable schedule button 598
adding a computed field (COMPUTE) in

virtual fields 659
adding color to graphs 305, 313
adding date-time values 382, 383
adding existing field to group field 670
adding fields 310
adding fields:to footings 310, 313
adding fields:to headings 310, 313
adding footings to graphs 310, 312
adding group fields 668
adding headings to graphs 310, 312
adding labels to graphs 310, 313
adding new field to group field 669
adding objects to HTML pages 463
adding objects to HTML pages:form

controls 497
adding objects to HTML

pages:frames 468
adding objects to HTML

pages:graphs 463
adding objects to HTML pages:group

boxes 481
adding objects to HTML pages:HTML

templates 563
adding objects to HTML

pages:hyperlinks 479
adding objects to HTML

pages:images 476
adding objects to HTML pages:lines 463,

474, 475

adding objects to HTML pages:push
buttons 482

adding objects to HTML
pages:reports 463

adding objects to HTML pages:reset
buttons 486

adding objects to HTML pages:tab
control 487

adding objects to HTML pages:text 478
additional tabs 491
adjusting work area 68
administering Report Broker 747
AHTML format 765
all columns 676, 678
ALL. prefix 92, 93
alphanumeric argument 363
alphanumeric fields 357
alphanumeric formats 86, 400, 405, 412
alphanumeric strings 410
Alternate Comment for Hyperlink 306
amper variable parameters 529
amper variable parameters:setting form

controls 529
amper variables 306, 307
And/Or keyword 114, 294
applying selections criteria in

OLAP;limiting data;limiting data:in
OLAP reports 224

area graphs 279
area graphs:styling 351, 353
ARGLEN function 364
argument formats 363
argument types 362
arithmetic operations 92
arranging graphic elements 283
ascending order 93
assigning prefix operators 288
associating components 497
ATODBL function 410
Auto Prompt button 113, 293
AutoDrill 176
AutoDrill;measures:drilling down

on;dimensions:drilling down on;drilling
down on dimensions;drilling down on
measures;column values in OLAP
reports 184

automatic drill down 126, 176
automatic field population 556
AYM function 382
AYMD function 383

B
background images and properties 495
banner links 7
bar charts 416
BAR function 416
bar graphs 279, 427
bar graphs:associating with columns 427
bar graphs:associating with dimensions

and measures 429, 432, 433, 436

bar graphs:attributes 429
bar graphs:deleting from measures 433
bar graphs:horizontal 427
bar graphs:styling 351, 353
bar graphs:vertical 427
bipolar graphs 279
BITSON function 365
blackout dates for schedules 744, 747
browser settings 3
btnBackColor 150
btnbold 150
btnCopy 150
btnCut 150
btnFldListList 151
btnFldListTree 150
btnForeColor 150
btnitalic 150
btnJustifyCenter 150
btnJustifyRight 150
btnLeftJustify 150
btnModDefine 150
btnPaste 150
btnRemoveFormat 150
btnSelectAll 150
btnunderline 150
burst values 694, 697, 700
burst values:specifying in an e-mail

subject line 711
bursting reports 694, 700, 701
bursting reports:guidelines and

limitations 722
Business View Master File 651
Business Views 646, 647, 648, 650, 651
Business Views menu options 648
Button Properties window 485
BY fields 74, 79
BY fields:OLAP and;ACROSS

fields;ACROSS fields:OLAP and;drilling
down on measures;ACROSS
fields:sorting with;measures:drilling
down on 190

BY fields:selecting 192
BY fields:selecting;ACROSS

fields:selecting; dimensions;measures:in
different dimensions 193

BYTVAL function 365

C
calculated values 83, 88
calculating remainders 418
calendar 522
Cascading Style Sheets (CSS) 105, 123,

124
Cascading Style Sheets (CSS):generating

internal CSS code 124
case sensitive searches 441, 442
cc mail considerations 711
centering character strings 368
chain feature 550
chained parameters 551

© Copyright IBM Corp. 2007 781



changing color settings 310, 317, 318
changing fonts 310, 313, 314, 316
changing formats 86
changing the display title for a field 93
changing the template for the schedule

page 602
character functions 357, 364
character string bits 365
character string formats 366
character strings 364
chart elements 283
charts 279
Check Box Properties window 511
check boxes:supplying parameter

values 510
CHGDAT function 384
CHKFMT function 366
CHKPCK function 417
cloning schedules 734
cluster joins in Synonym Editor 637, 640
color settings 317
color settings:changing 318
column fields 74, 79
column titles 128
column titles:displaying field

descriptions 128
column values in OLAP reports;column

values in OLAP reports:displaying
stacked 254

column values in OLAP reports:sorting
by 198, 200

column/field attribute summary 623
columns 427
columns in OLAP reports;columns in

OLAP reports:pivoting 212
columns in relational tables 605
columns:applying graphs to 427
combining expressions 114, 294
commands 83
commands:COMPUTE 83
commands:DEFINE 83
comparing character strings 376
comparing graphs 283
Components toolbar 460
Compute calculator 665
COMPUTE command 83
COMPUTE fields 88
computed fields 83, 659
computed fields in Synonym Editor 659
conditional styling 97, 98, 305
conditional styling:graphs and 305
configuring active report controls 581,

585
connected point plot graphs 279
Control Panel;OLAP Control Panel;OLAP

tools;OLAP Control Panel:opening 179
Control Panel:unique functions;OLAP

Control Panel:unique functions;OLAP
sorting options;OLAP data selection
options;OLAP save options;stacking
measures:in OLAP reports 184

controls 448
controls:adding to forms 448
converting alphanumeric strings 404,

410
converting case 379
converting character strings 371

converting characters 412
converting date formats 388, 401
converting date-time formats 400
converting date-time value formats 408
converting date-time values 407
converting decimal integers 412
converting double-precision formats 413
converting field formats 411
converting formats 384, 401, 402, 410
converting Gregorian date 408
converting mixed case 371
converting packed decimal 414
converting packed numbers 415
converting text to uppercase 379
converting timestamp 408
converting to lowercase 372
converting zoned format 415
Coordinated Compound Reports 722
Create Conditional Style Rule dialog

box 40
creating a Business View 647
creating a distribution list 696
creating business views 646
creating business views in Developer

Studio 646
creating filters 656
creating graphs 277
creating HTML pages 457
creating HTML pages:HTML Layout

Painter 457
creating joins 116, 118, 119, 298, 300, 301
creating launch pages 449
creating logical views 641
creating multiple graphs 296
creating parameters 99
creating parameters for drill downs 307
creating reports 5
creating synonyms 628
creating temporary fields 83, 659
creating virtual columns in Synonym

Editor 653
creating virtual fields 659
creating WHERE statements 109, 289
cross-century dates;DEFCENT

value;YRTHRESH value;Master
Files;Master Files:specifying values for
DEFCENT and YRTHRESH 245

CSS (Cascading Style Sheets) 124
CSS (Cascading Style Sheets):generating

internal CSS code 124
CTRAN function 367
CTRFLD function 368
custom reports:OLAP;saving custom

reports in OLAP 269
customizing graphs 305, 310, 351, 353,

355
customizing HTML pages 576

D
DA functions 386
DADMY function 386
DADYM function 386
DAMDY function 386
DAMYD function 386
data descriptions 605, 607

data profiling 676, 678, 680, 682, 683,
684

data profiling in synonyms 676
data source descriptions 605, 607
data source functions 358, 380, 382
data source values 380
data sources 116, 298, 380, 605
data sources for OLAP analysis;OLAP

data;OLAP-enabling a data
source;WITHIN attributes in a Master
File;defining an OLAP hierarchy in a
Master File;OLAP syntax
summary;defining an OLAP hierarchy
in a procedure 175

Data Style labels 314
data visualization 427
data visualization:applying to

measures 432, 433, 436
data visualization:bar graphs 245, 429
data visualization:deleting from

measures 433
data visualization:display modes 432,

436
data visualization:OLAP Control Panel

and 429, 432
data visualization:OLAP selections panel

and 429, 432
date and time functions 358, 382
date argument 363
date elements in OLAP

reports:adding 244
date elements in OLAP reports:applying

date ranges 238
date elements in OLAP reports:applying

selection criteria to 233
date elements in OLAP reports:applying

selection criteria to;date elements in
OLAP reports:applying date
ranges;OLAP Control Panel;applying
selections criteria in OLAP:to
dates;Control Panel 232

date elements in OLAP
reports:deleting 244

date fields in OLAP reports:specifying
selection criteria;date fields in OLAP
reports 233

date format 387
date formats 86, 87, 233
date formats:Julian dates;date

formats:limitations;Date Selection
pane;Julian dates;date formats:smart
dates;smart dates;date formats;Range
check box 245

date ranges in OLAP reports 225, 233
date ranges in OLAP

reports:applying 225
date ranges in OLAP reports:applying

criteria to 238, 239
date ranges in OLAP

reports:selecting 225
date string displays 384
DATEADD function 387
DATECVT function 388
DATEDIF function 389
DATEFNS parameter 398, 408
DATEMOV function 390
DATETRAN function 391

782 System i: Database IBM DB2 Web Query for System i



DAYDM function 386
DAYMD function 386
DB2 Web Query Developer

Workbench 2
DB2 Web Query Viewer 439
decimal formats 86, 87
decimal values 365
DECODE function 380, 381
decoding functions 358, 380, 381
decoding values 380, 381
DEFINE command 83
define-based joins 118, 300
defined fields 83, 118, 300
deleting a distribution list 700
deleting a field from group fields 671
deleting a schedule 736
deleting dimensions 644
deleting group field from segment 670
deleting joins 119, 302
descending order 93
describing data sources 605
describing files 605
designing user interfaces 447
designing user interfaces:HTML Layout

Painter 457
detail fields 92
detail reports 81
Developer Studio 646
Developer Workbench 2
development environment 2
DHTML format 765
Dimension Builder 641, 644, 646
Dimension Builder toolbar 646
dimension controls in OLAP reports 181
dimension controls in OLAP

reports:Selection pane 226
dimension elements in OLAP

reports 264
dimension elements in OLAP

reports:adding from the Control
Panel 264

dimension elements in OLAP
reports:adding from the Control
Panel;dimension elements in OLAP
reports 263

dimension elements in OLAP
reports:deleting from the Control
Panel 268

dimension elements in OLAP
reports:deleting from the report 266

dimension elements in OLAP
reports:sorting;dimension elements in
OLAP reports 200

dimension hierarchy 228
dimensions 177, 644
dimensions:deleting 266, 268
dimensions:dragging and

dropping;measures:dragging and
dropping 178

dimensions:exposing hidden 263, 264
dimensions:repositioning;repositioning

dimensions;columns in OLAP
reports:repositioning 208

direct output to printer 127, 165
display formats 765
display modes for measures 432
display titles 93

displaying graphs for OLAP
reports;graphing OLAP reports 180

displaying measures;displaying
measures:stacked 254

displaying missing values 302
displaying missing values:in graphs 302,

303, 304, 310
displaying multiple graphs in

columns 297
displaying stacked measures 254
displaying subfoots 95
displaying subheads 95
displaying subtotals 94, 104
distributing reports:by e-mail 712
distributing reports:by fax 712
distributing reports:to printers 698
distribution files 694, 712
distribution lists 695
distribution lists:creating 696, 698
distribution lists:deleting 700
distribution lists:editing 699, 737
distribution lists:specifying multiple

addresses in a field 694
dividing character strings 373
dividing text 373
DMOD function 418
DMY function 396
DOC format 765
document properties 68
Domain Tree 5
domains 4
Double List Box Properties window 509
double list control 507
DOWK function 397
DOWKL function 397
Drill Down Parameter dialog box 307
drill downs 307
drill downs:creating parameters for 307
drill downs:graphs and 306
drill-down reports 449
drilling down on dimensions 126
drilling down on dimensions:in

reports;dimensions:drilling down
on;drilling down on
dimensions;AutoDrill 184

drilling down on measures 126, 192
drilling down to new procedures 98
drop-down list 525
Drop-Down List Properties window 504
drop-down lists 503
drop-down lists:Drop-Down List

Properties window 504
drop-down lists:supplying parameter

values 503
DT functions 398
DTDMY function 398
DTDYM function 398
DTMDY function 398
DTMYD function 398
DTYDM function 398
DTYMD function 398
dynamic calendar 522
dynamic parameters 548
dynamic reports 449

E
e-mail 711, 712
e-mail:attachments 712
e-mail:inline reports 712
EDIT function 369, 411
editing a distribution list 699
editing a schedule 731, 733
editing a schedule with unavailable

options 734
editing joins 120, 302
editing Master Files 644
editor 6
elapsed time 409
elements in OLAP dimensions 177
elements in OLAP dimensions:reversing

the order 200
environment variables 424
Events subtab 525
everything value option 535
EXCEL 97 format 766
Exchange Mail Server

considerations 711
EXL2K format 766
EXL2K FORMULA format 766
EXP function 419
export as procedure 590
expressions 109, 289
expressions:combining 114, 294
expressions:deleting 114, 295
expressions:grouping 114, 115, 295
expressions:order of evaluation 148
external distribution files 694, 712
external functions 357
extracting character strings 369
extracting substrings 369, 370, 378

F
faxing reports 712
FGETENV function 424
field column titles 92
Field Creator dialog box 83
field display title 93
field formats 86
field formats:alphanumeric 86
field formats:date 86, 87
field formats:numeric 86, 87
field lists 83
field lists:resetting after a search 83
field lists:searching 82
Field Options tab 288, 326
fields 74, 79, 92, 605, 673, 674
Fields tab 135, 324
Fields window 135, 151, 310, 324, 334
fields:adding to footings and

headings 310, 313
fields:applying arithmetic operations 92
fields:displaying 92
fields:hiding y-axis 288
fields:including subtotals 94
fields:multi-selecting 81
fields:numeric 92
fields:ordering 93
fields:styling 97
fields:subtotals 104
fields:suppressing display 92, 93

Index 783



fields:temporary 84
file attributes summary 620
file descriptions 605, 607
Filter calculator 665
filtering criteria 115
filtering parameter values 550
filters 35, 115, 295, 656
finding date difference 389, 396
finding day of week 397
finding difference date-time value 401
finding maximum value 420
finding minimum value 420
finding substrings 374
fixed overflow 53
fixed scales 316
floating point formats 86, 87
flow margins 58
flowing overflow 56
flowing reports 60
FMOD function 418
FOCHTMLURL parameter 128
FOCHTMLURL parameter:pop-up field

descriptions and 128
fonts 313
fonts:changing 313, 314, 316
fonts:graphs and 313, 314, 316
footings 106, 108
footings:aligning 107
footings:customizing 107, 108
footings:for graphs 310
footings:styling 108
footnotes 313
form controls 498, 598
form controls:adding amper variable

parameters 529
form controls:adding to HTML

pages 497
form controls:check boxes 510
form controls:drop-down lists 503
form controls:list boxes 505, 506
form controls:radio buttons 512
form controls:supplying parameter

values 497, 530, 531
form controls:text areas 503
form controls:text boxes 498
form controls:types 498
Form Settings dialog box 520, 592
format conversion functions 361
format conversions 410, 412
format types 765
formats 86, 410
formats:alphanumeric 86
formats:date 86, 87
formats:numeric 86, 87
formatting graphs 314, 316
formatting text 478
Formatting toolbar 462
forms 448
forms:adding controls to 448
forms:form controls 498
forms:text boxes 498
Frame Properties window 468, 474, 475
frames 468
frames:adding to HTML pages 468
frames:Frame Properties window 468,

474, 475
FTOA function 412

full screen mode 489
fully qualified field names 78
function arguments 362
function types 357, 380, 416
functions 357

G
generating random numbers 421, 422
GETTOK function 370
GETUSER function 425
grand totals 79
Graph Assistant 1, 82, 277
Graph Assistant Properties tab 343
Graph Assistant Properties

tab:Settings 349
Graph Assistant:creating multiple

graphs 296
Graph Assistant:Data Style labels 314
Graph Assistant:Graph Preview 283
Graph Assistant:Looks tab 278, 284
Graph Assistant:Properties tab 285
Graph Assistant:rotating text 314
Graph Assistant:searching field lists 82
Graph Assistant:selecting graph

types 284
Graph Assistant:selecting scales 285
Graph Assistant:Styles tab 284
Graph control 181
Graph control:Selections pane 248
Graph control:Selections pane;Graph

control:Control panel 246
graph footings 310, 312
graph footings:adding fields to 310, 313
graph footings:location in output 311
graph headings 310, 312
graph headings:adding fields to 310, 313
graph headings:location in output 311
graph height 316, 317
Graph pane;OLAP Control Panel:graph

pane;Control Panel:graph pane;OLAP
reports:displaying as graphs 252

Graph Preview 281, 283
Graph Properties window 464, 465
graph styles:controlling in OLAP;multiple

graphs:OLAP and;graphs:displaying in
OLAP;OLAP reports:displaying as
graphs 252

Graph subtab 335
graph titles 310
graph types 279, 284
graph types:3D 279
graph types:area 279
graph types:bar 279
graph types:bipolar 279
graph types:connected point plot 279
graph types:horizontal bar;graph

types:horizontal line;graph
types:horizontal area;graph
types:pie;horizontal graphs;vertical
graphs;pie graphs 247

graph types:line 279
graph types:pie 279
graph types:radar 279
graph types:scatter 279
graph types:selecting 278
graph width 316, 317

graphical elements 283
graphs 277, 463
graphs:adding labels 310, 313
graphs:adding to HTML pages 463
graphs:conditional styling 305
graphs:creating parameters 307
graphs:customizing 305, 313
graphs:displaying data 285, 287
graphs:displaying in OLAP 246
graphs:displaying in OLAP;graph

types:OLAP and;graph styles;graph
styles:controlling in OLAP;graph
types:vertical bar;graph types:vertical
area;graph types:vertical line 247

graphs:displaying multiple graphs in
columns 297

graphs:drilling down 306
graphs:formats 318
graphs:formatting 296, 314
graphs:Graph Properties window 464,

465
graphs:Manage Layout dialog box 467,

468
graphs:merging multiple graphs 296
graphs:missing values and 302, 303, 304
graphs:modifying components 467, 468
graphs:printing 317
graphs:running 317
graphs:saving 317
graphs:scales 284, 285
graphs:selecting components 467
graphs:sending output directly to a

printer 318
graphs:setting height and width 316
graphs:styling 305, 310, 313, 314, 316,

351, 353, 355
greatest integer 420
GREGDT function 398
Group Box Properties window 481
group boxes 481
group boxes:adding to HTML pages 481
group boxes:Group Box Properties

window 481
group fields attributes 671
grouping expressions 114, 115, 295
grouping numeric data into tiles 217,

218
grouping WHERE statements 114, 295

H
HADD function 399
HCNVRT function 400
HDATE function 401
HDIFF function 401
HDTTM function 402
Heading Properties dialog box 337
headings 106, 108
Headings tab 151, 310, 334, 335
headings:aligning 107
headings:customizing 107, 108
headings:for graphs 310
headings:styling 108
Help link 7
HEXBYT function 412
HGETC function 403
HHMMSS function 403, 425

784 System i: Database IBM DB2 Web Query for System i



hidden parameters 556
hiding y-axis fields 288
hierarchies;OLAP hierarchies 177
high-to-low sort 170
high-to-low sort:for dimensions;low-to-

high sort:for dimensions 200
high-to-low sort:for measures;low-to-high

sort:for measures 195
high-to-low sort:for measures;low-to-high

sort:for measures;high-to-low
sort;low-to-high sort 196

HINPUT function 404
HMIDNT function 404
HNAME function 405
horizontal labels 313
HPART function 406
HSETPT function 406
HTIME function 407
HTML Active Reports 129, 130
HTML Active Reports:creating 129
HTML Active Reports:formatting 130
HTML Active Reports:styling 130
HTML display pages 449
HTML files 447
HTML files:display pages 447, 449
HTML format 767
HTML forms 447
HTML Graph Assistant 278
HTML Graph Assistant:searching field
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HTML Layout Painter: applying chaining

logic 555
HTML Layout Painter: binding

objects 577, 579
HTML Layout Painter: creating active

dashboards 576
HTML Layout Painter: delete active

report objects 580
HTML Layout Painter: enabling cached

processing 551
HTML Layout Painter: html layout

controls 581, 585
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control 488
HTML Layout Painter: modify and style

tabs 493
HTML Layout Painter: multiple tab
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HTML Layout Painter: Refresh for active
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schedule page 597
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controls 497
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graphs 463

HTML Layout Painter:adding group
boxes 481

HTML Layout Painter:adding HTML
templates 563
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HTML Layout Painter:adding
images 476

HTML Layout Painter:adding lines 474,
475
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buttons 482

HTML Layout Painter:adding
reports 463

HTML Layout Painter:adding text 478
HTML Layout Painter:binding

objects 577
HTML Layout Painter:chaining logic 554
HTML Layout Painter:changing slider

bars 520
HTML Layout Painter:creating HTML

pages 457
HTML Layout Painter:display
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HTML Layout Painter:double list

control 507, 508
HTML Layout Painter:form settings 592
HTML Layout Painter:Form Settings

dialog box 596
HTML Layout Painter:HTML pages 457,
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HTML Layout Painter:Properties

window 525
HTML Layout Painter:Selected

Value 548
HTML Layout Painter:Settings dialog

box 594
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templates 563
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HTML pages:customizing 576
HTML pages:HTML Layout Painter 457,

463
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window 563
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HTML pages:properties 563
HTML pages:styling 563
HTML pages:templates 563
HTML pages:themes 563
HTML Report Assistant 71, 128
HTML Report Assistant:pop-up field
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lists 82

HTML reports 128
HTML reports:pop-up field
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HTML templates 563
HTML templates:adding to HTML

pages 563
hyperlink properties 602
Hyperlink Properties dialog box 483
hyperlinks 479
hyperlinks:adding to HTML pages 479
hyperlinks:adding to text 479

I
identifying procedures in fields 673, 674
identifying procedures in Master

Files 673, 674
iframe 469
ignore value option 535
Image Properties window 476
images 476
images:adding to HTML pages 476
images:Image Properties window 476
images:supplying parameter values 558
IMOD function 418
Impact Analysis 673, 674
Impact Analysis in fields 673, 674
importing values 535
incrementing date-time values 399
inline e-mail reports 712
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inserting page breaks 94
INT function 420
integer formats 86, 87
internal functions 357
international date formats 391
introducing DB2 Web Query 1
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ITONUM function 413
ITOPACK function 414
ITOZ function 415

J
join structures 116, 298
join structures:creating 116, 118, 119,

298, 300, 301
join structures:deleting 119, 302
join structures:editing 120, 302
Join tool 116, 298
joining data sources 116, 298
JPG format 767
JULDAT function 408
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K
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Label Properties dialog box 314, 316,

345, 346
LAST function 382
launch pages 447
launch pages:creating 449
launch pages:customizing 449
launch pages:frameset 449
launch pages:single-page 449
laying out HTML pages 574
laying out HTML pages:object

relationships 574
layout in Synonym Editor 609
LCWORD function 371
legend fonts 314, 316
Legend Properties dialog box 343
LIKE operator 115
limitations 591
line graphs 279
line graphs:styling 351, 353
linear scales 284, 285
lines 474
lines:adding to HTML pages 474, 475
links 7
List Box Properties window 506
list boxes 505
list boxes:Double List Box Properties

window 509
list boxes:List Box Properties

window 506
list boxes:supplying parameter

values 505
LJUST function 371
LOCASE function 372
log files 739
log files:purging 742
LOG function 420
log reports 737, 739, 742
log reports:considerations 741
log reports:reading 738
log reports:troubleshooting 742
log reports:viewing 737
logarithmic scales 284, 285
logarithms 420
Logoff link 7
logon pages 447
Looks tab 278, 284
Lotus format 161, 165
low-to-high sort 195

M
main pages 447
maintaining a schedule 730
Manage Layout dialog box 467, 468
manually adding a schedule button 600
mask text property 499
Master Files 71, 605, 607, 616, 644, 673,

674
Master Files in Business View 651
Master Files:calculated values 88
Master Files:defining dimensions 175
Master Files:DESCRIPTION

attribute 128
MAX function 420
MDY function 396

measure-based sorting 198
measure-based sorting:ranking

values;suppressing subtitles;high-to-low
sort:for measures;low-to-high sort:for
measures;low-to-high sort 197

measure-based sorting:removing sorting
criteria 200

measures 177
Measures control 181
Measures control:Selections pane 226,

260, 261
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432, 433, 436
measures:bar graphs and 429, 432, 433,

436
measures:deleting bar graphs from 433
measures:displaying 432
measures:drilling down on 192
measures:drilling down on;drilling down

on measures 188
measures:graphing 246, 248
measures:hiding;measures:exposing

hidden 260, 261
measures:in different dimensions 192
measures:NOPRINT 260, 261, 432
measures:stacking 254
measuring length 364
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merging multiple graphs 296
MIN function 420
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missing values:displaying 302, 303, 304,

310
Modeling View tab 615, 628, 641
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multi-field joins 119, 301
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new columns 83, 84, 85
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NOPRINT measures 260, 261, 432
NOT LIKE operator 115
notification and log information for
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numbering pages 120, 122
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numeric fields 92
numeric format 412
numeric formats 86, 87
numeric formats:adding a percent

sign 88
numeric functions 361, 416, 417, 418,

419, 420
numeric strings 357
numeric values 416

O
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object relationships:breaking 575
object relationships:Positioning

toolbar 575
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object relationships:setting size 574
OCP (OLAP Control Panel) 429
OCP (OLAP Control Panel):data

visualization and 429
OLAP 641
OLAP (Online Analytical

Processing) 167
OLAP button 182
OLAP Control Panel;measures

box;Control Panel;Measures check
box;Sort check box;High-to-Low radio
button;Rank check box 197

OLAP Control Panel:analysis and;OLAP
tools:Control Panel;Control
Panel:analysis and 182

OLAP Control Panel:data visualization
and 429

OLAP Control Panel:Date Selection
pane;Control Panel:Date Selection
pane;Range check box;date elements in
OLAP reports;Relations buttons 232

OLAP Control Panel:graphing results of a
report request;Control Panel:graphing
results of a report request;Show Graph
check box;measures:Control Panel
properties box;Graph button 252

OLAP Control Panel:opening;Control
Panel:opening 176, 182

OLAP Control Panel:ordering
data;Control Panel;ordering data 200

OLAP Control Panel:pivoting data
elements;rows;rows:pivoting sort fields
in OLAP reports;Control Panel:pivoting
data elements 212

OLAP Control Panel:sorting data
elements;Control Panel:sorting data
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OLAP data;sorting 195
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OLAP graphs;graphs:in OLAP;displaying
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OLAP interface options 176
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OLAP reports;working with OLAP
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268
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OLAP reports:removing sort criteria 200
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OLAP reports:sorting 192, 193, 198, 200
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pane;OLAP tools 179
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from 226
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and 429
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on-demand paging 124, 439, 444
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page 440
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Online Analytical Processing

(OLAP) 167
opening HTML Graph Assistant 278
order of evaluation in expressions 148

ordering data 200, 201
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output options 120
output to printer 127, 165
overflow options 50, 51
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overlaying character strings with

substrings 372
overview of DB2 Web Query 1
OVRLAY function 372

P
packed formats 86, 87
page breaks 94
page heading 334
page heading titles 151
page numbering 120, 122
PARAG function 373
parameter prompting enhancement 726
parameter properties 113, 293
parameter values 530, 531, 539, 541, 550
parameter values:check boxes 510
parameter values:drop-down lists

and 503
parameter values:dynamic list 530, 539,

541
parameter values:filtering with the chain

feature 550
parameter values:list boxes 505
parameter values:radio buttons 512
parameter values:static list 530, 533
parameter values:supplying 497
parameter values:text areas 502
parameter values:text boxes and 498
parameters 99, 711, 723
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window 539
Parameters (Static Values) window 531
Parameters tab 525
Parameters window 530, 550
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parameters:hidden 556
parameters:Parameters (Active
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parameters:Parameters (Dynamic Values)

window 539
parameters:Parameters (Static Values)

window 531
parameters:Parameters window 530, 550
parameters:properties 530, 550
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line 711
parameters:specifying values in a
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parameters:supplying values 497
parenthesis 114, 295
pattern columns 678
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PCKOUT function 415
PDF format 767
PDF reports 124
pie graphs 279
pie graphs:styling 355
pivoting sort fields in OLAP reports 177
PNG format 768
pop-up field descriptions 128

POSIT function 374
positioning options 50
PostScript reports 124
Power Painter 1, 9, 50
Power Painter canvas 11, 66, 68
Power Painter canvas:aligning objects 68
Power Painter canvas:showing grids

rulers and guides 66
Power Painter: graph/chart

properties 25
Power Painter:adding data sources 9
Power Painter:auto prompting

facility 48
Power Painter:changing themes 70
Power Painter:chart editor 26
Power Painter:closing data sources 10
Power Painter:closing palettes 14
Power Painter:creating a COMPUTE
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Power Painter:creating a DEFINE

statement 36
Power Painter:creating a Join between

data sources 36
Power Painter:creating a WHERE

statement 43
Power Painter:creating conditional styling

rules 40
Power Painter:creating parameters 48
Power Painter:customizing 65
Power Painter:customizing fixed
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Power Painter:docking palettes 12
Power Painter:fixed overflow 53
Power Painter:flowing overflow 56
Power Painter:functions 9, 35
Power Painter:graph component 22
Power Painter:image component 31
Power Painter:image properties 32
Power Painter:layout 66
Power Painter:line component 32
Power Painter:line properties 33
Power Painter:opening data sources 9
Power Painter:options 11
Power Painter:overflow options 51
Power Painter:panels 11
Power Painter:pinning palettes 13
Power Painter:relative relationships

between objects 60
Power Painter:relative relationships

rules 64
Power Painter:report component 15
Power Painter:report properties 17, 19
Power Painter:resetting the layout 14
Power Painter:setting flowing report

overflow 56
Power Painter:showing palettes 14
Power Painter:sizing and overflow 58
Power Painter:stacking palettes 13
Power Painter:subtotal options 34
Power Painter:text component 27
Power Painter:text properties 30
Power Painter:using components 15
Power Painter:using palettes 12
PRDNOR function 421
PRDUNI function 421
predefined StyleSheets 105
prefix operators 104, 288
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prefix operators;performing calculations
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in OLAP reports;relational
operators 221

printers 698
printers:distributing reports to 698
printing Master Files 616
projects 605, 607
Properties subtab 525
Properties tab of Graph Assistant 313
Properties tab of Graph Assistant

(Pie) 355
Properties tab of Graph Assistant (X

axis) 351
Properties tab of Graph Assistant (Y

axis) 353
Properties window 529
PS (PostScript) format 768
purging log files 742
Push Button Properties window 485
push buttons 482
push buttons:adding to HTML

pages 482
push buttons:Push Button Properties

window 485
push buttons:supplying parameter

values 557, 560

R
radar graphs 279
radio buttons 512
Radio Buttons Properties window 513
radio buttons:supplying parameter

values 512
raising numbers to a power 419
RDNORM function 422
RDUNIF function 422
Read Limit box 122
read limits 122
Record Limit box 122
record limits 122
records 109, 289
records:restricting 122
records:selecting 109, 289
records:styling 98, 305
records:totaling 122, 123
referencing an existing procedure with

parameters 598
refreshing active reports 589
relational operators 225, 228
Relations buttons 226, 228
relative positioning of objects 50
relative relationship between objects 60
remove synchronization 580
removing OLAP functionality 272
Report Assistant 1, 71
Report Assistant:building reports 74
Report Assistant:enabling on-demand

paging 124
Report Assistant:fully qualified field

names 78
Report Assistant:HTML-based 71
Report Assistant:layout 72
Report Assistant:OLAP enabling

from 126
Report Assistant:read limits 122

Report Assistant:record limits 122
Report Assistant:running reports 132
Report Assistant:searching field lists 82
Report Assistant:styling reports 120
Report Assistant:warning messages 122
Report Broker 687
Report Broker schedule page 603
Report Broker:administration 747
report columns 427
report columns:applying graphs to 427
report formats 765
Report Frame 439
report headings and footings 107
report headings/footings 542
report options 162
report parameters 723
Report Parameters window 723
Report Properties window 464, 465
report types 449
report types:ad hoc 449
report types:detail 81
report types:drill-down 449
report types:dynamic 449
report types:static 449
report types:summary 81
reporting environments 1
reporting interface 3, 5
reporting objects 116, 298
reporting tools 1
reports 71, 695
reports:adding to HTML pages 463
reports:applying arithmetic

operations 92
reports:bursting 700, 701, 722
reports:combining expressions 114, 294
reports:customizing 107, 108
reports:displaying 120
reports:displaying subtotals 94
reports:editing 133
reports:enabling on-demand paging 124
reports:justifying 124
reports:Manage Layout dialog box 467,

468
reports:modifying components 467, 468
reports:OLAP-enabling 126
reports:OLAP-enabling;OLAP-enabling

reports 176
reports:Report Properties window 464
reports:running 132
reports:saving 120
reports:searching for 441, 442
reports:searching for

information;searching for report
data;OLAP searches;OLAP-enabled
reports;analyzing report
data;reports:data analysis 168

reports:selecting components 467
reports:sorting 93
reports:styling 97, 120, 123, 124, 305
reports:suppressing display of fields 92,

93
reports:tracking 737
reports:visualizing trends in 427
repositioning objects 574
Reset Button Properties window 486
resetting a field list 83
resizing objects 574

retrieving current time 403, 425
retrieving data source values 382
retrieving date-time components 405,

406
retrieving environment variable

values 424
retrieving user IDs 425
returning current date 425
returning dates 409
REVERSE function 375
reversing character strings 375
reversing order of data in OLAP

reports 200
right-justifying character strings 376
RJUST function 376
rotating text 314
row totals 79
rows:totaling 122, 123

S
save as procedure 591
save options 133, 317
saving OLAP reports 273, 275
saving OLAP reports:as Excel files 275
saving OLAP reports:as My Reports 275
saving reports 133, 269, 317
saving reports:without OLAP

functionality 272
scales 284, 285, 416
scatter graphs 279
schedule blackout dates 744, 747
schedule blackout dates:about the Extract

Utility 749
schedule blackout dates:about the Import

Utility 748
schedule blackout dates:using Extract

Utility in interactive mode 755
schedule blackout dates:using Import

Utility in interactive mode 753
schedules:blackout dates 747
schedules:checking status 745
schedules:cloning 734
schedules:deleting 736
schedules:editing 731, 733
schedules:maintaining 730
searching field lists 82
second horizontal category 296
segment attributes summary 621
selecting fonts 314, 316
selecting OLAP tools 126
selecting records 109, 289
selecting report fields 74
selecting StyleSheets 105
selecting values for the x-axis 287
selecting values for the y-axis 287
Selection Criteria pane:Control

Panel 228
selection criteria;Selection Criteria

pane;OLAP Control Panel:Selection
Criteria pane;Control Panel:Selection
Criteria pane 228

selection criteria;selection
criteria:applying 225

selection criteria;selection
criteria:applying from OLAP Selections
pane 226
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selection criteria;selection
criteria:applying;limiting data:from
Selections pane 226

selection criteria:applying 228
selection criteria:applying in graph

requests 310
selection criteria:applying to a date

range 225, 228, 238
selection criteria:applying to date

elements 232, 233
selection criteria:applying to OLAP

reports 228
selection criteria:applying;limiting

data:from Control Panel;Measures
control:Control Panel 228

selection criteria:deleting 232
selection criteria:OLAP and 181
selection criteria:Selections pane and 226
Selections list box;dates:specifying in

OLAP reports;dates 244
Selections list box:deleting dates 244
send to printer 127, 165
setting date-time value 404
setting fixed scales 316
setting graph height 317
setting graph width 317
Settings dialog box 520
Settings subtab 349
show synchronized reports 579
single column 680, 682, 683, 684
slider bars 516
Slider Control Properties window 521
sort fields 74, 79
sort fields:subfoots 95
sort fields:subheads 95
sort order;AutoSort 196
sorting by column values in OLAP

reports; sorting in OLAP reports;
suppressing subtitles; high-to-low sort:
for measures; low-to-high sort:for
measures;low-to-high sort 195

sorting by column values in OLAP
reports;sorting in OLAP reports 198,
200

sorting measures; measures:sorting 178
sorting OLAP data 170, 195
sorting reports;sorting reports:OLAP

and 192
SOUNDEX function 376
specifying date ranges;date

formats:specifying;Master
Files:specifying date formats;Master
Files:defining dimensions;date
formats;dimensions:defining 232

specifying multiple e-mail addresses 694
specifying report parameters 723
spelling out numbers 377
SPELLNUM function 377
SQRT function 423, 424
square root numbers 423
Stack Measures check box 254
stacking measures 254
standard date and time functions 358,

382
standard reporting functions 35
standard reporting functions:creating a

COMPUTE statement 36

standard reporting functions:creating a
DEFINE statement 36

standard reporting functions:creating a
JOIN between data sources 36

standard reporting functions:creating a
WHERE statement 43

Standard toolbar 460
Static field values 533
static parameters 535
static reports 449
static/dynamic controls 542
statistics 680
Status option 745
storing date-time values 403
style composer 469, 496
Styles tab 284
StyleSheets 105, 106
StyleSheets;StyleSheets:OLAP hyperlinks

and;OLAP hyperlinks:StyleSheets
and 177

StyleSheets:predefined 105
styling fields 97
styling graphs 314, 316, 351, 353, 355
styling reports 97, 305
subfoots 95
subheads 95
subroutines 357
SUBSTR function 378
substrings 369, 370
subtitles 313
subtotals 94, 104
subtracting date-time values 382, 383
sum fields 92
summary reports 81
supplying parameter values 497
supplying parameter values:images 558
supplying parameter values:push

buttons 557, 560
SVG format 768
synchronize options 577
synchronize to active report 577
synchronized report properties 579
synonym attributes 618
synonym attributes in Synonym

Editor 618
Synonym Editor 609, 610, 615, 616, 617,

618, 620, 621, 623, 625, 628, 637, 640,
641, 647, 653, 656, 659, 663, 665, 668,
669, 670, 671, 673

Synonym Editor toolbar 617
Synonym Editor:adding group

fields 668
Synonym Text View tab 616
synonyms 609, 628, 676
system functions 362, 424

T
tab control 489, 494
tab edges 494
tab items 495
tab location 494
tab size 494
temporary fields 83, 84, 85, 659
temporary fields:creating 83
temporary fields:deleting 83
temporary fields:editing 83

temporary fields:order of evaluation 148
text 478, 503
text areas 502
text areas:supplying parameter

values 502
text areas:Text Area Properties

window 502
Text Box Properties window 500
text editor 6
text properties dialog boxes 314
Text Properties window 478
text rotation 314
text:adding to HTML pages 478
text:supplying parameter values 498,

503
text:Text Area Properties window 503
text:Text Box Properties window 498,

500
text:Text Properties window 478
three-state check box 432
Thumbnails tab 525
TILE column;tile

fields;percentiles;quartiles;sort
order:grouping numeric data;numeric
data grouped in tiles 217, 218

TIMETOTS function 408, 425
titles 310
titles:adding 313
TODAY function 409, 425
toolbars 460, 462
toolbars:Components 460
toolbars:Positioning 575
toolbars:Standard 460
totaling records 122, 123
totals 79
translating characters 365, 367
tree control events 516
tree control properties 516
tree controls 514
Tree mode 81
Tree View tab 610
trends:displaying in graphs 245

U
unavailable options in Report

Broker 728, 734, 742
uniform field name referencing;field

referencing in OLAP;field names in
OLAP;OLAP:field name
referencing;field name referencing 273

unspecified join 157
UPCASE function 379
usage notes in Business Views 650
user IDs 425
user interfaces 447
user interfaces:designing 447

V
validating packed fields 417
values 380
values for data profile 683
values for x- and y- axes 285
values from a procedure 535
vertical labels 313
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Viewer Control Panel 440
Viewer Control Panel:case sensitive

searches 442
Viewer Control Panel:closing 440
Viewer Control Panel:navigating

reports 440, 441
Viewer Control Panel:searching

reports 442
viewing and editing synonym

attributes 618
viewing fully qualified field names 78
viewing sorted OLAP data 198
Virtual Column calculator 665
virtual field attributes 663
virtual fields 35, 83, 84, 659
visualizing

trends;trends;trends:displaying as
graphs 245

W
warning message in heading 122
Web Query Developer Workbench 2
Web Query overview 1
web searches;searching for report

data 167
web searches;searching the web;web

queries 167
WHERE statements 109, 289
WHERE statements:combining

expressions 114, 294
WHERE statements:creating 109, 289
WHERE TOTAL statements 109, 289
Workbench 2
WP format 769
Wrap check box 314

X
x-axis 285, 287, 296
x-axis:properties 314
x-axis:setting fixed scales 316

Y
y-axis 135, 285, 287, 324
y-axis fields 288
y-axis fields:hiding 288
y-axis values 288
y-axis:setting fixed scales 316
YM function 409
YMD function 396

Z
z/OS UNIX system 698
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